Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to: docfeedback@servicenow.com
## Table of Contents

### Now Platform User Interface

- **UI16**
  - Comparison of UI16 and UI15 styles.................................................................5
  - Activate UI16........................................................................................................11
  - Switch between UI16 and UI15..........................................................................15
  - UI16 application navigator..................................................................................16
  - System settings for the user interface (UI).......................................................24

- **UI15**
  - Switch between UI15 and UI11.........................................................................27
  - UI15 application navigator..................................................................................29
  - UI15 banner frame and Edge buttons.................................................................31
  - Define a menu category in UI15........................................................................35

- **Legacy: UI11**
  - Legacy: UI11 application navigator.................................................................36
  - Legacy: UI11 banner frame.................................................................................37
  - Legacy: UI11 Edge buttons..................................................................................39
  - Legacy: Define a menu category in UI11............................................................40

- **Common UI elements**
  - Log in to an instance..........................................................................................42
  - Application navigator.........................................................................................42
  - The Edge.............................................................................................................54
  - Forms..................................................................................................................56
  - Lists.....................................................................................................................94
  - Selecting fields on related tables using dot-walking.......................................159
  - Use a slushbucket.............................................................................................172
  - Tree picker.......................................................................................................175
  - Condition builder..............................................................................................177
  - Operators available for filters and queries......................................................181
  - Activity streams in UI16 and UI15....................................................................197
  - Installed components for UI plugins..............................................................199
  - URL schema......................................................................................................200
  - User presence....................................................................................................203
  - Tags.....................................................................................................................205
  - Keyboard shortcuts...........................................................................................217

- **Generally supported browsers**.......................................................................218

- **User interface configuration**...........................................................................219
  - Response time indicator....................................................................................219
  - Navigation stack...............................................................................................221
  - Navigation action cancellation.........................................................................223
  - Context-sensitive help.......................................................................................228
  - Embedded help and guided tours......................................................................235
  - Overview help pages.........................................................................................235
  - System user guide.............................................................................................259
  - Manage audio files............................................................................................280
  - Storing images in the database.........................................................................280
  - User preferences...............................................................................................285
  - View management..............................................................................................305
  - Welcome pages..................................................................................................313
  - Map pages.........................................................................................................315
  - Theming an instance.........................................................................................329

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Now Platform User Interface

The user interface (UI) is the main way to interact with the applications and information in a ServiceNow instance.

The following video provides more information on the user interface:

The following versions of the user interface are available. Each new version is intended to provide an updated look and usability improvements.

UI16

The UI16 interface provides an updated look and usability improvements. Notable features include real-time form updates, user presence, a redesigned application navigator with tabs for favorites and history, and enhanced activity streams. UI16 is the default user interface for new instances. For upgraded instances, an administrator must activate UI16.
UI16 user interface
UI15

Features introduced in the UI15 interface include redesigned icons, the ability to specify when related lists load with a form, other new options on the system menu, and form personalization.

UI15 user interface

UI11

UI11 builds on the classic user interface by adding the Edge and several features including split screen, bookmarks, and flyout windows. UI11 is activated but disabled by default.
UI11 user interface

User interface components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner frame</td>
<td>Runs across the top of every page and contains a logo, global navigation controls, and tools. See System settings for the user interface (UI), UI15 banner frame and Edge buttons, or Legacy: UI11 banner frame.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Also called the left-navigation bar. Provides links to all applications and modules. See UI16 application navigator, UI15 application navigator, or Legacy: UI11 application navigator.</td>
</tr>
<tr>
<td>Content frame</td>
<td>Displays information such as lists, forms, homepages, and wizards.</td>
</tr>
<tr>
<td>The Edge</td>
<td>A toolbar on the left side of the UI15 and UI11 interfaces that provides quick links to commonly used features. See The Edge. In UI16, the Favorites tab of the application navigator, represented by a star, replaces the Edge. The collapsed view of the UI16 application navigator is similar to the Edge.</td>
</tr>
</tbody>
</table>
UI16

The UI16 interface provides an updated look and usability improvements. Notable features include real-time form updates, user presence, a redesigned application navigator with tabs for favorites and history, and enhanced activity streams. UI16 is the default user interface for new instances. For upgraded instances, an administrator must activate UI16.
UI16 user interface
UI16 components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner frame</td>
<td>Runs across the top of every page and contains a logo and the following information, controls, and tools.</td>
</tr>
<tr>
<td></td>
<td>- User menu provides options to access your profile and preferences. Administrators can impersonate users and elevate their security role.</td>
</tr>
<tr>
<td></td>
<td>- Connect sidebar icon ( ): Lets you begin or continue conversations. This icon is available if Connect is enabled.</td>
</tr>
<tr>
<td></td>
<td>- Global text search icon ( ): Finds records from multiple tables.</td>
</tr>
<tr>
<td></td>
<td>- Help icon ( ): Opens the help panel with embedded help, where available. If there is no embedded help, it offers help search options.</td>
</tr>
<tr>
<td></td>
<td>- Gear icon ( ): Opens the System settings for the user interface (UI).</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Also called the left-navigation bar. Provides links to all applications and modules. See Application navigator.</td>
</tr>
<tr>
<td>Content frame</td>
<td>Displays information such as lists, forms, homepages, and wizards.</td>
</tr>
<tr>
<td>The Edge</td>
<td>The Edge is removed in UI16. The collapsed view of the UI16 application navigator is similar to the Edge.</td>
</tr>
</tbody>
</table>

Comparison of UI16 and UI15 styles

Review the basic style differences between UI16 and UI15 styles in the ServiceNow platform.

Banner frame comparison

In UI16, the banner information and controls are in different places. The search box in the UI16 header opens when you select it. The help icon is available from the banner frame, instead of being accessed from the Settings menu. Because the UI16 banner is narrower, there is no control to collapse it.
Banner frame differences

For more information about the UI16 changes, see System settings for the user interface (UI).
Application navigator

In UI16, modules that you select are not automatically marked as favorites as illustrated by the blue stars in the UI15 image. Any menu or module can be marked as a favorite, and it appears when you click the Favorites tab represented by the star. The other tab displays items you recently accessed.

For more information, see UI16 application navigator. The navigation filter works the same in both UI versions, by entering text in the navigation filter to show matching applications, modules, and favorites.

Another difference in the UI16 navigator menu is that you can no longer right-click an application menu name to edit the application menu. Navigate to System Definition > Application Menus to add or modify modules.

The Edge

The Edge in UI15 is replaced in UI16 by the Favorites tab, represented by the star. Any item you could place on the Edge can be marked as a favorite. When you switch to UI16, all bookmarks on the edge are migrated to favorites and are listed on the Favorites tab. For more information, see Use the UI16 navigator. The List and Form View option is no longer available in UI16.
System settings

UI16 System Settings appear in a pop-up window with subtabs to make it easier to update your settings. The Split Layout setting available in UI15 was removed. For more information, see System settings for the user interface (UI).

![System Settings](image)

UI16 system settings

Basic configuration and the company logo

The banner size and color scheme has changed significantly in UI16. Therefore, there is a set of system properties for UI16 to set up your logo and branding before you switch to UI16. For more information, see Configure logo, colors, and system defaults for UI16.

The banner in which your logo appears is narrow, and your logo image is scaled based on the aspect ratio. A wider image scales better than a smaller one and is more readable, as in the following example. It is also recommended that you create a logo image with a transparent background.
Activate UI16

UI16 is the default user interface for new instances. For upgraded instances, you can activate the UI16 plugin (com.glide.ui.ui16) if you have the admin role.

Confirm that the instance upgrade completed successfully by visiting the upgrade monitor.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the Load demo data check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.
5. Click Activate.

Switch between UI16 and UI15

You can switch between the UI16 and UI15 user interface versions.

Role required: admin

After UI16 is activated, all users see the enhanced UI16 user interface. By default, administrators see a button at the top of the System Settings window that lets them switch between UI16 and UI15. The administrator can add a system property to configure other roles that see the button.

1. Click the gear icon (⚙️) in the banner frame to open the System Settings window.
2. Click Switch to UI15 or Switch to UI16.
   - The button that appears is based on which UI version you are using when you open System Settings.
The application refreshes with the selected UI. Your homepage appears in the content frame. You can access your favorites on the Edge (UI15) or in the Favorites tab of the application navigator (UI16).

**Configure roles allowed to switch between UI16 and UI15**

After you enable UI16, users with the admin role see a button in the System Settings window that allows them to switch between UI16 and UI15. You can add a system property to configure other roles that are allowed to switch UI versions.

Role required: admin

You may need to allow users who develop or configure applications to view the changes in both versions of the user interface. You list the roles in the new system property, and users with one of the roles see the switch button at the top of the System Settings window.

1. **Add a new system property** with the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.ui15_switch_roles</td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a comma-separated list of roles that are allowed to switch between UI16 and UI15. If you set the value to Public, all users are able to switch between the UI versions.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

   Test the new system property by impersonating a user with one of the roles and verifying that the switch button appears when the user opens the System Settings window.

**UI16 application navigator**

The UI16 application navigator appears at the left of the interface and provides access to all available applications and modules, favorites, and recently viewed items.

Use the application navigator to quickly find information and services.

The application navigator consists of a navigation filter and the following tabs.
<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All applications</td>
<td>Displays all application menus and modules. Each application appears as a section in the application navigator denoted by an application label. The tab lists modules by name under each application label.</td>
</tr>
</tbody>
</table>

![Filter navigator](image)

All applications tab
<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites</td>
<td>Displays items you have added as favorites. If you upgrade to UI16 from a previous interface, any bookmarks you created are automatically converted to favorites.</td>
</tr>
</tbody>
</table>

![Favorites tab](image)
<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>Displays items you have recently accessed.</td>
</tr>
</tbody>
</table>

Enter text in the navigation filter to show matching applications, modules, and favorites. Matching favorites appear at the top of the results. You can also use the navigation filter to quickly access a specific table. For more information, see [Navigate directly to a table](#).

**Use the UI16 navigator**

Everyone can collapse and expand the navigator, work with favorites, and view navigation history in UI16.

Complete any of the following tasks to work with the navigator in UI16.

**Collapse or expand information in the UI16 application navigator**

You can collapse or expand information in the application navigator to display only what you want to see.

Role required: none

Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collapse or expand an application or application section</td>
<td>Click the application or application section label.</td>
</tr>
</tbody>
</table>
## Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collapse or expand all applications</td>
<td>Double-click the all applications tab icon ( ).</td>
</tr>
<tr>
<td>Collapse or expand the application navigator</td>
<td>Click the arrow icon at the bottom of the application navigator. In the collapsed view, the application navigator displays favorites only. Click the filter icon or the arrow icon in the collapsed view to expand the application navigator.</td>
</tr>
</tbody>
</table>

### Collapsed navigator

![Collapsed navigator](image)

## Add or edit favorites in UI16

You can add, edit, or delete favorites for frequently accessed items in the application navigator.

Role required: none

Items you add as favorites appear in the favorites tab of the application navigator, represented by a star icon.
Favorites also appear in the collapsed view of the application navigator as icons.

**Note:** Any bookmarks you created in a previous version of the UI are automatically converted to UI16 favorites. However, UI15 favorites are not converted to UI16 favorites and must be recreated manually.

1. Add a favorite in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a module as a favorite</td>
<td>In the application navigator, click the star icon by a module.</td>
</tr>
<tr>
<td>Add all the modules under an application as favorites</td>
<td>In the application navigator, click the star icon by an application.</td>
</tr>
</tbody>
</table>
| Add a list as a favorite using the list context menu | 1. Open a list.  
2. Click the list context menu icon (equilateral triangle) by the list title.  
3. Select Create Favorite.  
4. In the flyout, edit the name and icon as needed. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a list as a favorite by dragging and dropping</td>
<td>1. Open a list.</td>
</tr>
<tr>
<td></td>
<td>2. Drag a breadcrumb to the Favorites tab of the application navigator.</td>
</tr>
<tr>
<td>Add a record as a favorite using the form context menu</td>
<td>1. Open a record.</td>
</tr>
<tr>
<td></td>
<td>2. Click the form context menu icon (≡) by the form title.</td>
</tr>
<tr>
<td></td>
<td>3. Select Create Favorite.</td>
</tr>
<tr>
<td></td>
<td>4. In the flyout, edit the name and icon as needed.</td>
</tr>
<tr>
<td>Add a record as a favorite by dragging and dropping</td>
<td>1. Open a record.</td>
</tr>
<tr>
<td></td>
<td>2. Drag the record title to the Favorites tab of the application navigator.</td>
</tr>
<tr>
<td>Add a different type of link as a favorite</td>
<td>Drag a supported link type to the Favorites tab of the application navigator.</td>
</tr>
<tr>
<td></td>
<td>You can drag any of the following links:</td>
</tr>
<tr>
<td></td>
<td>• Breadcrumbs</td>
</tr>
<tr>
<td></td>
<td>• Links in lists</td>
</tr>
<tr>
<td></td>
<td>• Reports</td>
</tr>
<tr>
<td><strong>Note:</strong> You may not be able to create bookmarks with other types of links.</td>
<td></td>
</tr>
<tr>
<td>Add a knowledge base article as a favorite</td>
<td>1. Open a knowledge article.</td>
</tr>
<tr>
<td></td>
<td>2. In the header at the top left, click the star icon.</td>
</tr>
<tr>
<td></td>
<td>3. In the Create Favorite dialog box, edit the name and icon as needed.</td>
</tr>
<tr>
<td></td>
<td>4. Click Done.</td>
</tr>
</tbody>
</table>

You can add a different favorite for each view of a list or form.  
The favorite is added to the Favorites tab of the application navigator.

2. To edit or delete a favorite, complete any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reorder favorites in the list</td>
<td>1. At the bottom of the application navigator, click Edit Favorites.</td>
</tr>
<tr>
<td></td>
<td>2. Drag a favorite to a new location in the list.</td>
</tr>
<tr>
<td></td>
<td>3. Click Done or Edit Favorites.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Customize the name or icon for a favorite   | 1. At the bottom of the application navigator, click **Edit Favorites**.  
2. Click a favorite.  
3. Customize the name and icon as needed.  
4. Click **Done** or **Edit Favorites**. |
| Delete a favorite                           | 1. Point to the favorite.  
2. Click the remove favorite icon (**`). |

**View your navigation history**

In UI16, you can view your navigation history in the application navigator.

Role required: none

Items you have accessed recently appear in the history tab of the application navigator, which is represented by a clock icon. Items appear in chronological order from most to least recently accessed.
History entries are stored in the Navigator History (sys_ui_navigator_history) table. The system creates history entries for many types of content, including lists, records, and homepages. Some content types are not tracked in the history, such as UI pages and other non-standard interfaces.

1. In the application navigator, click the history tab, which is represented by a clock.
2. Click an item to open it.

**Configure the number of history entries displayed in the application navigator**

A system property sets the maximum number of history entries displayed in the history tab of the application navigator.

Role required: admin

By default, the application navigator shows 30 history entries. You can configure the glide.ui.nav.history_length property to change this value.

1. Navigate to sys_properties.list.
2. Locate the glide.ui.nav.history_length property.
3. Edit the property Value.

**System settings for the user interface (UI)**

You can define system settings to customize the UI for yourself. The gear icon, located within the banner frame, displays the system settings pop-up window.

The system settings are organized by tab. At the top, administrators (admin role) see the Switch to UI15 button if UI16 is activated.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General tab</td>
<td></td>
</tr>
<tr>
<td>Accessibility enabled</td>
<td>More advanced accessibility features are activated when this setting is enabled. The platform is designed to be accessible by default. Enabling this feature makes more accessibility features available.</td>
</tr>
<tr>
<td>Compact the user interface</td>
<td>The UI is optimized to display more information in the browser window when this setting is enabled.</td>
</tr>
<tr>
<td>Compact list date/time</td>
<td>Date and time values appear in a compact format when this setting is enabled. The year is not shown for date values within the current year, and seconds are not shown for time values. This setting is not available if the Date/Time selection is Time Ago.</td>
</tr>
<tr>
<td>Home</td>
<td>Determines whether the Home module opens <strong>Homepages</strong> or <strong>Dashboards</strong>. The user must have the pa_viewer role or the glide.cms.enable.responsive_grid_layout property must be set to true to see this setting.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>The format in which dates and times appear depends on this setting. Select Calendar (for example, 2015-11-13, 15:58:58), Time Ago (for example, 11 minutes ago), or Both.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language</td>
<td>Select a language or return to the default language (🔗). This setting is available if a language plugin is activated.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select a time zone or return to the default time zone for the current session. Upon the next login, the time zone will revert to the system default or user profile setting for time zone, if present. (🔗).</td>
</tr>
<tr>
<td>Domain</td>
<td>Specifies the currently selected domain for organizations that are using domain separation. The user must have the domain_admin or admin role to see this setting.</td>
</tr>
<tr>
<td>Show domain picker in header</td>
<td>Places a domain picker in the banner frame, next to the user menu, when this setting is enabled.</td>
</tr>
<tr>
<td>Printer friendly version (🔗)</td>
<td>Opens a printer friendly version of the current content frame.</td>
</tr>
<tr>
<td>Theme tab</td>
<td>Select a theme for the user interface. Select the System theme to return to the default theme.</td>
</tr>
<tr>
<td>Lists tab</td>
<td></td>
</tr>
<tr>
<td>Wrap longer text in list columns</td>
<td>Long strings wrap in list columns instead of appearing as one long line when this setting is enabled.</td>
</tr>
<tr>
<td>Striped Table Rows</td>
<td>List v3 rows alternate between contrasting shades of gray when this setting is enabled. This setting is available if List v3 is activated.</td>
</tr>
<tr>
<td>Modern Cell Styles</td>
<td>List field status indicators use modern cell styles when this setting is enabled. This setting is available if List v3 is activated, though it applies to v2 lists as well.</td>
</tr>
<tr>
<td>Forms tab</td>
<td></td>
</tr>
<tr>
<td>Tabbed forms</td>
<td>Form sections and related lists appear in tabs when this setting is enabled.</td>
</tr>
<tr>
<td>Related list loading</td>
<td>Determines when related lists load on forms. This setting applies only when List v3 is disabled for related lists. For more information, see Configure when a related list loads.</td>
</tr>
<tr>
<td>Notifications tab</td>
<td></td>
</tr>
<tr>
<td>Allow notifications</td>
<td>Global switch for enabling or disabling all notifications.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Notification channels   | List of your channels for receiving notifications. Use this section to:  
  - Enable or disable a channel by using its toggle switch. If you disable a channel, notifications are not delivered through that channel.  
  - **Add channels** using the Create Channel option.  
  - **Modify channel information**. Click the channel row or the right arrow (>) next to the appropriate channel to edit or delete it. |
| Notifications by category| List of notification categories that identify and group related notifications. Each category contains the notifications that you can subscribe to.  
  To view the notifications in a given category, click the category row or the right arrow (>) next to the appropriate category. You can:  
  - Edit a notification.  
    - Enable or disable channels for the selected notification.  
    - **Apply notification conditions**, such as schedules and filters, that affect the delivery of the notification.  
    - **Create personal notifications**, which are subscriptions to specific notifications that matter to you. |
| Developer tab            |                                                                                                                                               |
| Application              | (Administrators only) Provides a link to the application picker, the Applications list ( ), and the currently selected application ( ). |
| Show application picker in header | Places an application picker in the banner frame, next to the user menu, when this setting is enabled. |
| Update Set               | (Administrators only) Provides a link to the update sets list, the update set picker, and the currently selected update set.                  |
| Show update set picker in header | Places the update set picker in the banner frame, next to the user menu, when this setting is enabled. |
| JavaScript Log and Field Watcher | (Administrators only) Opens the client-side JavaScript Debug window. |
System Settings window, General tab

UI15

The UI15 interface provides an updated look, usability improvements, and redesigned icons. UI15 is the default user interface for upgraded instances.
UI15 user interface

UI15 components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner frame</td>
<td>Runs across the top of every page and contains a logo, global navigation controls, and tools. See <a href="#">UI15 banner frame and Edge buttons</a>.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Also called the left-navigation bar. Provides links to all applications and modules. See <a href="#">Application navigator</a>.</td>
</tr>
<tr>
<td>Content frame</td>
<td>Displays information such as lists, forms, homepages, and wizards.</td>
</tr>
<tr>
<td>The Edge</td>
<td>A toolbar on the left side of the interface that provides quick links to commonly used features. See <a href="#">The Edge</a>.</td>
</tr>
</tbody>
</table>
Switch between UI15 and UI11

You can disable UI15, which reverts the user interface to UI11.

If UI16 is enabled, you must first switch to UI15.

Role required: admin

1. Enter `sys_properties.list` in the navigation filter and press the Enter key.
2. Locate the `glide.ui.doctype` property in the System Properties list.
   The property is set to `true` by default, which enables UI15.
3. Set the property `Value` to `false`.
4. Log out and back in.
   UI15 is disabled for the instance. The interface reverts to UI11 in individual user sessions when each user logs out and logs back in.

UI15 application navigator

The application navigator appears at the left of the interface and provides access to all available applications and modules. You can collapse and expand all items, and switch perspectives to a specified role.

Each application appears as a section in the application navigator denoted by an application label. The application navigator lists modules by name under each application label. Use the application navigator to quickly find information and services.
Enter text in the navigation filter to show matching applications and modules. You can also use the navigation filter to quickly access a specific table. For more information, see Navigate directly to a table.

In the UI15 application navigator, a star appears by each module. For more information, see Use favorites in UI15.

**Collapse or expand information in the UI15 application navigator**

You can collapse or expand information in the application navigator to display only what you want to see.

- To collapse or expand an application or application section, click the application or application section label.
- To collapse all applications, click the application menu icon and select **Collapse All Applications**.
- To expand all applications, click the application menu icon and select **Expand All Applications**.
- To collapse or expand the application navigator, in the edge, click **Toggle Navigator**.
Switch perspectives in the UI15 application navigator

You can switch role perspectives to show different views of the application navigator. A perspective filters the available applications by that role. For example, select ITIL to show only ITIL items such as Incidents, and filter out asset management items such as Asset Portfolio. This option is available only if you have access to more than one role perspective.

To switch perspectives, in the application navigator, click the menu icon (Application navigator menu icon). Select Roles, and then select a perspective.

Use favorites in UI15

In UI15, you can select modules as favorites to quickly filter out modules you do not use often.

Role required: none

Each module in the application navigator has a star icon to the left of the module name that can be selected (⭐) or deselected (⭐).

Note: If you upgrade to UI16, you must recreate any UI15 favorites manually.

1. Click the star icons to select and deselect modules as favorites.
2. Click the filter favorites icon (⭐) next to the navigation filter to toggle between showing only the favorite modules and showing all modules.

By default, a module is automatically selected as a favorite when you open the module. To disable this setting, click the menu icon (▼) in the application navigator header and select Automatically Add Favorites.

UI15 banner frame and Edge buttons

The banner frame runs across the top of every page. In UI15, buttons on the Edge provide shortcuts to work with bookmarks and the user interface.

The banner frame for UI15 contains a logo and the following information, controls, and tools.

UI15 banner frame controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome message</td>
<td>Shows the name of the current user and provides a link to the user’s profile.</td>
</tr>
<tr>
<td>Impersonation key icon</td>
<td>(Administrators only) Allows the administrator to switch user views without logging out; useful for testing security and role-specific setup functions.</td>
</tr>
<tr>
<td>Elevate privileges icon</td>
<td>(Elevated privilege roles only) Allows the user to elevate to a higher security role when needed and then return to their normal role.</td>
</tr>
<tr>
<td>Global text search icon</td>
<td>Global text search finds records from multiple tables.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Collapse/Expand banner icon ( △ / ▼ )</td>
<td>Alters the amount of space the banner frame occupies.</td>
</tr>
<tr>
<td>Logout</td>
<td>Returns to the Welcome page for subsequent login.</td>
</tr>
<tr>
<td>Gear icon ( ⚙ )</td>
<td>Displays the system menu with additional settings and controls.</td>
</tr>
</tbody>
</table>

The gear icon, located within the banner frame, displays the system menu.

**System menu controls**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's new</td>
<td>Opens a slideshow of UI15 highlights.</td>
</tr>
<tr>
<td>Help icon ( ? )</td>
<td>Opens the ServiceNow Wiki in another window or tab.</td>
</tr>
<tr>
<td>Home icon ( home )</td>
<td>Provides links to available dashboards.</td>
</tr>
<tr>
<td>Wrap Longer Text in List Columns</td>
<td>Long strings wrap in list columns instead of appearing as one long line when this setting is enabled.</td>
</tr>
<tr>
<td>Compact View</td>
<td>The UI is optimized to display more information in the browser window when this setting is enabled.</td>
</tr>
<tr>
<td>Accessibility Enabled</td>
<td>Section 508 accessibility features are activated when this setting is enabled.</td>
</tr>
<tr>
<td>Tabbed forms</td>
<td>Form sections and related lists appear in tabs when this setting is enabled. This setting previously appeared as an icon in the form header.</td>
</tr>
<tr>
<td>Alt/#+Click Opens List Links in Form Pane</td>
<td>Pressing Alt (PC) or Command (Mac) and clicking the record name in a list, opens the record in a new form pane tab when this setting is enabled.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>The format in which dates and times appear depends on this setting. Select Calendar (for example, 2014-11-13, 15:58:58), Time Ago (for example, 11 minutes ago), or Both.</td>
</tr>
<tr>
<td>Compact list date/time</td>
<td>Date and time values appear in a compact format when this setting is enabled. The year is not shown for date values within the current year, and seconds are not shown for time values. This setting is not available if the Date/Time selection is Time Ago.</td>
</tr>
<tr>
<td>Split Layout</td>
<td>Splits the content frame into two panes, either Vertical or Horizontal. In a vertical split, the list pane is on the left and the form pane is on the right. In a horizontal split, the list pane is on the top and the form pane is on the bottom. Select None to disable the split layout.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related List Loading</td>
<td>Determines when related lists load on forms. For more information, see <a href="#">Configure when a related list loads</a>.</td>
</tr>
<tr>
<td>Application</td>
<td>(Administrators only) Provides a link to the Applications list ( ), the application picker, and the currently selected application ( ).</td>
</tr>
<tr>
<td>Update Set</td>
<td>(Administrators only) Provides a link to the update sets list, the update set picker, and the currently selected update set.</td>
</tr>
<tr>
<td>Language</td>
<td>Select a language or return to the default language ( ). This option is available if a language plugin is activated.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select a time zone or return to the default time zone ( ).</td>
</tr>
<tr>
<td>Theme</td>
<td>Select a theme for the user interface or return to the system theme ( ).</td>
</tr>
<tr>
<td>Domain</td>
<td>Specifies the currently selected domain for organizations that are using domain separation. The user must have the domain_admin role for this setting to appear.</td>
</tr>
<tr>
<td>Printer friendly version</td>
<td>Opens a printer friendly version of the current content frame.</td>
</tr>
<tr>
<td>JavaScript Log and Field Watcher</td>
<td>(Administrators only) Opens the client-side JavaScript Debug window. This icon is commonly called the debug icon.</td>
</tr>
</tbody>
</table>
System menu
UI15 Edge buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle navigator</td>
<td>Shows or hides the application navigator.</td>
</tr>
<tr>
<td>List and form view</td>
<td>Splits the content frame into two vertical panes, with the list pane on the left and the form pane on the right. To split the pane horizontally, click the gear icon in the banner frame and then click Split Layout Horizontal.</td>
</tr>
<tr>
<td>Tagged documents</td>
<td>Displays the Tagged Documents page.</td>
</tr>
<tr>
<td>All bookmarks</td>
<td>Provides a list of all bookmarks in the Edge. Users can create, customize, and delete bookmarks. For more information, see Bookmarks.</td>
</tr>
<tr>
<td>Bookmark and pane-based UI help</td>
<td>Displays the Edge help window.</td>
</tr>
</tbody>
</table>

Define a menu category in UI15

Menu categories allow administrators to change the appearance of application menu labels. Use menu categories to make certain application menus stand out.

Role required: admin

1. **Add a property** with the following specifications.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui14.navigator.use_border_color</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>
2. Navigate to **System Definition > Menu Categories**.
3. Click **New** or open an existing menu category.
4. In the **Style** field, define the border-color using an HTML color name, hexadecimal (hex) value, or RGB color value. For example, enter `border-color: blue`.
5. Optional: Enter a **Default order**.
   If you create an application without specifying an order, the default order of the category is used to determine the relative position in the application navigator.

**Note:** You may need to clear the instance cache and refresh the page after saving the menu category to see CSS changes.

---

**Legacy: UI11**

UI11 is deprecated in the Istanbul release. UI11 builds on the classic user interface by adding the Edge and several features including split screen, bookmarks, and flyout windows.

UI11 is activated but disabled by default.
UI11 components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner frame</td>
<td>Runs across the top of every page and contains a logo, global navigation controls, and tools. See <a href="#">Legacy: UI11 banner frame</a>.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Also called the left-navigation bar. Provides links to all applications and modules. See <a href="#">Application navigator</a>.</td>
</tr>
<tr>
<td>Content frame</td>
<td>Displays information such as lists, forms, homepages, and wizards.</td>
</tr>
<tr>
<td>The Edge</td>
<td>A toolbar on the left side of the interface that provides quick links to commonly used features. See <a href="#">The Edge</a>.</td>
</tr>
</tbody>
</table>

**Legacy: UI11 application navigator**

The application navigator appears at the left of the interface and provides access to all available applications and modules.

Each application appears as a section in the application navigator denoted by an application label. The application navigator lists modules by name under each application label. Use the application navigator to quickly find information and services.

Enter text in the navigation filter to show matching applications and modules. You can also use the navigation filter to quickly access a specific table. For more information, see [Navigate directly to a table](#).
In the UI11 application navigator, an icon appears by each module. Administrators can customize the icons.

**Legacy: Collapse or expand information in the UI11 application navigator**

You can collapse or expand information in the application navigator to display only what you want to see.

Role required: none

You can collapse or expand information in the application navigator to display only what you want to see.

Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collapse or expand an application or application section</td>
<td>Click the application or application section label</td>
</tr>
<tr>
<td>Collapse all applications</td>
<td>Click the collapse all applications icon (−)</td>
</tr>
<tr>
<td>Expand all applications</td>
<td>Click the expand all applications icon (+)</td>
</tr>
<tr>
<td>Collapse or expand the application navigator</td>
<td>In the Edge, click the toggle navigator icon</td>
</tr>
</tbody>
</table>

**Legacy: Switch perspectives in the UI11 application navigator**

You can switch role perspectives to show different views of the application navigator.

A perspective filters the available applications by that role. For example, select ITIL to show only ITIL items such as Incidents, and filter out asset management items such as Asset Portfolio.

**Note:** Administrators can customize which perspectives are available and who can access them. For more information, see [Create or modify a menu list](#).

1. In the application navigator, click the switch perspectives icon (⁻). This icon is available only if you have access to more than one perspective.
2. Select a perspective.

**Legacy: Modify or create a module icon**

Modules in the UI11 application navigator have icons in addition to names. You can modify the icon that represents a module in UI11, or create the icon.
Role required: admin

Administrators can modify the icons for existing modules and define icons for new modules.

Note: If you change the icon for a base system module, your change is preserved during software updates.

1. Navigate to System Definition > Modules.
2. Select the module for which you want to modify the icon.
3. In the Image field, click the reference lookup icon (🔍).
4. Select the desired image file from the existing images.
5. Click Update.
6. Complete the following steps to create a new icon.
   Use a graphics software program to create an icon file with the following specifications.
   • Size: 16 X 16 pixels
   • File type: .png, .gif, or .jpg
     a) Upload the new icon to the database.
     b) In the application navigator, right-click the application name and select Edit Application.
     c) Personalize the Modules related list to add the Image field.
     d) Use the list editor to enter the file name (example, my_image.png).

Legacy: UI11 banner frame

The banner frame runs across the top of every page. It contains a logo and the following information, controls, and tools. Administrators can customize the banner frame.
UI11 banner frame

The UI11 banner frame contains the following information, controls, and tools.

**UI11 banner frame controls**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome message</td>
<td>Shows the name of the current user and provides a link to the user’s profile.</td>
</tr>
<tr>
<td>Impersonation key icon (**)</td>
<td>(Administrators only) Allows the administrator to switch user views without logging out. This control is useful for testing security and role-specific setup functions.</td>
</tr>
<tr>
<td>Elevate privileges icon (**)</td>
<td>(Administrators only) Allows the user to elevate to a higher security role when needed and then return to their normal role.</td>
</tr>
<tr>
<td>Global text search icon (**)</td>
<td>Global text search finds records from multiple tables.</td>
</tr>
<tr>
<td>Collapse/expand banner icon (*/&quot;)</td>
<td>Alters the amount of space the banner frame occupies.</td>
</tr>
<tr>
<td>Logout</td>
<td>Returns to the Welcome page for subsequent login.</td>
</tr>
<tr>
<td>Homepage icon (**)</td>
<td>Provides links to selectable dashboards.</td>
</tr>
<tr>
<td>Printer friendly version icon (**)</td>
<td>Opens a printable version of the current content frame.</td>
</tr>
<tr>
<td>Help icon (**)</td>
<td>Opens the ServiceNow Wiki in another window or tab.</td>
</tr>
<tr>
<td>JavaScript Debugger window icon (**)</td>
<td>(Administrators only) Opens the client-side JavaScript Debug window. This icon is commonly called the debug icon.</td>
</tr>
</tbody>
</table>

The **Switch UI** link may also appear in the banner next to the global text search field. This link allows switching between UI11 and the classic interface. Administrators control the appearance of the link in the banner frame with the `glide.ui11.show_switch_link` property. This property is set to false for new instances.

**Legacy: UI11 Edge buttons**

In UI11, the Edge provides the following buttons.
UI11 Edge buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle navigator</td>
<td>Shows or hides the application navigator.</td>
</tr>
<tr>
<td>Toggle banner</td>
<td>Shows or hides the banner frame.</td>
</tr>
<tr>
<td>Toggle vertical split form pane</td>
<td>Splits the content frame into two panes, with the list pane on the left and the form pane on the right.</td>
</tr>
<tr>
<td>Toggle horizontal split form pane</td>
<td>Splits the content frame into two panes, with the list pane on the top and the form pane on the bottom.</td>
</tr>
<tr>
<td>All bookmarks</td>
<td>Provides a list of all bookmarks in the Edge. Users can create, customize, and delete bookmarks. For more information, see Bookmarks.</td>
</tr>
<tr>
<td>Bookmark and pane-based UI help</td>
<td>Displays the Edge help window.</td>
</tr>
</tbody>
</table>

Legacy: Define a menu category in UI11

Menu categories allow administrators to change the appearance of application menu labels with CSS styles. Use styles to make certain application menus stand out.

Role required: admin

1. Navigate to System Definition > Menu Categories.
2. Click New or open an existing menu category.
3. In the Style field, define CSS styles such as border-color, text color, and background-color. For example, enter border-color: blue; background-color: #e3f3ff; color: white.
4. Optional: Enter a Default order.
   If you create an application without specifying an order, the default order of the category is used to determine the relative position in the application navigator.

Note: You may need to clear the instance cache and refresh the page after saving the menu category to see CSS changes.
Common UI elements

This page lists common UI elements for the standard user interface.

Log in to an instance

Each ServiceNow instance has a unique, secure web address. The base URL for each instance has the default format: https://<instancename>.service-now.com.

Role required: none

Users log in to the instance from a web browser.

Note: ServiceNow does not support any methodologies before the London release to associate a custom or vanity URL. If you have a custom or vanity URL associated with an instance prior to the London release, ServiceNow recommends also providing users with the default URL. Users can access the ServiceNow instance if any issues arise from a non-supported custom URL configuration.

1. Enter the base URL in any web browser.
   - If your system uses external authentication, you are automatically logged in. For example, you may log in to company services when you log in to your computer.
   - If your system does not use external authentication, the Welcome page appears.

2. Enter your user name and password.

3. Optional: Select the Remember Me check box to remain logged in until you manually log out. The administrator can enable or disable this option. For more information, see Change settings for the Remember me check box and cookie.

4. Press the Enter key or click Login.

Application navigator

The application navigator, or left navigation bar, provides access to all applications and the modules they contain, enabling users to quickly find information and services.

An application is a group of modules, or pages, that provide related information and functionality in an instance. For example, the Incident application contains modules for creating and viewing incidents. The Configuration Management application contains modules for configuring servers, databases, and networks.

In UI16, the application navigator also provides access to favorites and recently viewed items.

Administrators can customize the application navigator to provide different modules by user role, modify or define applications and modules, and change its appearance.

The following video provides more information on the application navigator:

Navigate directly to a table

You can use commands in the navigation filter to navigate directly to the list, form, or configuration view of a table.

Role required: none

Commands work only for tables you are permitted to access.
Note: The table name must match the name in the dictionary entry for the table.

1. In the navigation filter of the application navigator, enter one of the following commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;table name&gt;.list</code></td>
<td>Opens the list view of the table in the same window or tab.</td>
</tr>
<tr>
<td><code>&lt;table name&gt;.LIST</code></td>
<td>Opens the list view of the table in a new window or tab.</td>
</tr>
<tr>
<td><code>&lt;table name&gt;.form</code> or <code>&lt;table name&gt;.do</code></td>
<td>Opens the form view of the table in the same window or tab.</td>
</tr>
<tr>
<td><code>&lt;table name&gt;.FORM</code></td>
<td>Opens the form view of the table in a new window or tab.</td>
</tr>
<tr>
<td><code>&lt;table name&gt;.config</code></td>
<td>Opens the configuration view [personalize_all.do] of the table in the same window or tab.</td>
</tr>
<tr>
<td><code>&lt;table name&gt;.CONFIG</code></td>
<td>Opens the configuration view [personalize_all.do] of the table in a new window or tab.</td>
</tr>
</tbody>
</table>

For example, enter `change_request.form` to open a new change request.

2. In UI16, press the Enter key.

Create or modify a menu list

In UI15 and UI11, it is possible to switch menu lists, providing different perspectives of the applications and modules. You can create or edit these menu lists using the Menu List table.

Role required: admin

Menu lists are not used in UI16.

1. Navigate to System UI > Menu Lists.
2. Select a menu list to modify, or click New to create a new menu list.
   The applications that appear on the form are listed in the **Applications** field, one per line. Applications use the name of the application record, not the human-readable record that appears in the left navigation bar.

   The roles that are able to see the form are listed in the **Roles** field.
   - Specifying no roles creates a global menu list.
   - A menu list displays only the applications and modules the role has permissions to see.
   - If a role is specified to see a menu list, but role cannot view any of the applications within it, they do not see the menu list.
3. Adjust the information in the menu list as desired.
4. Click Update.

Enable or disable an application menu or module

You can enable (show) or disable (hide) an application menu or module in the application navigator.

Role required: admin

1. Navigate to System Definition > Application Menus.
2. If you are enabling an application menu, click All in the breadcrumbs to display both active and inactive application menus (remove the default filter condition).

3. Click the desired title. The application menu record opens and the Modules related list shows the modules that appear in the application navigator.

4. Enable or disable the application menu and modules as desired.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable or disable a specific module in the application | 1. Double-click the Active field beside the module name in the Modules related list.  
2. Set Active to true (show) or false (hide). |
| Enable or disable multiple modules at the same time | 1. Select the check boxes next to the module names.  
2. Select Change active state from the Actions choice list. |
| Enable or disable the entire application menu (for example, Incident or Service Catalog) | Select or clear the Active check box. |
| Restrict the application menu to specific roles | Use the Roles field. |

5. Click Update.

When you change application menus or modules, the application navigator automatically refreshes to display the changes.

**Add an application menu to a category**

There are two methods for adding an application menu to a category.

**Note:** Menu categories are deprecated in UI16. The following procedure has no effect in UI16.

Use one of the following methods to add an application menu to a menu category.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| In the menu category record, add the application menu to the Application Menus related list. | 1. Navigate to System Definition > Menu Categories.  
2. Open a menu category.  
3. In the Application Menus related list, click Edit.  
4. Use the slushbucket to add the application menu to the category.  
5. Click Save. |
Create an application menu

Application menus define the main content that users can access in the application navigator. You can configure which applications appear in the application navigator.

Role required: admin

When creating an application menu, consider grouping like modules into a consolidated application menu. When editing an existing menu, add more useful modules to the application menu, and remove unneeded ones.

1. Navigate to System Definition > Application Menus.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Defines the display name of the application menu.</td>
</tr>
<tr>
<td>Roles</td>
<td>Restricts access to the specified roles. All users can view the application menu when it is active.</td>
</tr>
<tr>
<td>Category</td>
<td>Specifies the menu category that defines the navigation menu style (default value is Custom Applications).</td>
</tr>
<tr>
<td>Hint</td>
<td>Defines the text that appears in a tooltip when a user points to this application menu.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate the application menu. Only active application menus appear in the application navigator.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a more detailed explanation of what this application does.</td>
</tr>
<tr>
<td>Other fields</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Defines the relative position of the application menu in the application navigator. If you do not specify an order, the default order of the menu category is used.</td>
</tr>
<tr>
<td>Default device type</td>
<td>This field is not used. You can define application menus for mobile devices in a separate table. See Define a new smartphone application menu.</td>
</tr>
</tbody>
</table>
Note: You may need to configure the form to see all fields.

4. Click **Submit**.
5. **Create modules** to appear in the application menu.
   Only application menus that contain modules appear in the application navigator.

**Create a module**

Modules are the children, or the second tier navigation options, to the applications in the application navigator. Modules often link to other pages or records in the platform. You can configure which modules appear in the application navigator using the **Application Menus** module.

Role required: admin

1. Open the application menu record using one of the following methods.
   - Navigate to **System Definition > Application Menus** and select the application menu from the list.
   - In UI16, point to the application menu and click the edit application (pencil) icon.
   - In UI15 or UI11, right-click the application label in the application navigator and select **Edit Application**.
Two methods for creating a module
2. Scroll down to the **Modules** related list and click **New**.
3. Define the module by completing the fields on the form.

### Module form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Defines the module name. Choose a title that clearly identifies the module.</td>
</tr>
<tr>
<td><strong>Application menu</strong></td>
<td>Specifies the name of the application menu under which the module appears.</td>
</tr>
<tr>
<td><strong>Hint</strong></td>
<td>Defines the tool tip that appears when a user points to the module name.</td>
</tr>
<tr>
<td><strong>Note:</strong> Module Hints are deprecated in UI16</td>
<td></td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>The order in which the module displays in relation to other modules.</td>
</tr>
<tr>
<td><strong>Visibility</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Roles</strong></td>
<td>Restricts module access to the specified roles. If this field is left blank, the module is visible to all users who have access to the application menu.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Defines whether the module appears in the application navigator.</td>
</tr>
<tr>
<td><strong>Override application menu roles</strong></td>
<td>Allows users to access this module even if they do not have permission to view the containing application menu. Users must still meet the role requirements for this module.</td>
</tr>
<tr>
<td><strong>Link Type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Link type</strong></td>
<td>Specifies what type of link this module opens. You must specify additional information based on the link type. See Module link types.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Specifies the table used by the module.</td>
</tr>
<tr>
<td><strong>Note:</strong> The list shows only tables and database views that are in the same scope as the module.</td>
<td></td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Specifies the order in which the modules appear under the application.</td>
</tr>
</tbody>
</table>

### Module link types

The **Link type** field on the Module form specifies what type of link the module opens.
<table>
<thead>
<tr>
<th>Link Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Links to the assessment-based survey you select in the Assessment reference field. See Create a survey module.</td>
</tr>
<tr>
<td>Content Page</td>
<td>Displays the content page you select in the Content page reference field. See Create a content page.</td>
</tr>
<tr>
<td>Documentation Link</td>
<td>Links to a documentation page and opens in a new tab or window. This link type is used with embedded metadata in documentation topics. To open an internal document from a module, use the URL (from Arguments) module link type.</td>
</tr>
<tr>
<td>Homepage</td>
<td>Displays the homepage you select in the Homepage reference field.</td>
</tr>
<tr>
<td>HTML (from Arguments)</td>
<td>Places HTML in the application navigator. This link type is used for more complicated links, where a flat URL is not customizable enough. Note:</td>
</tr>
<tr>
<td></td>
<td>- The HTML (from Arguments) link type is supported in UI15 and UI11 only. In UI16, use the URL (from Arguments) link type instead.</td>
</tr>
<tr>
<td></td>
<td>- Enter a value for the Arguments field.</td>
</tr>
<tr>
<td>List Filter</td>
<td>Displays an unpopulated list view for the table you select in the Table field. Allows users to specify a filter without loading the list first. Use the Filter field to define the default filter for the list. Use the View name field to specify a view.</td>
</tr>
<tr>
<td>List of Records</td>
<td>Displays the list view for the table you select in the Table field. Use the Filter field to define the default filter for the list. Use the View name field to specify a view.</td>
</tr>
<tr>
<td>Map Page</td>
<td>Displays the map page you select in the Map page reference field.</td>
</tr>
<tr>
<td>New Record</td>
<td>Displays a form for creating a record in the table you select in the Table field.</td>
</tr>
<tr>
<td></td>
<td>- Use the View name field to specify a view.</td>
</tr>
<tr>
<td></td>
<td>- Use the Arguments field to apply a template. See Create a module for a template.</td>
</tr>
<tr>
<td>Run a Report</td>
<td>Runs the saved report you select in the Report field.</td>
</tr>
<tr>
<td>Script (from Arguments)</td>
<td>Runs a script, as defined in the Arguments field.</td>
</tr>
<tr>
<td></td>
<td>Note: Enter a value for the Arguments field.</td>
</tr>
<tr>
<td>Link Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search Screen</td>
<td>Link that displays a blank form for searching records in the table. Use the View name field to specify a view.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use the parameter &amp;sysparm_result_view=view_name to define the view the results are rendered in.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All searches use a (starts with) query to search for matching text. Other query types are not supported in search screens.</td>
</tr>
<tr>
<td>Separator</td>
<td>Creates a division between modules. Enter a name in the Title field to add a section name that users can collapse or expand.</td>
</tr>
<tr>
<td>Single Record</td>
<td>Displays a form for a single record on the table. Use the View name field to specify a view.</td>
</tr>
<tr>
<td>Survey</td>
<td>Links to the legacy survey you select in the Survey reference field. Use the Survey overwrite check box to determine whether the survey can be taken multiple times.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Survey link type is for use with legacy surveys only, which assessment-based surveys replace. Select the Assessment link type to link the module to an assessment-based survey.</td>
</tr>
<tr>
<td>Timeline Page</td>
<td>Displays the timeline page you select in the Timeline Page reference field. See Timeline pages.</td>
</tr>
<tr>
<td>URL (from Arguments)</td>
<td>Opens any URL, as defined in the Arguments field. (Optional) Use the Window name field to define a link that opens in a new window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For internal links, always use a relative link such as ./catalog_home.do? sysparm_view=catalog_default or catalog_home.do? sysparm_view=catalog_default. Do not use an absolute link to a ServiceNow instance. It creates problems when you move an update set from a development instance to a production instance because the URL still references the development instance.</td>
</tr>
<tr>
<td></td>
<td>• Enter a value for the Arguments field.</td>
</tr>
</tbody>
</table>
Additional queries and examples
The administrator can append queries to the List of Records module link type value. The URL (from Arguments) link type can be used to provide a custom filter or open the page in a new window.

Appending queries to list view modules

For List of Records module link types, you can append additional queries to the module to further define the filter for the returned list. For example, to filter active incidents that are assigned to the currently logged in user, use the following argument query:

```
active=true^assigned_to=javascript:gs.user_id()
```

Example URL module that opens in a new window
You can configure a module to open an external URL in a new browser window.

Role required: admin

1. Open the application menu record using one of the following methods.
   - Navigate to System Definition > Application Menus and select the application menu from the list.
   - Point to the application menu and click the edit application (pencil) icon. This action is possible in Istanbul UI16 only.
   - Right-click the application label in the application navigator and select Edit Application. This action is possible in UI15 and UI11 only.
2. Scroll down to the Modules related list and click New.
3. If the Window name field is not displayed, configure the form and add this field.
4. Select URL (from Arguments) from the Link type list.
5. Add the complete web address to the Arguments field.
6. Select an icon for the module in the Image field.
7. Enter _blank in the Window name field.
   If this field is empty, the page opens in the content frame, which is the default behavior.

Example URL module that opens a list with a custom filter URL
To create a module that opens a list with a custom filter, sort order, and grouping, use a link type of **URL (from Arguments)** and create a link to a custom URL.

Role required: admin

Use the following shortcut to determine the arguments for your custom URL.

1. Navigate to the list by URL, without loading it in the standard interface.
   For example, navigate to the Incident list by entering `<base URL>/incident_list.do`.
2. Apply the desired filter, sort order, and grouping.
3. Copy the resulting URL from the browser address bar.
   For example, if you apply a filter of `active=true` with an ascending sort on `priority`, a descending sort on `opened_on`, and grouped by `assignment_group`, the address bar reads: `incident_list.do?sysparm_query=active=true^EQ^ORDERBYpriority^ORDERBYDESCopened_at^GROUPBYassignment_group`

   **Note:** Do not copy the base URL (the `http://instance_name.service-now.com/` portion). Always use a relative link to prevent problems when you move an update set from a development instance to a production instance.

4. Define a module with a Link type of **URL (from Arguments)**.
5. Paste the custom URL from **step 3** into the Arguments field.
6. Click Submit.
   The module now opens the custom list in the content frame.

**Creating a change password module**

To allow users to change their own password, you can create a simple module in Self-Service.

**Prerequisites**

Role required: admin

Create a module in the Self-Service application called **Change Password**, give it a **Type** of **URL**, and give it an **Argument** of `login_cpw.do`. The module presents the user with a password change form and has them validate the new password by typing it twice.
## Change password module

<table>
<thead>
<tr>
<th>Title</th>
<th>Change password</th>
<th>Application</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application menu</td>
<td>Self Service</td>
<td>Order</td>
<td>650</td>
</tr>
<tr>
<td>Hint</td>
<td></td>
<td>Display name</td>
<td></td>
</tr>
</tbody>
</table>

### Visibility

Select the type of link for the module or select separator to create a horizontal line. The fields below change depending on your selection.

- **Link type**: URL (from Arguments:)
- **Arguments**: login_cpwd.do
- **Window name**: 

[Submit]
The Edge

The Edge is a toolbar on the left side of the screen which provides quick access to features such as bookmarks and flyout windows.

The Edge is available in UI15 and UI11. The collapsed view of the UI16 application navigator is similar to the Edge.

Bookmarks

A bookmark is a link to information in the ServiceNow system, such as a record or a module, that is stored on the Edge.

All users create and manage their own bookmarks.

Bookmarks are available in UI15 and UI11. Favorites replace bookmarks in UI16. For more information, see Use the UI16 navigator.

Bookmarks are stored in the Bookmark (sys_ui_bookmark) table. To view bookmarks in a list, navigate to System Definition > Bookmarks.

Create a bookmark

You can create bookmarks by dragging links to the Edge.

Role required: none
You can create a bookmark from any of the following links:
- Modules in the application navigator
- Breadcrumbs
- Links in lists (including lists displayed in flyouts)
- Reports

**Note:** You may not be able to create bookmarks with other types of links. To request this functionality for another type of link, you can log an enhancement request with the ServiceNow customer support system.

Drag a link to the Edge.
The bookmark for the link appears on the Edge. Each bookmark includes an image and a title, both of which can be customized.

**Customize a bookmark**
You can customize bookmark appearance and behavior.

Role required: none

1. Open the bookmark settings window from any of the following locations in the interface.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Bookmark tooltip** | 1. Point to the bookmark in the Edge.  
|                 | 2. In the tooltip window, click **Edit Bookmark**.                        |
| **Bookmarks list** | 1. Point to the all bookmarks icon in the Edge.                         |
|                 | 2. Point to a bookmark in the list.                         |
|                 | 3. Click the edit bookmark icon ( ) by the bookmark name.            |
| **Bookmark flyout** | 1. Open a flyout bookmark.                                         |
|                 | 2. Click the edit bookmark icon in the corner of the flyout.          |

2. Enter a Title.
3. To open the bookmark link in a flyout window, select the **Flyout** check box and clear the **Open in form pane** check box.

By default, the bookmark opens in the content pane. Selecting **Flyout** opens a window on top of the current screen without navigating away from your working panes.

**Note:** Do not add homepages that are set to refresh automatically as flyout bookmarks. These homepages refresh in the background, which can slow down performance for you and other users.
4. Select the **Show on edge** check box to display the bookmark as a button on the Edge. Clear the check box to remove the button from the Edge. The bookmark still appears in the bookmark list.

5. To change the bookmark image, click **Image** and then select from the list of available images.

6. Click **Update**.

---

**Open a bookmark**

When you open a bookmark, it appears in the content pane or as a flyout.

Role required: none

Open a bookmark in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the bookmark as defined in the bookmark settings</td>
<td>Click the bookmark.</td>
</tr>
<tr>
<td>Open the bookmark in a flyout</td>
<td>Hold Ctrl (Windows) or Command (Mac) and click the bookmark.</td>
</tr>
<tr>
<td>Open the bookmark in the content pane</td>
<td>Hold Shift and click the bookmark.</td>
</tr>
</tbody>
</table>

---

**Delete a bookmark**

You can delete a bookmark.

Role required: none

When you delete a bookmark, it is removed from the Edge.

Delete the bookmark from either of the following locations in the interface.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bookmark tooltip</strong></td>
<td>1. Point to the bookmark in the Edge.</td>
</tr>
<tr>
<td></td>
<td>2. In the tooltip window, click <strong>Edit Bookmark</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. In the edit bookmark window, click <strong>Delete</strong>.</td>
</tr>
<tr>
<td><strong>Bookmarks list</strong></td>
<td>1. Point to the all bookmarks icon in the Edge.</td>
</tr>
<tr>
<td></td>
<td>* UI15:</td>
</tr>
<tr>
<td></td>
<td>* UI11:</td>
</tr>
<tr>
<td></td>
<td>2. Point to a bookmark in the list.</td>
</tr>
<tr>
<td></td>
<td>3. Click the remove bookmark icon () by the bookmark name.</td>
</tr>
</tbody>
</table>

---

**Forms**

A form displays information from one record in a data table.
The specific information depends on the type of record displayed. Users can view and edit records in forms. Administrators can configure what appears on forms.
Form elements

<table>
<thead>
<tr>
<th>Form element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form header</td>
<td>Provides navigation tools and actions related to the record.</td>
</tr>
<tr>
<td>Fields</td>
<td>Stores specific data about the record.</td>
</tr>
<tr>
<td>Sections</td>
<td>Groups related information on the form. To enable or disable form tabs, click the gear icon in the banner frame (🔧) and toggle the Tabbed forms option. Users can use icons to collapse (🚫) or expand (❯) form sections when tabbed forms are disabled. When you collapse or expand a form section, your selection is saved as a user preference. The next time you access a record that uses the same form, the same sections are collapsed or expanded.</td>
</tr>
<tr>
<td>Related links</td>
<td>Provides access to additional functions based on record type and system setup. Administrators can add related links to forms using UI actions.</td>
</tr>
<tr>
<td>Related lists</td>
<td>Displays records in other tables that have relationships to the current record.</td>
</tr>
<tr>
<td>Embedded lists</td>
<td>Allows for editing related lists without having to navigate away from the form. Changes are saved when the form is saved.</td>
</tr>
<tr>
<td>Response time indicator</td>
<td>Appears at the bottom of some forms to indicate the processing time required to display the form.</td>
</tr>
</tbody>
</table>

Form headers for UI versions

Each UI version, UI16, UI15, and UI11, has a different form header that offers different navigation icons.

Learn about form header navigation by selecting the form header topic that corresponds to the UI version your organization uses.

UI16 form header

The form header displays the title of the form (table) and provides several controls.

The UI16 form header includes the following controls.
Form header UI16

UI16 form header controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>🔄</td>
<td>Navigates to the previously viewed page without saving changes.</td>
</tr>
<tr>
<td>Form context menu</td>
<td>📜</td>
<td>Appears when a user clicks the menu icon beside the form title or right-clicks the form header. This menu is also called a right-click menu.</td>
</tr>
<tr>
<td>Attachments</td>
<td>📄</td>
<td>Allows users to view and add attachments to the record. For more information, see Add and manage attachments.</td>
</tr>
<tr>
<td>Show activity stream</td>
<td>🕒</td>
<td>Moves focus to the journal entry section of the form. If the journal fields are not on the form, the activity stream opens in a fly-out window.</td>
</tr>
<tr>
<td>Personalize form</td>
<td>🌟</td>
<td>Opens the form personalization menu. For more information, see Personalize a form.</td>
</tr>
<tr>
<td>More options</td>
<td>🔜</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>💌</td>
<td>Opens an email window.</td>
</tr>
<tr>
<td>Template bar</td>
<td>&quot;</td>
<td>Opens a bar at the bottom of the form and lists available templates.</td>
</tr>
</tbody>
</table>
## UI15 form header

The form header displays the title of the form (table) and provides several controls. The UI15 form header includes the following controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotations</td>
<td><img src="image" alt="Icon" /></td>
<td>Displays on-form annotations. For more information, see <a href="#">Administering form annotations</a>.</td>
</tr>
<tr>
<td>Tags</td>
<td><img src="image" alt="Icon" /></td>
<td>Displays the option to create custom tags and categorize documents. For more information, see <a href="#">Tags</a>.</td>
</tr>
</tbody>
</table>

### Remaining controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit or Update</td>
<td><img src="image" alt="Icon" /></td>
<td>Saves changes and returns to the previously viewed page.</td>
</tr>
<tr>
<td>Related actions</td>
<td><img src="image" alt="Icon" /></td>
<td>Provides standard actions in the form header for some tables, such as Close Incident or Resolve Incident in incident.</td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image" alt="Icon" /></td>
<td>Deletes the record from the list.</td>
</tr>
<tr>
<td>Previous and Next</td>
<td><img src="image" alt="Icon" /></td>
<td>Opens the previous and next record on the list from which the record was accessed.</td>
</tr>
</tbody>
</table>

### Form context menu

- **Save**
- **Add to Visual Task Board**
- **Create Problem**
- **Create Request**
- **Create Normal Change**
- **Create Emergency Change**
- **Matrics Timeline**
- **Follow on Live Feed**
- **Show Live Feed**

### Related actions

- **Related actions**
- **Attachments, Annotations, Email, Live feed, Personalize, Follow record**

---

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### UI15 form header controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td><img src="image1.png" alt="Img" /></td>
<td>Navigates to the previously viewed page without saving changes.</td>
</tr>
<tr>
<td>Form context menu</td>
<td><img src="image2.png" alt="Img" /></td>
<td>Appears when a user clicks the menu icon beside the form title or right-clicks the form header. This menu is also called a right-click menu.</td>
</tr>
<tr>
<td>Edit tags</td>
<td><img src="image3.png" alt="Img" /></td>
<td>Displays the Add tag field below the form header, which allows users to create custom tags and categorize documents. For more information, see Tags.</td>
</tr>
<tr>
<td>Attachments</td>
<td><img src="image4.png" alt="Img" /></td>
<td>Allows users to view and add attachments to the record. For more information, see Uploading Attachments.</td>
</tr>
<tr>
<td>Annotations</td>
<td><img src="image5.png" alt="Img" /></td>
<td>Displays on-form annotations. For more information, see Administering form annotations.</td>
</tr>
<tr>
<td>Email</td>
<td><img src="image6.png" alt="Img" /></td>
<td>Opens an email window.</td>
</tr>
<tr>
<td>Show activity stream</td>
<td><img src="image7.png" alt="Img" /></td>
<td>Opens the document feed for this record in a flyout window.</td>
</tr>
<tr>
<td>Personalize form</td>
<td><img src="image8.png" alt="Img" /></td>
<td>Opens the form personalization menu. For more information, see Personalize a form.</td>
</tr>
<tr>
<td>Submit or Update</td>
<td></td>
<td>Saves changes and returns to the previously viewed page.</td>
</tr>
<tr>
<td>Related actions</td>
<td></td>
<td>Provides standard actions in the form header for some tables, such as Close Incident or Resolve Incident in incident.</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>Deletes the record from the list.</td>
</tr>
<tr>
<td>Previous and Next</td>
<td><img src="image9.png" alt="Img" /></td>
<td>Opens the previous and next record on the list from which the record was accessed. These controls save changes to the record.</td>
</tr>
</tbody>
</table>

### UI11 form header

The form header displays the title of the form (table) and provides several controls.

The form header for UI11 includes the following controls.
### UI11 form header controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>![arrow_left]</td>
<td>Navigates to the previously viewed page without saving changes.</td>
</tr>
<tr>
<td>Form context menu</td>
<td>![arrow_down]</td>
<td>Appears when a user points to the arrow beside the form title or right-clicks the form header.</td>
</tr>
<tr>
<td>Submit or Update</td>
<td></td>
<td>Saves changes and returns to the previously viewed page.</td>
</tr>
<tr>
<td>Related actions</td>
<td></td>
<td>Provides standard actions in the form header for some tables, such as Close Incident or Resolve Incident in incident.</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>Deletes the record from the list.</td>
</tr>
<tr>
<td>Attachments</td>
<td>![attachment]</td>
<td>Allows users to view and add attachments to the record.</td>
</tr>
<tr>
<td>Email</td>
<td>![email]</td>
<td>Opens an email window.</td>
</tr>
<tr>
<td>Show live feed</td>
<td>![live_feed]</td>
<td>Opens the document feed for this record in a flyout window.</td>
</tr>
<tr>
<td>Previous</td>
<td>![arrow_up]</td>
<td>Opens the previous record on the list from which the record was accessed. This control saves changes to the record.</td>
</tr>
<tr>
<td>Next</td>
<td>![arrow_down]</td>
<td>Opens the next record on the list from which the record was accessed. This control saves changes to the record.</td>
</tr>
<tr>
<td>Toggle tabs</td>
<td>![toggle]</td>
<td>Toggles between tabbed and sequential arrangements of form sections and related lists.</td>
</tr>
<tr>
<td>Collapse all sections</td>
<td>![collapse]</td>
<td>Collapse all form sections.</td>
</tr>
<tr>
<td>Expand all sections</td>
<td>![expand]</td>
<td>Expand all form sections.</td>
</tr>
</tbody>
</table>
### Form context menu

The form context menu provides controls based on the table and user access rights. Administrators can customize some of the options available on a context menu using UI actions.

Access the form context menu by clicking an icon beside the form title or by right-clicking the form header.

- UI16 and UI15 menu icon (≡)
- UI11 arrow icon
The form context menu includes the following options.

**Note:** Some of the options displayed on the form context menu depend on the user role, installed applications, and version of the UI.

### Form context menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves changes without leaving the form view.</td>
</tr>
<tr>
<td>Related actions</td>
<td>Provides standard actions in the form context menu for some tables, such as Add to Visual Task Board or Create Change in incident.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Insert</td>
<td>Saves the data as a new record and returns to the previously viewed page.</td>
</tr>
<tr>
<td>Insert and Stay</td>
<td>Saves and displays the new record. For more information about inserting records with either option, see <a href="#">Edit a form</a>.</td>
</tr>
<tr>
<td>Configure</td>
<td>Provides administrative functions, such as configuring forms.</td>
</tr>
<tr>
<td>Templates</td>
<td>(UI11 only) Provides administrative functions, such as creating templates.</td>
</tr>
<tr>
<td>Toggle Template Bar</td>
<td>(UI15 only) Shows or hides the template bar. For more information, see <a href="#">Toggle the template bar</a>.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports data to PDF. Administrators can also export to XML. For more information, see <a href="#">Exporting data</a>.</td>
</tr>
<tr>
<td>View</td>
<td>Changes fields to a predefined layout. Switching views submits the form, which saves all changes. Administrators can customize views.</td>
</tr>
<tr>
<td>Create Favorite</td>
<td>(UI116 only) Adds the current record to your favorites list, represented by a star icon on the tab.</td>
</tr>
<tr>
<td>Assign Tag</td>
<td>(UI115 only) Allows the user to assign a new or existing tag to a record, which provides quick access to frequently referenced or urgent information. When tag is assigned to a record, the record is displayed on the Tagged Documents page. For more information, see <a href="#">Tags</a>.</td>
</tr>
<tr>
<td>Copy URL</td>
<td>Copies to the clipboard the URL for the form view of the record. Follow browser instructions if browser security measures restrict this function.</td>
</tr>
<tr>
<td>Copy sys_id</td>
<td>Administrators only. Copies to the clipboard the sys_id of the record. Follow browser instructions if browser security measures restrict this function.</td>
</tr>
<tr>
<td>Show XML</td>
<td>Administrators only. Displays record data in XML format.</td>
</tr>
<tr>
<td>History</td>
<td>Administrators only. Displays audit history for the record, which must be enabled for the table. For more information, see <a href="#">Enable auditing for a table</a>.</td>
</tr>
<tr>
<td>Reload Form</td>
<td>Reloads information from the database to refresh the form view.</td>
</tr>
</tbody>
</table>

**Form fields**

A field represents an individual item of data on a record.

Users can view and modify field data on a form. For more detailed information, see [Field administration](#).

**UI16 and UI15 field status indicators**

Indicators are used on some fields to denote a special field type.
A field status indicator is a colored asterisk that may appear to the left of mandatory fields. Field status indicators change colors to represent different states of mandatory fields.

**Field status indicators**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unpopulated</td>
<td>Required field is empty. The user must enter a value to save the form. Default color is red.</td>
</tr>
<tr>
<td>Populated — saved</td>
<td>Required field contains a value that was saved or must be saved. Default color is gray.</td>
</tr>
<tr>
<td>Populated — unsaved</td>
<td></td>
</tr>
</tbody>
</table>

**UI16/UI15 field status indicators**

**UI11 field status indicators**

Indicators are used on some fields to denote a special field type.

A field status indicator is a colored bar that may appear to the left of form elements. These indicators convey the following statuses.

**UI11 field status types**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory</td>
<td>A required field that is empty. The user must enter a value to save the form. Default color is red.</td>
</tr>
<tr>
<td>Populated Mandatory</td>
<td>A required field for which a value has already been saved. Default color is light red. If the user enters a new value, the field status indicator changes to Modified (default green).</td>
</tr>
<tr>
<td>Modified</td>
<td>Contains data that has not been saved. Default color is green.</td>
</tr>
<tr>
<td>Read-only</td>
<td>User cannot edit on the form. Default color is orange.</td>
</tr>
</tbody>
</table>
Configure the activity filter

The activity formatter contains a filter that lets users select which of the available fields to show in the activity list.

Role required: none

All fields on the activity list display in alphabetical order by default. You can change the order that fields appear on the form by using the **Configure available fields** option in the activity formatter.

**Use the activity filter in UI16 and UI15**

Use the activity filter to show or hide fields that you want to display activity.

1. Open the filter by clicking the activity filter icon (✓) in the Activity header.
2. Select the fields for which you want to display activity.
   Fields are added or removed dynamically as the selection is made.
3. Click the activity filter icon again to close the filter.

**Use the activity filter in legacy: UI11**

Use the activity filter in UI11 to show or hide specific fields.

1. Open the filter by clicking the show/hide filter icon (✓) in the Activity header.
2. Select the fields for which you want to display activity. Fields are added or removed dynamically as the selection is made.
3. Click the show/hide filter icon again to close the filter.
   A filter icon appears on the Activity header to indicate that a filter is in effect.
4. Click the filter icon to toggle the filter on (display only the selected fields) or off (display all fields).

   When the activity filter is on, the filter icon has a blue border. The activities list shows the history of only those fields selected in the filter and the Activity header indicates how many of the available fields are selected, such as (4 of 5).

   When the activity filter is off, the blue highlight is removed from the filter icon and the form shows all available fields. If all fields are checked, the filter icon is not displayed.
Embedded lists

Some forms may show related lists as embedded. Changes to embedded lists are saved when the form is saved.

**Note:** Embedded lists are not supported in List v3. Embedded lists always display in List v2.

Use these controls to work with an embedded list. For more information, see Edit a form.

**Working with embedded lists**

<table>
<thead>
<tr>
<th>Task</th>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand an embedded list</td>
<td>![+]</td>
<td>Click the expand icon in the list header.</td>
</tr>
<tr>
<td>Collapse an embedded list</td>
<td>![−]</td>
<td>Click the collapse icon in the list header.</td>
</tr>
<tr>
<td>Insert a new row</td>
<td></td>
<td>Double-click Insert a new row...</td>
</tr>
<tr>
<td>Edit a row</td>
<td></td>
<td>Double-click in an empty area of that field. See Use the list editor.</td>
</tr>
<tr>
<td>Delete a row</td>
<td>![×]</td>
<td>Click the delete icon beside the row. New rows are removed immediately. Existing rows are designated for deletion when the record is saved. To clear this designation, click the delete icon again.</td>
</tr>
</tbody>
</table>
Related lists

Related lists appear on forms and show records in tables that have relationships to the current record.

Users can view and modify information in related lists like any other list. Administrators can configure related lists to appear on forms and in hierarchical lists by configuring a form. Related lists do not have a size limit.

**Note:** Related lists are not designed to work in situations where the relationship between two records is defined with a List field (for example a Watch List).

By default, all related lists display in List v2, even when List v3 is activated. An administrator can enable List v3 for related lists. The same List v3 compatibility rules apply to related lists as to standard lists. Hierarchical lists

Select or create records in a related list

When a form contains a related list, such as the Incidents related list in the problem form, you can select existing records or add new ones in the related list.
Role required: none

1. Open the record to work with records in a related list, such as a problem record.
2. Locate the related list, for example, Incidents.
3. To select existing records, complete the following steps.
   a) Click Edit.
   b) Using the slushbucket, select the records to associate with the current record.
      When you select a record, information about it appears below the Collection list to help you identify the record to select.
   c) Click Save.

4. To create a new related record, complete the following steps.
   a) Click New.
      A new form for the related table opens, for example, the incident form.
   b) Complete the form and click Submit.
      The new record is added to the related table and to the related list of the record.

Configure when a related list loads

If there are many related lists on a form or many records in the related lists, the form may load slowly. In UI16 and UI15, you can improve form response times by configuring related lists to load manually, on demand, or automatically, after the rest of the form loads.

Role required: none

Note: This functionality applies only when List v3 is disabled for related lists, which is the default setting. When List v3 is enabled for related lists, all related lists load asynchronously after the form loads, even if there are no v3 related lists on the form.

1. Click the settings icon (🔧) in the banner frame to open the system settings menu.
2. Select one of the following options under Related List Loading.

   In UI16, click the Forms tab to see this setting.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>With the Form</td>
<td>Related lists load when you open the form, which is the default setting.</td>
</tr>
<tr>
<td></td>
<td>When selected, it sets the value of the glide.ui.related_list_timing system property to default.</td>
</tr>
<tr>
<td>After Form Loads</td>
<td>Related lists load after the rest of the form loads.</td>
</tr>
<tr>
<td></td>
<td>When selected, it sets the value of the glide.ui.related_list_timing system property to deferred.</td>
</tr>
<tr>
<td>On-demand</td>
<td>Related lists load on demand. When this option is selected, a Load Related Lists button appears at the bottom of each form that contains related lists. Click the button to load related lists.</td>
</tr>
<tr>
<td></td>
<td>When selected, it sets the value of the glide.ui.related_list_timing system property to ondemand.</td>
</tr>
</tbody>
</table>
3. Close the system settings menu.

**Create a default filter for a related list**

You can create a default filter that is applied to a related list when a form loads.

Role required: admin

*Note: This functionality is not supported in List v3 related lists.*

1. Navigate to the related list (example, **Incidents** on a problem record).
2. Create the desired filter using the condition builder (example, *(Active) (is) (true))*.

3. Click **Set as Default Filter**.

**Configure the edit option**

You can configure the edit option that allows users to add records to related lists in forms.

Role required: admin

The **Edit** button is available for related lists that represent many-to-many and one-to-many relationships. Defined related lists may not have an **Edit** button, as related records are added to these lists automatically based on the relationship between the records.

1. Navigate to the related list, such as the **Incidents** related list on a problem record.
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select <strong>Configure &gt; List Control</strong>.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select <strong>List Control</strong>.</td>
</tr>
</tbody>
</table>

3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show the Edit option</strong></td>
<td>Clear the <strong>Omit edit button</strong> check box.</td>
</tr>
<tr>
<td><strong>Hide the Edit option</strong></td>
<td>Select the <strong>Omit edit button</strong> check box.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Show the Edit option if the check box is cleared and the button does not appear | Click Enable Edit.

4. If the list represents a one-to-many relationship (example, incidents can be associated with only one problem, but problems can be associated with many incidents), complete the following steps.
   a) Open a record in the target table (example, Incident).
   b) Right-click the header and select Configure > Dictionary.
   c) Open the dictionary entry for the reference field (example, Problem ID on Incident).
   d) In the Reference Specification section, select the Reference floats check box.

5. Click Update.

Create defined related lists
You can add default related lists to the form for all users to see when viewing records.
Role required: admin
For example, you may include a list of related incidents at the bottom of a problem record, or a list of members at the bottom of a group record. This functionality depends on reference fields or many-to-many table relationships. If two tables are related via the system dictionary, one can appear as a related list on the other.

Defined related lists allow relationships between arbitrary tables to be expressed as a related list. Any two tables that can have a logical relationship can appear as a parent/child pair via a related list. The following are some examples.

- On an incident record, show all incidents opened by the same caller.
- On a user record, show the last 20 transactions that user has made.
- On an incident record, show all problems opened on the reported CI.

These relationships are beyond the relationships normally defined in the system dictionary through reference fields and many-to-many relationships. Every related list requires a relationship record. Before creating a relationship, verify that there is not an existing relationship record that already provides the needed information. Use the following steps to create a relationship record.

1. Click System Definition > Relationships.
2. Click New.
3. Specify the relationship record fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type the name of the related list. The form configuration page displays this name in the list of available lists.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this check box to use JavaScript in place of the Applies to table and Queries from table fields.</td>
</tr>
<tr>
<td>Applies to table</td>
<td>Select the table on which the related list appears. This field is hidden in Advanced relationship records.</td>
</tr>
<tr>
<td>Queries from table</td>
<td>Select the table from which this related list retrieves data. This field is hidden in Advanced relationship records.</td>
</tr>
<tr>
<td>Apply to</td>
<td>Type a script that sets the answer variable to true when a user opens a form on the desired table. This field is only visible with the Advanced check box selected.</td>
</tr>
<tr>
<td>Query from</td>
<td>Type a script that sets the answer variable to the name of the table from which the related list retrieves data. This field is only visible with the Advanced check box selected.</td>
</tr>
<tr>
<td>Query with</td>
<td>Type a script to specify the records to include from the table the relationship queries.</td>
</tr>
<tr>
<td>Insert Callback</td>
<td>Type a script to run after a successful insert action. This field is only visible with the Advanced check box selected.</td>
</tr>
</tbody>
</table>

4. Click Submit.
Add incidents by same caller related list
This example adds the existing relationship, Incidents by Same Caller, to incident forms.

- **Applies to table**: This list appears as an available related list when viewing an incident record.
- **Queries from table**: This list displays a list of incidents.
- **Query with**: This script selects records where the caller_id matches the caller_id of the parent record (the incident you are viewing).

1. Open an incident.
2. Right-click the header and select **Configure > Related Lists**.
   - The name of the existing relationships appears in your list of available lists.
3. Move the **Incidents by Same Caller** list to the **Selected** list.
4. Click **Save**.
### Incident: INC000052

- **Caller:** Bud Richman
- **Location:** 161 North Highway 101, Solana B
- **Category:** Software
- **Subcategory:** -- None --
- **Affected CI:** SAP Financial Accounting
- **Impact:** 1 - High
- **Urgency:** 1 - High
- **Priority:** 1 - Critical

**Short description:** SAP Financial Accounting application appears to be down

<table>
<thead>
<tr>
<th>Number</th>
<th>Category</th>
<th>Priority</th>
<th>State</th>
<th>Assignment group</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC000052</td>
<td>Software</td>
<td>1 - Critical</td>
<td>Active</td>
<td>Software</td>
</tr>
<tr>
<td>INC000046</td>
<td>Software</td>
<td>3 - Moderate</td>
<td>New</td>
<td>Software</td>
</tr>
<tr>
<td>INC000049</td>
<td>Inquiry / Help</td>
<td>3 - Moderate</td>
<td>Awaiting Problem</td>
<td>Software</td>
</tr>
</tbody>
</table>

**Follow:**
- **Updated by:** Bud Richman
- **Open by:** ITIL User

**Additional Incidents by Same Caller:**
- INC000052: SAP Financial Accounting application appears to be down
- INC000046: Can’t access SFA software
- INC000049: JavaScript error on hiring page of corporate website
Notes and limitations:

- If you click the New button on one of these new relationships, the system attempts to ensure that the new record matches the list conditions. For example, clicking New on the example list results in an incident where the caller_id is pre-populated with Bud Richman.
- When scripting your condition, current is the record to which you want to add queries while parent is the main record being displayed.
- These relationships do not refresh until you update a form. In the example, if you changed the caller from Bud Richman to Fred Luddy, the list at the bottom of the screen still displays the incidents belonging to Bud Richman until you save the incident.
- You are not limited to a single query condition. It is, for example, possible to have a related list of all incidents opened by the same caller in the last week, or all open incidents opened by the same caller.
- The current and parent objects cannot be used with the Queries from field. Instead, the gs object is available for GlideSystem calls.
- The Edit button is not available on defined relationships, as the relationship is scripted.

Add transactions by user related list
This example adds a relationship, Last 20 transactions, to the user form.

Role required: admin

The new relationship creates a list of task records opened by the current user.

1. Navigate to System Definition > Relationships.
2. Click New.
3. Create a relationship with the following values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Last 20 transactions</td>
</tr>
<tr>
<td>Applies to table</td>
<td>User (sys_user)</td>
</tr>
<tr>
<td>Queries from table</td>
<td>Task (task)</td>
</tr>
<tr>
<td>Queries with</td>
<td>current.addQuery('opened_by', parent.sys_id);</td>
</tr>
</tbody>
</table>

4. Click Submit.
5. Navigate to User Administration > Users.
6. Select any user.
   For example, select David Loo.
7. Configure the related lists for the user form and add the related list Last 20 transactions.
9. Select any user.
   For example, select David Loo.
10. The Last 20 transactions related list displays all task records opened by the current user.

Notes and limitations:

- This query returns all task records opened by the user. The related list defaults to displaying 20 task records per page.
- The parent variable refers to the Applies to table. In this case, it applies to the User (sys_user) table.
- Querying against a record sys_id is a common query method for relationships.
Add fields to selections in a related list

When you click Edit in a related list and select an item, information about the item appears below the list. You can expand the fields that appear for the item to provide more information.

Role required: admin
To add fields to selections in a related list, record the exact field name, or element, not the label name. This example demonstrates adding fields to the **Groups** related list (sys_user_group).

1. Navigate to **System UI > Views**.
2. Select **sys_ref_list**.
3. To add fields from the Group table, in the **Lists** related list, select **sys_user_group**.
4. In the **List Elements** related list, click **New**.
5. Enter the field name and its relative position when it appears in the description.
   Fields appear from top to bottom, lowest to highest number.
6. Click **Submit**.

**Create a default related record selection filter for a related list**

You can set a default filter to restrict which related records users can select. Default filters are simple to set up but lack a dynamic filtering element, which prevents the end user from changing the default filter.

Role required: personalize_list

A filter is used to restrict the records that are listed in the slushbucket that displays when a user clicks **Edit** in a related list.
Unfiltered list of records

1. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click any column heading and select Configure &gt; List Control.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select List Control.</td>
</tr>
</tbody>
</table>

2. Configure the List Control form to add the **Edit default filter** field, if necessary.
3. In the **Edit default filter** field, use the condition builder to create a default filter.
4. Click **Update**.
   - When users click the **Edit** button in the related list, the list of records they can select is filtered according to the default filter.
Edit a form

You can edit a record in the form view. You can also insert a record, apply a template, and cancel changes to the record.

Role required: none

1. Navigate to the form.
   If another user is looking at the same record, you see their avatar with a green dot in the form header. If more than one user is viewing the record, the avatar is a number, and you can point your cursor to it to see the names.

2. Enter appropriate data.
   Depending on system setup, the data entered in a form can affect other options on the form or change its appearance. For example, if you select a status of Closed for an incident, a required Close Notes field may appear. Administrators can create custom form effects in various ways, including UI policies and client scripts.

3. Save the record using one of these methods:
   - Click Submit or Update to save changes and return to the previously viewed page.
   - Right-click the form header and select Save to save changes without leaving form view.
   - Right-click the form header and select Insert or Insert and Stay to save the data to a new record instead of updating the current record.

On UI16 forms, fields update dynamically and display a field update icon to indicate changes made by other users. You can point to the field update icon to see which user made the update. This dynamic indication helps to prevent users from accidentally overwriting each other's work.

Note: If you entered a different value from the value saved by the other user, the system does not update the field automatically. Change your value manually to match value entered by the other user. Otherwise, you overwrite the change when you save the record.
Insert a record

Insert provides a method for creating multiple similar items, such as email notifications, users, groups, or business rules.

Role required: none

Administrators can enable the Insert function for task records. For more information, see "Advanced form configuration".

1. Open a similar item.
2. Edit the item and give it a new Name.
3. Right-click the form header and select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Saves the item as a new record and returns to the previously viewed page.</td>
</tr>
<tr>
<td>Insert and Stay</td>
<td>Saves and views the new record.</td>
</tr>
</tbody>
</table>
Apply a template in a form

Your organization may use templates to help with frequently requested tasks. A template contains prepopulated fields that default when the template is selected.

Role required: none

This option is not available in UI11.

1. Navigate to the form.
2. Do the appropriate action for your version of the UI.

| UI16       | 1. Click the more options icon (…) in the form header.  
|            | 2. Select **Toggle Template Bar**. |
| UI15       | 1. Right-click the form header.  
|            | 2. Select **Toggle Template Bar**. |

3. Select the template to apply.

If there is a conflict between the selected template and the form, a conflict message appears with a link to view the details of the conflict. For example, if a field that does not appear on the form is populated in the template, the conflict message details identify the missing field and the value is not set. If you have a conflict message, review the details and notify your administrator if necessary.

Specific fields are populated with values from the template.

4. Complete the form.

You can change any value that was populated from the template.

5. Click **Submit** to create the record.

Cancel changes to a form

Cancel changes to a form by navigating away from the form without saving.
Role required: none

1. Navigate away from the form view without saving the record.

2. If a message appears, click **Leave this Page** to confirm cancellation.

   **Note:** Administrators can disable the confirmation message by setting the `glide.ui.dirty_form_support` property to false.

---

**Use form pane tabs in UI15**

When using the split screen feature, you can open multiple forms in the form pane. Form pane tabs are available in UI15 only.

Form pane tabs appear above the form header. The current tab is highlighted.
Form pane tabs

1. View a list in the content frame, for example, the Incident list.
2. Click the **List and Form View** button on the Edge to split the screen. The list is displayed in the list pane on the left and an empty form pane with a new highlighted tab is displayed on the right.
3. Select an incident record in the list pane to display the incident in the highlighted tab. The incident number appears in the tab at the top of the form pane.
4. Click the + tab to add a tab to the form pane. The new tab is added to the right of the current tabs and has the generic name **New Tab** until you select another incident from the list pane.
5. To remove a tab, select the tab to be deleted and click the x.

Personalize a form

When the form personalization feature is activated, users can personalize fields to appear on a specific form view according to individual preferences. Form personalization is available in UI16 and UI15.

Role required: itil, personalize_form, or admin

Personal form customizations do not affect what other users see on their forms.

In contrast to configuring a form, personalizing a form does not enable users to perform the following actions:
- Change the order of fields on the form.
- Add fields that are not configured to appear on the form.
- Hide mandatory fields.
Note: Personalizing a form in this way modifies the form for you only. To make changes to a form that are visible to all users, you must configure the form.

1. Open any record.
2. In the form header, click the personalize form icon.
   The Personalize Form menu appears and hide field icons appear on the form.

   ![Personalize Form Menu](image)

   **Personalize Form**

   A cleared gray check box indicates fields that you previously hid.

   **Note:** Only the fields that the form is configured to display are available in the Personalize Form menu. To add fields to the form, you must configure the form layout.

3. Clear a check box or click the hide field icon (🚫) by a field.
   Some check boxes are gray and selected. These check boxes indicate fields that cannot be hidden because they are required or are already hidden by UI policies or client scripts.

4. Click outside the Personalize Form menu to save your changes.
   If you navigate away from the form, the next time you personalize the form you must reset your customizations to show fields that you have hidden.

5. To restore the default form view, personalize the form and click **Reset**.
Add and manage attachments

You can upload a file as an attachment to an incident, a knowledge article, a change request, or to another type of record.

Administrators can configure attachments and how they work in the system. For more information, see Administering attachments.

Attachment file size is not limited by default. However, uploading large attachments can cause issues with the user's active session on the instance. Empty attachments (file size of 0 kb) are not supported.

**Note:** Do not use the **Upload File** module in the **System Definition** application. It is not compatible with multi-node instances.

1. Navigate to the record. For example, an incident record.
2. Click the attachments icon (🔗).
3. Click Choose Files or Browse, depending on your browser, and navigate to a file.
4. Optional: Upload multiple files in one of the following ways.
   - Select multiple files at the same time in the file browser. Internet Explorer does not support this feature.
   - Add each file on a separate line by clicking Add Another Attachment, and then clicking Choose Files on the next line. Repeat until all desired files are selected. This feature is available in all supported browsers.
5. Click Attach.

Attached files appear in the Current file attachments list and at the top of the form. A message appears if a file is not attached because it is too large or is a restricted file type. Administrators can configure these limits.

6. Close the pop-up window to return to the form.

Limit the users who can view attachments by applying ACL rules. For more information ACL rules, see Access control list rules.

Manage attachments

You can view, rename, and remove the attachments on a record, and add additional attachments.

1. Navigate to the record (example, an incident record).
2. Click the attachments icon (🔗) or the Manage Attachments link if files are already attached.

   The number of attachments for a record is listed on the Manage Attachments link.
3. To rename an attachment, complete the following steps.
   a) Click (rename) beside the file name at the top of the form or in the pop-up window.

   a) Edit the file name and press the Enter key.

   **Note:** Press the Esc key instead of the Enter key to undo your changes and cancel rename.

4. To remove attachments, click the Manage Attachments link and complete the following steps.
   a) Select the check boxes next to the attachments to delete.
   b) Click Remove.
      The attachment disappears and the pop-up window remains open.

   **Note:** After a record has been closed, you cannot delete the attachments for that record.

5. To add additional attachments, complete the following steps.
   a) Click Choose Files.
   b) Select the file to attach and click Open.
   c) Click Attach.

6. Close the pop-up window to return to the form.

**Attach files with drag-and-drop**

You can drag files from your computer to a form to upload them.
This functionality is supported in Firefox 3.6 or later and Chrome. Support will be added for other web browsers as they implement the HTML5 specification.

1. Navigate to the record.
2. On your computer, browse to the files to attach.
3. Select the files in the file browser, and then drag them over the form.
4. Release the mouse button to begin the upload.

When the upload is complete, the file name is added to the attachments header. Upload speed depends on the file size and the speed of your network connection.

**Warning:** Do not navigate away from the record while an upload is in progress. The upload must be completed for the file to be attached.

### Checklists

Checklists provide a simple way to track the progress of tasks without creating additional records. Checklists can be added to the form view of any table that extends Task (task).

For example, if a support agent is assigned an incident task to investigate a wireless issue, a checklist can be used to document the individual steps taken.

Checklists are added to records after they are submitted. You cannot add a checklist as you create a record.
Enabling checklists in forms

To enable checklists, navigate to the form and add the Checklist formatter. For instructions, see Add a formatter with the form designer.
Using checklists

You can add, remove, or rearrange checklist items. You can also save a checklist as a template for future use on other records. Any user can create or edit a checklist and check off completed items.

Activate checklists

Checklists are active by default on new instances. For instances upgrading from a previous version, the Checklist plugin must be activated.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see Purchase a plugin.

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see Request a plugin.

For plugins that you can activate yourself, continue with the following steps.

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/Upgrade related link.
   - If the plugin depends on other plugins, those plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under Some files will not be loaded because these plugins are inactive. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the Load demo data check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the Load Demo Data Only related link on the System Plugin form.
5. Click Activate.

Create a checklist

You can create a unique checklist for each task record. You can quickly create a checklist from a previously created template.

The Checklist formatter must be added to the form by a user with the personalize_form role.

Role required: for the write role, read role, and delete role, the logged in user must be sys_created_by.

Note: If the Explicit roles plugin is installed, the sn_internal role is required by the Customer Service Management and the Vendor Risk Management plugins (and possibly others.) The Explicit roles plugin automatically creates the sn_internal role and assigns it to all users.
A template saves time by creating checklist items automatically. You can add, edit, or remove checklist items without impacting the template. You can use any checklist template, even if it was created on a different table.

1. Navigate to a record that does not already contain a checklist.
2. Click the down arrow beside the Checklist formatter.
3. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a new checklist</td>
<td>Select Create new.</td>
</tr>
<tr>
<td>To create a checklist by using a template</td>
<td>Under Create from template, select a template. The checklist items in the</td>
</tr>
<tr>
<td></td>
<td>template appear. Use any of the following steps to manage items in the list.</td>
</tr>
</tbody>
</table>

4. Click Add Item.
5. Enter text for the checklist item.
6. Press the Enter key to add the checklist item.
7. Create as many additional checklist items as desired.
8. Optional: Click the minus (-) icon to delete a checklist item.
9. Optional: Click the drag icon ( ) and drag a checklist item to a different position in the list.
10. Optional: Save the checklist as a template for easy reuse.
   a) Click the down arrow beside the Checklist formatter.
   b) Select Save as Template. A dialog box appears.
   c) Enter a descriptive template name to identify the checklist.
      When a user creates a checklist from a template, all templates are listed in alphabetical order and there is no way to filter which templates appear. To provide a better user experience, consider implementing a naming system for checklist templates. For example, include the name of the table or another identifier to clarify how the checklist should be used.
   d) From the User Group list, select a group to limit the checklist template to.
      Only members of the selected group and the user who created the checklist can use the checklist as a template. Leaving this field blank prevents anyone but the template creator from using the checklist template.
   e) Click Save.
11. Save the form.

Delete checklist or a template
You can remove a checklist from a record, and delete checklist templates you no longer need.
Role required: for the write role, read role, and delete role, the logged in user must be sys_created_by.

Note: If the Explicit roles plugin is installed, the sn_internal role is required by the Customer Service Management and the Vendor Risk Management plugins (and possibly others.) The Explicit roles plugin automatically creates the sn_internal role and assigns it to all users.

Deleting a checklist template has no effect on checklists created from that template.
1. To delete a checklist, navigate to the record that contains the checklist.
2. Click the down arrow beside the **Checklist** formatter.
3. Select **Remove Checklist**.
   A confirmation dialog box appears.
4. Click **Delete**.
5. Complete the following steps to delete a checklist template.
   a) In the navigation filter, enter `checklist_template.list`.
   b) Select the check box by the checklist template you want to delete.
   c) In the actions choice list, select **Delete**.
   d) In the confirmation dialog box, click **Delete**.

**Lists**

A list displays a set of records from a table.

Users can search, sort, filter, and edit data in lists. Lists may be embedded in forms and may be hierarchical (have sublists).

The list interface consists of a title bar, filters and breadcrumbs, columns of data, and a footer. Each column in a list corresponds to a field on the table.

A [response time indicator](#) in UI16 and UI15, and in UI11) may appear at the bottom right of some lists to indicate the processing time required to display the list.

There are two versions of lists available. For more information, see [Comparison of List v2 and List v3](#).
Record list

List features and actions

The list interface consists of a title bar, filters and breadcrumbs, and columns of data. Each of these components provides features and lets you act on the list and the displayed records. There are two list versions: List v2 and List v3.
List v2 view features, menus, and actions
List v3 view features, menus, and actions

Hierarchical lists

Hierarchical lists allow users to view records from related lists directly from a v2 list without navigating to a form.

**Note:** Hierarchical lists are not supported in List v3. Tables that have hierarchical lists enabled always display in List v2.
Lists can have sublists in a hierarchy that can also be accessed in list view. To expand or collapse the related lists on a record in a hierarchical list, click the arrow beside the reference icon.

Hierarchical list

Administrators can enable hierarchical lists for a table. For more information, see Enable a hierarchical list.

Detail rows

Detail rows, when enabled, appear below the field row for each record and display the value of a specified field. For example, the detail row might display the short description for each incident in a list. Detail rows support the same functionality as fields, including links, editing capabilities, and access to the context menu.

Note: When a field is designated as the source for the list detail rows, the system hides the list column for that field.
Administrators can enable detail rows and add them to v2 lists (UI15 or later required). For more information, see Administer detail rows. Detail rows are not supported in List v3.

Comparison of List v2 and List v3

There are several differences between List v2 and List v3.

List v2 is the default version of lists and is supported in all versions of the UI. Users with the admin role can activate List v3, which is supported in UI16 only. Even when List v3 is activated, some UI16 lists may display in List v2. For details, see List v3 compatibility.

List v3 performance is different from performance in List v2. Based on your instance configuration and the complexity of the query, List v3 may load records more slowly than List v2.

In List v2, the list editor does not enforce client scripts or UI policies. In List v3, the list editor enforces UI policies and mandatory dictionary attributes, but not client scripts. Allowing list editing with client scripts running on fields in a form can result in incorrect data being saved to the record. For more information on list administration and using business rules and client scripts, see List editor administration.

Visual differences between List v2 and List v3

If you are unsure whether a list is v2 or v3, look for the following identifiers.

- The personalize list gear icon appears in the upper left corner of v2 lists. The personalize list option is located in the List title menus.
- Page controls appear in the list title bar of v2 lists.
- The list mode toggle appears in the list title bar of v3 lists. You can switch between the standard list mode, called Grid mode, and a Split list and form mode.
- Avatars appear by user names in v3 lists.
- Page controls appear in a footer at the bottom of the page for v3 lists.
- The response time indicator does not appear on the bottom, right of v3 lists. You can create a property to display the response time in milliseconds (ms) on the lower left in the List v3 footer.
### List v2 Identifiers

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Caller</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0000001</td>
<td>Can't read email</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000002</td>
<td>Unable to get to network file shares</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000003</td>
<td>Wireless access is down in my area</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000004</td>
<td>Forgot email password</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000005</td>
<td>CPU load high for over 10 minutes</td>
<td>Alejandro Mascall</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>INC0000006</td>
<td>Hang when trying to print VISIO document</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
</tr>
</tbody>
</table>
List v3 identifiers

List features

Most List v2 features are supported in List v3 as well, with the following exceptions.
Features that are not supported in List v3

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchical lists</td>
<td>Tables that have hierarchical lists enabled display in List v2.</td>
</tr>
<tr>
<td>Embedded lists</td>
<td>Embedded lists display in List v2.</td>
</tr>
<tr>
<td>Create a list report in the Report Designer</td>
<td>List reports display in List v2.</td>
</tr>
<tr>
<td>Customizing list title or list column heading menus</td>
<td>Options added to list context menus using the Context Menu (sys_ui_context_menu) table do not appear in List v3. Because it is only possible to customize the list title menu or list column heading menu by editing records on the Context Menu table, it is not possible to customize these menus in List v3. Administrators can customize list field menu options by editing UI actions.</td>
</tr>
<tr>
<td>Detail rows</td>
<td>Detail rows do not appear in List v3.</td>
</tr>
<tr>
<td>Pop-up form editing</td>
<td>Clicking the reference icon in list v3 opens a pop-up window of the record. Click Open Record in the pop-up window to open the form.</td>
</tr>
<tr>
<td>Composite fields</td>
<td>Links do not display in composite fields, and the different field values may appear on the same line in List v3.</td>
</tr>
<tr>
<td>Limiting access to list column personalization</td>
<td>Administrators cannot disable list column personalization or control which user roles can personalize list columns in List v3.</td>
</tr>
<tr>
<td>Administering certain list editor capabilities</td>
<td>Administrators cannot configure which field types are editable and cannot enable single-click list editing for v3 lists. In List v3, the list editor enforces UI policies and mandatory dictionary attributes.</td>
</tr>
<tr>
<td>Configuring when related lists load</td>
<td>When List v3 is enabled for related lists, all related lists load asynchronously after the form loads, even if there are no v3 related lists on the form.</td>
</tr>
<tr>
<td>Creating default filters for related lists</td>
<td>The Set as Default Filter button is not available in the filter interface for v3 related lists.</td>
</tr>
</tbody>
</table>

List title menus

The list title menu contains several options related to the list.

Some of the options displayed in the list title menu depend on the list version, the user role, and the installed applications. The List v3 list title menu contains several options that appear in the list column context menu in List v2.

To open the list title menu in UI16 or UI15, click the menu icon (≡) by the list title. In UI11, simply click the list title.

List title menu in List v2

You can click the title of the list to access options related to viewing and filtering the entire list.
Note: Administrators can customize which options appear in the list title menu.

Context menu list title

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Changes the view of the list by presenting different information.</td>
</tr>
<tr>
<td>Filters</td>
<td>Changes the values in the filter. Some of the choices are: None, Active, and Edit personal filters.</td>
</tr>
<tr>
<td>Group by</td>
<td>Groups records in a list by the values in a selected field from that table. Any field from the table can be used as a group filter, whether or not it appears in the list.</td>
</tr>
<tr>
<td>Show</td>
<td>Changes the number of rows shown on each page of the list.</td>
</tr>
<tr>
<td>Refresh List</td>
<td>Refreshes the list to show changes immediately.</td>
</tr>
<tr>
<td>Create Favorite</td>
<td>Adds a link to this list to your favorites.</td>
</tr>
</tbody>
</table>
List title menu in List v3

The options that appear are based on the user's role. Pictured are the options that administrators see. Administrators can customize which options appear in the list title menu.

### List title menu options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personalize List Columns</td>
<td>Configures which columns appear and the order in which they appear for a user.</td>
</tr>
<tr>
<td>Change View</td>
<td>Changes the view of the list by presenting different information.</td>
</tr>
<tr>
<td>List Layout</td>
<td>Configures the list view for all users (requires access rights).</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List Calculations</td>
<td>Configures list calculations for columns, which calculate column totals, minimums, maximums, and averages (requires access rights).</td>
</tr>
<tr>
<td>List Control</td>
<td>Configures list controls, such as buttons and filters (requires access rights).</td>
</tr>
<tr>
<td>Configure</td>
<td>Provides administrative functions related to the information displayed and how it is controlled (requires access rights).</td>
</tr>
<tr>
<td>Import</td>
<td>Import data from an Excel template file.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports data to Excel, CSV, XML (administrators only), or PDF.</td>
</tr>
<tr>
<td>Create Favorite</td>
<td>Adds a link to this list to your favorites.</td>
</tr>
<tr>
<td>Update All</td>
<td>Perform updates to multiple records at once.</td>
</tr>
<tr>
<td>Update Selected</td>
<td></td>
</tr>
<tr>
<td>Create Application Files</td>
<td>Creates demo data from the current list of records that can be included when you install or update the application on another instance (administrators only). Used with custom application development.</td>
</tr>
<tr>
<td>Import XML</td>
<td>Imports a set of records that were exported from a source instance, for example, a developer instance (administrators only).</td>
</tr>
</tbody>
</table>

### Column headings

Column headings appear at the top of each list column.

These headings display column names and provide some list actions. The available actions are different for v3 and v2 lists. In List v3, several of the actions are moved to the list title menu.

### Column headings in List v2

These headings display column names and provide some list options. Column headings are stationary at the top of the list and do not scroll with list content, except in UI11.

**Note:** Some of the options displayed in the list context menu depend on the user role and the installed applications.

### Column heading controls

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting</td>
<td>Click the column name to sort the list in ascending order. Click again to sort in reverse order. An arrow by the column name indicates the column currently being sorted as well as the sort direction. A downward pointing arrow indicates that the column is sorted in descending order.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List column context menu</td>
<td>Access this menu, also called a right-click menu, by clicking the menu icon (≡) at the top of a list column (UI16/UI15) or by right-clicking the column heading (any UI version). The list context menu offers the following controls.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Sort (a to z) and (z to a):</strong> Sort in ascending or descending order.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Visual Task Board:</strong> Create a Visual Task Board based on the current list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Group By:</strong> Aggregate records by a field. For more information, see Use a grouped list in List v2.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Bar Chart</strong> and <strong>Pie Chart:</strong> Create quick bar and pie chart reports based on the filter criteria of the list. Users can then modify these reports or create gauges (depending on access rights).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Launch Interactive Analysis</strong> (requires Performance Analytics Premium): Enables you to quickly explore data using visualizations.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Configure</strong> (requires access rights): Provides administrative functions related to the information displayed and how it is controlled. For more information, see List configuration.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Import</strong> (administrators only): Import data from an Excel template file.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Export:</strong> Exports data to Excel, CSV, XML (administrators only), or PDF. For more information, see Exporting data.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Update Selected</strong> and <strong>Update All:</strong> Perform updates to multiple records at once. For more information, see Edit multiple records in a list using the list editor. These options require the list_updater role.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Create Application Files</strong> (administrators only): Creates demo data from the current list of records that can be included when you install or update the application on another instance. Used with custom application development.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Import XML</strong> (administrators only): Imports a set of records that were exported from a source instance, for example, a developer instance. For more information, see Import an XML file.</td>
</tr>
</tbody>
</table>

Administrators can **customize** which options appear in this menu.

**Column headings in List v3**

These headings display column names and provide some list options. Column headings are stationary at the top of the list and do not scroll with list content.

**Note:** Some of the options displayed in the list context menu depend on the user role and the installed applications.
## Column heading controls

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting</td>
<td>Click the column name to sort the list in ascending order. Click again to sort in reverse order. An arrow by the column name indicates the column currently being sorted as well as the sort direction. A downward pointing arrow indicates that the column is sorted in descending order.</td>
</tr>
</tbody>
</table>
| List column context menu | Access this menu, also called a right-click menu, by clicking the menu icon (≡) at the top of a list column or by right-clicking the column heading. The list context menu offers the following controls.  
- **Sort (a to z) and (z to a)**: Sort in ascending or descending order.  
- **Group By**: Aggregate records by a field. For more information, see [Use a grouped list in List v3](#).  
- **Bar Chart** and **Pie Chart**: Create quick bar and pie chart reports based on the filter criteria of the list. Users can then modify these reports or create gauges (depending on access rights).  
- **Show Visual Task Board**: Create a Visual Task Board based on the current list. |
| Search (🔍)          | Enables the column search. For more information, see [Search by one or more columns in a list](#).                                      |

## Pop-up forms

Pop-up forms enable you to edit records without leaving a v2 list in UI16 or UI15.

To display a pop-up form, press Shift and click a field link or point to the reference icon for a record. You can edit the pop-up form like any other form.
Pop-up form for editing records

**Note:** Pop-up forms are not supported in List v3 or UI11. Holding the Shift key while clicking the reference icon in UI11 opens the standard record preview. Holding the Shift key while clicking a field link in UI11 opens the associated record in a new window or tab. Clicking the reference icon in list v3 opens a pop-up window of the record. Click **Open Record** to open the form.

**Note:** Related lists do not appear on forms opened in the pop-up window.

**List fields**

Fields display data and provide certain functions.
Note: Some of the options displayed in the field context menu depend on the user role and the installed features.

### Field functions

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Links</td>
<td>Open the associated record in form view. Click the first column field to open the current record. You can also click a link to a related record in other columns to go to that record.</td>
</tr>
<tr>
<td>Editing</td>
<td>Changes the information in one or more records. For more information, see <a href="#">Methods for list edits</a>.</td>
</tr>
<tr>
<td>Reference icon ( ![i](in UI16 and UI15, ![i](in UI11) )</td>
<td>Provides a preview of the record. In List v3, click the icon to open a preview, which stays open until you click elsewhere. The preview contains a button to open the record. If List v3 is enabled, the same behavior occurs even in a List v2 list. In List v2, point to the reference icon to open a preview, which closes when you move the cursor unless you hold the Shift key (or the Alt key on some UK keyboards). Click the reference icon to open the record in form view.</td>
</tr>
</tbody>
</table>
| Context menu               | Also called a right-click menu, offers several options, including:  
  - Quick filter options, such as Show Matching and Filter Out.  
  - The option to copy the record URL to the clipboard.  
  - The option to copy the sys_id of the record to the clipboard (administrators only).  
  - Quick edit options, such as Assign to me, Approve, and Reject.  
  - The option to edit the record tags, which provide quick access to frequently referenced or urgent information. When a tag is assigned to a record in UI16 or UI15, the record is displayed on the Tagged Documents page. In UI11, a link to the record is displayed in the application navigator under the assigned tag.  
  - Options specific to features such as Live Feed and Visual Task Boards. |

### Configure and use list functions

All users can interact with lists for the tables their role permits them to access. Some list and column header menu options are controlled by permissions granted to the user role.

The following procedures describe functions that users can configure or use with lists.
Sort a list
You can quickly find information in a list by sorting the list. The method that the system uses to sort a list depends on the type of record in the sort column.

Role required: none

Consider the example record: Label=Requested Item; Value=sc_req_item. Field types other than choice list types are sorted based on the label. The example record label, Requested Item, would be sorted with records whose labels start with "r."

A choice list field lets the user select from a pre-defined set of choices. Choice list fields are sorted by the underlying dictionary entry value of the field, not by the label. The example record value, sc_req_item would be sorted with records whose values start with "s."

Sorting by value can be useful. For example, choices for the State of tasks are ordered New > Work in Progress > Closed. Based on the label, the sort would be Closed > New > Work in Progress.

An arrow next to the column name indicates the current sort order. A downward pointing arrow indicates that the column is sorted in descending order. Only the primary sort order is indicated.

Note: The following sorting rules apply to lists:
- In a translated instance, only translated_text, translated_field, and translated_html type columns support sorting.
- The column label should be created in English first then translated accordingly.
- You cannot sort a list by an array-based field, such as a Glide list.

To sort a list, use one of the following methods:
- Click a column name to sort the list in ascending order. Click again to sort in reverse order.
- Right-click a column name and select Sort (a to z) or Sort (z to a) to sort in ascending or descending order, respectively.
- Specify a sort order with a filter. Filters provide for sorting by more than one column (for example, by Category and then Subcategory).

Configure field status indicators
You can enable or disable modern cell coloring for list field status indicators in UI16 or UI15. In List v2, this setting is available when you personalize a list. This setting is available in your system settings.

Role required: none

- In UI16 and UI15, field status indicators on lists are displayed with modern cell coloring, as a colored circle on the left side of the field. You can select the style of the field status indicator in UI16 or UI15. You can revert to using a field background color by disabling modern cell coloring.

  Modern cell coloring on

- In UI11, field status indicators on lists are displayed using a field background color.
Modern cell coloring off

The process differs for List v3 and List v2:

<table>
<thead>
<tr>
<th>Version</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| List v3 | 1. In the banner frame, click the gear icon.  
2. On the System Settings window, click the Lists tab.  
3. Toggle the Modern Cell Styles switch to enable or disable modern cell coloring.  

| List v2 | 1. Click the personalize list icon (🛠️) in the list.  
2. Select the Modern cell coloring check box to use the UI16/UI15 style field status indicator.  
Clear this check box to use the UI11 style.  
3. Click OK. |

For more information, see Creating Personal Lists.

Customize the number of list rows per page

You can customize the number of records, or rows, to display on each page of a list. The default is 20 rows per page.

Role required: none

When you customize the number of rows, it applies to all lists that you can access.

For information about the performance impact of displaying more rows, see the blog post Improve performance by displaying “just enough” data by a ServiceNow employee in the ServiceNow Community.

1. Open a list.  
2. Perform the appropriate action for the list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right-click the list title and select Show &gt; &lt;Number&gt; rows per page.</td>
</tr>
<tr>
<td>List v3</td>
<td>In the list footer, click the &lt;Number&gt; rows per page button and select the number of rows you want to display.</td>
</tr>
</tbody>
</table>

The list refreshes to display the number of records selected, or, if there are fewer than the number of rows you are displaying, the total number of records. The page control is updated to show your selected number of records (1 to 50 of 59).
Switch between list views

A view defines the elements that appear when a user opens a list.
Role required: none
You can switch between list views to which you have access.

1. Open the list.
2. Select the view to configure by performing the appropriate action for your list version.

<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List V2</td>
<td>Open the list title menu and select View &gt; (view name).</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the list title menu and select Change View, and then click the name of the view.</td>
</tr>
</tbody>
</table>

The page refreshes with in the selected view.

Perform actions on selected items in a list

Action check boxes enable you to perform actions on one or more items in a list.

1. Select the check boxes beside the records you want to affect.
   To select all records on the page in List v3, select the check box at the top of the list just under the list filter. To select all records on the page in List v2, select the check box at the bottom of the list.
2. Apply the desired action.
   - List v2: In the column context menu, select **Update Selected** to update all the selected records.
   - List v3: In the list title menu, select **Update Selected** to update all the selected records.
   - UI11: In the column context menu, **Update Selected** records using an editing form.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
In the action choice list below the list, select an action such as **Delete** (administrators only), or **Add to Visual Task Board**. The available actions vary depending on the list and which plugins are activated. In List v3, the action choice list appears after you select one or more check boxes.

**Use embedded lists**

Some lists may be embedded in forms when List v2 is in use. Use list controls to work with records in an embedded list within a form.

Role required: none

*Note:* Embedded lists are not supported in List v3. Embedded lists always display in List v2.

Changes to embedded lists are saved when the form is saved. For more information, see Edit a form.

Use the following controls to work with an embedded list.

- To expand or collapse an embedded list, click the expand (++){ } or collapse icon in the list header.
- To add a new row, double-click **Insert a new row...**
- To edit a row, double-click in an empty area of the field. See Use the list editor.
- To delete a row, click the delete icon (✘) beside the row. New rows are removed immediately and existing rows are designated for deletion when the record is saved. To clear this designation, click the delete icon again.
Activity streams in list view

If UI16 or UI15 is enabled, you can stream live activity information for all records on the current list.
Activity stream window
To view the activity stream information, click the list activity stream icon ( três horizontais ) in the list title bar. This icon appears in the title bar for all task tables.

The activity stream information appears in a flyout window, and is the same information that appears in the activity formatter for a record. The short description appears as the title for the entry. Activity stream items on the task table use the task number as the title. The information in the flyout window updates automatically with audit and journal entries. Click the >> icon at the top to close the activity stream.

You can add a comment to any item in the activity stream. When you point to the item with your cursor, a Comment button appears.

You can click an item to open the activity stream for that record. The record activity stream lets you open the task record, post additional comments or work notes, or preview images. Click the < icon at the top to close the record activity screen.

Search a list

You can search a list to find information quickly. The list title bar includes options for searching the list. Administrators can enable text searches for any list.

Role required: none

There are two options for searching the list: for a string in a selected field, or for a text string found in any field. In List v2, these options are labeled Go to and Search. In List v3, the search fields appear with no label.

- The Go to option sorts the list by the selected field and returns records where the field value is equal to or greater than the search term. For the Number field, which is a string type field, it finds the records that have a number ending with the number that you enter. For example, searching a list of incidents by selecting Number and entering 4 shows records with numbers like INC0000004 and INC0000014.

- The Search option appears when you select for text. It returns records that contain the search term in any field in the list table. If you added a related list condition, the search does not include records in the related table.

**Note:** In UI11, the Go to and Search options are displayed side-by-side in the header.

Each option in a choice list is defined with a column label and a value. For example, the incident State field contains several options, such as New and Closed. These labels are column labels, and each one has an underlying value. For incidents, the default value for New is 1 and the default value for Closed is 7. You can search a column for either the column label or the value with the following results.

- Enter the column label to list matching records, for example, all incident records in the New state.
- Enter the value to find records that have a state greater than or equal to (=>) the specified value. For example, enter 6 to list incident records in the Resolved and Closed states.

1. Navigate to a list of records.
2. If necessary, personalize the list to add the desired fields.
3. Select a field or select for text.
4. Enter the search text. Use wildcards to further refine list searches.
5. Press the Enter key to execute the search.

In UI11, you can press the Enter key or click the search icon (🔍).

Search by one or more columns in a list

In addition to searching by field or for text, you can search by one or more individual columns in a UI16 or UI15 list.

Role required: none

![Column search (List v2)](image)

Column search (List v2)

This search supports queries that include AND, but does not support OR. You cannot search in a column that uses the List field type, for example, watch lists.

1. Click the search icon 🔍 to expand the column headers and add a search field to each column.
2. To search a single column, enter the search text in the desired column search field and press the Enter key.
   Use wildcards to further refine column searches. For example, use the * to define a contains search.
3. To search multiple columns, perform one of the following actions.
   - Enter the search text in each of the desired column search fields and press the Enter key.
   - Search an individual column and then search additional columns based on the results of the first search.
The search returns records that match the search term.

To clear a column search, complete one of the following actions.

- Delete the text in the search field for the desired column and press the Enter key. This returns results for any remaining column search criteria.
- Delete the text in all the column search fields to return all records in the list.

**Available list search wildcards**

The platform supports several wildcard characters to expand and refine search results.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*search-term</td>
<td>Search for values that contain search-term.</td>
</tr>
<tr>
<td>%searchterm%</td>
<td></td>
</tr>
<tr>
<td>%search-term</td>
<td>Search for values that end with search-term.</td>
</tr>
<tr>
<td>search-term%</td>
<td>Search for values that start with search-term.</td>
</tr>
<tr>
<td>=search-term</td>
<td>Search for values that equal search-term.</td>
</tr>
<tr>
<td>l*searchterm</td>
<td>Search for values that do not contain search-term.</td>
</tr>
<tr>
<td>l%searchterm</td>
<td>Search for values that do not end with search-term.</td>
</tr>
<tr>
<td>l=seachterm</td>
<td>Search for values that do not equal searchterm.</td>
</tr>
</tbody>
</table>

**Configure the default search behavior**

The default search behavior in a list is to search for values that are greater than or equal to the value you enter. Administrators can add a property to change the search behavior to use a contains search by default, instead of a greater than search.

If you enter text in the search box without using a wildcard, the search is performed for values greater than or equal to the value you enter. For text data-type-fields, this means that the search first sorts the records on the selected field, then finds the first record that starts with the text and all following records. For numeric data-type-fields, this means that the search finds all records where the number field ends with the entered number.

**Note:** The system treats some string fields that contain record numbers as numeric fields. Any field named number or u_number is treated as a numeric field.

Role required: admin

1. Navigate to the list of system properties by typing `sys_properties.list` into the navigation filter.
2. Add the following property. For more information on adding a property, see [Add a property.](Add a property)  

**Default search behavior property**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.goto_usecontains</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

**Grouped lists**

Grouping aggregates a list by a field and displays the record count per group. Grouping can help you find data quickly by organizing and providing a summary of search or filter results.

For example, this picture shows active incidents grouped by caller.

![List grouped by caller (List v2)](image)

- Groups are named for the values of the field selected for grouping. For example, if you group by the assigned user, each group is a user's name.
- The record count for each group appears next to the group name.
- The total number of items in the list (all groups combined) appears near the paging controls in the list. This total displays only when the list is grouped on a field.

List v3 provides extended grouping capabilities.

**Use a grouped list in List v2**

You can find information by grouping a list by a particular field. After grouping items in a list, several options let you focus on a particular group or set of groups.
Role required: none

1. Use one of the following methods to group and ungroup items in a list.
   - On the title bar, click the context menu and select **Group By**. Select the field by which to group the list. To remove a grouping, select **-- None --**.
   - Right-click the column name and select **Group By**. To remove a grouping, select **Ungroup**.

For example, this picture shows active incidents grouped by caller.

```
<table>
<thead>
<tr>
<th></th>
<th>Number</th>
<th>Caller</th>
<th>Short description</th>
<th>Category</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>INC0000052</td>
<td>Bud Richman</td>
<td>SAP Financial Accounting application appears to be down</td>
<td>Software</td>
<td>1 - Critical</td>
</tr>
<tr>
<td></td>
<td>INC0000046</td>
<td>Bud Richman</td>
<td>Can’t access SFA software</td>
<td>Software</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>INC0000040</td>
<td>Bud Richman</td>
<td>JavaScript error on hiring page of corporate website</td>
<td>Inquiry / Help</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>INC0000039</td>
<td>Bud Richman</td>
<td>Trouble getting to Oregon mail server</td>
<td>Network</td>
<td>5 - Planning</td>
</tr>
</tbody>
</table>
```

2. Use any of the following actions to expand the groups.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To expand or collapse a group</td>
<td>Click the arrow (↑) next to the group name.</td>
</tr>
<tr>
<td>To expand or collapse all groups</td>
<td>Click the arrow at the top of the list.</td>
</tr>
<tr>
<td>To open the full list for a group</td>
<td>Click the group name.</td>
</tr>
<tr>
<td>To see all records for a given group</td>
<td>Open the full list.</td>
</tr>
</tbody>
</table>

**Note:** The maximum number of records shown per group is the **number of records per page** in list view.
Use a grouped list in List v3

You can find information by grouping a list by a particular field. In the grouped by list view, you can change the grouped list focus, hide the visualization panel, or switch the graph view.

Role required: none

1. Right-click the column heading for the column to group by, and then select **Group By <column name>**.
   
   To undo a grouping, click **Ungroup** in the list footer.
   
   The system groups the list by the column values and opens the grouping panel. Grouped order displays highest to lowest.
<table>
<thead>
<tr>
<th>Priority</th>
<th>Title</th>
<th>Created</th>
<th>Updated</th>
<th>Description</th>
<th>Status</th>
<th>Priority</th>
<th>State</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Critical</td>
<td>Network file shares access issue</td>
<td>2017-02-14 04:13:12</td>
<td></td>
<td><strong>Fred Luddy</strong> - Critical - On Hold - Network</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Network</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>Wireless access is down in my area</td>
<td>2017-02-21 04:17:30</td>
<td></td>
<td><strong>Joe Employee</strong> - Critical - In Progress - Network</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Network</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>Need access to sales DB for the West</td>
<td>2015-08-13 04:16:24</td>
<td></td>
<td><strong>Joe Employee</strong> - Critical - On Hold - Database</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Database</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>I can't launch my VPN client since the last software update</td>
<td>2017-02-06 05:08:46</td>
<td></td>
<td><strong>Fred Luddy</strong> - Critical - In Progress - Software</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Software</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>Rain is leaking on main DNS Server</td>
<td>2017-02-01 09:10:23</td>
<td></td>
<td><strong>Ron Ruppert</strong> - Critical - In Progress - Hardware</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Hardware</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>How do I create a sub-folder</td>
<td>2015-08-13 05:11:00</td>
<td></td>
<td><strong>Joe Employee</strong> - Critical - On Hold - Inquiry</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Inquiry</td>
</tr>
<tr>
<td>1 - Critical</td>
<td>Sales forecast spreadsheet is READ ONLY</td>
<td>2017-02-07 05:12:46</td>
<td></td>
<td><strong>Taylor Westland</strong> - Critical - In Progress</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>1 - Critical</td>
<td>Need to add more memory to laptop</td>
<td>2017-01-30 04:12:46</td>
<td></td>
<td><strong>Don Goodlife</strong> - Critical - In Progress - Hardware</td>
<td>1 - Critical</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Hardware</td>
</tr>
</tbody>
</table>
2. Use any of the following actions to work with grouped records.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide a group</td>
<td>In the Show All tab of the grouping panel, clear or select the check box by a group.</td>
</tr>
<tr>
<td>Focus on specific groups</td>
<td>In the Show Selected tab of the grouping panel, clear the check boxes of any groups you do not want to see.</td>
</tr>
<tr>
<td>Switch the graph view between a pie graph and a bar graph</td>
<td>In the grouping panel, use the graph toggle.</td>
</tr>
<tr>
<td>Show or hide the grouping panel</td>
<td>In the list footer, click Toggle group by.</td>
</tr>
</tbody>
</table>

**Note:** The maximum number of records shown per group is the number of records per page in list view.

---

**Filters and breadcrumbs**

A filter is a set of conditions applied to a table to help you find and work with a subset of the data in that table.

You can apply, modify, create, and save filters. A hierarchical list of conditions at the top of the table — breadcrumbs — indicates the current filter.

Breadcrumbs offer a quick form of filter navigation. They are ordered from left to right. The left condition is the most general, and the right condition is the most specific. Clicking a breadcrumb removes all the conditions to its right. Clicking the condition separator (>) before a condition removes only that condition.

**Note:** In List v3 split mode, you cannot edit the filter from the breadcrumb. Click the filter icon in the left pane to open the filter conditions in the right pane for editing.

By default, a user with no roles cannot see the breadcrumbs or filter. Administrators can configure the ESS portal to allow unauthenticated users to see breadcrumbs and filters by using a script include. For more information on using script includes to suppress breadcrumbs and filters, see Use script includes to suppress filters and breadcrumbs.

**Note:** In List v3 split mode, you cannot edit the filter from the breadcrumb. Click the filter icon in the left pane to open the filter conditions in the right pane for editing.
Examples:
- Clicking **Priority = 2** removes the condition **Category = Software** and returns all active incidents with a priority of 2.
- Clicking the condition separator (>) before **Priority = 2** removes the condition **Priority = 2** and returns all active incidents in the software category.
- Clicking **All** removes all conditions and returns all incidents in the system.

Click a breadcrumb to refresh the list of records and show the latest information for those records.

**Note:** Clicking the **New** button in a filtered list automatically applies the same filter to the new record. For example, clicking **New** in the Resolved Incidents list opens a record preset...
with **State** set to **Resolved**. In a list filtered for active, priority 1 incidents, clicking **New** opens a record preset with **Active** selected and **Priority** set to 1 - **Critical**.

You can change the preset values on the form as needed. If there is a field you do not want to have populated in this way, you can add the following dictionary attribute to the field: `ignore_filter_on_new=true`.

Additional navigational functions are available when you right-click a breadcrumb.

**Breadcrumb right-click options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open new window</td>
<td>Opens the results list for the breadcrumb in a new tab or window.</td>
</tr>
<tr>
<td>Copy URL</td>
<td>Copies the URL to the clipboard for the results list of the breadcrumb.</td>
</tr>
<tr>
<td>Copy query</td>
<td>Copies the encoded query to the clipboard for the breadcrumb. You can use this query in the URL of an instance or in the reference qualifier field of a dictionary entry. For example, if you are viewing a list of all active incidents with a high or medium impact, right-click the breadcrumb and copy the query <code>active=true^impact=1^ORimpact=2</code>. You can append this query to the end of the instance URL as follows: <code>https://{instance_name}/incident_list.do?sysparm_query=active=true^impact=1^ORimpact=2</code>. This selection is not available for the <strong>All</strong> breadcrumb.</td>
</tr>
</tbody>
</table>

**Quick filters**

To quickly filter a list using a value in a field, right-click in the field and select **Show Matching** or **Filter Out**. For date fields, choose from **Show Before**, **Show After**, and **Filter Out**.

These functions add a condition to the right in the breadcrumb of the current filter.
In this example, right-clicking **In Progress** and selecting **Show Matching** adds the condition **State = In Progress** as the most specific condition of the filter. By contrast, right-clicking **In Progress** and selecting **Filter Out** adds the condition **State != In Progress** as the most specific condition of the filter.

For date and date-time fields, you can also use **Show After** or **Show Before** to define a time-based filter.

Using the quick filter method to filter out a particular value builds the following conditions: (field) (is not) (value) or (field) (is) (empty). Records that contain empty or null values still display in the filtered list. If you manually create a filter, it does not automatically include the OR condition (field) (is) (empty), so records that have an empty or null value do not display in the filtered list.

**Filters**

A filter restricts what records appear in a list by providing a set of conditions each record must meet to be included in the list.

A condition consists of the following parts.

- **Field**: Each field contains data from a particular column in the table. Selecting a reference field allows you to dot-walk to data from other tables.
- **Operator**: Each field type has its own set of valid operators. The operator determines if a value is needed.
- **Value**: Each field has its own set of valid values determined by the field type. Reference fields have access to auto-complete, and choice lists provide a list of options.
- **Grouping**: Each condition line is grouped with either an AND or OR connector. The filter requires all condition lines linked with an AND connector to be met. The filter separately evaluates each condition line linked with an OR connector.

List v3 provides the Related Lists Conditions section that allows you to include a condition based on a related table.

Create filters on a list using the condition builder.

**Related list conditions in List v3**

By default, all lists allow you to filter on the current table data, which includes dot-walking to fields in referenced tables. In v3 lists, another type of condition, Related Lists Conditions, is available in the condition builder. For more information, see [Add related list conditions](#).

**Pin a filter in List v2**

To make the condition builder appear every time you open the list, click the pin/unpin filter icon (in UI16 and UI15, and in UI11). This functionality is not supported in List v3.

**Create a filter in List v2**

You can create a filter to restrict what records appear in a list by providing a set of conditions. When you run the filter, only records that meet the specified conditions are listed.

Role required: none

1. Open the condition builder in one of the following ways.
   - Click the show / hide filter icon (beside the breadcrumbs in UI16 or UI15.
   - Click the arrow icon (beside the breadcrumbs in UI11.
If the icon is disabled and the breadcrumb has a related list condition in it, you must remove the related list condition to open the filter. The condition was created when the List v3 was enabled for this list. List v2 does not support related list conditions. For more information about related list conditions, see Add related list conditions.

2. Select a field from the list.
   The field type determines the available operators and values. For example, the Active field can have a value of true, false, or empty, while a text field can have many different values. Similarly, the greater than operator does not apply to the Active field, but it does apply to the Priority field. For more information, see Condition builder.
3. Select an operator from the list.
4. Select or enter a value, if appropriate.
5. Add or remove conditions to construct the desired filter by completing one or more of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a top-level condition</td>
<td>Click AND or OR on the condition builder toolbar, above the conditions.</td>
</tr>
<tr>
<td>To add a dependent condition</td>
<td>Click AND or OR beside the condition.</td>
</tr>
<tr>
<td>To remove a condition</td>
<td>Click x beside the condition.</td>
</tr>
</tbody>
</table>

Note: To find all records that do not contain the specified value, create a filter with two conditions: (field) (is not) (value) or (field) (is) (empty).

6. To specify the sort order of the results, click Add Sort and then select a field to sort by and a sort order.
7. Optional: Click Save to keep the filter for future use. For more information, see Save and use filters in a list view.
8. Click Run to apply the filter.

Create a filter in List v3
You can create a filter to restrict what records appear in a list by providing a set of conditions. When you run the filter, only records that meet the specified conditions are listed.

Role required: none
The filter can include conditions from a related list. For example, you filter the problem list to show high-priority problems. You can add a related list condition to include only those high-priority problems that have one or more related incidents.

Note: List v3 is supported only in UI16.

1. Click the show / hide filter icon (   ) beside the breadcrumbs in UI16.
2. Select a field from the first choice list.
You can dot-walk to a field on a referenced table, as shown in the following example. An arrow icon appears beside each reference field. Click the arrow to open additional reference fields to the right to find the field to use.

3. Select an **operator** from the next choice list.
   The field type determines the available operators and values. For example, the **Active** field can have a value of **true**, **false**, or **empty**, while a text field can have many different values. Similarly, the **greater than** operator does not apply to the **Active** field, but it does apply to the **Priority** field. For more information, see **Condition builder**.

4. Select or enter a **value**, if appropriate.

5. Add or remove conditions to construct the desired filter by completing one or more of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a top-level condition</td>
<td>Click <strong>New Criteria</strong> below the condition builder.</td>
</tr>
<tr>
<td>Add a dependent condition</td>
<td>Click <strong>AND</strong> or <strong>OR</strong> beside the condition.</td>
</tr>
<tr>
<td>Remove a condition</td>
<td>Click the remove condition icon (＃) beside the condition.</td>
</tr>
</tbody>
</table>
**Option** | **Description**  
--- | ---  
Add a related list query | Click RELATED LISTS CONDITIONS below the condition builder. Select a relationship from the Table choice list and the number of records to include in the result. Optionally, select the field, operator, and value for the related table. Related list queries add the ability to quantify the related list query, which you cannot do if you dot-walk to the related field. For more information, see Add related list conditions.  

*Note:* To find all records that do not contain the specified value, create a filter with two conditions: *(field) (is not) (value)* or *(field) (is) (empty)*.  

6. To specify the sort order of the results, click **Add Sort**, and complete the following steps.  
   a) Select a field to sort by and select a sort order.  
   b) Optional: Click the add condition icon (+) beside the sort condition to add an extra level of sorting.  
      For example, you can sort a list of incidents by state, then sort incidents of the same state by date opened.  
   c) Optional: Click the remove condition icon (-) beside a sort condition to remove it.  
   d) Click **Run Sort**.  

You cannot add **Keywords** to the filter more than once.  

7. Optional: Click **Save Filter** to keep the filter for future use. For more information, see [Save and use filters in a list view](#).  

8. Click **Run** to apply the filter.  

**Add related list conditions**  
Related list conditions allow you to include a relationship with another table in the filter. Related list conditions are supported only in List v3.  

Role required: none  

You can optionally include conditions on the related table. For example, you can filter active problems with one or more related incidents that are in the Canceled state. Another example is to filter incidents with a breached service level agreement (SLA).  

The List v3 filter contains two sections, one for the current table conditions and one for related lists conditions. You can include only one related table in the query, however, you can add multiple conditions for that table.
Problem filter for open problems

The easiest way to understand the parts of a related list condition is to use an example. The steps below use the example of open problems with some number of related incidents. You can perform these steps for any list view that supports List v3.

1. For this example, navigate to Problems > Open.
2. Open the list filter and select the conditions for the current (Problem) table. The (State) (is) (Open) condition is already added.
3. Click RELATED LISTS CONDITIONS to expand the section.
4. From the choice list, select the table relationship to include in the query.
   For this example, select Incident>Problem. You can select any table that you have access to view.
5. To select a quantifier, click Greater Than Or Equal To 1. The Quantity popover opens.
6. Select a quantity, enter number of records in the related table that must match, and then click X to close the popover.

The default number is 1. Following are descriptions and examples of each quantifier for this example.

- **Greater Than Or Equal To**: Returns problem records where the number of related incidents is greater than or equal to the number you enter. A value of 5 includes problems with five or more related incidents. Problem records with 4 or fewer incidents are not returned.
- **Greater Than**: Returns problem records that have more than this number of related incidents.
- **Less Than Or Equal To**: Returns problem records that have the number or fewer than the specified number of related incidents. A value of 1 includes problem records with one or no related incidents.
- **Less Than**: Returns problem records with fewer than the number of related incidents. A value of 1 returns problems with no related incidents.
- **Equal To**: Returns problems with this number of related incidents. A value of 5 includes problem records with exactly five related incidents.
- **None**: Returns problems that do not match the specified table relationship. A selection of None returns problems with no related incidents.
- **Between**: Returns problems with any number of related incidents that is between the two numbers you enter. Between values of 5 and 10 include problem records with 5, 6, 7, 8, 9, or 10 related incidents.

7. Optional: Enter one or more conditions for the related table. Click **New Criteria** to add another condition.

The following image shows the example of filtering for problem records with more than two related incidents that are critical priority.
Note: You cannot perform a keyword search in a related table condition.

8. Click Run to execute the filter query.

The breadcrumb displays Related List condition.... Open the filter to view the related list query statement.

List breadcrumb and the related list condition query statement

Note: If List v3 is disabled for a list with a related list condition query in the default filter, the filter edit function is disabled. Remove the related list condition to enable list filter editing.
OR conditions
The condition builder uses two different types of OR conditions: top-level and dependent.

Using a dependent OR condition, you can specify alternative criteria to a single operation. Dependent OR conditions work in the manner A and (B or C). When you have an OR condition in the query, the magnifying glass is no longer available. The conditions you put in the quick search headers are ANDed together. Having an OR makes it ambiguous as to where the new condition should go, for example before the OR, or after the OR.

For example, to return a list of all unassigned problem and incident records from the Task table, create a filter with a dependent OR on the Number field.

- (Assigned to) (is) (empty) AND (Number) (begins with) (PRB) OR (Number) (begins with) (INC).

Dependent OR List v2
A top-level OR condition allows you to display the results of multiple filter criteria in a single list. Top level OR conditions work in the manner (A and B) or (C and D).

For example, to return a single list of all active incidents with a category of hardware, and all inactive incidents with a category of software, create two condition sets separated by a top-level OR condition.

- **(Active) (is) (true) AND (Category) (is) (Hardware)**
- **Top level OR condition**
- **(Active) (is) (false) AND (Category) (is) (Software)**
Top level OR List v2

In List v3, select the **New Criteria** button in the condition builder to create a new top-level OR condition.
Top level OR List v3

Top-level and dependent OR conditions can be used together. Filters using both types of OR conditions work in the manner (A or B) or (C or D). By mixing AND conditions with top-level and dependent OR conditions, you can create very specific filters.

Filter on multiple string values
For a string field, you can create a filter that searches for multiple values by creating a comma-delimited list.

This feature enables administrators to copy and paste search criteria from a Microsoft Excel spreadsheet into a filter, for example.

**Note:** Do not use the **(is one of)** operator on fields that contain commas, as the query does not return the expected set of records. Instead, create a filter using multiple **(or)** statements.

1. Create the filter with the **(is one of)** or **(is not one of)** operator.
   Depending on the selected field, a choice list or a text box appears.
2. Select one or more of the options by using multiple selection key commands.
   The choice list remains visible.
Alternatively, for text or number fields, type your search options. Separate the options by commas or put each option on a separate line, and do not enclose the selections in brackets.

3. Click **Run** to filter the list. The filter conditions appear as a comma-delimited string at the top of the results list.
Comma-delimited filter string

Dynamic operators
The dynamic operator, **is (dynamic)**, lists predefined dynamic filter options where the condition value is computed from a value in a reference field.

The following dynamic filter options are available by default.

---

**Note:** Administrators can create new dynamic filter options.

---

Default dynamic filter options

<table>
<thead>
<tr>
<th>Target table of reference field</th>
<th>Option label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User (sys_user)</td>
<td>Me</td>
<td>The reference field contains the current user.</td>
</tr>
<tr>
<td></td>
<td>One of My Assignments</td>
<td>The reference field contains the current user or someone for whom the current user is a delegate for assignments.</td>
</tr>
<tr>
<td></td>
<td>One of My Approvals</td>
<td>The reference field contains the current user or someone for whom the current user is a delegate for approvals.</td>
</tr>
<tr>
<td></td>
<td>Users With Roles</td>
<td>The reference field contains users that have any role.</td>
</tr>
</tbody>
</table>
The following table contains examples and descriptions of dynamic filter conditions.

**Example of using the dynamic operator**

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Dynamic filter option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>is (dynamic)</td>
<td>Me</td>
<td>Computes the value of Caller based on the current user viewing the list.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>is (dynamic)</td>
<td>One of My Groups</td>
<td>Computes the value of Assignment group based on the current user viewing the list.</td>
</tr>
</tbody>
</table>

**Save and use filters in a list view**

Depending on your access rights, you may save filters for everyone, a user group, or yourself. You can apply saved filters and edit or delete them.

Role required: varies depending on action. See procedure.

**Note:** A new Create ACL allows all users to save filters by default. This overrides any custom ACLs in place if administrators are restricting filter access. The new ACL gives all users access to the User field by default, and access to the Group field only if users have the filter_group role and are in the currently selected group.

1. Create or modify a filter in the filter interface.
2. Click **Save...** (or **Save Filter** in List v3).
3. Enter a name for the filter.
4. Select one of the following visibility options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Me</td>
<td>Creates a personal filter, which only you can access. If you do not have Write access to the User field, this option will not be available. See your administrator for more information.</td>
</tr>
<tr>
<td>Everyone</td>
<td>Creates a global filter, which all users can access. This option is available to users with the filter_global role.</td>
</tr>
<tr>
<td>Group</td>
<td>Creates a group filter, which only members of the user group you select can access. This option is available to users with the filter_group role. If you do not have Write access to the Group field, this option will not be available. See your administrator for more information.</td>
</tr>
</tbody>
</table>

5. Click **Save** (or **Submit** in List v3).

**Note:** In UI15, click the **Save** button that appears to the right of the visibility options, as opposed to the **Save...** button at the top.
6. To use a saved filter, select the filter name in the list title menu. The filter runs and the breadcrumbs appear.

7. Click **Save** (or **Submit** in List v3).

8. To use a saved filter, select the filter name in the list title menu (List v2) or open the filter interface and select **Load Filter** (List v3). The filter runs and the breadcrumbs appear.

9. To edit or delete personal filters, complete the appropriate action for your list version.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Select <strong>Edit personal filters</strong> from the title menu.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>List v3</td>
<td>Select the edit filter icon, click <strong>Load Filter</strong>, and then click <strong>Manage Filters</strong>.</td>
</tr>
</tbody>
</table>

10. Complete the following steps.
   a) Click the title of the filter to edit.
   b) Update the filter title or add or remove conditions.
   c) Optional: To delete the filter, click **Delete** and confirm deletion.
   d) If you edited the filter, click **Update**.

**Filter admin functions**

Administrators can work with filters in the Filters table (sys_filter), including creating, editing, and deleting filters.

Administrators can also create scripted filters that cannot be created in the condition builder. Scripted filters required a knowledge of JavaScript. Scripted filters can be used to create additional **dynamic filter options**.

**Create and edit filters**

Administrators can create and edit any saved filter.

Role required: admin

1. Navigate to **System Definition > Filters**.
2. To create a filter, complete the following steps.
   a) Enter a **Title** and select the **Table**.
   b) Add filter conditions.
   c) Click **Submit**.
3. To edit a saved filter, select the filter to edit and complete the following steps.
   a) Modify the **Filter** conditions as necessary.
   b) Click **Update**.

**Delete filters**

You can delete any saved filter, including global, group, or personal filters.

Role required: admin

1. Navigate to **System Definition > Filters**.
2. Optional: To see who created the filter and when, personalize the list to add the **created_by** and **created** fields to the list.
3. Optional: To see who has access to the filter, configure the list to add the **user**, **group**, or **domain** fields.
   Filters that are not assigned to a user or group are global.
4. Select the filter to delete.
5. Click **Delete** and confirm the deletion.

**Create scripted filters**

The condition builder alone cannot create some filters, such as displaying a record set that depends on an unrelated table. If you know JavaScript, you can create JavaScript functions for use in advanced filters.
Role required: admin

1. Create a new script include.
   a) Navigate to **System Definition > Script Includes**.
   b) Click **New**.
   c) Fill out the form, and then select **Submit**.

2. Open the script include and, in the **Script** field, create a JavaScript function that returns an array of `sys_ids`.
   - Ensure that the function uses the same name as the script include.
   - Ensure that the script include is **Active** and **Client callable**.

3. Call the JavaScript function from the condition builder.
   For more information, see **GlideRecord queries and Script includes**.

A company provides intensive care for a group of customers. To track these services, the service manager needs a high-level journal and links to all incidents that the customers raise.

The company creates an application, Intensive Care, and a table, (u_intensive_care). While the table contains a reference field for the customer name, there is no direct link to the user table. Thus, the manager cannot set up an incident list filter using the condition builder for customers who are under intensive care.

The solution is to write a JavaScript function that uses a GlideRecord query to build an array of user `sys_ids` in the (u_intensive_care) table, as shown in the sample code below. Call the function from the condition builder in the Incident table (`(Caller) (is) (javascript:myFunction())`).

```javascript
function myFunction () {
  var arrUsers = [];
  gr = new GlideRecord ( 'u_intensive_care' );
  gr. query ( );
  while (gr. next ( ) ) {
    arrUsers. push (gr. u_customer. toString ( ) );
  }
  return arrUsers;
}
```

Create a dynamic filter option
Dynamic filter options enhance filtering by allowing users to run existing script includes or JavaScript against a reference field within condition builders and dynamic reference qualifiers.

Role required: admin

This task describes how to create a new dynamic filter option and an associated script include.

Dynamic filter options "objectize" script includes/JavaScript, enabling them to be reused in multiple condition builders and dynamic reference qualifiers. This type of filter enables you to modify a script once and have the changes automatically take effect everywhere the dynamic filter option is used.

When defining a dynamic filter, you can:

- use an existing **is (dynamic)** dynamic filter option (condition builder only)
- use an existing dynamic filter option (OOB or custom)
create a new dynamic filter option and script include/JavaScript

All condition builder dynamic filters use the **is (dynamic)** operator and call a dynamic filter option. In the following example, the pre-existing dynamic filter option **Me** is being used. For a list of available pre-existing condition builder dynamic filter options, see **Dynamic operators**.

**Note:** Dynamic filters are not supported in scoped applications or UI policy conditions.

Dynamic operands

1. **Create a scripted filter** as a client-callable script include or business rule.
2. Navigate to **System Definition > Dynamic Filter Options**.
3. Click **New**.
4. Complete the form.

**Dynamic filter options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a descriptive name for the dynamic filter option.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter the name of the function you created, JavaScript (no script include needed), or the complete script include/business rule call, such as <strong>new GlobalCanvasUtil().refQualPaTabs()</strong>.</td>
</tr>
<tr>
<td>Field type</td>
<td>Select <strong>Reference</strong>.</td>
</tr>
<tr>
<td>Referenced table</td>
<td>Select the table to which this dynamic filter option applies.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to designate the placement of this dynamic filter option in the filter option choice list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the role a user must have to see this option.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable or disable the option.</td>
</tr>
<tr>
<td>Reference script</td>
<td>Optional. Select the client-callable script include or business rule you created for the scripted filter. If the Script field contains JavaScript, an encoded query, or the entire script include/business rule reference, this field can be empty.</td>
</tr>
<tr>
<td>Available for filter</td>
<td>Select this option to display the dynamic filter option as a filter breadcrumb.</td>
</tr>
<tr>
<td>Available for default</td>
<td>Select this option to allow dynamic filter option to be a default in a dictionary entry.</td>
</tr>
<tr>
<td>Available for ref qual</td>
<td>Select this option to allow dynamic filter option to be selected as a dynamic reference qualifier.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Encoded query strings**

An encoded query string represents a complex filter on a list of records.

Use encoded query strings to include a filter as part of a URL parameter, such as the `sysparm_query` URL parameter, or as a reference qualifier to restrict the data that is selectable for a reference field.

To construct an encoded query string, generate a list query and then copy it from the list filter. This is the preferred method because the alternative is to create the string manually.

In order to create an encoded query string manually, you need to know the relevant table and field names and operators.

**Encoded query string examples**

<table>
<thead>
<tr>
<th>Title</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referring to Boolean or string values</td>
<td>To create a query string on Boolean fields, use this syntax: <code>field=true</code> or <code>field=false</code>. For example, to return only active records in a table, use:</td>
</tr>
<tr>
<td></td>
<td><code>active=true</code></td>
</tr>
<tr>
<td></td>
<td>To create a query string with a field that has a specific string value, use this syntax: <code>field=value</code>. For example, to return incident records where the category is network, use:</td>
</tr>
<tr>
<td></td>
<td><code>category=network</code></td>
</tr>
<tr>
<td>Title</td>
<td>Example</td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| Referring to reference fields | To create a query string that refers to a reference field in another table, use this syntax: field_in_referenced_table=value. For example, to return users with the itil role in the Assigned to reference field on the Incident form, use:  

```
roles=itil
```

| Referring to choice list values | To create a query string that refers to a choice list option, use the value of the choice list, not the label, with this syntax: choice list field=value. For example, to return configuration items (CIs) with the status Installed, which has a value of 1 in the choice list, use:  

```
install_status=1
```

See [Values to associate with choice labels for scripting](#) to find the options for the values.

| Using multiple conditions | To use two conditions joined by an AND operator, use the carat ^ symbol in this syntax: field1=value1^field2=value2. For example, to return all active users with the "itil" role, use:  

```
active=true^roles=itil
```

To use two conditions joined by an OR operator, use the carat symbol with OR with this syntax: field1=value1^ORfield1=value2. For example, to return all users with either the "itil" or "admin" roles, use:  

```
roles=itil^ORroles=admin
```

To add multiple conditions where one condition is a JavaScript function, use this syntax: javascript:'field=value^' + function(). The function must return a string that can be concatenated with the first string to produce a valid query string. For example, to return all active users and meet the conditions of the getGroupQualifier() function, use:  

```
javascript:'active=true^' + getGroupQualifier()
```
<table>
<thead>
<tr>
<th>Title</th>
<th>Example</th>
</tr>
</thead>
</table>
| Listing values in order | To sort data by a specific field, use the `ORDERBY` condition with the following syntax: `field1=value^ORDERBYfield2`. For example, to return the days of the week in order from the Day of the Week (sys_cal_unit) table, use: 

```
unit_name=day^ORDERBYvalue
```

In the Day of the Week table, `unit_name` is the field that specifies day, week, or month, and `value` is a numerical value for each day from 1 (Monday) to 7 (Sunday). The query string returns a list of the days of the week in order from the lowest value, which represents Monday, to the largest value, which represents Sunday.

**Note:** Reference qualifiers do not support the `ORDERBY` condition. In reference qualifiers, you can sort the reference lookup list by using standard list controls. To specify the order of an auto-complete list for a reference field, use the `ref_ac_order_by` dictionary attribute.

| Including a related list query | At the end of the query statement, enclose the related list information with `^RLQUERY` and `^ENDRLQUERY` and the quantity. For example, in a query on the Problem table that includes problems with at least one related incident, use: 

```
^RLQUERYincident.problem_id,>=1^ENDRLQUERY
```

You can also specify conditions on the related table. For example, to include the condition that at least one of the related incidents is critical priority, use:

```
^RLQUERYincident.problem_id,>=1^priority=1^ENDRLQUERY
```

**Note:** Related list queries must be enabled in System PropertiesList v3. Select the Allow related list query conditions to be added through the filter check box to enable it. You can build a related list query for a list that uses List v2, however, the filter conditions cannot be modified until you removed the related list condition in the breadcrumb.

---

*Generate an encoded query string through a filter*

You can generate an encoded query string through a filter on any list and paste the string into a URL query or a reference qualifier.*
Role required: none

1. Open a list of records.
2. Construct the filter.
3. Click Run.
4. Right-click the end of the filter breadcrumb and select Copy query from the context menu.

Copy the query from the breadcrumb

If you are in split mode in List v3, right-click the blue filter text in the left pane.

5. Copy the query to your system clipboard.
6. Use the query string to construct a URL or an advanced reference qualifier.

When you use the CONTAINS operator on a list filter, the system translates the filter to a LIKE query. For example, if you filter for active records with numbers that contain 123, the URL is

https://InstanceName.service-now.com/incident_list.do?sysparm_query=active%3Dtrue%5EGOTOnumberLIKE123.

Methods for list edits

Users can edit data in lists using various methods.

Quick edit functions

To edit a record in a list using quick edit functions, right-click a field and select the appropriate function.

Assign to me

For records that use assignments, places the name of the logged-in user into the Assigned to field.

Approve

For records that use approvals, changes the approval state of the record to Approved.

Reject

For records that use approvals, changes the approval state of the record to Rejected.
Assign tag
For records you want to track based on a user-defined label, lets you select an existing tag or add a tag.

List editor
The list editor lets you edit field values in a list without opening a form. Administrators can configure the list editor. By default, list editing is disabled for some tables. Fields of certain types cannot be edited from lists.

Multiple record edits
You can edit more than one record at the same time using the list editor or an editing form.

Use the list editor
The list editor allows you to edit field values directly from a list without navigating to a form.
Role required: none
The list editor lets you edit field values in a list without opening a form. Administrators can configure the list editor. By default, list editing is disabled for some tables. Fields of certain types cannot be edited from lists.

Before the list editor opens, access rights to edit the field are verified. If this process takes longer than expected, a loading indicator appears. In List v2, if the field has a dependency relationship (for example, Category and Subcategory), then a composite editor opens to allow editing of all dependent fields. You must have rights to edit all dependent fields to use the list editor.

1. Double-click in an empty area of the field. The appropriate editor for the field type opens.
   For v2 lists, you can enable single-click editing from the list personalization interface. You can also use keyboard navigation to access the list editor.
2. Enter the appropriate values.
3. Save the records by performing the appropriate action for your list version.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List v2</strong></td>
<td>Click the save icon (✓). Click the cancel icon (✗) or press the Escape key to retain the original value.</td>
</tr>
<tr>
<td><strong>List v3</strong></td>
<td>Click Save. Press the Escape key or click outside the dialog box to retain the original value.</td>
</tr>
</tbody>
</table>
4. To use keyboard navigation in List v2, press the Tab key until the first field in the list is selected, and then select the field to edit in one of the following ways.
   - Move right: Tab or the Right Arrow key.
   - Move left: Shift + Tab or the Left Arrow key.
   - Move down: the Down Arrow key.
   - Move up: the Up Arrow key.

To select multiple fields in the same column, hold Shift and press the Down Arrow or the Up Arrow key.

5. Press the Enter key to open the list editor.

6. Enter a new value. To add another line in a multi-line text field, press Shift + Enter.

7. Save or cancel your changes in one of the following ways:
   - Press the Enter key. The new value is saved and the field below the edited field becomes selected.
   - Press the Tab key. If the list is configured to save immediately, the new value is saved. If the list is configured to save data by rows, an indicator appears beside the value and the list editor opens for the next field. The row is saved only when you navigate away from the row or click the check mark icon beside the row.
   - Press Ctrl + Enter keys. If the list is configured to save immediately, the new value is saved. If the list is configured to save data by rows, an indicator appears beside the value and the current field remains selected.
   - Press the Esc key. The list editor closes without saving changes and the field remains selected.

---

**Note**: Certain browsers use different key combinations to edit certain field values. For example, to edit a choice list using Chrome, press the Spacebar.

---

**Create a new record**

Users can create records by inserting a new row in the list.

**Role required**: any role required to create records on the table

Administrators can configure the list editor to enable this feature for lists.
Note: This feature is not supported in List v3. When this feature is enabled for a list, the list displays in List v2.

1. Navigate to the empty row at the bottom of the list.
2. Open the list editor for a field in the row and enter a value.
3. Save or cancel your changes.

**Edit multiple records in a list using the list editor**

You can edit multiple records at the same time using the list editor. If you want to update a single field on multiple records to have the same value, the list editor is the quickest method.

Role required: none

1. Select the records you want to edit by performing one of the following actions.
   - To select multiple consecutive fields, hold Shift and drag in the desired fields, or select a cell and then press Shift + Up Arrow or Shift + Down Arrow.
   - To select multiple non-consecutive fields, press Shift and click in one of the desired fields, then hold Shift + Ctrl (Shift + Command on Mac), and click in the desired fields.

2. Open the list editor by double-clicking (or clicking, depending on setup) in an empty area of the field.
   The number of selected rows that you are editing is indicated. If any rows cannot be edited due to security constraints, that is indicated.
Selected fields are highlighted in blue

3. Enter the appropriate values and click **Save**.

**Edit multiple records in a list using an editing form**

You can edit multiple records at the same time using an editing form. If you want to edit multiple fields or fields that do not appear in the list view, use an editing form.

Role required: list_updater

Depending on your ACL settings, some of these options might not be available even with the right role. For example, if the list is task.list and users try to select multiple incident records from that task list, the form uses the task form and not the incident form so ACLs on task are enforced instead. Since users would not have access to task specifically, the form would not show any fields.

1. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update selected records</td>
<td>1. Select the check box by each row you want to edit.</td>
</tr>
<tr>
<td></td>
<td>2. Perform the appropriate action for the list version:</td>
</tr>
<tr>
<td></td>
<td>• List v3: Open the list title menu and select Update Selected.</td>
</tr>
<tr>
<td></td>
<td>• List v2: Right-click any column header and select Update Selected.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Update all records in the list              | 1. Filter the list so it contains only the rows you want to edit.  
2. Perform the appropriate action for the list version:  
   - List v3: Open the list title menu and select Update All.  
   - List v2: Right-click any column header and select Update All. |

An editing form opens.

2. Enter appropriate values in any of the fields and click **Update** to save your changes in all selected records.

### Personal lists

Users can create personal lists to customize which columns appear and the order in which they appear. Personal lists modify a specific list view according to individual preferences.

Personal list customizations do not affect what other users see in their lists. Administrators can manage the personal lists function.

**Note:** In List v2, some general list preferences are available in the list personalization interface. The List v3 list personalization interface does not contain these preferences. Some of the preferences are located in the Lists section of the system settings. Others do not apply to List v3 or are not supported.

### Personalize a v2 list

In List v2, you can personalize a specific list view based on individual preferences.

1. Open the list.
2. Click the personalize list icon (⚙️) in the upper left corner.  
The Personalize List Columns window opens.
3. Use the slushbucket to select the columns and the desired order. Values in the first column appear as links. If the first column is not a reference field, the link opens the record from the list, as expected. If the first column is a reference field, the link opens the record from the referenced table. This behavior can be confusing. For this reason, avoid using a reference field as the first column.

4. Select display options.

**Note:** These options apply to all v2 lists, not just the view you are personalizing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display long text on more than one line</td>
<td>Select the <em>Wrap column text</em> check box. Clear the check box to display text on one line. In UI16, this option is also available in the Lists section of the system settings.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condense the vertical space between rows</td>
<td>Select the <strong>Compact rows</strong> check box. Clear the check box to use standard row spacing.</td>
</tr>
<tr>
<td>Highlight list rows as the cursor passes over them</td>
<td>Select the <strong>Active row highlighting</strong> check box. Clear the check box to restore the static, alternate row highlighting.</td>
</tr>
<tr>
<td>Use updated field status indicators available in UI16 and UI15</td>
<td>Select the <strong>Modern cell coloring</strong> check box. Clear the check box to use field status indicators available in UI11. In UI16, this option is also available in the Lists section of the system settings.</td>
</tr>
</tbody>
</table>

5. Select list editing options (requires you to configure the list editor).

**Note:** These options apply to all v2 lists, not just the view you are personalizing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow the list editor to open for the list</td>
<td>Select the <strong>Enable list edit</strong> check box. Clear the check box to prevent the list editor from opening for the list.</td>
</tr>
<tr>
<td>Open the list editor with a double-click</td>
<td>Select the <strong>Double click to edit</strong> check box. Clear the check box to open the list editor using a single click.</td>
</tr>
</tbody>
</table>

6. Click **OK**.

The list reloads to show the changes. If you personalized the columns, an indicator appears on the personalize list icon (⚙).

To reset a list to the default layout, click the personalize list icon and click the **Reset to column defaults** button.

**Personalize a v3 list**

In List v3, you can personalize a specific list view based on individual preferences.

Role required: none

1. Open the list.
2. Click the list title menu icon and select **Personalize List Columns**.
   The Personalize Columns window appears.
3. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add columns</td>
<td>In the <strong>Available</strong> section, select the check box by each column you want to add. Use the search field to find a specific column.</td>
</tr>
<tr>
<td>Remove columns</td>
<td>In the <strong>Available</strong> section, clear the check box by each column you want to remove. Alternatively, in the <strong>Selected</strong> section, point to a column and click the delete icon (<strong>X</strong>)</td>
</tr>
<tr>
<td>Rearrange columns</td>
<td>In the <strong>Selected</strong> section, drag columns in the desired order.</td>
</tr>
</tbody>
</table>
Values in the first column appear as links, which open the record from the list. If the first column is a reference field, the open reference value icon (🔗) appears by the value. Click the icon to open the record from the referenced table.

4. Click **Save**.
The list reloads to display the changes.

To reset a list to the default layout, open the list personalization interface and click the **Reset Columns** button.

---

**List v3 split mode**

In List v3, split mode lets users view a list and form side by side, in a split pane layout.

Split mode differs from the standard list mode, called grid mode. In grid mode, lists display records in a table view, with several columns. An administrator can activate **List v3**.

List v3 split mode is similar to the list and form view available in UI15. However, List v3 split mode consolidates information from multiple columns into a single row. List v3 split mode does not support multiple form tabs.

---

**Note:** Users with the personalize_control role can make split mode the default view for a list, by configuring the list control and setting the **Default view mode** field to **Split**.

When you open a record in split mode, **Display** type business rules are evaluated twice, once for each pane. This double evaluation might have an impact on performance. Consider this impact when creating business rules.

---

**List pane configuration**

In split mode, the title of the list card is either a default value or it is configured in **System Mobile UI > Table Titles**.
Important:

Table title records are used in the mobile application as well as in the list pane. You can change the title for any table or add a title record for a different table, however, the change affects the mobile user interface (UI).

For example, in split mode the default title for the Departments (cmn_department) table is the department Name. If you create a table title record to display the Description field as the Department list card title, the Departments list appears in the mobile application.

Other fields that appear in the list card are specified in the base system and cannot be modified.

Use List v3 split mode

In List v3, you can view lists and forms side by side in split mode.

Role required: none

In split mode, you can select a record from a compact view of the list, to open it in the adjacent form pane.

1. Open a v3 list.
2. In the list title bar, select Split in the list mode toggle.

Note: The list mode toggle is not available in grouped or related lists.

The list reloads in split mode.
3. Perform any of the following actions to filter the list.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Edit the filter conditions** | 1. Click the filter icon ( ) to open the filter condition builder in the right pane.  
2. Add, remove, or edit conditions as you would in the standard List v3 filter interface. For more information, see *Create a filter in List v3*.  
3. Load or save the filter, or add a sort order.  
4. Click Run.                                                                 |
| **View all breadcrumbs**     | 1. Click the filter icon ( ) to open the filter condition builder in the right pane.  
2. Add or remove conditions using the breadcrumbs.  
3. Right-click a breadcrumb to access the breadcrumb context menu. For more information about breadcrumb conditions and the breadcrumb context menu, see *Filters and breadcrumbs*. |
| **View the breadcrumb right-click options** | 1. Right-click the blue filter text in the left pane.  
2. Select any of the following options.  
   - Open new window: Opens the results list for the breadcrumb in a new tab or window.  
   - Copy URL: Copies the URL to the clipboard for the results list of the breadcrumb.  
   - Copy query: Copies the encoded query to the clipboard for the breadcrumb.  
4. Right-click a record in the list to access the following options.  
   - Copy URL  
   - Copy sys_id  
5. Click a record in the list to open it in the adjacent form pane. |

**Selecting fields on related tables using dot-walking**

Dot-walking provides access to fields on related tables from a form, list, or script.  
If the current table contains a reference to another table, any field on the referenced table can be accessed using dot-walking.

Dot-walking references a field by building a chain of field names separated by dots (periods). For instance, `incident.assigned_to.company` references the company of the user assigned to an incident. The recommended limit for chain length is three levels.
Dot-walking examples

Access fields on a related table from a form, list, or script by dot-walking. This topic includes examples of the different ways you can dot-walk.

List fields

You can dot-walk to related fields in a list, such as the field list in a filter. This example demonstrates how to filter the Incident (incident) table by the company of the caller who registered the incident.

When you open the list of fields that you want to filter, you see the list of available Incident table fields. The reference fields are followed by the related fields. For example, Caller is followed by Caller > User fields, which means that Caller is a reference field, and the related fields are user fields on the Caller record. If the related fields are not present in the list, you would select Show Related Fields at the bottom of the list.

When you select Show Related Fields, the menu reloads to display related fields.
When you select a related field, the menu reloads with the fields of the related table.
When you select **Company** under **Caller # User fields**, the field then becomes **Caller.Company**.

The following example shows where you are in the dot-walk. Each selected reference is stored at the top of the fields menu, and the number of dots preceding the field label indicate how many dots from the initial record the user has reached.
The example shows that the user is at **Incident.Caller.Company**. You can return to higher levels in the hierarchy by selecting fields located at the top of the menu. For instance, selecting **Incident fields** returns to the list of incident fields.

The related fields can be removed by selecting **Remove Related Fields** at the bottom of the list.
Condition builders

You can make a detailed query on a table by dot-walking in the condition builder. To dot-walk in a condition builder, first select Show Related Fields on the fields menu. This action allows you to add fields from related tables to your query.

The following GIF shows how you would dot-walk fields in a condition builder to find all Incident records assigned to one specific user, Beth Anglin. In the example, the user navigates to Incident > Open and then opens the condition builder. In the fields menu, the user first selects Show Related Fields and then opens the fields menu again to select Assigned to # User fields. The user opens the fields menu again to select Last name. The user builds the following condition: (Last name) (is) (Anglin). After the user selects Run, the Incident list displays only the records assigned to Beth Anglin.
Make your life easier, create a dashboard!

Did you know you can create a dashboard version of this homepage? Dashboards are like homepages for apps. Dashboards have a drag-and-drop canvas that lets you easily add, move, and resize widgets. You can then share dashboards with your team. Flexible sharing lets any user view and collaborate on dashboards with you!

Don't ask me again Remind me later

Add content PA Activity Usage

Top 10 Orchestration Activities
List collectors

When selecting a list of fields from a list collector (for example, when you are configuring a form), you can dot-walk to fields from other forms.

To see which fields are reference fields and can be dot-walked, look for green fields with a plus symbol.

Once a reference field is highlighted, the expand icon (.expand) appears above the add icon.
Selecting the expand icon opens the list of fields from the related list in the Available pane. The following example shows that the Assigned to fields were selected. The previous lists of fields appear at the top of the list.
Once the field is added to the **Selected** pane, it appears with its full dot-walked syntax. The following example, shows that **Assigned to.Active** has been selected.
Scripts

You can dot-walk within a script by invoking the dot-walk syntax. This functionality requires a knowledge of JavaScript.

For scripts that run on the server side, such as business rules, it is necessary to add `current`.

The following script, for example, is a scripted approval rule that requests an approval from the manager of the user who opened the ticket.

```javascript
try {
    current. opened_by. manager ; } catch (err) {} 
```

For scripts that run on the client side, such as client scripts, `current` is not necessary. For instance, the following Highlight VIP Caller script runs on the client side.

```javascript
function onChange (control, oldValue, newValue, isLoading) {
    //wait until there is a valid record in the field if (newValue) {
    //get the caller object so we can access fields var caller = g_form.
    getReference ( 'caller_id' ) ;
```
var callerLabel = document.getElementById('label.incident.caller_id'); var callerField = document.getElementById('sys_display.incident.caller_id')

//check for VIP status if (caller.vip == 'true') {
    //change the caller label to red background //style object is CSSStyleDeclaration, style names are not standard css names if (callerLabel)
        document.getElementById('label.incident.caller_id').style.backgroundColor = 'red';
    //change the caller's name field to red text if (callerField)
        document.getElementById('sys_display.incident.caller_id').style.color = 'red';
    } else { //not a VIP, remove temporary styles if (callerLabel)
        document.getElementById('label.incident.caller_id').style.backgroundColor = '';
        if (callerField)
            document.getElementById('sys_display.incident.caller_id').style.color = '';
    }
} }

Variables

Often, you can add variables into templates, notifications, or other forms where a value is being called from the form.

For example, ${assigned_to} is the variable for the Assigned to field.

As shown in the example, you can dot-walk to fields on the original record of any reference field. It is possible to dot-walk to any field on the assigned_to record, for example, ${assigned_to.manager}.

When you dot-walk, you can have a longer chain if you need it, as in this example: ${assigned_to.department.manager.mobile_phone}.

Sometimes, you can select this variable from a tree picker.

Tree pickers

The tree picker interface has an expandable, hierarchical view that you can use to look up the following items:

- Configuration Items (CIs) that are subordinate to another, higher-level CI.
- Members of a certain group. For example, you would use a tree picker to look up a user in the Service Desk group.
- Reference elements for any hierarchical table. A hierarchical table is any table that has a parent field pointing back at itself. The Group (sys_user_group) table, for example, would be considered a hierarchical table because certain groups are children of parent groups.

The following example shows how you would use a tree picker to assign an Incident record to a user in the Database group.

You would first navigate to any Incident record and then enter Database in the Assignment group field.
In this example, the Database group is a parent group with multiple child groups under it. When you select the search icon (🔍) next to the **Assigned to** field, a window displays reference fields in the Database group.

Reference fields have the expand icon (+) next to their name. Clicking the + expands a list of the fields on that referenced field. In this example, expanding the **Database Atlanta** or **Database San Diego** fields opens a list of user records within each child group.

You would select any one of the user records to add it as a value in the **Assigned to** field.
**Note:** You can configure the tree picker to pick up to 1,000 nodes when you configure the `glide.ui.group_hierarch.max_nodes` property. To set the property, modify the dictionary entry for the field, and add `tree_picker=true` to the Attributes field. If there are multiple attributes, use a comma to separate them without any spaces between.

### Use a slushbucket

Slushbuckets allow you to select multiple items from a list of available items and to remove items from a list of selected items.

Slushbuckets are used in many operations, such as personalizing lists, adding items to related lists, and Service Catalog list collector variables.

The slushbucket interface has two columns: the available items on the left and the selected items on the right.

- To add items to the selection, double-click an available item on the left or select an item and click the add icon (►). The new item is added at the bottom of the selected items column on the right.
- To remove items from the selection, double-click the item on the right, or select the item and click the remove icon (◄).
- To select multiple consecutive items, hold the Shift key and click the first and last item.
- To select multiple non-consecutive items, hold the Ctrl key (Command key on Mac) and click the desired items.

### Arrange slushbucket selections

Some slushbuckets allow users to customize the order of selections, such as when you are configuring a form or list.

Follow one of the two methods below to move an item.

- To move items one position, select the items and click the up or down icon.
- To move an item multiple positions, select consecutive items above or below the item then click the up or down icon. In this example, to move **Assigned to** to the top of the selections order, complete the following steps.
  a) Hold the Shift key and click **Short description** then **Number**.
  b) Click the down icon.
Find available slushbucket items

Some slushbuckets provide filter and search controls for available items, such as adding items to related lists.
Information fields for the highlighted available item appear beneath some slushbuckets. The information fields are the same as the reference lookup for a reference field on a form. To modify which fields appear, configure the reference lookup list.

- To filter available items, create conditions using the condition builder and click Run filter.
- To search available items, enter text in the Search field. The list of available items is filtered as you type.

**Set the number of slushbucket items visible in the available column**

You can modify the `glide.xmlhttp.excessive` property to change the number of items that appear in the Available column of the slushbucket.
Role required: admin

1. Add the property to the System Properties (sys_properties) table.
2. Change the Type to Integer.
3. Enter a number in the Value field. The default value is 100.

Warning: Selecting a number significantly higher than 100 can lead to performance issues on your instance as the data is loaded into the slushbucket.

4. Save the property.

Tree picker

The tree picker is a special reference lookup that you can add as an attribute to a form.

The tree picker is a special reference lookup for the following items.

- Configuration Items (CIs) for a field that depends on another CI field.
- Reference elements for any hierarchical table. A hierarchical table is any table that has a parent field pointing back at itself.
- Values for a user reference that depends on the group.

Add the tree picker attribute

A limit of 1000 has been placed on the number of nodes returned to the tree picker. This limit is configurable with the glide.ui.group_heirarchy.max_nodes property.

Role required: personalize_dictionary

1. Modify the dictionary entry for the field.
2. Add tree_picker=true to the Attributes field.
   If there are multiple attributes, use a comma to separate them without any spaces between.

   Attributes: tree_picker=true

Tree picker examples

The sections below include tree picker examples.

Simple dependent fields

It is also possible to add the tree-picker attribute on a reference field that depends on a reference field of a different type. For example, if Assigned to depends on Assignment group, it is possible to add the tree picker attribute on Assigned to. The result is a one-node tree for the group and its members.
Dependent fields

In this example, there are two CI reference fields, and one depends on the other. The dependent one has the `tree_picker` attribute:

For this example, the configuration item is Bond Trading. The tree picker for the **Dependent CI** field shows all downstream and upstream relationships for that CI. The small orange square icon above indicates an open task.
a relationship indicates that the CI, lawson, already has an open task against it. Pointing to the orange square displays a pop-up window with information about the open task.

**Note:** Dependencies for CIs are enforced only when the dictionary entry for the reference field has `tree_picker=true` in the Attributes field.

### Condition builder

A condition builder constructs a condition statement with a series of contextually generated fields. Condition builders are used in many operations, such as creating filters, administering surveys, and administering access control.

### Condition builder format

A condition consists of three parts:

- **Field:** a choice list based on the table and user access rights. The choice list can include fields on related tables by dot-walking.
- **Operator:** a choice list based on the field type. For example, in the Incident (incident) table, the greater than operator does not apply to the **Active** field but it does apply to the **Priority** field.
- **Value:** a text entry field or a choice list, depending on field type. For example, in the Incident (incident) table, the **Active** field offers a choice list with the values `true`, `false`, and `empty`, while the **Short Description** field offers a text entry field.

The condition builder in the list filter has a different appearance in List v2 and List v3. In UI16, condition builders in forms can be configured to look and work like the List v3 condition builder.

### Condition builder actions

You can add a dependent condition by clicking **AND** or **OR** next to the condition. You can add a top-level condition by clicking **AND** or **OR** on the condition builder toolbar above the conditions (List v2) or clicking **New Criteria** (List v3). You can remove a condition by clicking the delete icon (X) next to the condition (List v2). In List v3, you click the remove condition icon (#) next to the condition.
Filtering on empty fields

Most filter operations do not return empty fields in their result set. You can create a filter that displays records with an empty field value in addition to records that match the initial filter conditions.

For example, when viewing all records that are assigned to the Hardware group, to include records with an empty Assignment group field, complete the following steps.

1. Create the filter condition (Assignment group) (is not) (Hardware).
Note: This condition does not return those records where the Assignment group field is empty.

2. Click OR next to the original filter condition.
3. Create another filter condition of (Assignment group) (is empty).
4. Run the filter.

Values for date/time fields

When you filter on fields of type date/time, such as the Created field on any task record, several time-related options are available, such as Today, This week, Last 3 months, and so on.

For example, at 12:00 on June 1, a user in New York filters a list of incidents using the Created on Today condition. The resulting list shows all incidents created during the last six hours: between midnight (00:00:00) and the user’s current time, noon (12:00:00), on June 1. A filter for This week returns incidents created between the previous Monday at midnight to the current day and time.

A filter for Last 3 months returns incidents between midnight on the first of the month three full months ago and the current day and time. For example, if you choose the Last 3 months filter on April 15, the results show records created since January 1 up until April 15. A filter for Last 12 months returns records created from midnight on the first of the month 12 months ago and the current day and time.

A filter for Last week returns incidents from midnight on Sunday the week previous ending the following Sunday at midnight. It does not include up to the present day. For example, if you choose the Last week filter on Thursday August 17, the results show records created Sunday August 6 up until Sunday August 13.

For the at or before and at or after filters, use midnight as a start or end point. For example, if you filter a list of incidents created at or after (Yesterday), the resulting list shows all incidents created at midnight yesterday or later. If it is Thursday, August 7, and you filter a list of incidents created at or before (Last week), the resulting list shows all incidents created at and before midnight on Sunday August 3, which is the end of last week.

Operators and values available for date and time fields

You can filter date and time fields using the operators and values listed here.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td>Returns records after the specified time period.</td>
<td>A filter run (after) (Next Month) on April 18, 2018 will return records from June 1 and later.</td>
</tr>
<tr>
<td>at or after</td>
<td>Returns records during and after the specified time period.</td>
<td>A filter run (at or after) (Next Month) on April 18, 2018 will return records from May 1 and later.</td>
</tr>
<tr>
<td>at or before</td>
<td>Returns records during and before the specified time period.</td>
<td>A filter run (at or before) (Next Month) on April 18, 2018 will return records from May 31 and earlier.</td>
</tr>
<tr>
<td>before</td>
<td>Returns records before the specified time period.</td>
<td>A filter run (before) (Next Month) on April 18, 2018 will return records from before May 1.</td>
</tr>
<tr>
<td>Operator</td>
<td>Definition</td>
<td>Example</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>between</td>
<td>Returns records between to specified dates.</td>
<td>A filter run (between) April 18, 2018 (00:00:00) and April 19, 2018 (23:59:59) will return records on or between the two dates.</td>
</tr>
<tr>
<td>is anything</td>
<td>Returns all records, including records with empty values in the specified field.</td>
<td>A list of incident records filtered on (Created) (is anything) returns all incidents.</td>
</tr>
<tr>
<td>is different</td>
<td>Returns records within a different time frame from another field.</td>
<td>A list of incident records filtered on (Created) (is different) (year) from (Closed) returns records where the values in the (Created) and (Closed) field are in different years.</td>
</tr>
<tr>
<td>is empty</td>
<td>Returns records where the specified field has no value.</td>
<td>A list of incident records filtered on Closed (is empty) returns records where the Closed field has no value.</td>
</tr>
<tr>
<td>is less than</td>
<td>Returns records where a field is within specified time frame when compared to another field.</td>
<td>A list of incident records filtered on (Closed) (is less than) (2) (hours) (after) (Created) will return results where the (Closed) value is less than 2 hours after the (Created) value.</td>
</tr>
<tr>
<td>is more than</td>
<td>Returns records where a field is beyond the specified time frame when compared to another field.</td>
<td>A list of incident records filtered on (Closed) (is more than) (2) (hours) (after) (Created) will return results where the (Closed) value is more than 2 hours after the (Created) value.</td>
</tr>
<tr>
<td>is not empty</td>
<td>Returns records where the specified field has a value.</td>
<td>A list of incident records filtered on (Closed) (is not empty) returns results where the Closed field has a value.</td>
</tr>
<tr>
<td>is same</td>
<td>Returns records where the two fields share a specified time frame.</td>
<td>A list of incidents filtered on (Created) (is same) (hour) as (Closed) returns records where the record (Created) and (Closed) fields are within the same hour.</td>
</tr>
<tr>
<td>not on</td>
<td>Returns records that do not match the specified value.</td>
<td>A filter of (not on) (Today) returns records that do not match the current date.</td>
</tr>
<tr>
<td>on</td>
<td>Returns records on the specified value.</td>
<td>A filter run (on) (Today) on April 18, 2018 will return records from April 18.</td>
</tr>
<tr>
<td>relative</td>
<td>Returns records with a specified time frame before or after the current time.</td>
<td>A filter run on (Created) (relative) (before) (5) (minutes) (ago) run at 12:00:00 returns records from before 11:55:00 of the same date.</td>
</tr>
</tbody>
</table>
**Operator** | **Definition** | **Example**
---|---|---
trend | Returns records on, after and/or before a specified hour of the day, day of the week, week of the year, month, quarter, or year. | A filter of *(Created) (trend) (Monday)* returns records where the *(Created) date* falls on a Monday.

### Values available for date/time fields

<table>
<thead>
<tr>
<th>Value</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current hour/minute</td>
<td>Returns records matching the current hour or minute</td>
<td>A filter run <em>(on) (Current hour)</em> on April 18 (12:02:00), would return records from April 18 (12:00:00) to April 18 (12:59:59)</td>
</tr>
<tr>
<td>Last n minutes/hours/days/weeks/months/quarters/years</td>
<td>Returns records within the previous selected time period, starting with the beginning of that time frame.</td>
<td>A filter run <em>(on) (Last 3 months)</em> on April 18, would return records from January 1 up until April 15.</td>
</tr>
<tr>
<td>Next n weeks/months/quarters/years</td>
<td>Returns records within the next selected time period, including records with values up to the end of that time frame.</td>
<td>A filter run <em>(on) (Next year)</em> on April 18, 2018 will return any records with a date in 2019, including dates in 2019 after April 15.</td>
</tr>
<tr>
<td>One year ago</td>
<td>Returns records from the current time, one year ago to the end of the current month</td>
<td>A filter run <em>(on) (One year ago)</em> on April 18, 2018 (12:00:00) will return records from April 18, 2017 (12:00:00) to April 30 (23:59:59)</td>
</tr>
<tr>
<td>This week/month/quarter/year</td>
<td>Returns records with the current selected time period.</td>
<td>A filter run <em>(on) (This week)</em> on April 18, 2018 will return records from April 16 (00:00:00) to April 20 (23:59:59)</td>
</tr>
<tr>
<td>Today</td>
<td>Returns midnight of the current day and midnight of the next day</td>
<td>A filter run <em>(on) (Today)</em> on April 18, 2018 will return records from April 18 (00:00:00) to April 18 (23:59:59)</td>
</tr>
<tr>
<td>Tomorrow</td>
<td>Returns records between midnight (00:00:00) and the current time.</td>
<td>A filter run <em>(on) (Tomorrow)</em> on April 18, 2018 will return records from April 19 (00:00:00) to April 19 (23:59:59)</td>
</tr>
<tr>
<td>Yesterday</td>
<td>Returns records between midnight of the previous day and midnight of the current day.</td>
<td>A filter run <em>(on) (Yesterday)</em> on April 18, 2018 will return records from April 17 (00:00:00) to April 17 (23:59:59)</td>
</tr>
</tbody>
</table>

### Operators available for filters and queries

The system provides a set of operators for use with filters, condition builders, and encoded queries. The data type of a field determines what operators are available for it.
### Operators available for condition builders

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
</table>
| **AND**       | (Active) (is) True (AND) (Caller) (is not empty) | ^ | active=true^CallerISNOTEMPTY | All records that have both of the following:  
  - Active field is True  
  - Caller field has any value |
| **OR condition** | (Short description) (is empty) (OR) (Description) (is empty) | ^OR | short_descriptionISEMPTY^ORdescriptionISEMPTY | All records that have at least one of the following:  
  - Short description field has no value  
  - Description field has no value |
| **OR filter** | All these conditions must be met  
  (Short description) (is empty)  
  OR all these conditions must be met  
  (Description) (is not empty) | ^NQ | short_descriptionISEMPTY^NQdescriptionISNOTEMPTY | All records that have at least one of the following:  
  - Short description field has no value  
  - Description field has no value |

### Operators available for string fields

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>starts with</strong></td>
<td>(Short description) (starts with) (SAP)</td>
<td>STARTSWITH</td>
<td>short_descriptionSTARTSWITHSAP</td>
<td>All records in which the characters “SAP” appear at the beginning of the value for the Short description field.</td>
</tr>
<tr>
<td><strong>ends with</strong></td>
<td>(Short description) (ends with) (outage)</td>
<td>%</td>
<td>short_descriptionENDSWITH</td>
<td>All records in which the string “outage” appears at the end of the value for the Short description field.</td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------</td>
<td>----------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>contains</td>
<td>(Short description)</td>
<td>· *</td>
<td>short_descriptionLIKE</td>
<td>All records in which the characters &quot;SAP&quot; appear anywhere in the value for the Short description field.</td>
</tr>
<tr>
<td></td>
<td>(contains)(SAP)</td>
<td>· LIKE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not contain</td>
<td>(Short description)</td>
<td>· !*</td>
<td>short_descriptionNOTLIKE</td>
<td>All records in which the characters &quot;SAP&quot; do not appear anywhere in the value for the Short description field.</td>
</tr>
<tr>
<td></td>
<td>(does not contain)(SAP)</td>
<td>· NOTLIKE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is</td>
<td>(Short description)</td>
<td>=</td>
<td>short_description=</td>
<td>All records in which the Short description says nothing else but &quot;Network storage is unavailable.&quot;</td>
</tr>
<tr>
<td></td>
<td>(is)(Network storage unavailable)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>is not</td>
<td>(Short description)</td>
<td>!=</td>
<td>short_description!=</td>
<td>All records in which the value for the Short description field says anything but &quot;Network storage is unavailable.&quot;</td>
</tr>
<tr>
<td></td>
<td>(is not)(Network storage unavailable)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>is empty</td>
<td>(Short description)</td>
<td>IEMPTY</td>
<td>short_descriptionIEMPTY</td>
<td>All records in which there is no value in the Short description field.</td>
</tr>
<tr>
<td></td>
<td>(is empty)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>is not empty</td>
<td>(Short description)</td>
<td>ISNOTEMPTY</td>
<td>short_descriptionISNOTEMPTY</td>
<td>All records in which there is any value in the Short description field.</td>
</tr>
<tr>
<td></td>
<td>(is not empty)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>is anything</td>
<td>(Short description)</td>
<td>ANYTHING</td>
<td>short_descriptionANYTHING</td>
<td>All records in which the Short description field is one of the following:</td>
</tr>
<tr>
<td></td>
<td>(is anything)</td>
<td></td>
<td></td>
<td>· any value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>· empty</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>· NULL</td>
</tr>
<tr>
<td>is empty string</td>
<td>(Short description)</td>
<td>EMPTYSTRING</td>
<td>short_descriptionEMPTYSTRING</td>
<td>All records in which there is no value in the Short description field.</td>
</tr>
<tr>
<td></td>
<td>(is empty string)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| less than or is | (Short description) (less than or is) (s) | <= | short_description <= s | All records in which the string in the Short description field is one of the following:  
- the first letter is any letter between "a" and "s"  
- the exact value is "s" |
| greater than or is | (Short description) (greater than or is) (s) | >= | short_description >= s | All records in which the string in the Short description field is one of the following:  
- the first letter is any letter between "s" and "z"  
- the exact value is "s" |
| between | (Short description) (between) (q) and (t) | BETWEEN | short_description BETWEEN q @ t | All records in which the first letter in the Short description field is "q," "r," "s," or "t." |
| is same | (Short description) (is same) as (Description) | SAMEAS | short_description SAMEAS description | All records in which there exist matching values for the Short description and Description fields. |
| is different | (Short description) (is different) from (Description) | NSAMEAS | short_description NSAMEAS description | All records in which there exist differing values for the Short description and Description fields. |

**Operators available for reference fields**

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
<td>(Caller) (is) (Don Goodliffe)</td>
<td>=</td>
<td>caller_id=9ee1b&lt;13&gt;0&lt;1&gt;136&lt;1&gt;00&lt;1&gt;0&lt;1&gt;690&lt;1&gt;69&lt;1&gt;10&lt;1&gt;</td>
<td>All records in which the Caller is no one else but Don Goodliffe.</td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>is not</td>
<td>(Caller) is not(Don Goodliffe)</td>
<td>!=</td>
<td>caller_id!=9ee1b13dc612271</td>
<td>All records in which the Caller field is populated by any user record but Don Goodliffe.</td>
</tr>
<tr>
<td>is empty</td>
<td>(Caller) is empty</td>
<td>IEMPTY</td>
<td>caller_idIEMPTY</td>
<td>All records in which the Caller field has no value.</td>
</tr>
<tr>
<td>is not empty</td>
<td>(Caller) is not empty</td>
<td>ISNOTEMPTY</td>
<td>caller_idISNOTEMPTY</td>
<td>All records in which there is any value in the Caller field.</td>
</tr>
<tr>
<td>starts with</td>
<td>(Caller) starts with (Don)</td>
<td>STARTSWITH</td>
<td>caller_idSTARTSWITH</td>
<td>All records in which the name in the Caller field begins with “Don.”</td>
</tr>
<tr>
<td>ends with</td>
<td>(Caller) ends with (liffe)</td>
<td>%ENDSWITH</td>
<td>caller_idENDSWITHliffe</td>
<td>All records in which the name in the Caller field has the letters “liffe” at the end.</td>
</tr>
<tr>
<td>contains</td>
<td>(Caller) contains (on)</td>
<td>*LIKE</td>
<td>caller_idLIKEon</td>
<td>All records in which the characters “on” appear anywhere in the name for the Caller field.</td>
</tr>
<tr>
<td>does not contain</td>
<td>(Caller) does not contain(on)</td>
<td>!*NOTLIKE</td>
<td>caller_idNOTLIKEon</td>
<td>All records in which the characters “on” do not appear anywhere in the name for the Caller field.</td>
</tr>
<tr>
<td>is anything</td>
<td>(Caller) is anything</td>
<td>ANYTHING</td>
<td>caller_idANYTHING</td>
<td>All records in which the Caller field is one of the following:</td>
</tr>
<tr>
<td>is same</td>
<td>(Caller) is same as (Assigned to)</td>
<td>SAMEAS</td>
<td>caller_idSAMEASassigned_to</td>
<td>All records in which the same user record is referenced in the Caller and Assigned to fields.</td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>is different</td>
<td>(Caller) (is different) from (Assigned to)</td>
<td>NSAMEAS</td>
<td>caller_idNSAMEAS=</td>
<td>All records in which the user records in the Caller and Assigned to fields do no match.</td>
</tr>
<tr>
<td>is empty string</td>
<td>(Caller) (is empty string)</td>
<td>EMPTYSTRING</td>
<td>caller_idEMPTYSTRING=</td>
<td>All records in which the Caller field has no value.</td>
</tr>
<tr>
<td>is (dynamic)</td>
<td>(Caller) (is (dynamic))(Me)</td>
<td>DYNAMIC</td>
<td>caller_idDYNAMIC=</td>
<td>All records in which your user record populates the Caller field.</td>
</tr>
</tbody>
</table>

**Note:** Not all operators are available for all reference types. Depending on the reference you select, you may see a shorter list of operators.

Operators available for choice fields containing strings

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
<td>(Subcategory) (is) (Email)</td>
<td>=</td>
<td>subcategory=email=</td>
<td>All records in which the Subcategory is nothing else but Email.</td>
</tr>
<tr>
<td>is not</td>
<td>(Subcategory) (is not) (Email)</td>
<td>!=</td>
<td>subcategory!=email=</td>
<td>All records in which the Subcategory field is populated by any value except Email.</td>
</tr>
</tbody>
</table>
| is one of           | (Subcategory) (is one of) [DB2, MS SQL Server, Oracle] | IN                        | subcategoryIN[db2,sqlserver,oracle]= | All records in which the Subcategory field is populated by one of the following values:  
  - DB2  
  - MS SQL Server  
  - Oracle

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
</table>
| is not one of        | (Subcategory) (is not one of) (DB2, MS SQL Server, Oracle) | NOT IN                    | subcategory NOT IN db2,sql server,oracle | All records in which the **Subcategory** field is populated by anything except the following values:  
  · DB2  
  · MS SQL Server  
  · Oracle |
| contains             | (Subcategory) (contains) (Em)              | LIKE                      | subcategory LIKE Em            | All records in which the characters “Em” appear anywhere in the value for the **Subcategory** field. |
| starts with          | (Subcategory) (starts with) (Em)           | STARTSWITH                | subcategory STARTSWITH Em      | All records in which the characters “Em” appear at the beginning of the value for the **Subcategory** field. |
| ends with            | (Subcategory) (ends with) (il)             | %                         | subcategory ENDSWITH il        | All records in which the characters “il” appear at the end of the value for the **Subcategory** field. |
| does not contain     | (Subcategory) (does not contain) (Em)      | NOT LIKE                  | subcategory NOT LIKE Em        | All records in which the characters “Em” do not appear anywhere in the value for the **Subcategory** field. |
| is anything          | (Subcategory) (is anything)                | ANYTHING                  | subcategory ANYTHING           | All records in which the **Subcategory** field is one of the following:  
  · any value  
  · empty  
  · NULL |
<p>| is same              | (Subcategory) (is same) as (Category)      | SAMEAS                    | subcategory SAMEAS             | All records in which there exist matching values for the <strong>Subcategory</strong> and <strong>Category</strong> fields. |</p>
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is different</td>
<td>(Subcategory) (is different) from (Category)</td>
<td>NSAMEAS</td>
<td>subcategoryNSAMEAS</td>
<td>All records in which there exist differing values for the Subcategory and Category fields.</td>
</tr>
</tbody>
</table>

Operators available for choice fields containing integers

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
<td>(Impact)(is)(1 - High)</td>
<td>=</td>
<td>impact=1</td>
<td>All records in which the value in the Impact field is nothing else but 1 - High.</td>
</tr>
<tr>
<td>is not</td>
<td>(Impact)(is not)(1 - High)</td>
<td>!=</td>
<td>impact!=1</td>
<td>All records in which the value in the Impact field is anything but 1 - High.</td>
</tr>
</tbody>
</table>
| is one of         | (Impact)(is one of)(1 - High, 2 - Medium)              | IN                        | impactIN1,2   | All records in which the Impact field is populated by one of the following values:    
|                   |                                                        |                           |               | - 1 - High     |
|                   |                                                        |                           |               | - 2 - Medium   |
| is not one of     | (Impact)(is not one of)(1 - High, 2 - Medium)          | NOT IN                    | impactNOT IN1,2 | All records in which the Impact field is populated by anything except the following values:    
<p>|                   |                                                        |                           |               | - 1 - High     |
|                   |                                                        |                           |               | - 2 - Medium   |
| is empty          | (Impact)(is empty)                                     | EMPTY                     | impactISEMPTY | All records in which the Impact field has no value. |
| is not empty      | (Impact)(is not empty)                                 | NOTEMPTY                  | impactISNOTEMPTY | All records in which the Impact field has any value. |
| less than         | (Impact)(less than)(2 - Medium)                        | &lt;                         | impact&lt;2      | All records in which the Impact field has a value of 1 - High. |</p>
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>greater than</td>
<td>(Impact)(greater than)(2 - Medium)</td>
<td>&gt;</td>
<td>impact&gt;2</td>
<td>All records in which the <strong>Impact</strong> field has a value of 3 - Low</td>
</tr>
<tr>
<td>less than or is</td>
<td>(Impact)(less than or is)(2 - Medium)</td>
<td>&lt;=</td>
<td>impact&lt;=2</td>
<td>All records in which the <strong>Impact</strong> field has a value of 1 - High or 2 - Medium.</td>
</tr>
<tr>
<td>greater than or is</td>
<td>(Impact)(greater than or is)(2 - Medium)</td>
<td>&gt;=</td>
<td>impact&gt;=2</td>
<td>All records in which the <strong>Impact</strong> field has a value of 2 - Medium or 3 - Low.</td>
</tr>
</tbody>
</table>
| between                  | (Impact)(between)(1 - High) and (3 - Low)             | BETWEEN                    | impactBETWEEN1@2 | All records in which the **Impact** field has one of the following values:  
|                          |                                                        |                            |               | • 1 - High  
|                          |                                                        |                            |               | • 2 - Medium  
|                          |                                                        |                            |               | • 3 - Low   |
| is anything              | (Impact)(is anything)                                  | ANYTHING                   | impactANYTHING | All records in which the **Impact** field is one of the following:  
|                          |                                                        |                            |               | • any value  
|                          |                                                        |                            |               | • empty  
|                          |                                                        |                            |               | • NULL    |
| is same                  | (Impact)(is same) as (Urgency)                         | SAMEAS                     | impactSAMEASUrgency | All records in which there exist matching values for the **Impact** and **Urgency** fields. |
| is different             | (Impact)(is different) from (Urgency)                 | NSAMEAS                    | impactNSAMEASUrgency | All records in which there exist differing values for the **Impact** and **Urgency** fields. |

**Note:** The operators ‘less than or is’ and ‘greater than or is’ are not supported for integer fields in the condition builder. Use a scripted condition instead.
Operators available for date-time fields

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>on</td>
<td>(SLA due) (on) (Today)</td>
<td>ONToday</td>
<td>sla_dueONToday@jservices:gs.daysAgoStart(0)@javascript:gs.daysAgoEnd(0)</td>
<td>All records in which the value for the SLA due field matches the date for today.</td>
</tr>
<tr>
<td>not on</td>
<td>(SLA due) (not on) (Today)</td>
<td>NOTONToday</td>
<td>sla_dueNOTONToday@jservices:gs.daysAgoStart(0)@javascript:gs.daysAgoEnd(0)</td>
<td>All records in which the value for the SLA due field is any other date but today.</td>
</tr>
<tr>
<td>before</td>
<td>(SLA due) (before) (Today)</td>
<td>&lt;</td>
<td>sla_due&lt;javascript:gs.daysAgoStart(0)</td>
<td>All records in which the value for the SLA due field is any date previous to today.</td>
</tr>
</tbody>
</table>
| at or before   | (SLA due) (at or before) (Today) | <=                              | sla_due<=javascript:gs.daysAgoStart(0)@javascript:gs.daysAgoEnd(0)            | All records in which the value for the SLA due field is one of the following:  
                                                                                     - any date previous to today  
                                                                                     - today prospects                                                                 |
| after          | (SLA due) (after) (Today)        | >                               | sla_due>javascript:gs.daysAgoStart(0)                                       | All records in which the value for the SLA due field is any date after today.  |
| at or after    | (SLA due) (at or after) (Today)  | >=                              | sla_due>=javascript:gs.daysAgoStart(0)                                     | All records in which the value for the SLA due field is one of the following:  
                                                                                     - today  
                                                                                     - any date after today prospects                                                                 |
<p>| between        | (SLA due) (between) (Yesterday) and (Today) | BETWEEN                     | sla_dueBETWEENjavascript:gs.daysAgoStart(1)@javascript:gs.daysAgoEnd(0)   | All records in which the value for the SLA due field is either yesterday’s or today’s date. |
| trend (on or after) | (SLA due) (trend) (on or after) (Monday) | DATEPART                     | sla_dueDATEPARTMonday@jservices:gs.datePart(©dayofweek©,©monday©,©GE©)    | All records in which the date in the SLA due field is on any day of the week except a Sunday. |</p>
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>trend (on or before)</td>
<td>(SLA due) (trend) (on or before) (Monday)</td>
<td>DATEPART</td>
<td>sla_dueDATEPART</td>
<td>which the date in the SLA due field is on either a Sunday or a Monday.</td>
</tr>
<tr>
<td>trend (after)</td>
<td>(SLA due) (trend) (after) (Monday)</td>
<td>DATEPART</td>
<td>sla_dueDATEPART</td>
<td>which the date in the SLA due field is on any day of the week except a Sunday or a Monday.</td>
</tr>
<tr>
<td>trend (before)</td>
<td>(SLA due) (trend) (before) (Monday)</td>
<td>DATEPART</td>
<td>sla_dueDATEPART</td>
<td>which the date in the SLA due field is on a Sunday.</td>
</tr>
<tr>
<td>trend (on)</td>
<td>(SLA due) (trend) (on) (Monday)</td>
<td>DATEPART</td>
<td>sla_dueDATEPART</td>
<td>which the date in the SLA due field is on a Monday.</td>
</tr>
<tr>
<td>relative (on or after)</td>
<td>(SLA due) (relative) (on or after) (1) (Hours) (ago)</td>
<td>RELATIVEGE</td>
<td>sla_dueRELATIVEGE</td>
<td>which the time on the SLA due field is less than or equal to one hour before the time that you entered the query.</td>
</tr>
<tr>
<td>relative (on or before)</td>
<td>(SLA due) (relative) (on or before) (1) (Hours) (ago)</td>
<td>RELATIVELE</td>
<td>sla_dueRELATIVELE</td>
<td>which the time on the SLA due field is greater than or equal to one hour before the time that you entered the query.</td>
</tr>
<tr>
<td>relative (after)</td>
<td>(SLA due) (relative) (after) (1) (Hours) (ago)</td>
<td>RELATIVEGT</td>
<td>sla_dueRELATIVEGT</td>
<td>which the time on the SLA due field is no more than an hour before the time that you entered the query.</td>
</tr>
<tr>
<td>relative (before)</td>
<td>(SLA due) (relative) (before) (1) (Hours) (ago)</td>
<td>RELATIVELT</td>
<td>sla_dueRELATIVELT</td>
<td>which the time on the SLA due field is less than an hour before the time that you entered the query.</td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>relative (on)</td>
<td>(SLA due)(relative) (on)(1)(Hours) (ago)</td>
<td>RELATIVEEE</td>
<td>sla_dueRELATIVEEE</td>
<td>All records in which the time on the SLA due field is exactly one hour before the time that you entered the query.</td>
</tr>
<tr>
<td>is empty</td>
<td>(SLA due)(is empty)</td>
<td>IEMPTY</td>
<td>sla_dueIEMPTY</td>
<td>All records in which the SLA due field has no value.</td>
</tr>
<tr>
<td>is not empty</td>
<td>(SLA due)(is not empty)</td>
<td>ISNOTEMPTY</td>
<td>sla_dueISNOTEMPTY</td>
<td>All records in which the SLA due is populated by any value.</td>
</tr>
</tbody>
</table>
| is anything    | (SLA due)(is anything) | ANYTHING | sla_dueANYTHING | All records in which the SLA due field is one of the following:  
- any value  
- empty  
- NULL |
| is same        | (SLA due)(is same) as (Activity due) | SAMEAS | sla_dueSAMEASactivity_due@day | All records in which there are matching values for the SLA due and Activity due fields. |
| is different   | (SLA due)(is different) from (Activity due) | NSAMEAS | sla_dueNSAMEASactivity_due@day | All records in which there are differing values for the SLA due and Activity due fields. |
| is more than   | (SLA due)(is more than)(1)(Days) (before)(Activity due) | MORETHAN | sla_dueMORETHANactivity_due@day@before@1 | All records in which the date value for the SLA due field is two or more days previous to the date in the Activity due field. |
| is less than   | (SLA due)(is less than)(3)(Days) (before)(Activity due) | LESSTHAN | sla_dueLESSTHANactivity_due@day@before@3 | All records in which the date value for the SLA due field is no more than three days prior to the date in the Activity due field. |
### Operators available for numeric fields

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
<td>(Reassignment count) (is) (0)</td>
<td>=</td>
<td>reassignment_count = 0</td>
<td>All records in which the Reassignment count is nothing else but 0.</td>
</tr>
<tr>
<td>is not</td>
<td>(Reassignment count) (is not) (0)</td>
<td>!=</td>
<td>reassignment_count != 0</td>
<td>All records in which the value for the Reassignment count is any number but 0.</td>
</tr>
<tr>
<td>is empty</td>
<td>(Reassignment count) (is empty)</td>
<td>EMPTY</td>
<td>reassignment_count EMPTY</td>
<td>All records in which there is no value in the Reassignment count field.</td>
</tr>
<tr>
<td>is not empty</td>
<td>(Reassignment count) (is not empty)</td>
<td>NOTEMPTY</td>
<td>reassignment_count NOTEMPTY</td>
<td>All records in which there is any number in the Reassignment count field.</td>
</tr>
<tr>
<td>less than</td>
<td>(Reassignment count) (less than) (2)</td>
<td>&lt;</td>
<td>reassignment_count &lt; 2</td>
<td>All records in which the value in the Reassignment count field is any number less than (but not equal to) 2.</td>
</tr>
<tr>
<td>greater than</td>
<td>(Reassignment count) (greater than) (2)</td>
<td>&gt;</td>
<td>reassignment_count &gt; 2</td>
<td>All records in which the value in the Reassignment count field is any number greater than (but not equal to) 2.</td>
</tr>
</tbody>
</table>
| less than or is| (Reassignment count) (less than or is) (2) | <=                        | reassignment_count <= 2 | All records in which the value in the Reassignment count field is one of the following:  
  - a number less than 2  
  - 2 |
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
</table>
| greater than or is | $(\text{Reassignment count}) \geq (2)$ | $\geq$ | `reassignment_count >= 2` | All records in which the value in the `Reassignment count` field is one of the following:  
- $2$
- A number greater than $2$
| between | $(\text{Reassignment count}) \text{ BETWEEN } (1) \text{ and } (3)$ | `BETWEEN` | `reassignment_count BETWEEN 1@3` | All records in which the number in the `Reassignment count` field is either $1, 2, 3$.
| is anything | $(\text{Reassignment count}) \text{ ANYTHING}$ | `ANYTHING` | `reassignment_count ANYTHING` | All records in which the `Reassignment count` field is one of the following:  
- Any value
- Empty
- `NULL`
| is same | $(\text{Reassignment count}) \text{ SAMEAS } (\text{Reopen count})$ | `SAMEAS` | `reassignment_count SAMEAS reopen_count` | All records in which there are matching numbers for the `Reassignment count` and `Reopen count` fields.
| is different | $(\text{Reassignment count}) \text{ NSAMEAS } (\text{Reopen count})$ | `NSAMEAS` | `reassignment_count NSAMEAS reopen_count` | All records in which there are differing values between the `Reassignment count` and `Reopen count` fields.
| greater than field | $(\text{Reassignment count}) \text{ GT}_{\text{FIELD}} (\text{Reopen count})$ | `GT_FIELD` | `reassignment_count GT_FIELD reopen_count` | All records in which the number in the `Reassignment count` field is greater than (but not equal to) the number in the `Reopen count` field.
<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>less than field</td>
<td>(Reassignment count) [less than field](Reopen count)</td>
<td>LT FIELD</td>
<td>reassignment_count &lt; reopen_count</td>
<td>All records in which the number in the Reassignment count field is less than (but not equal to) the number in the Reopen count field.</td>
</tr>
<tr>
<td>greater than or is field</td>
<td>(Reassignment count) [greater than or is field](Reopen count)</td>
<td>GT OR_EQUALS FIELD</td>
<td>reassignment_count =&gt; reopen_count</td>
<td>All records in which the number in the Reassignment count field is one of the following:</td>
</tr>
<tr>
<td>less than or is field</td>
<td>(Reassignment count) [less than or is field](Reopen count)</td>
<td>LT OR_EQUALS FIELD</td>
<td>reassignment_count = reconnect</td>
<td>All records in which the number in the Reassignment count field is one of the following:</td>
</tr>
</tbody>
</table>

**Operators available for boolean fields**

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
<tbody>
<tr>
<td>is</td>
<td>(Active) [is] (true)</td>
<td>=</td>
<td>active=true</td>
<td>All records in which the Active field is True.</td>
</tr>
<tr>
<td>is not</td>
<td>(Active) [is not] (true)</td>
<td>!=</td>
<td>active!=true</td>
<td>All records in which the Active field is False, empty, or NULL.</td>
</tr>
<tr>
<td>Operator label</td>
<td>Example condition</td>
<td>Equivalent query operator</td>
<td>Example query</td>
<td>Example output</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>is empty</td>
<td>(Active) (is empty)</td>
<td>IEMPTY</td>
<td>activeIEMPTY</td>
<td>All records in which there is no value in the <strong>Active</strong> field.</td>
</tr>
<tr>
<td>is not empty</td>
<td>(Active) (is not empty)</td>
<td>ISNOTEMPTY</td>
<td>activeISNOTEMPTY</td>
<td>All records in which the <strong>Active</strong> field is either <strong>True</strong> or <strong>False</strong>.</td>
</tr>
</tbody>
</table>
| is anything   | (Active) (is anything) | ANYTHING                  | activeANYTHING | All records in which the **Active** field is one of the following:  
|               |                    |                           |               | - True  
|               |                    |                           |               | - False  
|               |                    |                           |               | - empty  
|               |                    |                           |               | - NULL   |
| is same       | (Active) (is same) as (Made SLA) | SAMEAS                  | activeSAMEASmade_sla | All records in which there are matching values for the **Active** and **Made SLA** fields. |
| is different  | (Active) (is different) from (Made SLA) | NSAMEAS                | activeNSAMEASmade_sla | All records in which there are differing values for the **Active** and **Made SLA** fields. |

Operators available for email notifications

<table>
<thead>
<tr>
<th>Operator label</th>
<th>Example condition</th>
<th>Equivalent query operator</th>
<th>Example query</th>
<th>Example output</th>
</tr>
</thead>
</table>
| changes       | (State) (changes) | VALCHANGES                | stateVALCHANGES | All records in which the **State** field is updated.  
|               |                   |                           |               | All records in which the **State** field is updated to another value after previously being **Awaiting User Info**. |
| changes from  | (State) (changes from) (Awaiting User Info) | CHANGESFROM | stateCHANGESFROM | All records in which the **State** field is updated to another value after previously being **Awaiting User Info**. |
| changes to    | (State) (changes to) (Awaiting User Info) | CHANGESTO | stateCHANGESTO | All records in which the **State** field is updated to **Awaiting User Info** after previously being any other value. |

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Activity streams in UI16 and UI15

An activity stream is a list of entries in records and conversations. Examples of activity streams include journal fields like comments and work notes that display in task records and Connect Chat conversations.

There are three types of activity streams.

List activity stream
Streams live activity information for all records on the current list. For more information, see Activity streams in list view. Click an item to open the record activity stream without opening the record.

Record activity stream
Appears in forms that are configured with the activity formatter. You can customize the activities to include.

When you follow a record to view it in the Connect Chat interface, the conversation contains the same information as the record activity stream. Comments entered in the Connect Chat window update the record activity stream.

Visual Task Boards
Streams live activity information for all task cards in the current task board. Click an item in the activity stream to open the task card and view the activity stream of the record.

@ Mentions
Get someone’s attention on a record by mentioning them with the @ character in an activity stream.

Note: Emails sent for @Mention run against live_notification table and are not added to the journal field of the parent table.

Any user can use activity stream mentions in the following places:

- On a form, in the activity formatter (UI16 only).
- In a list, in the activity stream for a specific record.
- On a Visual Task Board card, in the card details.
- In a Connect record conversation.

To mention someone, enter the @ character in a supported activity stream. Next, select a user from the suggestion list, which allows you to select any user in the instance. You can see which users have access to the record and, if presence is enabled, who is online. Enter any other text and post to the activity stream.
By default, you receive an email notification when someone mentions you. You can disable this behavior by unsubscribing from the Activity Stream @Mention Email notification on your notification preference page.

If Connect is enabled, you can receive additional notifications, depending on whether you follow the record in Connect. When someone mentions you in a record you do not follow in Connect, you receive whichever Connect notifications you enabled globally, as well as the Activity Stream @Mention Email notification. If you do follow the record in Connect, you only receive notifications according to your notification preferences for the record conversation. In this case, you do not receive the Activity Stream @Mention Email notification.

**Note:** The system creates a record on the Notification (live_notification) table each time a user is mentioned. The record stores the information required to generate notifications.
Installed components for UI plugins

The following components are added with the user interface plugins.

Tables

User interface tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks (sys_ui_bookmark)</td>
<td>Stores user bookmarks and preferences. To access, navigate to System Definition &gt; Bookmarks.</td>
</tr>
</tbody>
</table>

Properties

User interface properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.allow_ie_compatibility_mode</td>
<td>Often, Internet Explorer is configured to use compatibility mode when viewing ServiceNow. However, UI15 does not display when compatibility mode is turned on. When this property is set to false, the system does not allow use of compatibility mode on UI15 pages. The default value for this property is false.</td>
</tr>
<tr>
<td>glide.ui.doctype</td>
<td>Enables or disables the UI15 interface. The default value for this property is true. After enabling or disabling this property, the administrator must log out and log back in to effect the change in the instance. When users log out and log back in, they see the change in their individual user sessions.</td>
</tr>
<tr>
<td>glide.ui.doctype.ie_version</td>
<td>Sets the minimum version of Internet Explorer required to use UI15. The default value for this property is 9. It is recommended that you do not change this value.</td>
</tr>
</tbody>
</table>

User preferences

User interface user preferences

<table>
<thead>
<tr>
<th>User Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.navpage_state</td>
<td>Do not edit this preference; system record of a user's UI11 configuration.</td>
</tr>
<tr>
<td>ng.navigator_preference</td>
<td>Stores a user's selected application navigator favorites in UI15.</td>
</tr>
</tbody>
</table>
User Preference | Description
--- | ---
glide.ui.field_style_circles | Shows field status indicators on lists as circles instead of cell backgrounds. The system administrator can set this preference for new logins. Users can make this change by navigating to a list, clicking the personalize list icon (⊙), and selecting the **Modern cell coloring** check box.

### URL schema

Users can navigate to a record or module directly by using a URL. This topic explains the URL schema by which the system renders pages.

The basic schema for a system URL is:

```
```

The URL schema consists of the following elements.

- **base URL**: Unique, secure web address for each instance. The default format is: https://<instancename>.service-now.com.
  
  To display a custom base URL in email notifications, you can set the `glide.email.override.url` property. For more information, see [Additional email properties](#).

- **nav_to.do?uri=** (optional): Loads the page in the standard interface, with the banner frame on top and the application navigator on the left.

- **<page name>.do?** Where the page name is the form, list, UI page, or other page to open. To view a list, use `<table name>_list.do`.

- **sys_id=<sys_id>** (optional): Where `<sys_id>` is the sys_id of the record to open in form view. To create a new record, specify a `sys_id` of -1.

- **<page parameters>** (optional): May specify a query, view, redirection page, and more. The following are some of the sample parameters.
  
  - **sysparm_view=ess**: Specifies a view (ess).
  - **sysparm_query=number=INC00040**: Specifies a query (number is INC00040).
  - **sysparm_query=priority=2^active=true**: Specifies a complex query with two terms (priority is 2 and active is true).
  - **sysparm_query=priority=2^active=true^EQ^GROUPBYcategory**: Groups query results (by category).
  - **sysparm_order=number**: Specifies the field by which to sort (number).
  - **sysparm_order_direction=desc**: Specifies a sort order (descending).
  - **sysparm_force_row_count=5**: Limits the maximum number of results (five records).
  - **sysparm_result_view=viewname**: Specifies the view for search results.

  - **CSV**: Specifies a file format, can be CSV, XML, PDF, or UNL (Unload).
  - **&**: Separates page parameters.
  - **^ (carat)**: Builds multiple term queries or specifies multiple field values.

### Forms vs. lists (sysparm_query)

The **sysparm_query** page parameter behaves differently for a list versus a form.
- List: returns records that match the query conditions.
- Form (with sys_id=-1 specified): applies the values to the new record.

**Note:** If you are using the default table templates where the template name matches the table name, such as change_request or incident, using sysparm_query for that form does not work.

---

**Enable tiny URL support**

The default URLs by which the system renders pages may exceed the character limit of Microsoft Internet Explorer, resulting in an error message. To prevent this error, you can enable tiny URL support, which generates shortened internal URLs.

**Role required:** admin

The Tiny URL Support plugin is activated automatically but is not enabled. Activate this plugin if Microsoft Internet Explorer displays failure to open page errors during routine operations in the Now Platform.

**Note:** The system does not convert all URLs to tiny URLs. Only some URLs the system generates as redirects are converted. For example, a URL the browser generates when a user opens a record is not converted to a tiny URL.

1. Navigate to **System Properties > System**.
2. Select the **Use tiny URLs when a redirect URL becomes too large**. This ensures that URLs that are too large for IE (greater than 2083) are not used. Instead, they are converted to a tiny URL to work around the IE issue. (glide.use_tiny_urls property).
3. Optional: Update the value in the **Minimum length of a redirect URL that is turned into a tiny URL (default=1024)** (glide.tiny_url_min_length property), if desired.
4. Click **Save**.

---

**Examples of navigating by URL**

A list of example URLs that demonstrate ways to open pages in the ServiceNow application.

**Open a form with preset values**

**Schema:** https://<baseURL>/nav_to.do?uri=<table name>.do?
sys_id=-1%26sysparm_query=<field=value>

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens a new Incident form in the standard interface with a priority of 1 and an incident state of Awaiting Problem.</td>
<td>https://&lt;instance name&gt;.service-now.com/nav_to.do?uri=incident.do?sys_id=-1%26sysparm_query=priority=1^incident_state=3</td>
</tr>
<tr>
<td>You can also use JavaScript to access GlideSystem methods. The following example creates the same type of incident as above, and also populates the caller ID with the current user ID.</td>
<td>https://&lt;instance name&gt;.service-now.com/nav_to.do?uri=incident.do?sys_id=-1%26sysparm_query=priority=1^incident_state=3^caller_id=javascript:gs.getUserID()</td>
</tr>
</tbody>
</table>
Open an existing record with preset values

Schema: https://<baseURL>/nav_to.do?uri=<table name>_do?sys_id=<sys_id>

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the incident record with the sys_id 966c9a414f5593001f6eac118110c75c</td>
<td>https://&lt;instance name&gt;.service-now.com/incident.do?sys_id=966c9a414f5593001f6eac118110c75c</td>
</tr>
<tr>
<td>Opens the incident record with the number INC0010001</td>
<td><a href="https://demonightlyus.service-now.com/incident.do?sysparm_query=number=INC0010001">https://demonightlyus.service-now.com/incident.do?sysparm_query=number=INC0010001</a></td>
</tr>
</tbody>
</table>

View a list of incidents

Schemas for the following examples:
- https://<baseURL>/nav_to.do?uri=<table name>_list.do
- https://<baseURL>/<table name>_list.do

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens a list of all incidents with (example 1) the navigation frame.</td>
<td>https://&lt;instance name&gt;.service-now.com/nav_to.do?uri=incident_list.do</td>
</tr>
<tr>
<td>Opens a list of all incidents without the navigation frame.</td>
<td>https://&lt;instance name&gt;.service-now.com/incident_list.do</td>
</tr>
</tbody>
</table>

View a list of attachments

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the Attachments table in list view.</td>
<td>https://&lt;instance name&gt;.service-now.com/sys_attachment_list.do</td>
</tr>
</tbody>
</table>

View a filtered list

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do?
sysparm_query=<field=value>

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Returns a list of active incidents with high escalation in the standard interface.</td>
<td>https://&lt;instance name&gt;.service-now.com/nav_to.do?uri=incident_list.do?sysparm_query=active=true^escalation=2</td>
</tr>
</tbody>
</table>
Return a file

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do?
sysparm_<sysparmTypeOrField=value>%26CSV

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| Returns a comma-separated value file of records in the Incident table that meet the query conditions. | https://<instance name>.service-now.com/nav_to.do?
uri=incident_list.do?
sysparm_query=active=false%26CSV |

User presence

User presence is a UI16 feature that lets you see who is online when you are working in an instance.

Your avatar appears in the form header next to your name, and in multiple other places such as in activity streams, Visual Task Boards, live feeds, and Connect conversations. A dot on the avatar of the user represents online status.

- Green dot if the user is logged in.
- No dot if the user is not logged in.
- Orange dot if the user recently logged out.

Users can add an avatar image to their live feed profile. If no image is uploaded to the live feed profile, the avatar is the user’s initials.

**Note:** Live Feed does not use images uploaded to User (sys_user) records.

When you are viewing a record in a form, such as an incident, you can see if other users are viewing the same record.

User presence in a form

If multiple users are viewing the record, the avatar is represented by the number of users. Point your cursor to the number to see the names and avatars of the users.
When you are in a Connect conversation or entering comments in an activity stream, you can see information about the activity of the other participant, for example if they are viewing or typing.

![System Administrator is typing ...]

User presence in a conversation

An administrator can disable user presence globally.

**Disable user presence**

You can disable user presence globally by enabling a system property.

Role required: admin

Enabling the property turns off all user presence features.

1. Navigate to `sys_properties.list`.
2. Locate the property named `glide.ui.presence.disabled`.
3. Set the **Value** to `true`. 
Disable live form features

User presence includes several new live form features. You can show or hide these features using the glide.ui16.live_forms.enabled property.

Role required: admin

The glide.ui16.live_forms.enabled property is included automatically with UI16 as part of the com.glide.ui.form_presence plugin. It controls the following form features:

- Live form updates
- Form presence
- Activity formatter appearance
- Attachments displaying in the activity stream

1. Enter sys_properties.list in the Navigation filter.
2. In the system properties list, search for the glide.ui16.live_forms.enabled property.
3. In the Value field, type false.

Tags

Tags are text labels that you can associate with items like records and pages. Tags enable you to group and organize the items. Tags can be visible to any user (global), visible only to specific groups or users (shared), or visible to a single user (private).

Tags are stored in the Tag (label) table. To view tags in a list, navigate to System Definition > Tags or Self-Service > My Tags.

Tag sharing levels

The tag sharing level enables other users to use the tag. The Viewable by property setting for a tag controls the sharing level.

<table>
<thead>
<tr>
<th>Sharing level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Me</td>
<td>Private tag, visible only to the owner.</td>
</tr>
<tr>
<td>Groups and Users</td>
<td>Shared tag, visible to the owner and specific groups or users.</td>
</tr>
<tr>
<td>Everyone</td>
<td>Global tag, visible to everyone. This option is available to users with the admin or tags_admin role.</td>
</tr>
</tbody>
</table>

Tag name conflicts

Conflicts can occur if multiple tags have the same name.

- If a private tag and a shared or global tag have the same name, the system appends (private) to the name of the private tag. For example, Sample tag (private).
- There cannot be multiple shared or global tags with the same name. If a user attempts to create a shared or global tag with a name that is already in use, an error message appears and the system prevents the tag from being saved.
Administering tags

If you have an administrator role, you can configure and manage all tags, even tags created by other users. You can also configure notifications, auto-assignment, and Zing indexing for tags. You must have the tags_admin role for these administrative tasks.

Create a tag from the Tags list

You can create a tag directly from the Tags list.

Role required: tags_admin

1. Navigate to System Definition > Tags or Self-Service > My Tags.
2. Click New.
3. Enter a name for the tag in the Name field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Specifies the owner of the tag. Users are allowed to change the ownership of the tag to someone else.</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies the type of tag.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Standard</strong>: is controlled by users who have access to the tag. These users can add or remove records from the tag.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Most Active</strong>: displays the most frequently accessed modules and is automatically maintained by the system. There is no maximum duration a module can remain as most active.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Most Recent</strong>: displays the most recently accessed modules and is automatically maintained by the system.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Most Active Record</strong>: displays the most frequently viewed records and is automatically maintained by the system. There is no maximum duration a record can remain as most active.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Most Recent Record</strong>: displays the most recently viewed records and is automatically maintained by the system. Only tags of the <strong>Standard</strong> or <strong>Most Recent Record</strong> types appear on the Tagged Documents page. You can view other types of tags by adding them to a homepage. For more information, see Add a tag to a homepage.</td>
</tr>
<tr>
<td>Viewable by</td>
<td>Specifies the sharing level. By default tags are visible only to the user (Me), but you can share tags with Groups and Users. Users with the tags_admin role are the only users who can create global tags shared with Everyone.</td>
</tr>
<tr>
<td>Active</td>
<td>Specifies whether the tag is enabled or disabled.</td>
</tr>
</tbody>
</table>
Edit tags from the Tags module

From the Tags module, you can edit all tags.
Role required: tags_admin

**Note:** Tag names are case-insensitive and must not include punctuation.

1. Navigate to **System Definition > Tags**.
2. Open a tag.
3. Make the necessary changes.
4. Click **Update**.

Configure tags to assign automatically

Configure the system to automatically assign a tag to records that match conditions defined in the tag record.

Role required: tags_admin, however for users with the tags_admin role to be able to create conditions for labels, you need to create the following ACLs. Creating ACLs requires the security_admin elevated role. Include tags_admin as a required role for each ACL. For more information on creating an ACL, see [Create an ACL rule](#).

<table>
<thead>
<tr>
<th>Name</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>label_table</td>
<td>read</td>
</tr>
<tr>
<td>label_table</td>
<td>write</td>
</tr>
<tr>
<td>label_table</td>
<td>create</td>
</tr>
<tr>
<td>label_auto</td>
<td>read</td>
</tr>
<tr>
<td>label_auto</td>
<td>write</td>
</tr>
<tr>
<td>label_auto</td>
<td>create</td>
</tr>
<tr>
<td>(Optional) label_table</td>
<td>delete</td>
</tr>
<tr>
<td>(Optional) label_auto</td>
<td>delete</td>
</tr>
</tbody>
</table>

Use automatically assigned tags to group high urgency incidents, overdue incidents, canceled changes, or any other set of records. The system automatically assigns the tag to records that match the criteria and removes the tag from records that no longer match the criteria.

1. Navigate to **System Definition > Tags**.
2. Open the tag that you want to assign automatically.
3. Configure the form to add the **Conditions for Labels** embedded list.
4. Create a row in the **Conditions for Labels** list.
5. Click the reference icon in the **Table** column.
   The Label Table list opens in a pop-up window.
6. Click **New**.
7. Enter a **Name**, select a **Table**, and add conditions for the automatic assignment of the tag.
8. Click **Submit**.
9. Click the check mark icon to save the new row.
10. Click **Update**.
Configure notifications for tagged records

You can enable the system to send a notification when a record with a certain tag is updated.

Role required: tags_admin

1. Navigate to System Definition > Tags.
2. Open a tag.
3. In the Label Entries related list, open the record for which you want notifications.
4. Select the Notify onchange check box to be notified any time the record is modified.
5. Use the Notify when condition builder to specify the conditions that must be true to trigger the notification.
6. Select a business rule in the Notify script field.
7. Save the record.

Configure Zing tag indexing for text search

Zing text indexing is available for tags on records.

Role required: admin

No tags are indexed by default. You can enable text indexing of tags on a table-by-table basis. Private tags are never indexed.

1. Navigate to the dictionary entry for the table you want to turn on indexing for.
2. In the Attribute related list, click New.
3. Click the reference icon to see available attributes.
4. Select the Text Index Tags attribute (text_index_tags).
5. For the attribute value, enter one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>everyone_only</td>
<td>Only tags shared with everyone are indexed.</td>
</tr>
<tr>
<td>all_shared</td>
<td>All shared tags (Everyone, Groups and Users) are indexed.</td>
</tr>
</tbody>
</table>

6. Click Submit.
7. Under Related Links, click Generate Text Index to reindex the table.

After you turn on text indexing for tags on records, records are reindexed when any of the following actions occurs.

- When you add or remove tags.
- When you modify a tag, as long as fewer than 100 records are affected. If there are more records, you must manually reindex.
- When you manually reindex an entire table (required after initial tag indexing setup).

Assigning tags

You can assign tags to records from the form or list view. You can also add tags to a homepage.

The list view provides multiple ways of assigning tags. You can assign tags with inline field editing, the action menu, the context menu, or the edit tags icon.

Note: Tag names are case-insensitive and must not include punctuation.
Add a tag to a homepage

You can add a tag to a homepage to view records to which the tag has recently been assigned.

Role required: none

You might want to do this task for tags of a type other than Standard or Most Recent Record, as they do not appear on the Tagged Documents page.

1. Open a homepage to which you have permission to add content.
2. Click the add content icon (+).
3. Select Labels in the left column of the Add content window.
4. Select the tag you want to show on the homepage.
5. Click the appropriate Add here button.
6. Close the Add content window.

Assign a tag from the list view using inline field editing

You can assign one or more tags to a record directly from the list view.

Role required: none

1. Navigate to a list.
2. Personalize the list to display the Tags column.
3. In List v2, complete the following steps.
   a) Click in the Add Tag field.
   b) To assign an existing tag, begin typing the tag name, select the tag from the choice list, and press the Enter key.
   c) To create a new tag, enter a new tag name and press the Enter key.
4. In List v3, complete the following steps.
   a) Double-click in the Tag field.
      The Edit Tags dialog opens.
   b) To assign an existing tag, select one of the recent tags or click the lookup icon and select the tag.
   c) To create a new tag, enter a new tag name and press the Enter key.
   d) Click X to close the dialog.

The tag is added to the record.

Assign a tag from a list using the action menu

You can assign one or more tags to a record using the action menu in a list.

Role required: none

1. Navigate to a list.
2. Select the check box beside one or more records.
3. Click Actions on selected rows and complete the appropriate steps for the list version.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **List v2**  | 1. Scroll to the Assign tag listing.  
               2. To assign an existing tag, select the tag listed.  
               3. To create a new tag, select New, enter the tag name, select the sharing level, and then click Save. |

**List v3**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select Assign a tag to open the Edit Tags dialog.</td>
</tr>
<tr>
<td>2. To assign an existing tag, select one of the recent tags or click the lookup icon and select the tag.</td>
</tr>
<tr>
<td>3. To create a new tag, enter a new tag name and press the Enter key.</td>
</tr>
<tr>
<td>4. Click x to close the dialog.</td>
</tr>
</tbody>
</table>

**Note:** In List v3, the sharing level defaults to Me. To change the sharing level, edit the tag from the form view or edit the tag record directly.

The tag is added to the record.

**Assign a tag from the list context menu**

You can assign one or more tags from the list context menu.

Role required: none

1. Navigate to a list.  
2. Right-click a record.  
3. To assign an existing tag, complete the appropriate steps for the list version.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List v2</strong></td>
<td>Select Assign Tag &gt; (Tag Name).</td>
</tr>
</tbody>
</table>
| **List v3**  | 1. Select Edit Tags and select one of the recent tags or click the lookup icon and select the tag.  
               2. Click x to close the dialog.         |

4. To create a new tag, complete the appropriate steps for the list version.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **List v2**  | 1. Select Assign Tag > New Tag.  
               2. Enter a new tag name and select the appropriate sharing level.  
               3. Click Save.                                                             |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| List v3 | 1. Enter a new tag name and press the Enter key.  
          2. Click x to close the dialog. |

**Note:** In List v3, the sharing level defaults to Me. To change the sharing level, edit the tag from the form view or edit the tag record directly.

### Assign a tag using the edit tags icon

You can assign one or more tags to a record using the edit tags icon in the form header.

**Role required:** none

1. Navigate to a form.
2. Perform the appropriate action for your version of the UI.

<table>
<thead>
<tr>
<th>UI version</th>
<th>Action</th>
</tr>
</thead>
</table>
| UI16       | 1. Click the more options icon (○○○) in the form header.  
            2. Select Add Tag. |
| UI15       | Click the edit tags icon (○○○). |
| 3. Click in the Add Tag field.  
4. Perform one of the following actions. |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign an existing tag</td>
<td>Begin typing the tag name and select the tag.</td>
</tr>
<tr>
<td>Create a new tag</td>
<td>Enter a new tag name and press the Enter key.</td>
</tr>
</tbody>
</table>

The tag is added to the record.

### Editing tags

You can edit tags that you created from the list and form views, the My Tags module, and the Tagged Documents page. You can also merge tags from the My Tags module.

**Note:** Tag names are case-insensitive and must not include punctuation.

### Edit tags from the list view

In the list view, you can edit tags that you created.

**Role required:** none

1. Navigate to a list that contains records you have previously tagged.
2. Click the edit tag audience icon (○○○) beside the tag name.
The Tag Details dialog box opens.
3. Edit the Name field as necessary.
4. Select an option for the Viewable by field to set the sharing level.
5. Click Save.
   All records associated with the tag are updated to reflect the change.

**Edit tags from the form view**

From the form view, you can edit tags that you created.
Role required: none
1. Navigate to a record you have tagged.
2. Perform the appropriate action for your version of the UI.

| UI16 | 1. Click the more options icon (•••) in the form header.  
|      | 2. Click the edit tag audience icon ( utilisateur ) beside the tag name. |
|      | 1. Click the edit tags icon (1).  
|      | 2. Click the edit tag audience icon ( utilisateur ) beside the tag name. |

The Tag Details dialog box opens.
3. Edit the Name field as necessary.
4. Edit the Viewable by field to set the sharing level.
5. Click Save.
   All records associated with the tag are updated to reflect the change.

**Edit tags from the My Tags module**

From the My Tags module, you can edit tags you created.

---
**Note:** Tag names are case-insensitive and must not include punctuation.

1. Navigate to Self-Service > My Tags.
2. Open a tag.
3. Make the necessary changes.
4. Click Update.
   All records associated with the tag are updated to reflect the change.

**Edit tags from the Tagged Documents page**

You can edit tags from the Tagged Documents page.
Role required: none
1. Navigate to Self-Service > My Tagged Documents.
Alternatively, in UI15 you can click **Tagged Documents** in the Edge.

2. Click **Edit Tags**.
   A list of tags you have created appears.

3. Open a tag.
4. Make the necessary changes.
5. Click **Update**.
   All records associated with the tag are updated to reflect the change.

**Merge tags**

You can merge one or more tags with another tag. For example, when you merge Tag A with Tag B, Tag A is deleted and all associated records are reassigned Tag B.

Role required: A user with the admin or tags_admin role can merge any tag into any other tag.

All other users can merge tags they created into tags that are visible to them.

1. Navigate to **Self-Service > My Tags**.
2. Select the check box for each tag you want to merge with another tag.
3. Select **Actions on selected rows > Merge Tags**.
4. Enter the tag to merge other tags with.
5. Click **OK**.

**Using tags**

Use tags to filter records and view tagged documents. Remove a tag when it is no longer useful.

**Filter records by tag**

You can filter records on a table by tags you have access to.

Role required: none

Filter records by tag in any of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter from the form view</td>
<td>Perform the appropriate action for your version of the UI.</td>
</tr>
<tr>
<td></td>
<td>• UI16: Click the more options icon ( ), and then click the tag in the menu that opens. A new tab or window opens and displays a list of records that contain the tag.</td>
</tr>
<tr>
<td></td>
<td>• UI15: Click the edit tags icon ( ), and then click the tag.</td>
</tr>
<tr>
<td>Filter from the list view using the Tags column</td>
<td>With the Tags column visible, click the tag name. Clicking two or more tags filters the tags together with the AND operator and shows records containing all the selected tags. This functionality is not available in List v3.</td>
</tr>
<tr>
<td>Filter from the list view using the list filter</td>
<td>Click the show/hide filter icon ( ), select Tags from the field choice list and enter the tag name.</td>
</tr>
</tbody>
</table>
View tagged documents

The Tagged Documents page displays recently viewed documents or user-tagged documents in the content frame.

Role required: none

An administrator can configure the fields that appear on the tagged document cards by configuring the mobile view of the task, for example, the mobile view of the Incident form. If there is not a mobile view available for the page, the record reverts to the default view. For more information, see Create and delete views.

1. Navigate to Self-Service > My Tagged Documents. Alternatively, in UI15 you can click Tagged Documents in the Edge. The sidebar displays all tags that you have access to. A preview area displays tagged documents.

2. Optional: Click Show Global Tags to display global tags.

3. Perform one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display most recently viewed documents</td>
<td>Click Most Recent in the sidebar.</td>
</tr>
<tr>
<td>Display documents associated with a tag</td>
<td>Click the tag name in the sidebar.</td>
</tr>
<tr>
<td>Remove a tag from a record</td>
<td>Click the x in the corner of the document preview.</td>
</tr>
<tr>
<td>Open the form for a tagged document</td>
<td>Click the title of the document preview.</td>
</tr>
</tbody>
</table>

Remove a tag from a record

There are many ways to remove a tag from a record.
Role required: none

Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove a tag from a record in the list view using the Tags column</td>
<td>Perform the appropriate action for your list version.</td>
</tr>
<tr>
<td></td>
<td>• List v2: Ensure that the Tags column is visible and click the remove tag icon (x) beside the tag name.</td>
</tr>
<tr>
<td></td>
<td>• List v3: Double-click the tag in the column to open the Edit Tags dialog. Click the remove tag icon (x) beside the tag name.</td>
</tr>
<tr>
<td>Remove a tag from one or more records in the list view using the action menu</td>
<td>Select the check box for one or more records, then click Actions on selected rows &gt; Remove Tag: &gt; (Tag name).</td>
</tr>
<tr>
<td></td>
<td>This functionality is not available in List v3.</td>
</tr>
<tr>
<td>Remove a tag from a record in the form view</td>
<td>Perform the appropriate action for your version of the UI.</td>
</tr>
<tr>
<td></td>
<td>• UI16: Click the more options icon (●●●) in the form header, then click the remove tag icon (x).</td>
</tr>
<tr>
<td></td>
<td>• UI15: Click the edit tags icon (●●), then click the remove tag icon (x).</td>
</tr>
<tr>
<td>Remove a tag from a record in the Tagged Documents page</td>
<td>Click the remove tag icon (x) in the corner of the document preview.</td>
</tr>
</tbody>
</table>

If a tag is automatically applied to a record based on specific conditions, the tag is automatically removed when those conditions no longer apply. For more information, see Administering tags.

Recently viewed and most viewed records

If the Most Active and Most Recent tags are activated in UI11, users with the ITIL role can see the history of the records that they have viewed the most or most recently viewed.

**Note:** In UI16, a similar feature is available. For more information, see Use the UI16 navigator.
Activate Most Active and Most Recent tags

To activate Most Active and Most Recent tags in UI11, you must first have viewed some records within the platform.

Role required: itil

After viewing some records within the platform, perform the following steps to activate Most Active and Most Recent tags.

1. Navigate to your homepage.
2. Click Add content.
3. Select Labels from the first pane.
4. Select Most Recent from the second pane to activate that tag. It is not necessary to click Add.
5. Select Most Active from the second pane to activate that tag. It is not necessary to click Add.
6. After selecting the tags you want to activate, refresh your browser (F5).
The tags should now be visible in the application navigator. Items in the **Most Recent** tag are listed chronologically in reverse order, as you would expect from a history list.

**Deactivate Most Active and Most Recent tags**

In UI11, if you do not want to see the Most Active and Most Recent tags after they have been activated, you can deactivate them.

Role required: itil

1. Click **Most Active** or **Most Recent** in the application navigator.
   The Tag form appears.
2. Clear the **Active** check box.
3. Click **Update**.
   Upon browser refresh, the tag is no longer displayed.

**Remove the Most Active and Most Recent tags**

In UI11, if you do not want to use Most Active and Most Recent tags, you can remove them.

Role required: tags_admin

1. From the left navigation pane, select **System Definition > Tags**.
2. Delete everything with a name of **Most Active** or **Most Recent**.
3. From the left navigation pane, select **System UI > Widgets**, and deactivate the **Labels** widget.
   This prevents it from showing up in the **Add Content** part of homepages.

**Keyboard shortcuts**

You can use keyboard shortcuts to quickly perform common actions in the user interface.

*Access keys* depend on the browser and operating system you are using. Available keyboard shortcuts are based on the UI version.

<table>
<thead>
<tr>
<th>UI16 keyboard shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>Activate global search field</td>
</tr>
<tr>
<td>Toggle application navigator</td>
</tr>
<tr>
<td>Activate navigation filter field</td>
</tr>
<tr>
<td>Impersonate user</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>UI15 and UI11 keyboard shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>Activate global search field</td>
</tr>
<tr>
<td>Toggle banner frame</td>
</tr>
<tr>
<td>Toggle application navigator</td>
</tr>
<tr>
<td>Activate navigation filter field</td>
</tr>
<tr>
<td>Toggle list and form view</td>
</tr>
<tr>
<td>Toggle horizontal split</td>
</tr>
<tr>
<td>Action</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>Maximize the current pane</td>
</tr>
<tr>
<td>Send email</td>
</tr>
<tr>
<td>Submit form</td>
</tr>
</tbody>
</table>

### Generally supported browsers

Browser support varies for each version of the user interface (UI). Most major browsers are supported.

Some features have additional browser requirements, which are noted in the appropriate documentation. Browser versions listed in the following table are the latest public release at the time of testing.

**Note:** UI11 is in maintenance mode. Upgrade to UI15 or UI16.

### Browser support for each UI version

<table>
<thead>
<tr>
<th>UI version</th>
<th>Chrome support</th>
<th>Firefox support</th>
<th>Internet Explorer support</th>
<th>Microsoft Edge support</th>
<th>Safari support</th>
<th>Tablet mobile browser</th>
<th>Phone mobile browser*</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td></td>
<td></td>
<td>11 and up, Edge mode is supported</td>
<td>9.1 and up</td>
<td>Supported</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>UI15</td>
<td></td>
<td></td>
<td>11 and up, Edge mode is supported</td>
<td>9.1 and up</td>
<td>Supported</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>Legacy: UI11</td>
<td></td>
<td></td>
<td>11 and up, however UI11 is in maintenance mode and does not work well with any version of IE</td>
<td>9.1 and up</td>
<td>Limited support</td>
<td>Limited support</td>
<td></td>
</tr>
</tbody>
</table>

*Mobile phone browsers do not support the desktop version of the UI. Instead, mobile browsers use the [mobile UI](#).
Internet Explorer web browser notes

**Important:** Due to significant performance issues, ServiceNow recommends that customers utilize a modern browser for its products and migrate away from Internet Explorer 11. For more information, refer to [KB0683275](#).

- Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.
- In Jakarta and later, Internet Explorer versions prior to IE11 are no longer supported.
- Compatibility mode is not supported.
- Setting Security Mode to High (via Internet Options > Security tab) is not supported.

Safari web browser notes

- There is a security issue in some versions of Safari. User credentials may be disclosed to an unexpected site via auto-fill. For more information, see the [Apple security update](#).
- Starting with Safari 9.1 and future versions of Safari, the leave page / stay on page pop-up message only displays once.

Firefox web browser notes

The iOS version of Firefox does not support ServiceNow Community or other Service Portal-based pages.

User interface configuration

Change appearance, navigation menus, CSS, and utilize cutting edge interface tools.

Response time indicator

A response time indicator may appear at the bottom right of forms and in List v2 list views.

This indicator provides the processing time, including the total time and the time for each step, for a completed transaction. In List v3, the administrator can add the `glide.ui.list_v3.client.timings.roles` property to allow specified roles to see the response time.

The following example shows the response time for retrieving a filtered v2 list in a demo instance.

```
Response time(ms): 968, Network: 3, server: 548, browser: 417
```

**Response time in v2 lists**

The response time text is:

```
Response time(ms): 968, Network: 3, server: 548, browser: 417
```

In this example, the transaction took the following amount of processing time.

- 968 milliseconds total time
3 milliseconds moving data across the network
548 milliseconds on the server
417 milliseconds in the browser, rendering the HTML and parsing and executing JavaScript

In List v3, the response time appears on the lower left for users whose role is specified in the system property.

Response time in v3 lists

Response time appears on most pages. However, it does not appear for simple operations, such as paging through a set of records or changing the sort order of a list, or for the first transaction in a session.

To hide the response time in List v2 or forms, click the clock icon. Click the clock icon again to show the response time.

Point to the clock to view a tooltip with the response time.

To view a detailed breakdown of the browser processing time on forms, click browser.

Detailed response time information

Administrators can disable the response time by setting the glide.ui.response_time property to false.
Add a property to display response time in List v3

The response time indicator that displays in List v2 is not supported in List v3. You can add a property to show the display time in milliseconds (ms).

You determine which roles can view the response time. It appears in the lower left corner of the list footer.

1. **Add a property** with the following settings.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.list_v3.client.timings.roles</td>
</tr>
<tr>
<td>Description</td>
<td>For specified roles, show in milliseconds the length of time it takes for the list to load in List v3. Separate each role with a comma.</td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a comma-separated list of roles.</td>
</tr>
</tbody>
</table>

**Note:** This property does not apply to the response time indicator in forms.

2. Click **Submit**.

Navigation stack

The navigation stack is the portion of the ServiceNow suite of applications that determines where a user is redirected after the update of a record.

An administrator can cause page references to be manually inserted into the navigation stack when a link in the Navigation Page is clicked. This is done by modifying a module definition to include an argument of `sysparm_stack` with a string value equal to the URL reference to the page to be inserted into the stack. The administrator can also override the redirection...
determined by the stack by creating a business rule or editing an existing one to include `gs.setRedirect("http://redirect_page.com")`.

**Operating parameters of the navigation stack**

The navigation stack can be thought of a user’s navigation history in the instance. It is updated every time a user views a new page. The navigation stack is referenced when users press the page back button. It is also referenced when a user submits or updates a record, at which point users are redirected to their last page in the navigation stack.

**Inserting pages to the navigation stack**

The administrator can insert page references manually into the navigation stack when a link in the navigation page is clicked. The module definition is modified to include an argument of `sysparm_stack` with a string value equal to the URL reference to the page to insert into the stack. The following image shows the system definition for the Incident > Create New module. By passing an argument of `"sysparm_stack=incident_list.do"`, the list view of incidents (`incident_list.do`) is added to the stack. After submitting an incident, the user is directed to this page.
Overriding the redirection behaviors of the navigation stack with onEvent business rules

The redirection behaviors that occur as a result of navigation stack behaviors can be overridden using onEvent business rules. This override is performed by using the function gs.setRedirect. Doing so overrides the redirection as determined by the navigation stack, when the specified event occurs. The function gs.setRedirect takes a string argument that is a URL for the page that the user is redirected to. This URL can be external, for example: gs.setRedirect('http://www.google.com').

Navigation action cancellation

The Request Manager allows users to cancel any navigation action they select from the application navigator by clicking another application navigator link. System properties work with settings for the table to allow navigation action cancellation.

This allows users to cancel slow loading transactions without having to wait for the previous transaction to complete.
One of the following conditions must be true for the Request Manager to cancel a transaction.

- Both the original transaction and new transaction are cancelable (both transactions have the setting `sysparm_cancelable=true`).
- The original transaction is a member of the always cancelable white list (the module is listed in the `glide.request_manager.always_cancel` system property) and the new transaction is cancelable (has the setting `sysparm_cancelable=true`).
- Both the original and new transaction produce an auto-completer query in a reference field.

Cancellation workflow

The Request Manager uses the following workflow to determine whether to cancel a transaction.
Cancel navigation actions

1. **Start**

2. Is the property `glide.request.manager.cancel_other_transaction` set to true?
   - **No**

3. Do both the original transaction & new transaction have the cancelable sysparm?
   - **No**

4. Is the original transaction on the `glide.request.always_cancel` white list & the new transaction cancelable?
   - **No**

5. **Cancel transaction**

6. **Stop**

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Navigation cancellation system properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.request_manager.cancel_other_transaction | Enables or disables automatic cancellation behaviors. When true, users can cancel one navigation action with another navigation action.  
 **Type:** true | false  
 **Default value:** true  
 **Location:** sys_properties table |
| glide.request_manager.always_cancel           | A comma-separated list of URIs that users can always cancel by clicking another navigation action. Typically items on this list are modules that provide read-only data such as homepages, reports, or knowledge articles.  
 **Type:** string  
 **Default value:** home,sys_report_template  
 **Location:** sys_properties table |
| glide.request_manager.cancel_reference_completer | Cancels a user query in a reference field when the user enters more information. For example, if the user starts an AJAX search in the Problem number field by entering PRB and then enters PRB000, the second query cancels the first query.  
 **Type:** true | false  
 **Default value:** true  
 **Location:** sys_properties table |

Use cases

There are three use cases where administrators can control user cancellation actions.

1. A user clicks a module, such as the homepage (home.do), and while waiting for the module to load decides to navigate to another module, such as the list of open incidents (incident_list.do). The system property glide.request_manager.cancel_other_transaction controls this use case.

2. A user clicks a module that displays read-only data, such as a report (sys_report_template.do?sysparm=sysid), and while waiting for the module to load decides to navigate to another module, such as the list of open incidents (incident_list.do). The system properties glide.request_manager.cancel_other_transaction and glide.request_manager.always_cancel control this use case.

3. A user starts typing a query in a reference field, such as entering PRB in the related Problem field and while waiting for the auto-completer to display results, decides to enter more information, such as PRB000. The system properties glide.request_manager.cancel_other_transaction and glide.request_manager.cancel_reference_completer control this use case.
Add sites to the always cancel white list

You can add UI pages or other links to the always cancel white list so that users can cancel actions on these pages by navigating to another module or link.

Role required: admin

User actions can always cancel items on the white list. You should only add items to the white list that provide read-only data to the user, such as a homepage or a report.

1. Enter `sys_properties.list` in the navigation filter and press the Enter key.
2. In the Go to field, select Name, enter `glide.request_manager.always_cancel`, and click Go.
3. Click the property name to open it.
4. In the Value field, add a comma-separated list of URIs you want to allow users to cancel.
5. Click Update.

Prevent users from canceling module transactions

You can explicitly prevent users from canceling the activity of a module by updating the module definition.

Role required: admin

1. Perform the appropriate action for your version of the UI:

<table>
<thead>
<tr>
<th>UI16</th>
<th>UI15 or UI11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point to the application menu you want to add the module to and click the edit application (pencil) icon.</td>
<td>Right-click the application menu you want to add the module to and select Edit Application Menu.</td>
</tr>
</tbody>
</table>

2. In the Modules related list, click the module you want to prevent users from canceling.

3. Configure the form layout and add the field Uncancellable by Other Modules.

4. Select the check box for Uncancellable by Other Modules.

5. Click Update.

Context-sensitive help

By default, the help link available in the product opens the welcome page of the help system, allowing you to enter search criteria for the information you want to find. With context-sensitive help, you can set a base URL for an external help system. The context-sensitive system properties define the base URLs for the default and custom help systems.
The ServiceNow system provides several preconfigured help contexts connected to this link that display the exact information you need for the current list, form, or record. You can define your own help topics and configure them to appear when you click the help icon in a ServiceNow record.

Users click the help icon to open the default help pages provided in the base system. For any page that does not have context-sensitive help defined, the instance displays the help system welcome page. Users can use the search feature or the index to find the correct help topic. The location of the help icon depends on the user interface version you are using.

**UI15**

Click the gear icon in the banner frame to open the menu containing the help icon. The appearance of the menu and icons might be different, depending on the UI scheme you have configured for your instance.

![Context help access in UI15](image)

**UI16**

Click the help icon in the right corner of the header bar and select **Search Product Documentation** from the menu.
Context help access in UI 6

Alternatively, administrators can create custom context-sensitive help to suit the needs of their organizations. Create a help context that links the help icon to a topic describing a list, form, or specific record. You may initially want to set a base URL to direct to a help system other than the default ServiceNow help system.

Set base URLs

To create numerous help contexts that direct to a single server other than the ServiceNow help system, enter the base URL in the `help.base.default` property.
Base URL for custom help contexts

On the Help Context form, when the **ServiceNow Product Documentation** check box is cleared and you enter a value in the **URL or page name** field that does not contain the string `://`, that value is appended to the base URL defined by **help.base.default** property.
Note: When the ServiceNow Product Documentation check box is cleared and the URL or page name field contains an absolute URL (distinguished by the string : // in the value), the value in the help.base.default property is ignored. This allows you to create help contexts that link to several different servers.

Context-sensitive help properties

To access the context-sensitive help properties, navigate to sys_properties.list and filter by Name. You can edit a property value from the list or by opening the property record.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.help.default.page</td>
<td>The default URL the help icon directs to when no help context is specified. This is the base URL of the ServiceNow help system and opens to the welcome page. Do not change this value.</td>
<td><a href="http://docs.servicenow.com/">http://docs.servicenow.com/</a></td>
</tr>
<tr>
<td>help.base.default</td>
<td>The base URL for custom help contexts in which the ServiceNow Product Documentation check box is cleared, and an absolute URL is not specified. When the base URL is set, the system creates the address of a help context record by appending the target page or file name to the base URL. Custom help contexts using this base URL overwrite the help provided by default in your instance for the same table. For details, see set base URLs.</td>
<td><a href="http://docs.servicenow.com/?context=">http://docs.servicenow.com/?context=</a></td>
</tr>
<tr>
<td>help.base.servicenow</td>
<td>The base URL for help contexts in which the ServiceNow Wiki check box is selected. This is the base URL for the help provided in your instance by default. Do not change this value. For details, see Create a new help context.</td>
<td><a href="http://docs.servicenow.com/?context=">http://docs.servicenow.com/?context=</a></td>
</tr>
</tbody>
</table>

Create a new help context

You can create new help contexts to supplement or replace the default help contexts. For example, if your organization has heavily customized a form, you might create a new help context for that form. The customized help context could link to more relevant information, such as a company knowledge base article.

1. Navigate to System UI > Help Contexts.
2. Click New.
3. Complete the Help Context form from the fields in the table.
### Help context form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select <em>Form</em>, <em>List</em>, or <em>Record</em>. If you select <em>Record</em>, the <strong>Table name</strong> field is replaced by the <strong>Document</strong> field.</td>
</tr>
</tbody>
</table>
| **Table name** | Select the table for which the help context is being defined. If the **Type** is *Record*, this field is replaced by the **Document** field.  
**Note:** The list shows only tables and database views that are in the same scope as the help context. |
| **Document** | Click the reference lookup icon (🔍) to open the document selection dialog box (pictured). Select the table and document (record) for this help context.  
This field is only visible if you have selected *Record* as the **Type**. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language of the help page to which you are linking. The choices available depend on the <a href="https://service-now.com/platform/technical.html#internationalization">internationalization plugins</a> active on your instance. This field allows you to create multiple help contexts for the same form, list, or record, each directing to a help page in a different language. For example, you might have two help contexts for Form X: one for English and the other for Spanish. If a user whose language is set to Spanish clicks the help icon while viewing Form X, the help page defined in the Spanish help context opens.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to have the system use the help context. This check box is selected by default for new help contexts.</td>
</tr>
<tr>
<td>ServiceNow Product Documentation</td>
<td>Indicates if this help was created by a customer or was provided by ServiceNow. Clear this check box to create custom help for your organization. Do not attempt to modify existing help topics provided by ServiceNow for your own use. The system is configured to use your custom records rather than the default help contexts, even when they are created on the same table.</td>
</tr>
<tr>
<td>URL or page name</td>
<td>Identifies the topic to display when a user clicks the help icon while viewing a form, list, or record. You can enter the complete URL of the help page or just the target file name if you set a <a href="https://service-now.com/platform/technical.html#base-url">base URL</a> in the <code>help.base.default</code> system property.</td>
</tr>
</tbody>
</table>

**Note:** If you reconfigure the fields on the form, you see the available fields **Plugin ID** and **System Property Base URL**. Do not use these fields. They are for internal use only.

4. Click **Submit**.

**Help context types and prioritization**

You can create a help context with the type **Form**, **List**, or **Record**, and link it to a particular table in your ServiceNow instance. If you have multiple help contexts, prioritization determines which help contexts apply to what a user views.

**Help context types**

When a user clicks the help icon, the system analyzes the relevant help contexts to determine which help page to display.

- **Record-level help** applies to only one specific record, not the list or form for that table.
For example, if a **Record** type help context exists for the **Validate Number** record in the Business Rule table, the help icon only directs to the page specified when a user views that record.

- List-level help applies to the list for a table. If no form-level help is defined, list-level help also applies to the form for the same table.

  For example, if a **List** type but not a **Form** type help context exists for the Business Rule table, the help icon directs to the page specified by the **List** type help context when a user views any list or record (if record-level help is not defined for it) in the Business Rule table.

- Form-level help applies to the form for a table. If no list-level help is defined, the form-level help also applies to the list for the same table.

  For example, if a **Form** type but not a **List** type help context exists for the Business Rule table, the help icon directs to the page specified by the **Form** type help context when the user views any record (if record-level help is not defined for it) in the Business Rule table.

- If both list- and form-level help are defined for a table, the appropriate help is displayed for the list and the form.

  For example, if a **List** type and a **Form** type help context exist for the Business Rule table, the help icon directs to the page specified by the **List** type help context when a user views the Business Rules list. The help icon directs to the page specified by the **Form** type help context when a user views any record (if record-level help is not defined for it) in the Business Rule table.

---

**Important:** If you create a help context for a base table list or record, the help system opens that target topic for any list or record in a table that extends the base table if no other help context is created in that extended table.

---

**Help context prioritization**

When there are several matching help context records, the following rules determine which help context is used, in descending order of priority.

1. A customer-created help context is used instead of a default help context provided in the instance for the same table.

2. A help context that matches the user’s language setting is used instead of a help context in the default language of the instance. See the **Language** field on the **Help Context form**.

3. A help context for a closer table in an extended table hierarchy is used instead of a help context for a further table.

   Consider the case of the Linux Server (cmdb_ci_linux_server) table, which has the following parentage: cmdb_ci > cmdb_ci_hardware > cmdb_ci_computer > cmdb_ci_server > cmdb_ci_linux_server. If help contexts exist for both the cmdb_ci_server table and the cmdb_ci table, the help icon directs to the page specified by the cmdb_ci_server help context when you view a record in the cmdb_ci_linux_server table.

---

**Embedded help and guided tours**

Embedded help and guided tours provide just-in-time assistance to your users within the instance. Some content is provided in the base system, and an administrator can add or modify content.

Embedded help and guided tours (com.glide.embedded_help and com.glide.sn_tourbuilder) are active by default in all instances. You can use the Embedded Help application to create customized content for your organization.
Embedded help

Embedded help provides targeted help content to a user in a UI page, based on their role. Some embedded help content comes with the base instance. Your organization can add or replace embedded help content.

**Note:** Embedded help is only available in UI16. It is not compatible with UI15. For more information, see *Activate UI16*.

The Embedded Help plugin must be active for embedded help to be available in the instance. Embedded help content appears in the right sidebar when the user clicks the help icon. If embedded help exists for the current UI page, the help icon has an indicator (🔍).
Help

Work on Service Catalog tasks

1. Open the catalog task to work on and look at the state in the Approval field. Verify that the request was approved before you begin work.

   You can look at the requested item record to verify the approval. Point your cursor to the info icon next to the Request Item field to view the record in a pop-up window.

2. Change the state to Work in Progress and click Update.

3. Complete the work described in the task.

4. In the task record, enter worknotes about the completed work. If necessary, update items in the Variables section.

5. Click Close Task in the form header. The task is completed and the next task automatically changes to Open state.

Related information

Work on Service Catalog tasks
If there is no embedded help, the sidebar displays links to the User Guide and the documentation site search. If the user clicks the Search Documentation link, a documentation search is performed for the page the user originated from. For example, if the user clicks Search Documentation from the Catalog Tasks list view, the search term is Catalog Task and matching topics are listed.

If there is embedded help, it displays based on the user’s role. If the content has no associated role, all users see it. If the role is one other than admin, such as itil, then users with the specified role and above see the content. For example, content with the itil role appears for itil, itil_admin, and admin.

**Working with embedded help content**

You can add new embedded help content or replace content. Replacing content involves inactivating the existing topic and adding a topic.

Following are some of the reasons for your organization to add or replace embedded help content.

- To provide help for custom applications.
- To provide more specific instructions that follow your business process.
- To provide embedded help content where none exists for a page.
- To provide different content for different roles.

The UI page name identifies embedded help content, and you cannot edit the content in a base system topic. In base system topics, the read-only ServiceNow Help check box is selected. If you edit the content and try to save changes, you see an error message.

To replace a topic with custom content, copy the base system topic, which clears the ServiceNow Help check box. Modify the topic with your content and save it. If customized content exists, it is displayed when a user opens help in that UI page.

**Embedded help process**

The ServiceNow datacenter contains the Content Delivery Network (CDN) where embedded help content is stored. Topics in the local (instance) Embedded Help Content (sys_embedded_help_content) table are populated from the CDN.

When a user accesses a UI page, the embedded help process displays a custom topic if one exists for the user’s role. If there is no custom topic, it performs the following steps.

1. Checks the browser cache first, and then checks the Embedded Help Content (sys_embedded_help_content) table for the corresponding embedded help topic with the role.

2. If a topic is found, it checks the date in the Last sync field. If the date is 15 or more days old, it checks the CDN to see if the topic was updated.
   - If the topic was updated, it pulls the updated topic into the table, displays the topic, and updates the Last sync date.
   - If the topic was not updated, it displays the local cached or database topic, and updates the Last sync date.

The administrator can modify the default 15-day synchronization duration in system properties.
Embedded help system properties

Embedded help is active by default on your instance. The administrator can change system properties to modify how the instance interacts with embedded help.

The administrator can enter `sys_properties.list` in the navigator and search for Name *embedded to change these properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.embedded_help.auto_close</td>
<td>Auto-closes the help pane when the user clicks Start a Tour or Back To Guided Setup.</td>
</tr>
</tbody>
</table>
|                                           | • Type: true | false  
|                                           | • Default value: true                                                                                                                                                                                      |
| com.glide.embedded_help.cdn_timeout       | Duration in milliseconds at which a content pull from the Content Delivery Network (CDN) is timed out.                                                                                                      |
|                                           | • Type: integer  
|                                           | • Default value: 2000                                                                                                                                                                                      |
| com.glide.embedded_help.enabled           | Enables the embedded help plugin for activation.                                                                                                                                                           |
|                                           | • Type: true | false  
|                                           | • Default value: true                                                                                                                                                                                      |
| com.glide.embedded_help.guided_setup.persist_actions | Guided Setup actions that are based on states to display on all pages. An example is the Mark as Complete action. The default behavior (false) is to only show actions on the initial Guided Setup page. |
|                                           | • Type: true | false  
|                                           | • Default value: false                                                                                                                                                                                      |
| com.glide.embedded_help.guided_tours.enable | Enables the addition and use of guided tours in the instance.                                                                                                                                              |
|                                           | • Type: true | false  
|                                           | • Default value: true                                                                                                                                                                                      |
| com.glide.embedded_help.sync              | Enables the instance to look in the CDN for updated content when a user accesses a UI page. The instance checks the Last sync date in the topic against the specified frequency to determine whether to look in the CDN for updated content. |
|                                           | • Type: true | false  
<p>|                                           | • Default value: true                                                                                                                                                                                      |
|                                           | If the property is disabled (false), the embedded help content is never synced with CDN topic updates.                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.embedded_help.sync_frequency</td>
<td>Specifies how many days must pass from the Last sync date in the topic for the embedded help process to look for updated content in the CDN.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 15</td>
</tr>
<tr>
<td>com.glide.embedded_help.sync_self_hosted</td>
<td>Specifies whether a self-hosted instance syncs content with the CDN.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>com.glide.embedded_help.url</td>
<td>Lists the location from where embedded help is dynamically retrieved.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: varies</td>
</tr>
<tr>
<td>com.glide.embedded_help.version</td>
<td>Specifies the instance version for which help is displayed.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: Jakarta</td>
</tr>
<tr>
<td></td>
<td>If blank, displays the help for the version the instance is currently running.</td>
</tr>
</tbody>
</table>

**Embedded help planning**

Before writing custom embedded help, plan the content and note the information used in the Embedded Help form. Careful planning ensures that the topic appears for the right page and role.

Each UI page can display embedded help, specified in the **Page** field as shown in the following example.
Embedded help topic for the Catalog Items list view
In planning for embedded help topics, consider how the following fields are used and note the values that you need for your custom topics.

**Page**

Identify and note the UI page name which is found in the URL when the page is displayed as shown. If the page name begins with a dollar sign, such as $mid_server_user, include the dollar sign in the page name. Before you write an embedded help topic for the page, search for the page name to locate a file you can copy.

**Modifier**

- **Normal** content appears for any user with the appropriate role who navigates to the page.
- **Setup** content appears when the page is accessed from a link in Guided Setup.

Many embedded help topics in the base system are for Guided Setup. You can copy Setup content and change the Modifier to Normal to quickly provide help for all users.

**Role**

Specify the lowest level role to provide access to this embedded help topic. All roles that contain the role also see the content, unless another topic targeted to their role exists for the same page.

For example, if you add embedded help content for the itil role that describes your business process for entering incidents, the itil_admin role also sees the content. If you write a different topic with the itil_admin role, the itil_admin sees that content instead of the itil content.

**Product**

Write content only for the Enterprise topic. You can copy an Express topic and change this field to Enterprise if appropriate.

**Version**

Base system content is typically specified to the current software version. If you are editing the content for a custom application or to provide information relevant to your organization business process, select All.

**ServiceNow Help**

If the check box is selected, this field indicates a base system topic. You cannot edit a base system topic, but you can create a copy to add custom content.

**Content**

You can use the formatting tools to format the content. The following list describes the limitations.

- You cannot include images or videos in embedded help content.
- To add a related information link, you must use a full URL, not a relative URL.
- Best practice is not to use the highlight text tool, as the color may make text unreadable depending on the theme the user has selected.

**Embedded help roles**

Embedded help content can be targeted to users with a specified role who access the UI page. All roles that contain the role also see the content, unless another topic targeted to their role exists for the same page.

For example, if you add embedded help content for the itil role that describes your business process for entering incidents, the itil_admin role also sees the content. If you write a different topic with the itil_admin role, the itil_admin sees that content instead of the itil content.
Embedded help role priority

The embedded help role priority is stored in the Embedded Help Role Priority (sys_embedded_help_role) table. Each role is assigned a default priority order number based on the role name in the Roles (sys_user_role) table.

<table>
<thead>
<tr>
<th>Order number</th>
<th>Role name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>admin</td>
</tr>
<tr>
<td></td>
<td>Examples: admin, chat_admin, pa_admin, survey_admin</td>
</tr>
<tr>
<td></td>
<td>Exception: itil_admin</td>
</tr>
<tr>
<td>100</td>
<td>manager or itil_admin</td>
</tr>
<tr>
<td></td>
<td>Examples: itil_admin, catalog_manager, content_manager, sla_manager</td>
</tr>
<tr>
<td>300</td>
<td>itil (only)</td>
</tr>
<tr>
<td>1000</td>
<td>All other roles or no role (ESS user)</td>
</tr>
<tr>
<td></td>
<td>Examples: approver_user, financial_management_user, personalize_form, template_editor</td>
</tr>
</tbody>
</table>

The priority executes from the lowest number to the highest, meaning that embedded help content with no role displays only if no other content is available for the UI page and the user’s role. All base system content is targeted to a role unless the content is intended for all users, including ESS users. When you add a role, such as a role for a custom application, it is automatically added to the Embedded Help Role Priority (sys_embedded_help_role) table with the appropriate default order. You can modify the order of priority as needed.

If a page requires different help content for different roles, separate topics must be added. For example, users with any role can access the incident.do page, and it opens with a view appropriate for their role.

The following list describes how content for different roles can be targeted for the Incident form.

**Admin**
Provides information and links to help with configuring the Incident form.

**itil_admin**
Describes how to monitor the progress of the incident.

**itil**
Describes how to work on an incident.

**No role**
Explains what the user can review and modify in the Self-Service view of the Incident form.

Modify embedded help role priority
You can modify the default order of priority that is assigned to a role in the Embedded Help Role Priority (sys_embedded_help_role) table. The priority order determines what embedded help content a user accesses on a UI page, based on roles assigned to the user.
Role required: embedded_help_admin or admin

When you add a role, such as a role for a custom application, it is automatically added to the Embedded Help Role Priority (sys_embedded_help_role) table with the appropriate default order. You can modify the role priority, including adding priority numbers between the default priority numbers, if appropriate.

1. Navigate to Embedded Help > Role Priority and locate the role to modify the priority.
2. Double-click the value in the Order column to open the list editor.
3. Enter the new priority order number and click the green check mark to save it.

Add custom embedded help from a copy

To customize embedded help for your organization, you can edit a topic in the base system and save it as a copy.

Role required: embedded_help_admin or admin

In base system topics, the read-only ServiceNow Help check box is selected. When you create a copy, the ServiceNow Help check box is cleared, allowing you to modify the content.

When a user navigates to a UI page for which custom content exists, the custom content displays instead of the base system content.

1. Navigate to Embedded Help > Help Content.
2. Open the embedded help topic to copy.
3. Update the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The embedded help topic name.</td>
</tr>
<tr>
<td>Page</td>
<td>The UI page this topic corresponds to. Typically, you do not change the page name.</td>
</tr>
</tbody>
</table>
| Modifier  | - Normal content appears for any user with the appropriate role who navigates to the page.
- Setup content appears when the page is accessed from a link in Guided Setup. |
| Role      | The role that the topic is written to assist. Users assigned to the role see the content when they navigate to the associated UI page. All roles that contain the role also see the content, unless another topic targeted to their role exists for the same page. For more information, see Embedded help roles. |
| Active    | Specifies whether this content displays for the UI page. Clear the check box to prevent the content from being available. |
| Product   | Enterprise is the default, and should not be changed. |
| Version   | The version this topic is appropriate for. If you are editing the content for a custom application or to provide information relevant to your organization business process, select All. |
4. In the **Content** field, update the text using the HTML formatting tools as needed. If you add a link, enter the full URL to the web page. A good practice is to select **New window (_blank)** as the **Target**.

   **Note:** Do not add images or videos in an embedded help topic. Images and videos are removed from the content section when the record is saved.

5. Click **Copy** in the form header. The edited topic is saved and the list redisplays. The **ServiceNow Help** check box is cleared in the saved topic.

### Add custom embedded help content

You can create a new custom embedded help topic, for example, if you have a custom application and you want to provide help to users.

**Role required:** embedded_help_admin or admin

When you write content for your users, keep the following limitations in mind.

- You cannot include images or videos in embedded help content.
- To add a related information link, you must use a full URL, not a relative URL.
- Best practice is not to use the highlight text tool, as the color may make text unreadable depending on the theme the user has selected.

1. Navigate to **Embedded Help > Help Content**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the embedded help topic name. A typical name is the title of the page to which it applies.</td>
</tr>
<tr>
<td>Page</td>
<td>Enter the UI page this content provides help for, without the .do file extension.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Modifier  | Select the modifier, typically Normal.  
- Normal content appears for any user with the appropriate role who navigates to the page.  
- Setup content appears when the page is accessed from a link in Guided Setup. |
| Role      | Select the role that the topic is written for.  
All roles that contain the role also see the content, unless another topic targeted to their role exists for the same page. For more information, see Embedded help roles. |
| Active    | Select the check box to make this content appear. Clear the check box to prevent the content from being available, for example, to have someone review it before it is accessed on the UI page. |
| Product   | Enterprise is the default, and should not be changed. |
| Version   | Select a version, if different from the current version of your instance. To provide content for a custom application or information relevant to your organization business process, select All. |
| Order     | Change the default role, if needed. The order defaults based on the selected role. For more information about default order priority numbers, see Embedded help roles. |

4. In the **Content** field, enter the text using the HTML formatting tools as needed.  
If you add a link, enter the full URL to the web page. A good practice is to select **New window (_blank)** as the **Target**.  

**Note:** Do not add images or videos in an embedded help topic. Images and videos are removed from the content section when the record is saved.  

5. Click **Submit**.  

**Guided tours**  
A guided tour provides a way to demonstrate to users how to use a feature. An administrator can create a task demo with callouts to demonstrate how to do something in the instance, such as how to perform a task.  

**Note:** The Guided Tour Designer is only available in UI16. The designer is not compatible with UI15. For more information, see Activate UI16.  

The guided tour is performed within the instance. If the guided tour provides instructions on inserting a record, at the end of the tour the record exists in the database. For example, if an HR manager completes a guided tour to create an HR department report, that report becomes available to everyone in HR.
Users access a guided tour by navigating to a page that has one. If they have one or more of the roles that the tour is targeted to, they can click the icon so the GTD panel opens to show the **Take a Tour** button. If more than one tour is available to a user on a page, the **Select Tour** choice list appears so they can select which tour to launch.

Several guided tours are provided with the guided setup for particular applications. The administrator can edit existing tours, or create new guided tours. One or more roles can be assigned to a guided tour to control access.

### Guided tour components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>One discrete element of a guided tour. A step can provide a definition, an instruction, or both.</td>
</tr>
<tr>
<td>Callouts</td>
<td>Displays the definition and instruction about the current step in the tour. The callout includes the instruction to proceed to the next step. It points to the element that the instruction describes.</td>
</tr>
<tr>
<td>Triggers</td>
<td>Moves the tour to the next step. Triggers include pressing the Enter key, clicking or right-clicking a UI element, or clicking a <strong>Next</strong> button in the callout.</td>
</tr>
</tbody>
</table>

Guided tours require careful planning prior to entering the tour into the instance. The best practice is to create an outline and include any assumptions. List each step, callout, and trigger.

#### Sample guided tour outline: Set a vacation delegate

<table>
<thead>
<tr>
<th>Step</th>
<th>Callout</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>This tour assumes that the user has navigated to <strong>User Administration &gt; Delegates</strong>. The UI page is <code>sys_user_delegate_list.do</code>.</td>
<td>Points to the <strong>New</strong> button in the Delegates list view. Text: Click <strong>New</strong> to set up a delegate who receives your notifications while you are on vacation.</td>
<td>Click the element: <strong>New</strong> button.</td>
</tr>
</tbody>
</table>

Open the Delegate form to enter a new record.
<table>
<thead>
<tr>
<th>Step</th>
<th>Callout</th>
<th>Trigger</th>
</tr>
</thead>
</table>
| Describe the **User** field. | · Points to the **User** field.  
· Text: Your name defaults as the user who wants to delegate to another user. If you are setting up a delegate for someone else, you can select a different user. | Next Button |
| Select the delegate | · Points to the **Delegate** field.  
· Text: You specify who you want to delegate to. Type the user’s name, and select it when it appears. | Next Button |
| Set the start date | · Points to the **Starts** field.  
· Text: Enter the date and time to start forwarding notifications. Click away from the field to proceed. | Change the Value: **Starts** field. |
| Set the end date | · Points to the **Ends** field.  
· Text: Select the date and time to stop forwarding notifications. Click away from the field to proceed. | Change the Value: **Ends** field. |
| Describe the delegate options | · Points up from below the **Meeting invitations** field.  
· Text: If you do not want these notifications forwarded to your delegate, you can clear any of these fields. | Next Button. |
| Submit the delegate record | · Points to the **Submit** button  
· Text: Click **Submit** to add the delegate. | Click the element: **Submit** button. |

**Guided tour advice**

Use these tips to help you create effective guided tours.

**Note:** The Guided Tour Designer is only available in UI16. The designer is not compatible with UI15. For more information, see [Activate UI16](#).

**Planning the guided tour**

Before you begin outlining the details of a guided tour, answer the following questions.
• What is the purpose of the tour? Do you want to show the features of a UI page with descriptive callouts? Or do you want the user to learn how to perform a task? It is important to be clear before you begin to outline so you can properly break down the steps.

• What assumptions are you making regarding what the user already knows about the page or task? Do all users who can take the tour have the same level of understanding? Use this information to decide how much description to provide at the beginning so that any user who takes the tour understands the content.

• If the purpose of the tour is to perform a task, how can you personalize the instructions so that each user who takes it creates a different record? For example, if the tour walks the user through creating a group called Facilities, the first user creates the record and the subsequent users get a duplicate name error.

**Selecting triggers**

If the purpose of the tour is to describe the features of a page, such as a custom dashboard, then the appropriate trigger is the Next button. If the purpose is to accomplish a task, such as creating a record, keep the following considerations in mind.

• To populate a field with a lookup element, such as a reference field or a date field, do not use a trigger that opens the lookup window. The tour ends when the lookup window opens. Use one of the following triggers.
  - **Next** button: The user can type the value or look it up and select it, and then click Next.
  - **Change Element Value** trigger: After the user selects the value and clicks outside the field, the trigger moves to the next step.

• For some UI elements, the **Right click the Element** trigger is available. Typically, the right-click action is used to open a menu, however, you cannot place a callout on a right-click menu option. You can use this trigger in a descriptive guided tour where you want to describe right-click menu options. Put the descriptive information into the callout text, and at the end, tell them to right-click the element to look at the menu. Following is an example of this type of callout.

![Meeting invitations](image)

*Meeting invitations*

You can right-click a field label to access options to configure the dictionary and other applicable choices. To see the menu, right-click now.

*Example callout instruction for a right-click menu*

When the user right-clicks, this instruction disappears, and the next one appears.

• The **Mouse over the Element** trigger is similar. When the user points to the element, the callout disappears. For example, if you demonstrate that a hint appears when you point to a field
label, the callout step disappears before the hint text appears. This can seem disruptive to the
guided tour flow.

**Callout placement**

A callout must be placed on top of an element to interact with it. The element is highlighted in
blue when it is selected as the target. In the following example, it looks like the callout is pointing
to the context menu icon, but notice that the header bar is highlighted blue.

![Incorrect callout placement for the context menu](image)

This example depicts the correct placement of the callout for the context menu. Notice that the
context menu icon is highlighted blue.

![Correct callout placement for the context menu](image)

**Guided tour triggers**

Each callout in a guided tour step has a defined action that triggers the next step to occur. You
specify the trigger for each callout. Only applicable triggers appear based on the UI element the
callout points to.
### Guided tour triggers

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Button</td>
<td>Places a <strong>Next</strong> button in the callout, which the user clicks to progress to the next step. This trigger is useful for the following steps:</td>
</tr>
<tr>
<td></td>
<td>- The callout describes the element it points to and the user does not have to click a UI element.</td>
</tr>
<tr>
<td></td>
<td>- To enter information in a reference or date picker field. Users can use the lookup function, enter the data, or select it from a list. They can proceed when they have completed the entry for the step.</td>
</tr>
<tr>
<td>Click the Element</td>
<td>Progresses to the next step when the element that the callout points to is clicked.</td>
</tr>
<tr>
<td>Mouse over the Element</td>
<td>Progresses to the next step when the user points the cursor at the element.</td>
</tr>
<tr>
<td>Right-click the Element</td>
<td>Progresses to the next step when the element that the callout points to is right-clicked.</td>
</tr>
<tr>
<td>Press Enter Key</td>
<td>Progresses to the next step when the user presses the Enter key. Use this trigger to acknowledge that the user has entered something, such as in a text box.</td>
</tr>
<tr>
<td>Change Element Value</td>
<td>Progresses to the next step when the user enters or selects a value in a field and clicks outside the field.</td>
</tr>
<tr>
<td>Press any key</td>
<td>Progresses to the next step when the user presses any key.</td>
</tr>
</tbody>
</table>

### Guided Tour Designer interface

The Guided Tour Designer (GTD) is a simplified way to create a guided tour. You can drag a callout to the element, and enter the step instructions and trigger in one step. You can test the steps as you build them, and modify them as needed.

**Note:** The Guided Tour Designer is only available in UI16. The designer is not compatible with UI15. For more information, see [Activate UI16](#).

Following is a description of the elements of the GTD.
GTD interface

Guided tour actions (A)

The icons on the upper right are used to perform the following actions.

- Copy a link to the tour so you can share it with another user, such as a tester.
• Dock or undock the steps panel. This action is useful if your tour is for a wide page, such as a dashboard or a list view.

Callouts (B)
When you build a tour, select each callout based on the direction it is pointing. The point must touch the element you are assigning it to.

Steps (C)
The numbers of the steps are colored or not based on whether they appear on the current page. In this example, Step 1 takes place on the Delegates list view. The instance is fully interactive. To change the first step, you can click the back arrow on the upper left and open the list view where the step appears.

**Note:** Do not put more than one interaction with a field in a step. Each step should describe or provide an interaction with just one field or other object.

Step interaction (D)
As pictured, when you point to a step, its corresponding number in the page is enlarged. Click the step to edit the text or change the trigger. Drag it to a different position as needed. Click the (-) icon to delete it.

If you make a mistake with a step, such as pointing it to the wrong element, you must delete it. Then you can add it with the correct information and drag it into place.

Tour action buttons (E)
Click **Exit** to close the GTD. The browser tab or window closes and changes you made are automatically saved.

Click **Play** to open the instance and designated UI page in a new browser tab or window and proceed through the steps. When you finish, close the tab or window to return to the GTD.

Add a guided tour
After you outline the guided tour, use the Guided Tour designer to enter the steps using callouts and triggers.

Role required: sn_tourbuilder.tour_admin or admin. If the user with embedded_help_admin is not an admin, the user needs the role that provides access to the page where the tour is being added or modified.

Guided tours require careful planning prior to entering the tour into the instance. The best practice is to create an outline and include any assumptions. List each step, callout, and trigger.

**Note:** The Guided Tour Designer is only available in UI16. The designer is not compatible with UI15. For more information, see [Activate UI16](#).

1. Navigate to **Embedded Help > Guided Tour Designer > Create Tour**.
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tour Name</td>
<td>Enter a name for the tour that describes what the user accomplishes by completing it.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application Page Name</td>
<td>Enter the application page the tour starts on. The application page is listed in the URL displayed in the address bar of the browser. The following image is an example of the Delegates list view page. Do not include the .do extension. You can begin typing the UI page name to display a list of matching pages, and then select it from the list.</td>
</tr>
<tr>
<td>Roles this tour is for</td>
<td>Select the roles who can access this guided tour and move them to the <strong>Selected Roles</strong> list.</td>
</tr>
</tbody>
</table>

3. **Click Create.**
   The Guided Tour Designer opens in a new tab or window.
4. Complete the following steps to add a tour step with a callout and trigger.
   a) Drag a callout shape from the upper right and drop it on top of the UI element.
      The element is highlighted when the callout is positioned correctly.

   ![Callout Example]

   b) In the callout that appears, enter the instructions and select the trigger. Only triggers that you can use for the selected element appear in the list.

   ![Trigger Selection]

   c) Optional: To apply text formatting, such as bold or italic, add html tags around the text to format.
      For example, Click <b>New</b> to set up a delegate....

   d) Click Save

5. Continue adding steps until you have completed the tour.
   The tour is saved as you save each step.

6. To test the steps, click Play below the steps at any time.
   The page opens in a new tab or window, and the first callout appears. When you are at the last callout, the Next button displays Done. A good practice is to have a closing statement in a callout to reinforce what the user accomplished, and to trigger it on the Next button.

   As you test the guided tour, note the steps that are not working properly or that need correction. Edit the tour or the steps as described in Edit a guided tour.
Edit a guided tour

You can modify the settings of a guided tour, such as the roles that access the tour. You can also edit, add, delete, and reorganize the guided tour steps, and apply additional formatting to the instructional text.

Role required: sn_tourbuilder.tour_admin or admin. If the user with embedded_help_admin is not an admin, the user needs the role that provides access to the page where the tour is being added or modified.

Use the Guided Tour Designer (GTD) to add, delete, and reorganize guided tour steps. Use the Guided Tour form only to perform tasks you cannot do easily from the GTD.

1. Navigate to Embedded Help > Guided Tour Designer > Guided Tours, and open the tour to edit.
2. In the Guided Tour form, take any of the following actions.
   - Edit the name.
   - Enter a different page name in the Context field. For example, if the form page is listed and you want the user to start on the list view to enter a new record.
   - Enter or edit the description.
   - Clear the Active check box to disable the guided tour. Consider inactivating the tour until you are finished editing it. Select the check box to enable the tour when it is ready.
3. To apply text formatting in the step instructions, click the step number in the Guided Tour Steps related list and complete the following steps.
   a) Scroll to the Content HTML formatter.
   b) Edit the content and apply formatting as appropriate.
   c) Click Update.
4. To work with the tour steps, click Edit with Designer in the form header.
   The target UI page opens in the GTD in a new tab or window.
5. Perform any of the following steps.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the text or trigger in a step</td>
<td>Navigate to the UI page the step is in and click the step in the list on the right. For example, if the tour starts in the list view but you want to edit a step in the form, open the form. The steps in the current view are numbered inside an orange circle. Complete your changes and click Save.</td>
</tr>
</tbody>
</table>
| Place the callout on a different page element | 1. Click the # icon to delete the step with the incorrect placement.  
2. Create a step on the correct page element.  
3. Drag the step into the correct position in the order of steps. |
| Rearrange steps        | Drag the steps to the desired order.                                    |
Use a view with a guided tour

You can assign a list or form view to a guided tour step if you are changing from the Default view view to a different view, such as Self-Service.

Role required: sn_tourbuilder.tour_admin or admin. If the user with embedded_help_admin is not an admin, the user needs the role that provides access to the page where the tour is being added or modified.

To assign a view to a tour step, you must know the view name. The name you see in the context menu View option is the title of the view. Look up the view name before you assign it to a tour step.

Note: You can add a view to only one tour step in a guided tour, and only if the step starts on the default view. When the tour is played and the step is executed, the UI page refreshes with the new view.

1. Complete the following steps to locate the view name.
   a) Navigate to System UI > Views.
      The first two columns are Name and Title.
   b) Locate the view by its Title, and note the value in the Name column.

2. Navigate to Embedded Help > Guided Tours.
3. Open the tour to be modified with a view.
4. In the Guided Tour Steps related list, open the tour step to add a view.
5. In the Tour Step form section, enter the view name in the View field.
6. Click Update.
7. Complete the following steps to test the tour with the view.
   a) In the Guided Tour form, click Edit with Designer.
   b) In the Guided Tour Designer tab or window, click Play below the list of steps.
c) Verify that the step you modified displays the correct view.

Overview help pages

The overview help feature included with the base system displays slides with introductory information on new features offered in the ServiceNow® platform. An administrator can hide the option from the help menu.

To learn about the latest features in your version, click the What's New link in the UI16 help sidebar.

Overview help link

The Overview Help Page (sys_ui_overview_help) table contains the records for each panel that appears, including images, icons, descriptions, and condition statements that control display. By default, the instance displays panels describing notable features of the current release, but users can modify this page to display panels for customized features in their own instance and then define who can see these panels.

Users scroll through the panels by clicking the buttons provided or by clicking the directional arrows at the bottom of the page, depending on how the page was configured.

Note: Administrators can edit the default help page to modify, add, or delete existing panels from this page to match the features in your system.
Hide the What’s New option

Administrators can hide the What’s New option using a system property. To find the property, type sys_properties.list in the application navigator. Find the glide.product.show_what_is_new property and change the value to false.

Create custom overview help

You can edit existing overview help pages to display your own custom panels to selected users.

Role required: admin

1. Navigate to System UI > Overview Help and edit the help page for your version.
2. Modify the Overview Help Page form using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique title of this page.</td>
</tr>
<tr>
<td>Subtitle</td>
<td>General introduction for the subject of this page. This content appears as the description of the first panel that users see.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of this help page. All overview help pages are created in the global scope, so that they are visible from anywhere in the system. This field is read-only.</td>
</tr>
</tbody>
</table>

3. Save the page.
4. Click **New** in the **Overview Help Panel** related list and complete the form using the fields in the table.
5. Click **Submit**.

### Overview help panel fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique name for this panel. This name is the title of the panel shown to users.</td>
</tr>
<tr>
<td>Page</td>
<td>Names the overview page to which this panel is connected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Controls the sequence of the panels in the page. When using icon buttons, the button for the lowest order number appears on the left, and the button for the highest order number appears on the right. When icon buttons are disabled, the lowest order number panel begins the scrolling sequence.</td>
</tr>
<tr>
<td>Roles</td>
<td>Names all the user roles that are entitled to see this panel.</td>
</tr>
<tr>
<td>Condition</td>
<td>Defines the conditions under which this panel is viewable. For example, you can configure this panel to display only when a specific plugin is activated.</td>
</tr>
<tr>
<td>Image</td>
<td>Background image to use when this panel is displayed. Supported image formats are: .jpg, .png, .bmp, .gif, .jpeg, .ico, .svg</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon used as the access button for this panel from the page. This field is read-only. You cannot specify an icon for your custom panels.</td>
</tr>
<tr>
<td>Is title</td>
<td>Controls the display of the title on the initial slide. The field is not used for panels.</td>
</tr>
<tr>
<td>Show title</td>
<td>Controls the display of the title on the initial slide. This field is read-only and is not available for panels.</td>
</tr>
<tr>
<td>Text</td>
<td>Text describing what is shown in the image for this panel. This content appears below the panel title.</td>
</tr>
</tbody>
</table>

**Example of adding a panel to an existing overview help page**

This example adds panels to the existing overview help page that display only for users with specific roles and when a specific plugin is activated.

Role required: admin

You can create a panel that displays a screenshot of auditing gauges to users with the sn_audit.manager role, when the GRC: Audit Management plugin is activated. Create another panel visible only to users with the activity_admin role that displays a view of the Custom tab in the Workflow Editor. Add the panels to the overview help page for the current version. Use the condition on a panel to specify the plugin and a slushbucket to select the roles required for access.

1. Navigate to System UI > Overview Help.
2. Open the help page for the current version.
3. In the Overview Help Panels related list, click New.
4. Create a panel with these values:
   - **Title**: Custom Orchestration Activities. The title is the label that appears on the panel when it is displayed to the user.
   - **Order**: 20. This order number is the lowest for any of the panels in this page, and means that this button appears on the left side of the page.
   - **Roles**: activity_admin. Only users with this role are able to see this panel.
   - **Image**: This is a view of the Workflow Editor and the Custom tab that best introduces the feature to users.
   - **Text**: Enter a description of the feature, emphasizing the highlights in this version. In this example, the text describes the ability to create activities and share them in the ServiceNow store.

**Note**: Buttons for custom panels do not have icons on them.
Workflow Editor panel

5. Save the record.
6. Create another panel with these values:
   - **Title**: Assessment Reports. The title is the label that appears on the panel when it is displayed to the user.
   - **Order**: 60. This order number is the highest for any of the panels in this page, and means that this button appears on the right side of the page.
   - **Roles**: assessment_admin. Only users with this role are able to see this panel.
   - **Image**: This is an example of a bubble chart that you want the assessment administrators to see.
   - **Text**: Enter a description of the chart to display to the users, emphasizing the advantages of this type of chart.
Assessment reports panel

7. Save the record.
8. Log in as a user with the assessment_admin role.
9. Click the help icon in the form header, and then click **What’s New** in the help sidebar. The overview help page for the current version appears, with the control button for the auditing dashboard displayed for the user in the order configured.
10. Click the button to display the assessment report panel.
   The image you selected for your custom panel appears with the title and description you defined.
11. Log out and log in again as a user with the activity_admin role.
12. Click the help icon in the form header, and then click **What's New** in the help sidebar.

The overview help page for the current version appears, with the control button for the Workflow Editor tabs displayed for the user in the order configured.
13. Click the button to display the Orchestration activities panel.
The image you selected for your custom panel appears with the title and description you defined.
System user guide

The system user guide enables you to create end user help documentation that is specific to the policies and procedures of your organization. A default help page is provided in the base system that displays UI16 help documents for system navigation and other basic operations.

The user guide provides the tools for designing help portal pages containing feature-specific help documents. You can create custom help pages and deploy them in various ways using controls in the system. User guide documents are grouped in relevant sections on a help page, using a two-column format. You can display the sections and the documents within them in any order. You can display a section on more than one help page. The user guide is supported in UI16, UI15, and UI11.
A default help page is provided in the base system that displays help documents for system navigation and other basic operations. This page is accessible from the help icon in the header bar for UI16 users. To make this page available to users of other supported UI versions, you must create a programmatic entry point.

**Note:** The default help page can be used as a template for your own help content. To personalize pages, sections, or documents in the User Guide, simply edit the ServiceNow® records to suit your needs. Remember that any records you customize are not updated when you upgrade your instance to a new version. Review any changes on a development system first and then decide whether to accept the updated content into your customized User Guide.
Create a user guide help page

A user guide help page is a portal displayed to the end user that contains links to related help documents.
Role required: admin

2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Page identification used by the system to create a help URL.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this help page. This field is read-only and defaults to the Global scope.</td>
</tr>
<tr>
<td>Title</td>
<td>Display title for this page.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Create a user guide section

The sections in a system user guide page are the category containers for the individual help documents.

Role required: admin

Create your help page sections separately and then associate them to the page you created.

2. Give your section a unique and concise title, and then click **Submit**. The view returns to the list of sections.

3. Create additional sections for your help page.

### Create user guide help documents

User guide help documents are grouped in appropriate sections on the page and listed in a configurable order.

Create all your help documents from within the section record. This allows you to refine their titles, adjust their placement, and decide if they are appropriate for the section.

**Role required:** admin

1. Navigate to **System User Guide > Administration > Help Page Sections**.
2. Open a section record you created.
3. In the **Help** related list, click **New** to create a help document for that section.
4. Complete the form.

### Help document field definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Document number generated automatically by the system.</td>
</tr>
<tr>
<td>Section</td>
<td>Section in which this document appears.</td>
</tr>
<tr>
<td>Order</td>
<td>Listing order for this document in the selected section.</td>
</tr>
<tr>
<td>Published</td>
<td>Date this document was created.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date this document was last updated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the content of this document. This description is used as the title for the document on the help page.</td>
</tr>
<tr>
<td>Text</td>
<td>Document content, including graphics and tables. You can format your entry, create bulleted or numbered lists, and attach images.</td>
</tr>
</tbody>
</table>
To view your queue and take a survey:

1. Navigate to Self-Service > My Assessments & Surveys.
2. Click Take Survey on a survey card to open the questionnaire.
5. Click **Submit**.
The view returns to the section record.
6. Repeat the process to create the necessary help documents for that section.

Configure the help page

After creating the sections and help documents for your user guide, arrange the sections on the help page.

Role required: admin

1. Navigate to **System User Guide > Administration > Help Pages** and open your new page.
2. In the **Page to Sections** related list, click **New**.
3. Complete the form.

**Page to Section field definitions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Column location on the page for this section. The first column is designated as 0 and the second column is designated as 1. There must be at least one entry for column 0 for the sections to display.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order in which the sections display in the columns on the page. If no order number is defined, the system lists the sections in alphabetical order.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this record. This field is read-only and defaults to the <strong>Global</strong> scope.</td>
</tr>
<tr>
<td>Page</td>
<td>Help page on which this section appears. You can use the lookup field to change the page on which a section appears.</td>
</tr>
<tr>
<td>Section</td>
<td>Name of the section to display on the selected page.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
5. The view returns to the Help Page form.
6. Continue adding the sections to the help page.

**User guide page entry points**

You can create entry points in your instance for help generated with the system user guide by providing the correct address parameters in the target URL.

Help pages generated with the user guide can be displayed to end users from configurable entry points in the system, including **application modules** and **UI actions**. To create these entry points, you must express a target URL using these parameters:

**URL entry points for displaying user help**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Provides</th>
</tr>
</thead>
<tbody>
<tr>
<td>$h.do</td>
<td>Processor that renders the banner frame at the top of the page.</td>
</tr>
</tbody>
</table>
Manage audio files

You can upload and store .mp3 or .ogg audio files. Once uploaded, you can reference audio files using HTML.

Role required: image_admin

The Database Storage for Audio Files (com.glide.db_audio) feature must be activated to store audio files. The plugin is activated by default on new instances. For upgraded instances, you can activate the plugin if you have the admin role. For more information on activating a plugin, see Activate a plugin.

1. Navigate to System UI > Audio Files.
2. Click New.
3. Enter a Name for the audio file, including the file extension.
4. Add the Audio file.
5. Save the record.
6. Optional: Complete the following steps to reference audio files using HTML.
   a) Use the `<audio>` HTML tag and set the `src` attribute to the name of the file as set by the Name field of the Audio record.
   b) Use the `controls` attribute to display the audio controls.

   Use the following HTML.

   ```html
   <audio src="Beep.mp3" title="Beep" control="control"/>
   ```

Storing images in the database

Administrators and users with the image_admin or content_admin role can upload and store images in the database. These images are saved in the Images (db_image) table. Uploading an image to the database allows it to be referenced from HTML fields by appending the name of the image to the URL of the instance.
Images vs attachments

If you want to access an image from a record, or if you want to prevent users from appending the image name to the URL of the instance, upload it as an attachment instead. When you upload an image as an attachment, the image is saved in the Attachments (sys_attachment) table. See Administering attachments and Add and manage attachments for more information.

Acceptable image file types

Upload image files with the following extensions:

- .gif
- .jpg
- .png
- .bmp

*Note:* The system does not support uploading zip files that contain .bmp images.

If you upload an image that may not be supported in Internet Explorer browsers, a warning message appears.

The system does not support uploading images in the .ico format through this interface. Microsoft Internet Explorer requires the .ico format for favorite icons. To upload an .ico image, attach the .ico image to a record instead of using the standard image upload interface.

To understand how to insert an image into a form record, see the *Insert an image into your article, incident, or other form record* blog post in the ServiceNow Community.

Updating an existing image

You can change an existing image to an updated version.

Role required: image_admin or content_admin

1. Navigate to System UI > Images.
2. In the Images list, click the name of the image to be replaced.
3. In the Image field, click the (Update) link.
4. Click Browse and navigate to the desired image file.
5. Click Open, and then click OK.

The new file is uploaded into the instance database, replacing the previous file. It is used in all locations that reference the file name.

*Note:* If the new image does not appear as expected, clear the browser cache.

Upload one or more images

You can upload one image or multiple images at one time.
Role required: image_admin or content_admin

1. To upload one image at a time, complete the following steps:
   a) Navigate to System UI > Images to see the list of images stored in the database.
   b) Click New to add a new image.
   c) Complete the form.

### Images form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the file name by which to reference the image in HTML.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to allow the image to be referenced in HTML.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category in which to organize the image file.</td>
</tr>
<tr>
<td>Image</td>
<td>Select Click to add... to upload an image. If an image is already uploaded, click (Update) to upload a new version of the image or (Delete) to remove the image.</td>
</tr>
<tr>
<td>Format, Size bytes, Height, and Width</td>
<td>View current image metadata. This information is automatically populated when the image is uploaded.</td>
</tr>
</tbody>
</table>
2. To upload multiple images at once, complete the following steps:
   a) Create a .zip file that contains only acceptable image file types.
   
   **Note:** The system does not support uploading zip files that contain .bmp images.
   b) Navigate to System UI > Image Zip Upload.
   c) Click Choose File then select the file.
   d) Click Upload.
A message indicates that the files are uploaded to the database, and the images list is sorted by updated date in descending order (the uploaded images appear first).

**Note:**

- If the `.zip` file contains a folder structure, the resulting image names are the path name with underscores in place of the slashes. For example, if the `.zip` contains `myimages/imagel.gif` then the resulting image is named `myimages_imagel.gif`. 
- Image names cannot exceed 100 characters in length, including folder structure. Files with excessively long names are rejected.
- Uploads are logged in the system. View system logs to see whether files are uploaded or rejected.

**Restrict file extensions**

Use the `glide.ui.strict_content_types` to restrict the image file extensions that appear in the UI.

Role required: admin

1. Enter `sys_properties.list` in the Navigation filter.
2. Verify that the property does not exist by searching for the property name.
3. Click **New**.
4. Complete the system property using the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui.strict_content_types</code></td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>Comma-separated list of acceptable image file names. Use any of the following file types: <code>ico, gif, png, jpg, jpeg, bmp, js, css, htm, html, ogg, mp3, eot, woff, woff2, svg, ttf, swf, cur, map</code></td>
</tr>
</tbody>
</table>

**Note:** Any files that use a file extension that is not included in the list of values appear broken in the UI.

**User preferences**

Individual users can configure many UI features, such as the number of rows per page in a list or whether the response time displays at the bottom of a v2 list or form.

These user customizations are stored as records in the User Preference (sys_user_preference) table, and are updated each time the user changes the setting.

The UI displays according to each user's preferences.

For example, by default the response time may appear at the bottom of v2 lists and forms. If a user hides the response time, a user preference record is created showing the response time indicator as hidden. During the user's future sessions, the response time indicator is hidden. If the same user later displays the response time, the user preference record is updated appropriately and future sessions open with the response time indicator visible.

Navigate to **User Administration > User Preferences** for a list of user preference records. Click a preference name to display that preference in form view.

**Note:** Having more than 10,000 user preferences causes system degradation and UI performance issues.
## User Preferences form

### User preference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the feature or functionality.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional short description of the feature or functionality.</td>
</tr>
<tr>
<td>System</td>
<td>Shows whether this record indicates the system-wide default (TRUE), or not (FALSE).</td>
</tr>
<tr>
<td>Type</td>
<td>Shows the data type of entry accepted for the Value. For example, you can select string or integer.</td>
</tr>
<tr>
<td>User</td>
<td>Shows the name of the user for whom the setting is customized. If User is blank, the record is for a system-wide default.</td>
</tr>
</tbody>
</table>
Records for the system-wide value, which applies to users who have not customized the feature, have these values: `System=True` and `User=blank`. For each user who customizes the features, a separate record is created with these values: `System=False` and `User=<username>`. As a result, the same customizable UI feature may have multiple user preference records.

For some features, the system-wide record does not appear in the User Preferences module initially. The system-wide record may be added to the User Preferences list when a user record is created for the same feature.

When an administrator manually changes a user's preference value through this module, the user's next session uses the administrator's setting. However, the user can customize the features again through the UI, which updates their user preference record. If the administrator deletes the user preference record for a particular user, that user's next session uses the system-wide value for that feature. When the user later customizes the feature, the system creates a user preference record for the user.

**User preferences and update sets**

User preference records for system-wide values, also called the default or global values, are stored in update sets. Any changes are implemented when you import the update set and affect all users who have not customized the feature. User preference records for specific users are not stored in update sets, so user customizations are retained when you import an update set.

**Troubleshooting user-specific UI differences**

If a user encounters an unexplained behavior in the user interface, an administrator can check their user preferences. Navigate to User Administration > User Preferences. Search for the user name to find all that user's records. Delete the record that affects the behavior in question.

The system-wide preference is active during the user's next session. If the user customizes the behavior, a new user preference record is created and used for subsequent sessions.

**User preference settings**

User preferences primarily track the way individual users interact with various features so that new sessions activate the user's last settings. For example, user preferences track whether the user activates the tabbed or scrolling interface for multi-section forms. Other user preference records allow administrators to adjust certain feature settings.

**View settings**

To view the user preference settings, navigate to User Administration > User Preferences.
**User preference list**

This list describes user preference records in the base system. It provides the default value and a description for each. The Updated By column indicates how the preference is set.

<table>
<thead>
<tr>
<th>User preference record</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Only</td>
<td>User action sets and updates the value. Manual changes through the User Preference record do not affect the user experience.</td>
</tr>
<tr>
<td>Admin Only</td>
<td>The administrator can change the value through the User Preference record to modify the user experience.</td>
</tr>
<tr>
<td>Admin or User</td>
<td>User action sets and updates the value, but the administrator can change the user experience by manually updating the User Preference record.</td>
</tr>
<tr>
<td>System Only</td>
<td>The system sets and updates the value. Administrators should not modify these records.</td>
</tr>
</tbody>
</table>

**User preferences**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;table&gt;.autocomplete</td>
<td>Search</td>
<td>Admin Only</td>
<td>If the glide.ui.ref_ac.startswith property (System Properties &gt; All Properties) is set to false, autocomplete.contains determines whether reference fields for the named table use a contains or a starts with search to provide auto-complete text. True = use a contains search to auto-complete reference fields. False = use a starts with search to auto-complete reference fields. <strong>Type</strong>: True/False <strong>Default value</strong>: False</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| `<table>.db.order`          | List Sort| Admin or User | For the identified table, indicates which column is used to sort the records in a list. This record updates automatically each time the user changes the sort order for the table.  
**Type**: String  
**Default value**: User selection or the Number column if the user does not select a column. If the Number column is empty, the Name field is used to sort the records. |
| `<table>.db.order.direction`| List Sort| Admin or User | For the identified table, indicates whether the list shows records in ascending (ASC) or descending (DESC) order by the field identified in `<table>.db.order`. This record updates each time the user changes the sort direction for the table.  
**Type**: String  
**Default value**: None |
| `bsm_map.default_ci`       | BSM      | User Only   | Contains the sys_id of the last configuration item the user viewed in the business service management (BSM) map. This record updates automatically each time the user views a new configuration item in the BSM map.  
**Type**: String  
**Default value**: None |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| ci_manage_relationships.cmdb_ci | CMDB | Admin Only | Constrains what appears in the **Available CIs** side of the slushbucket when defining a relationship for a configuration item. The value is in the format of an encoded query string. 
**Type:** String  
**Default value:** location=ANYTHING^operational_status=ANYTHING |
| ci_manage_relationships.sys_user | CMDB | Admin Only | Constrains what appears in the **Available User** side of the slushbucket when defining a relationship for a configuration item. The value is in the format of an encoded query string. 
**Type:** String  
**Default value:** active=true |
| ci_manage_relationships.sys_user_group | CMDB | Admin Only | Constrains what appears in the **Available Groups** side of the slushbucket when defining a relationship for a configuration item. The value is in the format of an encoded query string. 
**Type:** String  
**Default value:** active=true |
| collapse.<related table>.<related field> | Forms | User Only | Indicates that a related list is collapsed. The same related list will be collapsed when the user's next session begins. This record updates automatically whenever the user expands or collapses the same related list. 
**True** = collapse the identified related list.  
**False** = expand the identified related list.  
**Type:** String  
**Default value:** None |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| collapse.section.<sys_id> | Forms      | User Only  | Indicates the sys_id of a form section that is collapsed. The same form section will be collapsed when the user's next session begins. This record updates automatically whenever the user expands or collapses the same section of the same form.  
  **True** = collapse the identified section.  
  **False** (or blank) = expand the identified section.  
  **Type**: True/False  
  **Default value**: False or blank |
| glide.ui11.use            | UI11       | Admin or User | Indicates whether UI11 is active for this user. This record updates automatically when the user clicks the **Switch to the new UI** or the **Switch to the old UI** link near the top right of the screen. Manual changes made by the administrator through **User Administration > User Preferences** are implemented in the user's next session.  
  **True** = UI11 is active.  
  **False** = UI11 is not active.  
  **Type**: True/False  
  **Default value**: False |
| glide.ui.navpage_state    | Menus      | System Only | DO NOT MODIFY. Indicates the user's UI11 configuration.  
  **Type**: String  
  **Default value**: None |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| glide.ui.javascript_editor | UI       | Admin or User         | Indicates whether the JavaScript editor and formatting controls are enabled or disabled for the user. The JavaScript editor icon and formatting controls are available only in instances where the Syntax Editor plugin is active. This record updates automatically when a user clicks the icon to enable or disable script editing. For more information, see Syntax editor.  
**True** = enable script editor.  
**False** = disable script editor.  
**Type**: True False  
**Default value**: True (if syntax editor feature is active) |
| glide.ui.response_time     | UI       | Admin or User         | Determines whether the response time information is expanded or collapsed at the bottom of a list or form. This record updates automatically whenever the user clicks the response time indicator icon (clock) at the bottom of a v2 list or form.  
**True** = expand the response time information.  
**False** = collapse the response time information.  
**Type**: String  
**Default value**: False |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>homepage</td>
<td>Homepages</td>
<td>Admin or User</td>
<td>Indicates which dashboard appears when a user first logs in to the instance or clicks the homepage icon. The value indicates the sys_id of the selected dashboard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: None</td>
</tr>
<tr>
<td>knowledge.search.sort.field</td>
<td>List Sort</td>
<td>Admin or User</td>
<td>Determines the sort order for results when searching the knowledge base. This record updates each time the user selects a different Sort by option in the search results header. Available options are: Number of Views (views), Relevancy (relevancy), and Last Modified (sys_updated_on).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: views</td>
</tr>
<tr>
<td>list_edit_double</td>
<td>Lists</td>
<td>Admin or User</td>
<td>Indicates what action opens the list editor in List v2. This record updates automatically when the user personalizes any v2 list and changes the Double click to edit setting. For more information, see List editor administration. This preference does not apply to v3 lists. Single-click list editing is not supported in List v3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>True</strong> = open the list editor when the user double-clicks a field in a v2 list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong> = open the list editor when the user single-clicks a field in a v2 list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: True/False</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: True</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>list_edit_enable</td>
<td>Lists</td>
<td>Admin or User</td>
<td>Indicates whether the list editor is available for editing fields directly in a list. This record updates automatically when the user personalizes any list (gear icon above the first column in the list) and changes the Enable list edit setting. This preference does not apply to v3 lists. True = enable use of the list editor. False = disable use of the list editor. Type: True/False Default value: True</td>
</tr>
<tr>
<td>live_message.feed.last_display</td>
<td>Survey</td>
<td>Admin or User</td>
<td>Stores the last feed the user viewed: My Feed (sysparm_feed_type=myfeed) or Company Feed (sysparm_feed_type=company_feed). This record updates automatically each time the user selects a different feed. Type: String Default value: sysparm_feed_type=company_feed</td>
</tr>
<tr>
<td>live_tag.feed.order</td>
<td>Live</td>
<td>Admin or User</td>
<td>Tracks the user's choice of sorting for tag display. This record updates automatically when a user selects a different Tag Option in Live. Available options are Order by Created (sys_created_on) and Order by Last Activity (last_activity). Type: String Default value: None (defaults to sys_created_on)</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>menu.&lt;identifier&gt;.expanded</td>
<td>Indices</td>
<td>User Only</td>
<td>Indicates the sys_id of a section of the application navigator menu that is open (expanded) for the user. The same section will be open when the user's next session begins. This record updates automatically each time the user expands or collapses the same section of the application navigator.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: None</td>
</tr>
<tr>
<td>mobile_rowcount</td>
<td>Mobile</td>
<td>Admin or User</td>
<td>Indicates the number of rows displayed in a list on a mobile device. This record updates automatically each time the user chooses a different number of rows per page from the mobile screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: 20</td>
</tr>
<tr>
<td>mobile_use_full.android</td>
<td>Mobile</td>
<td>Admin or User</td>
<td>Indicates which user interface appears on the user's Android mobile device. This record updates automatically each time the user clicks the gear icon above the mobile homepage to display the full desktop interface or clicks the cell phone icon in the welcome bar to display the mobile interface.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>True</strong> = display the full desktop interface on Android mobile devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>False</strong> = display the mobile interface on Android mobile devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Type</strong>: True/False</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Default value</strong>: False</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| mobile_use_full.iphone| Mobile       | Admin or User   | Indicates which user interface appears on the user's iPhone mobile device. This record updates automatically each time the user clicks the gear button above the mobile homepage to display the full desktop interface or clicks the cell phone icon in the welcome bar to display the mobile interface.  
**True** = display the full desktop interface on an iPhone mobile device.  
**False** = display the mobile user interface on an iPhone mobile device.  
**Type**: True/False  
**Default value**: False |
| module                | Menus        | User Only       | Records the sys_id of the last module the user accessed.  
**Type**: String  
**Default value**: sys_id |
| owned_by_indicator.form| Update Sets  | Admin Only      | Shows or hides the update indicator icon in form headers when customer updates to that form are being tracked by update sets.  
**True** = show the customer updates indicator icon.  
**False** = hide the customer updates indicator icon.  
**Type**: True/False  
**Default value**: False |
| recent.impersonations | Administration| User Only       | DO NOT MODIFY. Shows who the administrator most recently impersonated. For more information, see [Impersonate a user](impersonate-a-user).  
**Type**: String  
**Default value**: None |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>report.expanded</td>
<td>Reporting</td>
<td>Admin or User</td>
<td>Works with the UI property List of roles (comma-separated) that can expand the report header to determine whether the report header is open when viewing a report. For users whose role permits them to access the report header, the report.expanded user preference indicates whether reports open with the header expanded or collapsed. Expanding the report header reveals the report builder which is used to modify the report definition. This user preference record updates automatically each time the user expands or collapses the report header. If the user's role does not have permission to view the report header, the report header is never accessible, regardless of this user preference setting. True = expand the report header when displaying a report. False = collapse the report header when displaying a report. Type: String Default value: True</td>
</tr>
<tr>
<td>rowcount</td>
<td>Lists</td>
<td>User Only</td>
<td>Indicates the maximum number of rows that display on a single page in a list. This value also determines the maximum number of records that display in a list report on a dashboard. This record updates automatically when a user chooses a different number. Type: Integer Default value: 20</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sys_update_set</td>
<td>Update Sets</td>
<td>User Only</td>
<td><strong>DO NOT MODIFY.</strong> Indicates the update set that is currently active. This value updates automatically when a user selects a different update set. Type: GUID &lt;br&gt; Default value: sys_id of default update set</td>
</tr>
<tr>
<td>tabbed.forms</td>
<td>Forms</td>
<td>User Only</td>
<td>Indicates whether forms that contain more than two sections use a tabbed interface or a scrolling list of sections. This setting applies to all forms. It is not set on a form-by-form basis. This record updates automatically when a user clicks the <strong>Toggle Tabs</strong> icon in the banner bar. For more information, see <a href="#">Configure the form layout</a>. Type: True/False &lt;br&gt; Default value: False</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| table.compact   | Lists    | User Only  | Indicates whether lists appear with more or less blank space above and below each row. This setting applies to all lists. It is not set on a list-by-list basis. This record updates automatically when a user personalizes any list and changes the **Compact rows** option.  
**True** = reduce the blank space above and below each row in a list to show more rows on the screen at one time.  
**False** = add blank space above and below each row in a list to improve readability.  
**Type**: True/False  
**Default value**: False |
| table.wrap      | Lists    | User Only  | Indicates whether long text in a list is wrapped onto multiple lines or truncated. This setting applies to all lists. It is not set on a list-by-list basis. This record updates automatically when a user changes the **Wrap column text** option in the List v2 personalization interface or the **Wrap longer text in list columns** option in the UI16 system settings.  
**True** = wrap long text in a list. All text is seen in list view, but each row may occupy more vertical space.  
**False** = do not wrap the long text in a list. Text is truncated in list view, but each row takes less vertical space. Full text can be seen in form view.  
**Type**: True/False  
**Default value**: True |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>top_searches.period</td>
<td>Homepages</td>
<td>User Only</td>
<td>Indicates the default time period (hour, day, week, or month) covered by top searches widgets on a dashboard. When this record exists for individual users, it indicates the current time period for the Top Searches — All widget. The time period setting for top searches widgets on individual tables is stored in the top_searches.period.&lt;table&gt; user preference. For more information, see Top Searches homepage. Type: String Default value: Day</td>
</tr>
<tr>
<td>top_searches.period.&lt;table&gt;</td>
<td>Homepages</td>
<td>User Only</td>
<td>Indicates the time period (hour, day, week, or month) covered by top searches widgets for the specified table. This record updates automatically when a user chooses a different time period in a top searches widget for the specified table. If no record exists for a specific table, top searches widgets for that table use the time period set in the top_searches.period user preference where System=true. Type: String Default value: Day</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ts.match</td>
<td>Text Search</td>
<td>Admin or User</td>
<td>Indicates whether the task record should be returned by a global text search in which the search text exactly matches a task number. This record updates automatically when a user clicks the Search tips and preferences link on the search results page and changes the Return task record if searching for exact number setting. For more information, see Global text search finds records from multiple tables.&lt;br&gt;<strong>True</strong> = return the task record. A link is provided for full search results.&lt;br&gt;<strong>False</strong> = return full search results, even if the search term matches a task number.&lt;br&gt;<strong>Type</strong>: True/False&lt;br&gt;<strong>Default value</strong>: True</td>
</tr>
<tr>
<td>Preference</td>
<td>Category</td>
<td>Updated by</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ts.remember.expanded    | Text Search   | Admin or User     | Indicates whether to remember which search groups were expanded and collapsed during the previous search. The search groups available depend on the user's access rights and selections. This record updates automatically when the user clicks the **Search tips and preferences** link on the search results page and changes the **Use remembered expand / collapse preferences** setting.  
**True** = remember the expand/collapse setting and use it for subsequent searches.  
**False** = do not remember the expand/collapse setting.  
Expand all groups for subsequent searches.  
**Type**: String  
**Default value**: True                                                                                                                                                                                                                                                                                                                                                                                                                                                                                              |
| ts.show_empty_groups    | Text Search   | Admin or User     | Indicates whether global text search results include groups with no matches. The search groups available depend on the user's access rights. This record updates automatically when the user clicks the **Search tips and preferences** link on the search results page and changes the **Show groups with no search matches** setting.  
**True** = include empty groups when displaying global text search results.  
**False** = hide empty groups when displaying global text search results.  
**Type**: String  
**Default value**: True                                                                                                                                                                                                                                                                                                                                                                                                                                                                                              |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| ts.show_negative_result_info | Text Search             | Admin or User    | Indicates whether group headers in the global text search results page should identify tables that had no matches. The search groups available depend on the user's access rights. This record updates automatically when the user clicks the **Search tips and preferences** link on the search results page and changes the **In search group header, list tables with no search matches** setting.  
  True = show tables that returned no matches in the group header.  
  False = hide tables that returned no matches in the group header.  
  **Type:** String  
  **Default value:** True                                                                                                                                                                                                                                                                                                                                                                           |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
</table>
| ts.show_search_groups | Text Search    | Admin or User | Indicates whether the global text search results page includes check boxes that let the user indicate which groups to search and display. The search groups available depend on the user's access rights and settings. This record updates automatically when the user clicks the Search tips and preferences link on the search results page and changes the Show selectable search groups setting.  
True = show the check boxes for enabling or disabling individual search groups.  
False = hide the check boxes for enabling or disabling individual search groups.  
Type: String  
Default value: True |
| user.can.logout     | Security       | Admin Only    | Indicates whether users see a Logout button. If this is False, users are automatically logged out when their session times out. For more information, see Remove the Logout button. This user preference does not apply to UI16.  
True = show the Logout button, which enables manual logout.  
False = hide the Logout button, which disables manual logout.  
Type: True/False  
Default value: True |
<table>
<thead>
<tr>
<th>Preference</th>
<th>Category</th>
<th>Updated by</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>use.concourse</td>
<td>UI16</td>
<td>Admin Only</td>
<td>Indicates whether users see UI15 or UI16. The UI16 plugin (com.glide.ui.ui16) must be enabled for users to see UI16. True = show UI16 by default False = show UI15 by default Type: String Default value: True</td>
</tr>
</tbody>
</table>

Remove the welcome splash screen

You can create a user preference to turn off visibility to the welcome splash screen that introduces a new version of the ServiceNow® platform. This preference is useful if you are waiting to roll out features that are described in the welcome content.

Role required: admin

1. Navigate to User Administration > User Preferences.
2. Click New.
3. Enter the following values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>overview_help.visited.helsinki</td>
</tr>
<tr>
<td>System</td>
<td>Select this field</td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click Submit.
The welcome splash screen is marked as Visited for every user.

View management

A view defines the elements that appear when a user opens a form or a list, and you can switch the view from the default for lists and forms.

When the system displays a form or list it usually displays only a subset of the fields belonging to the underlying table. For example, this is the Incident form in the Self-Service View:
Self service view

This is the Incident form in the **Metrics View**: 
Metrics view

Administrators and users with the personalize role have permission to perform the key tasks related to views:
• create views for any list and form
• determine which view is visible by default
• delete views they have created
• create and modify view rules determining which views are available depending on the values
  of the fields of the underlying table
• create rules that determine which views pertain to specific user roles

Users with the admin or view_changer roles can change views.

Views included with the base system

Several views are included with the base system, including the Default view and Advanced view.

Warning: Do not delete any of the base system views.

Switching views

To switch between list views, click the table name at the top left corner of the list, and then select
Views > (Desired View):

To switch between form views, click the table name at the left side of the form header, and then
select Views > (Desired View):
Switching views submits the form, which saves all changes and triggers any `onSubmit` client scripts that apply. You cannot switch form views on a new form that has not been saved yet.

When a user switches views, the selected view is saved as a user preference so the user sees the same view by default when the form opens. When a user has a view saved as a user preference and then opens a URL to a record that specifies another view, the form displays in the view saved in the user preference, not the URL. For example, if a user selects the Mobile view on an Incident record and then tries to open the following link, which specifies the visual task board view, the form still opens in the Mobile view:

```
https://{instance}/nav_to.do?uri=incident.do?sys_id={sys_ID}sysparm_view=vtb
```

The `sysparm_view` parameter specifies the view to be used for a list or a form, and can be overwritten by a user’s stored preference for a view. You can override this behavior by setting the `sysparm_view_forced` parameter to `true`.

### Create and delete views

Administrators can create new views and delete any views they have created.

Role required: admin

1. Navigate to **Application** > **Module**.
2. If you are creating a view for a list, perform the appropriate action for your list version.
<table>
<thead>
<tr>
<th>Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>List v2</td>
<td>Right click the header and select Configure &gt; List Layout or Configure &gt; Form Layout.</td>
</tr>
<tr>
<td>List v3</td>
<td>Open the context menu and select List Layout.</td>
</tr>
</tbody>
</table>

3. If you are creating a view for a form, right-click the header and select Configure > Form Layout.

4. Under the List View section, select the view on which you want to base your new view. The fields visible for that view appear in the Selected list.

5. From the choice list, select New. The Create New View form appears.

6. Enter the descriptive name of the view. View names should be unique and cannot use special characters or spaces, only the characters A-Z, a-z, 0-9 and _.

7. Click OK. The fields in the Available column are the same as the first view you based the new view on.

8. Select the fields to appear in this view by adding or removing the fields from the Selected column. You can also adjust the order they appear on the form by moving the fields up or down.

   If you are creating a view for a form, you can select a form section and configure the fields for that section. You can also create views in the same manner when you configure a related list.

9. To delete a view, navigate to System UI > Views.

10. Click the view to delete.

11. Click Delete on the form header.

Warning: In the views list, you may see multiple entries formatted as rpt-temp<sys_id><user>. The instance creates these views to store the current state of reports. Avoid deleting these records, as it may impact the state of active reports.

Warning: Do not delete the base system views.

Create a view rule

When a user switches views, the selected view is saved as a user preference so the user sees the same view by default when the form opens. You can override this functionality to force a specified view to be used.

Role required: admin

View rules do not apply to users who have no role. View rules do not always apply if there are existing user preference entries on the instance. Delete the user preference entry and clear the system cache to make sure the respective view rule applies. You can clear the system cache by appending cache.do to the instance URL. For example, instance_name.service-now.com/cache.do.

1. Navigate to System UI > View Rules.
2. Click New.
3. Complete the form, using the fields in the table.
**View rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify an identifying name for the rule. This field is case-sensitive and must match exactly the view name.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this option to apply the view rule according to the conditions you specified. If unchecked, the view rule is not be applied.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select this option to specify a code-based condition instead of using the condition builder. Selecting this option displays the Script field and hides the <strong>Match conditions</strong>, <strong>Conditions</strong>, and <strong>View</strong> fields.</td>
</tr>
<tr>
<td>Match Conditions</td>
<td>Select whether <strong>Any</strong> or <strong>All</strong> of the conditions need to be met. The system hides this field when you create an advanced View Rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the condition builder to determine when the view is applied. The system hides this field when you create an advanced View Rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Displays the application to which the View Rule record belongs.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table on which this view rule will be applied. The list shows only tables and database views that are in the same scope as the view rule</td>
</tr>
<tr>
<td>Device type</td>
<td>Select which interface this view rule applies to.</td>
</tr>
<tr>
<td>View</td>
<td>Enter the name of the View you are creating a rule for. The system hides this field when you create an advanced View Rule.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter a script to determine when to display a particular view. The system only displays this field when you create an advanced View Rule.</td>
</tr>
</tbody>
</table>

4. **Click** Submit.

**Restrict view by role**

You can use a script to control the form view used by different roles.

---

**Caution:** The customization described here was developed for use in specific instances, and is not supported by ServiceNow Customer Support. This method is provided as-is and should be tested thoroughly before implementation. Post all questions and comments regarding this customization to our community forum.

**Name:** Restrict View by Role  
**Type:** System UI > View Rules  
**Table:** Any
**Description:** Generally the view used on a form is controlled by either specifying the `sysparm_view` parameter in the URL or module properties, or by inheriting the view from the previous form or list. Sometimes this does not apply, such as when opening a referenced field form from a record producer. In this case, you may want to control the view of the form based on roles. This script assumes there is a view called `ess` available to the current table.

**Parameters:**
- **view** - A string containing the name of the current view.
- **is_list** - A Boolean value indicating whether this is a list view.

**Script:**

```javascript
(function overrideView(view, is_list) {
  // Force non-ITIL users to use the ess view
  if (gs.hasRole("itil")) {
    return;
  }
  if (view.startsWith("ess")) {
    return;
  }
  // do not change view if it starts with sys_ (e.g. sys_ref_list)
  if (view.startsWith("sys_")) {
    return;
  }
  answer = "ess"; // set the new view to answer
})(view, is_list);
```

**Navigation Handler**

A Navigation Handler is essentially a scripted View Rule and runs each time data from the specified table is requested in the form view.

The following script, which is a navigation handler included with the HR plugin, forces the ESS view for users with no roles, and uses the default view for all other users.

```javascript
var gr = new GlideRecord(hr.TABLE_CASE);
if (gr.get(g_uri.get('sys_id'))) {
  if (!gs.getUser().hasRoles()) {
    g_uri.set('sysparm_view', 'ess');
  } else {
    g_uri.set('sysparm_view', '');
  }
}
answer = g_uri.toString('hr_case.do');
```

Use the `glide.ui.view_rule.check_after_nav_handler` system property to control the order in which View Rules and Navigation Handlers are applied. Set the property value to `True` to process view rules after navigation handlers. If the system property does not exist in your instance, the navigation handler always takes precedence.

The system property only overrides the Navigation Handler if the Navigation Handler scripted function does not return an answer. In the example script above, the property will have no effect as the Navigation Handler will always return an answer due to the `answer` line being outside of the `if` statement.

To force the Navigation Handler Script above to honor View Rules for the table, add the property above, set it to true, and update the code to only return an answer when the view needs to be changed or forced.

```javascript
var gr = new GlideRecord(hr.TABLE_CASE);
if (gr.get(g_url.get('sys_id'))) {
```
Welcome pages

The welcome page contains instructions and any important information you would like to convey to your customers each time they log in to use the system.

The base system login page content is completely customizable by the administrator of the system.

Welcome page sections

Welcome pages can contain different sections, including:

- **Welcome**: General information
- **Using**: Some tips and tricks for using the system
- **Login**: Login information
- **Demonstration**: Information about logging in to a base system demo system
- **More Information**: A link to the ServiceNow documentation

View, create, and configure the welcome page sections by navigating to **System UI > Welcome Page Content**. You can edit any item by clicking its short description. Sections that are not needed can be removed.

**Note**: If it is not visible, you may need to enable the module.

Welcome page section fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A description of the section.</td>
</tr>
<tr>
<td>Active</td>
<td>Mark the section active to display it on the welcome page. Inactive sections are not visible.</td>
</tr>
<tr>
<td>Display order</td>
<td>A number representing the order in which sections are displayed. Lower numbered sections are displayed above higher numbered sections.</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which the section belongs.</td>
</tr>
<tr>
<td>Language</td>
<td>The section appears when the logged in user's language matches this value. If no user is logged in, the guest user's language preference is used.</td>
</tr>
<tr>
<td>Condition</td>
<td>The section appears on the welcome page when the script in this field evaluates to true.</td>
</tr>
<tr>
<td>Published</td>
<td>The published date of the section.</td>
</tr>
<tr>
<td>Text</td>
<td>The content of the section.</td>
</tr>
</tbody>
</table>
Selecting a language on the welcome page

Users can select a language on the welcome page in the login section, enabling them to start their session in the language of their choice.

Choosing language on login

![Login](image)

**Note:** Before a user logs in, the welcome page is displayed in the default language of the guest user.

Create company-specific welcome page content

You can create company-specific welcome page content.

**Role required:** admin

1. Navigate to **System UI > Welcome Page Content**.
2. To create a new section, click **New**.
3. Enter the following in the **Condition** field, where Company is the name of the company whose users see this section.

   ```javascript
   gs.getUser().getCompanyRecord().name.toString() == "Company"
   ```
4. Complete the form.
5. Click Submit.

Map pages

Map pages display ServiceNow data graphically on a Google map page based on location data that you provide.

You can create as many map pages as required to define the types of data to display, the links to show, and the appearance of the map. After creating the map pages, you can create modules to display the map pages.

**Note:** Map pages are subject to the non-production access limitations. See [Set up Google Maps API](#) for details.

Map locations

Locations are used by various applications to locate users, facilities, or configuration items (CI) and are stored in the Location (cmn_location) table. You can configure different levels of location in a parent-child hierarchy. For example, an email server might be associated with a location of Second Floor, whereas the email business service might be associated with New York City.

Each level of this hierarchy contains a separate location record, with the next higher level specified as a parent. In this example each location is selectable as a hierarchy from reference fields:
## Location hierarchy

The location is also used to generate a full identifier in the **Full name** field, which is available by configuring the form as follows.

```
| Full name: | Earth/Americas/New York/New York City/New York Datacenter/Second Floor |
```

### Location Full name

## How locations are defined

To create a location, navigate to **User Administration > Locations** and click **New**.

### Define a location

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the location. This name is the display value that the system uses when referencing this location on a form.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the location.</td>
</tr>
<tr>
<td>City</td>
<td>The city of the location.</td>
</tr>
<tr>
<td>State / Province</td>
<td>State or province of the location.</td>
</tr>
<tr>
<td>Zip / Postal Code</td>
<td>The zip or postal code of the location.</td>
</tr>
<tr>
<td>Country</td>
<td>The country of the location.</td>
</tr>
<tr>
<td>Contact</td>
<td>Name of a user who is the contact for this location.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number for the location.</td>
</tr>
<tr>
<td>Fax phone</td>
<td>The fax number for the location.</td>
</tr>
<tr>
<td>Parent</td>
<td>Name of the parent location for this location. Location hierarchies are described above.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latitude</td>
<td>The latitude of the location. The <code>get_lat_long</code> business rule automatically populates this field and the Longitude field described below when the form contains enough information, such as an address or city name and a postal code. Deactivate this business rule to prevent the system from overwriting any values entered manually into these fields.</td>
</tr>
<tr>
<td>Longitude</td>
<td>The longitude of the location.</td>
</tr>
</tbody>
</table>

**Fields that can be added by configuring the form:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>A reference field to the <code>core_company</code> table.</td>
</tr>
<tr>
<td>Full name</td>
<td>A read-only, calculated field that assembles the parent hierarchy of the location into a full name.</td>
</tr>
<tr>
<td>Stock room</td>
<td>A boolean field that identifies whether the location is being used as a stock room.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone of the location. By default, the location uses the system time zone.</td>
</tr>
</tbody>
</table>

---

**Latitude and longitude**

When a Company or Location record is created, or has one of its address fields changed [street, city, state, zip or country], the `get_lat_long` business rule is triggered. This business rule uses the GoogleMapsHelper script include to create `sys_geocoding_request` records.

A scheduled job called Process Geocoding Request runs every 10 minutes, and processes `sys_geocoding_request` records. Process Geocoding Request uses Google Map service to populate the latitude and longitude fields of the changed or created Company and Location records.

After the latitude and longitude are populated, Map Pages can be defined that display locations in an interactive map.

**Note:** Latitude and longitude are expressed as a floating point data type. Previous releases expressed this information as a string. During an upgrade, the system converts the data where possible.

---

**Set up Google Maps API**

Map pages enable you to graphically display data on a Google Map, based on location data.

**Role required:** admin

Maps can be generated using basic JavaScript, but are flexible enough to display even the most complicated of queries. The maps you generate use standard Google Maps API mapping features, including various link types to records in your instance. This feature requires the Google Maps plugin.
1. If necessary, obtain a Google Maps for Work license key to cover development use of the Google Maps API.
   See the [Getting Started Guide](#) on the Google web site for details on obtaining a key, using the API, and relevant terms of service.

2. When you receive your key, enter it in the **System Properties > Google Maps** property form, and configure your maps using the property definitions from the table.

3. After you complete the configuration, create map pages or use the default pages included with the plugin.
   Map pages define what data is displayed on the map and the appearance of the links. For a tutorial on how to display all markers that link to your records, see the [Display Map Markers on Google Maps](#) blog post on the ServiceNow Community.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>google.maps.auto_close</td>
<td>If true, automatically closes a map information window before opening a new one.</td>
</tr>
<tr>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>google.maps.client</td>
<td>Client ID for Google Maps API for Work.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: gme-servicenow</td>
</tr>
<tr>
<td></td>
<td>• Location: <strong>System Properties &gt; Google Maps</strong></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>google.maps.private.key</td>
<td>Private key for Google Maps API for Work. This key activates the geolocation feature, which locates users in the system precisely, using data from their mobile devices.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: empty</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.version</td>
<td>Version number of the current installation of Google Maps API.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: current version number</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.key</td>
<td>The Google Maps API key that is tied to the URL of the server. This key authorizes development use of Google Maps API.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: empty</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.latitude</td>
<td>Starting latitude of the map. This value determines the starting position displayed in Google Maps.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: 36.008522</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.longitude</td>
<td>Starting longitude of the map. This value determines the starting position displayed in Google Maps pages.</td>
</tr>
<tr>
<td></td>
<td>Type: string</td>
</tr>
<tr>
<td></td>
<td>Default value: -95.221764</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.max_items</td>
<td>Maximum number of items to display on the map.</td>
</tr>
<tr>
<td></td>
<td>Type: integer</td>
</tr>
<tr>
<td></td>
<td>Default value: 500</td>
</tr>
<tr>
<td></td>
<td>Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>google.maps.table</td>
<td>Table used by the map. The table needs the following fields: name, longitude, latitude.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: cmn_location</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Google Maps</td>
</tr>
<tr>
<td>google.maps.zoom</td>
<td>Starting zoom level of the map (1 is the lowest)</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 4</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Google Maps</td>
</tr>
</tbody>
</table>

**Create a map page**

Your ServiceNow instance provides several default map pages. You can also create custom map pages with the script examples described in this page.

Role required: admin

The default map page record displays critical incidents on a Google map page.
1. Navigate to **System UI > Map Pages**.
2. Click **New**.
3. Complete the form, using the fields in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the map.</td>
</tr>
<tr>
<td>Center map on</td>
<td>Enter the location for centering the map using the decimal form of latitude and longitude. For example, to center the map on the statue of liberty, enter 40.689865, -74.045235.</td>
</tr>
<tr>
<td>Initial zoom</td>
<td>Set the zoom level of the map on opening.</td>
</tr>
<tr>
<td>Controls size</td>
<td>Select whether the Google navigation icons on the map should be large or small.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a map background style: Satellite, Hybrid, Normal, or Terrain.</td>
</tr>
</tbody>
</table>
Create a map page module

You can create a new application module for desktop or smartphone users to display a map page.

Role required: admin

To create a desktop module that opens a map page:

1. Navigate to System Definition > Modules and click New.
2. Select the appropriate application for the module.
   
   For example, if you are planning to display critical incidents, add a module to the Incident application menu.
3. Perform the appropriate action for your version of the UI:
   
   - UI16: Point to the application menu you want to add the module to and click the edit application (pencil) icon.
   - UI15 or UI11: Right-click the application menu in the application navigator and select Edit Application Menu.
4. Select the Link Type tab and select the type of link you want for the module.
   
   For example, you can create a module that opens a map page directly, or one that links through a URL.
5. Complete the form, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application menu</td>
<td>Select the application menu where you want this module to appear. By default, this field displays the application menu that you opened to create the module.</td>
</tr>
<tr>
<td>Hint</td>
<td>Enter a brief description to display when a user points to the module name in the application navigator.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to activate this module. Only active modules appear in the application menu.</td>
</tr>
<tr>
<td>Image</td>
<td>Select an icon to display with this module in the application navigator. If this field is blank, a default icon is used.</td>
</tr>
<tr>
<td>Link type</td>
<td>Select the desired link type from the list. This selection changes the available fields in the form.</td>
</tr>
<tr>
<td>Map page</td>
<td>Select the pre-configured map page to use for this module. For example, Critical Incidents.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles that are permitted to access this module. If this field is blank, all roles can access the module.</td>
</tr>
<tr>
<td>Arguments</td>
<td>Define the URL for this module in the format map_page.do?sysparm_name=&lt;map page name&gt;. This field is available when the <strong>Link type</strong> is <strong>URL (from Arguments)</strong>.</td>
</tr>
</tbody>
</table>

**Note:** If the map page title has a space in it, replace the space with `%20` for the correct syntax. For example, a map page called Critical Incidents becomes Critical%20Incidents%20 in a URL.
6. ClickSubmit.

Create a smartphone map page module

You can create a custom smartphone module that links directly to a map page.

Role required: admin

1. Obtain the sys_id of the map page.
   The sys_id is required when you create the module.
2. Navigate to System Mobile UI > Navigator Apps.
3. Open the application menu where you want the new module to appear.
4. In the Modules related list, click New.
5. Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the module.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to specify the order of the module within the application menu. For example, an entry of 100 would place this module before one with an Order entry of 200.</td>
</tr>
<tr>
<td>Application menu</td>
<td>Select the application menu where you want this module to appear. By default, this field displays the application menu that you opened to create the module.</td>
</tr>
<tr>
<td>Table</td>
<td>Do not select a table.</td>
</tr>
<tr>
<td>Updated</td>
<td>Displays the date and time when the module record is updated.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select the roles that are permitted to access this module. If this field is blank, all roles can access the module.</td>
</tr>
</tbody>
</table>
### ServiceNow Jakarta Now Platform User Interface

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to activate this module. Only active modules appear in the application menu.</td>
</tr>
<tr>
<td>Filter</td>
<td>Do not add a filter condition.</td>
</tr>
<tr>
<td>Path</td>
<td>Enter <code>map/</code> followed by the <code>sys_id</code> of the map page. For example: <code>map/c86c5feac0a80a6600706f0102968196</code></td>
</tr>
</tbody>
</table>

6. Click **Submit**.

### Scripting for map pages

The Script field on the Map Page form allows the use of attributes or custom code to define map characteristics, such as marker appearance, display information, and more.

### Scripting map item attributes

The following attributes are available.

**Note:** To create an item on the map, use the `map.addItem.glideRecord` method. Pass a valid GlideRecord to `addItem()`.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name used for identification.</td>
</tr>
<tr>
<td>latitude</td>
<td>If you define an address, latitude is not necessary.</td>
</tr>
<tr>
<td>longitude</td>
<td>If you define an address, longitude is not necessary.</td>
</tr>
<tr>
<td>icon</td>
<td>URL of the icon to display for the marker. If a custom icon is not specified, the default Google marker is used.</td>
</tr>
<tr>
<td>icon_width</td>
<td>Width of the icon. The default is 32.</td>
</tr>
<tr>
<td>icon_height</td>
<td>Height of the icon. The default is 32.</td>
</tr>
<tr>
<td>table_name</td>
<td>Table whose records display when the marker icon is clicked. Used with the <code>sys_id</code> attribute.</td>
</tr>
<tr>
<td>sys_id</td>
<td><code>Sys_id</code> of the record that displays when the marker icon is clicked. Used with the <code>table_name</code> attribute.</td>
</tr>
<tr>
<td>view</td>
<td>View of the form displayed in the dialog box when the marker icon is clicked.</td>
</tr>
<tr>
<td>html</td>
<td>Arbitrary HTML code for the pop-up window. If used, this value overrides the dialog box.</td>
</tr>
<tr>
<td>marker_label</td>
<td>Optional marker icon label text.</td>
</tr>
<tr>
<td>label_offset_left</td>
<td>Optional attribute that is used with <code>marker_label</code> to define the horizontal position of the marker label. The default is 0.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>label_offset_top</td>
<td>Optional attribute that is used with marker_label to define the vertical position of the marker label. The default is 0.</td>
</tr>
</tbody>
</table>

**Scripting custom map page behavior for smartphone**

If you plan to access the map page from a smartphone, you may want to set custom smartphone interface behavior using the isMobile variable. You can use the isMobile variable to set custom behavior for the smartphone view of the map. For example, you might set different values for the icon_width and icon_height attributes when isMobile is true.

**Basic map page script**

This script displays all active, critical incident locations.

```javascript
//setup new GlideRecord query on the incident table
var gr = new GlideRecord("incident");
//add condition for priority 1
gr.addQuery('priority', '1');
//add condition for active incidents
gr.addActiveQuery();
//execute the query
gr.query();

//loop through the list of incidents returned by the query
while (gr.next()) {
  //create a new map item to display - linked to the current incident record
  var item = map.addItem(gr);
  //add the latitude value from the incident's location
  item.latitude = gr.location.latitude;
  //add the longitude value from the incident's location
  item.longitude = gr.location.longitude;
  //link to the icon image
  item.icon = "http://maps.google.com/mapfiles/kml/pal3/icon51.png";
  //set the icon size
  item.icon_width = "16";
  item.icon_height = "16";
}
```

**isMobile map page script**

This script displays all active, critical incident locations with custom settings for smartphone users.

```javascript
//setup new GlideRecord query on the incident table
var gr = new GlideRecord("incident");
//add condition for priority 1
gr.addQuery('priority', '1');
//add condition for active incidents
gr.addActiveQuery();
//execute the query
gr.query();

//loop through the list of incidents returned by the query
```
while (gr.next()) {

    //create a new map item to display - linked to the current incident record
    var item = map.addItem(gr);
    //add the latitude value from the incident's location
    item.latitude = gr.location.latitude;
    //add the longitude value from the incident's location
    item.longitude = gr.location.longitude;
    //link to the icon image
    item.icon = "http://maps.google.com/mapfiles/kml/pal3/icon51.png";

    //set the icon size (use smaller icons for smartphone users)
    if (isMobile) {
        item.icon_width = "12";
        item.icon_height = "12";
    } else {
        item.icon_width = "16";
        item.icon_height = "16";
    }
}

### Advanced map page script

This script displays the number of open incidents by location. It varies the size of the icon based on the number of open incidents for the location. Using the html parameter, it also displays the location name and number of incidents, as well as a link to the list of related incidents.

```javascript
//get the instances url so we can link back to it
var uri = gs.getProperty("glide.servlet.uri");
//create an aggregate query on the incident table
var count = new GlideAggregate('incident');
//set condition for active incidents
count.addQuery('active', 'true');
//set aggregate field to location to get count by location
count.addAggregate('COUNT', 'location');
//execute the query
count.query();

//loop through the results
while (count.next()) {

    //get the current record's location
    var loc = count.location;
    //get the count of incidents for this location
    var locCount = count.getAggregate('COUNT', 'location');
    //only display location is there are active incidents
    if (locCount > 0) {
        //create new new map item for this location
        var item = map.addItem(count);
        //set lat/long from the location record
        item.latitude = loc.latitude;
        item.longitude = loc.longitude;
        //build the link to the list of incidents for the location
        var link = 'href=' + uri + 'incident_list.do?sysparm_query=active%3Dtrue%3Dlocation%3D' + loc + '
        //build the html value to be displayed when you click the map icon
        item.html = '<a ' + link + '>'+ loc.getDisplayValue() + ' (' + locCount + ')</a>';
        //link to the icon image
        item.icon = "http://maps.google.com/mapfiles/kml/pal3/icon51.png";
    }
}
```
//set the size of the icon based on the number of active incidents
if (locCount < 5) {
    item.icon_width = "12";
    item.icon_height = "12";
} else if (locCount < 15) {
    item.icon_width = "16";
    item.icon_height = "16";
} else {
    item.icon_width = "32";
    item.icon_height = "32";
}
}

Map page marker label script

Marker labels allow you to add dynamic text to markers. This example displays the active incident count at each location.

//get the instances url so we can link back to it
var uri = gs.getProperty("glide.servlet.uri");
//create an aggregate query on the incident table
var count = new GlideAggregate('incident');
//set condition for active incidents
count.addQuery('active', 'true');
//set aggregate field to location to get count by location
count.addAggregate('COUNT', 'location');
//execute the query
count.query();

//loop through the results
while (count.next()) {

    //get the current record's location
    var loc = count.location;
    //get the count of incidents for this location
    var locCount = count.getAggregate('COUNT', 'location');
    //only display location if there are active incidents
    if (locCount > 0) {
        //create new new map item for this location

var item = map.addItem(count);
//set lat/long from the location record
item.latitude = loc.latitude;
item.longitude = loc.longitude;

//create a marker label with the count
item.marker_label = locCount;
//define label offset for proper position
item.label_offset_left = -4;
item.label_offset_top = -20;

//option to define table and record for label hyperlink
//setting table and sys_id will override the use of html parameter
//item.table = 'cmn_location';
//item.sys_id = loc;

//build the link to the list of incidents for the location
var link = 'href=' + uri + 'incident_list.do?sysparm_query=active%3Dtrue%3Dlocation%3D' + loc;
//build the html value to be displayed when you click the map icon
item.html='<a ' + link + '>' + loc.getDisplayValue() + ' (' + locCount + '</a>');</a>';

//link to the icon image
item.icon = "images/red_marker.png";
//set the size of the icon based on the number of active incidents
item.icon_width = 24;
item.icon_height = 24;
}
}

**Theming an instance**

An administrator may want to change the styles throughout the instance to change the look and feel of the usual instance interface.

This theming can be done in several different places, often using global CSS or system properties. Other information on theming can be found in the following sources.

- To create a themed interface for users, see [Content Management System](#).
- To find out how to modify the banner image and text, see [Modify the banner](#).
- For styles of individual fields, see [Define field styles](#).

Beyond theme controls, it is also possible to customize the UI using customized scripts.

**Configure logo, colors, and system defaults for UI16**

You can use the Basic Configuration UI16 module to brand your instance with your company logo and colors and set basic system defaults. This place is the best starting point if you are setting up your instance for the first time or if you have recently enabled UI16.

To prepare for completing basic configuration, gather the following information.

- Obtain the company banner image to use in the header. The image can be high resolution, but when it displays it is scaled based on the aspect ratio. It scales to a maximum of 20px high.
- Get the brand color hex or RGB numbers of your company, typically from your marketing department. Use them to decide how to configure the UI background colors.
Role required: admin

Each color selection option provides a color picker to select a color. The text box beside the color picker lets you enter the value of the color as any of the following CSS formats.

- Name: predefined color names, such as red, green, blue
- RGB decimal: RGB(102, 153, 204)
- RGB hex: #223344

Refer to [HTML Color Names (W3CSchools)](https://www.w3schools.com/html/html_ref_colors.asp) for information about HTML color names.

1. Navigate to **System Properties > Basic Configuration UI16**
2. Complete the configuration by changing any of the following settings.

### Basic system configuration properties

<table>
<thead>
<tr>
<th>Label</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page header caption</td>
<td>glide.product.description</td>
<td>Change the text that appears next to your logo.</td>
</tr>
<tr>
<td>Browser tab title</td>
<td>glide.product.name</td>
<td>Change the text that appears on the browser tab.</td>
</tr>
<tr>
<td>System timezone for all users unless overridden in the user's record</td>
<td>glide.sys.default.tz</td>
<td>Select the timezone in the choice list. Click <strong>Configure available time zones</strong> to select the time zones that your users can select from in user preferences.</td>
</tr>
<tr>
<td>Banner image for UI16</td>
<td>glide.product.image.light</td>
<td>Click + next to the image and upload your logo.</td>
</tr>
<tr>
<td>Date format</td>
<td>glide.sys.date_format</td>
<td>Select the date and time formats from the choice lists.</td>
</tr>
<tr>
<td>Time format</td>
<td>glide.sys.time_format</td>
<td></td>
</tr>
<tr>
<td>Header background color</td>
<td>css.$navpage-header-bg</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Banner text color</td>
<td>css.$navpage-header-color</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Header divider stripe color</td>
<td>css.$navpage-header-divider-color</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Label</td>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Navigation header/footer</td>
<td>css.$navpage-nav-bg</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Navigation selected tab</td>
<td>css.$navpage-nav-selected-bg</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>background color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigation separator color</td>
<td>css.$nav-hr-color</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Background for navigator and sidebars</td>
<td>css.$navpage-nav-bg-sub</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Unselected navigation tab icon and favorite icons color</td>
<td>css.$navpage-nav-unselected-color</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Currently selected Navigation tab icon color for UI16</td>
<td>css.$navpage-nav-selected-color</td>
<td>Select or enter the color.</td>
</tr>
<tr>
<td>Module text color for UI16</td>
<td>css.$navpage-nav-color-sub</td>
<td>Select or enter the color.</td>
</tr>
</tbody>
</table>
For most of the settings, as you make changes, the page refreshes with a preview of the change. Only you see these changes.

3. Click **Save** at the top or bottom of the page.

After you save the configuration changes, all users who select the **System** theme in their UI personalization options see the new configuration colors.

### Configure logo, colors, and system defaults

You can use the Basic Configuration module to brand your instance with your company logo and colors and set basic system defaults. This place is the best starting point if you are setting up your instance for the first time.

To prepare for completing basic configuration, gather the following information.

- Obtain the company banner image to use in the header. The image can be high resolution, but when it displays it is scaled based on the aspect ratio. It scales to a maximum of 50px high.
- Decide whether to change the banner and list header background color, and the banner text color. If you plan to do so, obtain the brand color hex or RGB numbers of your company. Typically, this information comes from your marketing department.

Role required: admin

This procedure applies to configuring UI15 and UI11.

1. Navigate to **System Properties > Basic Configuration**
2. Complete the configuration by changing any of the following settings.

#### Basic system configuration properties

<table>
<thead>
<tr>
<th>Label</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page header caption</td>
<td>glide.product.description</td>
<td>Change the text that appears next to your logo.</td>
</tr>
<tr>
<td>Label</td>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Banner and list caption background color</td>
<td>css.base.color</td>
<td>Click the color picker and select the color to use. You can also enter the name, RGB decimal, or RGB hex number of the color. Refer to <a href="https://www.w3schools.com/tags/ref_color_names.asp">HTML Color Names (W3CSchools)</a> for information about HTML color names.</td>
</tr>
<tr>
<td>Browser tab title</td>
<td>glide.product.name</td>
<td>Change the text that appears on the browser tab</td>
</tr>
<tr>
<td>Banner image</td>
<td>glide.product.image</td>
<td>Click + next to the image and upload your logo.</td>
</tr>
<tr>
<td>System timezone for all users unless overridden in the user's record</td>
<td>glide.sys.default.tz</td>
<td>Select the timezone in the choice list. Click <a href="https://devcenter.servicenow.com/snc/help/content/7/company5/en/3/en/2/1/servicenow-jakarta-now-platform-user-interface-system-theme-system-theme-personalization-system-timezone-system-timezone.html">Configure available time zones</a> to select the time zones that your users can select from in user preferences.</td>
</tr>
<tr>
<td>Date format</td>
<td>glide.sys.date_format</td>
<td>Select the date and time formats from the choice lists.</td>
</tr>
<tr>
<td>Time format</td>
<td>glide.sys.time_format</td>
<td></td>
</tr>
<tr>
<td>Banner text color</td>
<td>css.banner.description.color</td>
<td>Click the color picker and select the color to use. You can also enter the name, RGB decimal, or RGB hex number of the color.</td>
</tr>
</tbody>
</table>

As you make changes, the page refreshes with a preview of the change. Only you see these changes.

3. **Click Save** at the top or bottom of the page.

After you save the configuration changes, all users who select the **System** theme in their UI personalization options see the new configuration colors.

### Menu categories

Menu categories let you put CSS styles on application labels to make them stand out from other applications.

You navigate to **System Definition > Menu Categories** to view existing menu categories. This CSS style can include border color, text color, background color, and other options.

The base system includes the following menu categories.

**Administration**

Applications in this category have a light blue background.

Style: `border-color: #a7cded; background-color: #e3f3ff;`

**Custom Applications**

Applications in this category have a light gray background.
Applications in this category have a blue background.

**Label**

border-color: blue; background-color: rgb(102, 153, 204); color: white

**Maint**

Applications in this category have a blue background.

Style: border-color: blue; background-color: rgb(102, 153, 204); color: white

**SocialIT**

Applications in this category have a blue background.

border-color: blue; background-color: rgb(102, 153, 204); color: white

To add an application to a category, add it in the related list of applications at the bottom of the category record, or specify the category on the application record.

**Business service map properties**

Administrators can edit the Business Service Map look and feel in the module **BSM Map > Properties**.

The following properties can be changed.

- How many child nodes to display when too many children exist for parent CI.
- Color used for the collapsed node when too many children exist for parent CI.
- Text style used for collapsed node when too many children exist for parent CI.
- The color of any of the following items.
  - Affect neighbor node
  - Node with an open change request
  - Node with an outage
  - Node with an open incident
  - Recently expanded nodes

**Change survey question header colors**

All the lists and forms draw the color of their headers from the base color, which allows theming from the CSS properties.

One notable exception is the survey, which has its own CSS. It is possible to change the CSS by adding a property.

1. Enter `sys_properties.form` into the navigation filter and press the Enter key. A new Property form displays.
2. Name the new property `css.list.row.survey.background.color`.
3. Enter the hexadecimal value of the desired color into the **Value** field.
4. Click **Submit**.
   The survey should now use the desired color.
CSS properties

Some theming properties may be customized by navigating to System Properties > CSS.

Colors are specified using predefined color names, RGB decimals, or RGB hexadecimals. The following properties are available through CSS Properties.

- Banner text color
- Banner and list caption background color
- Font used in forms and lists (this is a global font setting)
- Base font size (UI11)
- Button styles (background color, border color, border width, text color)
- Field status indicator colors (including the indicators for Changed, Mandatory Populated, Mandatory Unpopulated, and Read-only)
- List cell vertical alignment
- Navigator menu styles (text font size, background color, text color)
- Header font name and size
- List and form caption color override
- Global text search background color (both for catalog results and knowledge base results)

CSS theme support

Themes give the user interface a specific look and feel by using different color combinations.

System administrators can create themes or customize the existing themes for an instance. To see existing themes, navigate to System UI > Themes.

Activating CSS theme support

There are different plugins that activate CSS themes support.

Activate one of the following plugins to use themes, based on the version of the UI you use.

- **UI16**: CSS Theme support — UI15 is activated automatically with UI16
- **UI15**: CSS Theme support — UI14 is activated automatically with UI15
- **UI11**: CSS Theme support

See [Activate a plugin](#).

Enable the theme picker (UI15)

The theme picker adds a field to the system menu that allows the user to quickly switch between CSS themes during the current browser session.

Role required: admin

You can enable the theme picker by activating the `ui_theme_changer` UI macro.

1. Navigate to System UI > UI Macros.
2. Locate the `ui_theme_changer` UI macro.
3. Set the `Active` field to `true`.

Select a theme

You can switch between different themes for the user interface.
Themes are user-specific. Each user can select a different theme and the selection is stored as a user preference.

Select a theme by performing the appropriate action for your version of the UI.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td>Click the gear icon in the banner frame to access the System Settings window. Select the Theme tab, and then select the theme.</td>
</tr>
<tr>
<td>UI15</td>
<td>Click the gear icon in the banner frame to access the system menu. Then select a theme from the Theme picker.</td>
</tr>
<tr>
<td>UI11</td>
<td>Select a theme from the Theme picker in the banner frame.</td>
</tr>
</tbody>
</table>

Configure a company theme

You can configure a default CSS theme for a particular company in UI15. The theme appears for all users associated with the company unless they select a different theme.

Role required: personalize_form

Specify a company theme on the company record.

**Note:** In UI16, the basic configuration is used instead of the theme selected in the company record.

1. Navigate to System Properties > My Company.
2. Configure the form and add the Theme field.
3. In the Theme field, select a theme.
4. Click Update.
   Users in this company will see the selected theme the next time they log in, unless they have selected a different theme.

Create or customize a theme

You can create themes or customize existing themes.

Role required: admin

1. Navigate to System UI > Themes.
2. To create a new theme, click New. To customize an existing theme, click the theme name.
3. Enter a name for the theme in the Name field.
4. Add any of the default CSS styles in the CSS field.
   Sometimes the default style is not the only style definition for an object. In such cases, you can use the CSS important rule format to override any other style definitions with the default definition. For example, this definition overrides the text color in the main navigation:
   $navpage-nav-color-sub: #fff !important.
5. Select the Active check box.
6. Select one of the following from the Device choice list to identify the user interface version for the theme.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser</td>
<td>Identifies a UI11 theme.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Doctype</td>
<td>Identifies a UI15 theme.</td>
</tr>
<tr>
<td>Concourse</td>
<td>Identifies a UI16 theme.</td>
</tr>
</tbody>
</table>

7. **Click Submit.**

Refresh the page to see the new theme in the theme picker. The theme picker displays only themes that are compatible with the current version of the UI.

**Default CSS styles**

You can use CSS styles to control the appearance of elements in a theme.

Your version of the UI determines which CSS styles you can use.

### Default CSS styles for UI16

```
$search-text-color: #e7e9eb
<navpage-header-bg: #303a46
<navpage-header-color: #ffffff
<navpage-header-divider-color: #455464
<navpage-header-button-color: #ffffff

$nav-highlight-main: #3D4853
$subnav-background-color: #455464
<navpage-nav-bg: #303a46
<navpage-nav-bg-sub: #455464
<navpage-nav-color-sub: #bec1c6
$nav-hr-color: #303a46

$nav-highlight-bar-active: #278efc
<nav-highlight-bar-inactive: #828890
<navpage-nav-selected-bg: #4B545F
<navpage-nav-selected-color: #ffffff
<navpage-nav-unselected-color: #bec1c6

$connect-latest-message: #cfd4d8
<navpage-nav-app-text: #cfd4d8
<navpage-nav-border: #ddd
<navpage-button-color: #fff
<navpage-button-color-hover: #7EC24F
```

### Default CSS styles for UI15

```
base.color: rgb(102, 153, 204)
base.font-family: arial

$color-darkest: #343d47
$color-darker: #485563
$color-dark: #81878e
$color-light: #bdc0c4
$color-lighter: #e6e8ea
$color-lightest: #ffffff

$color-positive: ${$color-green}
$color-warning: ${$color-orange}
```
# Banner branding styles

banner.background.attachment: scroll
banner.background.color: #FFF
banner.background.image: url("../images/s.gifx")
banner.background.position: center bottom
banner.background.repeat: repeat-x

# UI15 with Bootstrap

$navbar-default-bg: #f8f8f8
$navbar-default-color: #777777
$brand-warning: #df8a13
$brand-primary: #428bca
$brand-info: #5bc0de
$jumbotron-bg-color: #428bca
$panel-bg: #ffffff

$state-success-text: ${g_darken($color-positive, 25%)}
$state-success-bg: ${g_lighten($color-green-lighter, 20%)}
$state-success-border: ${g_lighten($color-positive, 30%)}

$state-info-text: ${g_darken($color-info, 25%)}
$state-info-bg: ${g_lighten($color-blue-lighter, 8%)}
$state-info-border: ${g_lighten($color-info, 30%)}

$state-warning-text: ${g_darken($color-warning, 25%)}
$state-warning-bg: ${g_lighten($color-orange-lighter, 10%)}
$state-warning-border: ${g_lighten($color-warning, 30%)}

$state-danger-text: ${g_darken($color-negative, 25%)}
$state-danger-bg: ${g_lighten($color-red-lighter, 8%)}
$state-danger-border: ${g_lighten($color-negative, 30%)}

Default CSS styles for UI11

base.color: rgb(102, 153, 204)
base.font-family: arial
base.font-size: 10pt
# application font size
menu.font-size: smaller

mobile.font-family: ${base.font-family}
mobile.font-size: ${base.font-size}

mobile.touch.font-family: ${base.font-family}
mobile.touch.font-size: 13pt

button.action.text.color: ${base.text.color}
button.action.background.color: ${base.color}
button.action.border.color: #666666
### Banner branding styles

- `banner.background.attachment: scroll`
- `banner.background.color: #FFF`
- `banner.background.image: url("../images/s.gifx")`
- `banner.background.position: center bottom`
- `banner.background.repeat: repeat-x`

### Body background color

- `body.background.color: ${base.background.color}`

### Table background color

- `table.background.color: ${base.background.color}`
- `table.column.head.background.color: ${base.background.color}`

### Button header style

- `button.header.text.color: ${base.text.color}`
- `button.header.background.color: ${table.column.head.background.color}`
- `button.header.border.color: white`
- `button.header.border.width: 1px`

### Label styles

- `label.text.color: black`
- `label.mandatory.text.color: ${base.text.color}`
- `label.mandatory_populated.text.color: ${base.text.color}`
- `label.foreign.text.color: black`
- `label.foreign.background.color: silver`
- `label.error.text.color: black`
- `label.error.background.color: khaki`
- `label.debug.text.color: black`
- `label.debug.background.color: khaki`
- `label.debug.success.text.color: black`
- `label.debug.success.background.color: #99FF33`
- `label.debug.failure.text.color: black`
- `label.debug.failure.background.color: #FF9933`

### List row styles

- `list.row.even.background.color: #EEEEEE`
- `list.row.highlight.background.color: #EEE`
- `list.row.even.text.color: ${list.base.text.color}`
- `list.row.odd.background.color: ${base.background.color}`
- `list.row.odd.text.color: ${list.base.text.color}`
- `list.row.low.background.color: khaki`
- `list.row.low.text.color: ${list.base.text.color}`
- `list.row.medium.background.color: orange`
- `list.row.medium.text.color: ${list.base.text.color}`
- `list.row.high.background.color: tomato`
- `list.row.high.text.color: ${list.base.text.color}`
- `list.row.survey.background.color: khaki`
list.row.survey.text.color: ${list.base.text.color}
list.row.list_add.text.color: ${list.base.text.color}
list.row.vertical.align: top

link.text.color: WindowText
link.column.header.color: ${base.text.color}
link.button.color: black
link.breadcrumb.color: blue
link.web.color: blue
link.navigation.link.color: blue

spellcheck.message.color: ForestGreen

banner.line.color: black

outputmsg.info.text.color: black
outputmsg.info.text.font-size: normal
outputmsg.error.text.color: black
outputmsg.error.text.font-size: normal

nav.menu.background.color: #eeeeee
nav.menu.text.color: black
nav.menu.border.color: #bbbbbb
nav.menu.border.width: 1px
nav.menu.width: 18%
nav.menu.width.right: 82%

contextmenu.background.color: menu
contextmenu.border.color: ${base.border.color}
contextmenu.border.width: 1px
contextmenu.text.color: black

slush.header.border.width: 1px
slush.header.border.color: #CCCCCC;
slush.header.background.color: #F0F0F0

treeview.cell.background.color: #f0f0f0
treeview.outerbody.border.width: 1px
treeview.outerbody.border.color: #D0D0D0
treeview.outerbody.background.color: #F0F0F0

filter.table.border.width: 1px
filter.table.border.color: ${base.border.color}
filter.table.background.color: #F0F0F0

report.table.background.color: #F0F0F0

olap.column.head.background.color: #dddddd
olap.column.head.text.color: black

assistant.box.border.width: 1px
assistant.box.border.color: #bbbbbb
assistant.box.background.color: #F0F0F0

nav_header.font-family: verdana, arial
nav_header.font-size: 24px
nav_header.background.color: ${base.color}
nav_header.text.color: ${base.text.color}
nav_header.margin-left: 16px

drag.section.border: #d5d5d5
drag.section.border.dark: #999999
drag.section.selected.border: #aabbdd
drag.section.dragging.border: #222222
drag.section.hilight.border: #00ff00
drag.section.hilight.neighbors.border: #ff9900
drag.section.top.background.color: #ebeeef
drag.section.header.background.color: #ebeeef
drag.section.header.active.background.color: #ccccff

table.white-space: normal
table.cell.padding: 2px

input.disabled.text.color: #444444
input.disabled.background.color: #f6f6f6

input.ref_dynamic.border.color: #00CC00
input.ref_invalid.border.color: #DC143C

textsearch.kb.background.color: #f0f7f9
textsearch.catalog.background.color: #f7f7f7

questionset.text.width: 250px
questionset.reference.width: 157px

user_image.max.height: 250px
user_image.max.width: 250px

# All the properties needs to be moved in a  new Table_UI_Properties file

# Tablet header and footer background
tablet.gradient.start: #666666
tablet.gradient.end: #111111

# Tablet header footer text color
tablet.headerfooter.text.color: #ffffff

script.editor.width: 80%

#mobile
m.label.color: #666
m.separator.color: #DDD
m.border-box: -moz-box-sizing: border-box; box-sizing: border-box;
m.context_menu.background: background: none repeat scroll 0 0 #FFFFFF;
m.context_menu.border: border-left: 1px solid darkgrey; border-right: 1px solid rgba(0, 0, 0, 0.2); border-radius: 4px;
m.context_menu.element.font: font-weight: bold; color: #000;
m.context_menu.element.padding: padding: 5px;
m.one-line-clipped: white-space: nowrap; text-overflow: ellipsis; overflow: hidden;

m.message.background.error: #F2DEDE
m.message.error: background-color: ${m.message.background.error}; border-color: #E9E9E9; color: #B94A48;
m.message.error: ${m.message.background.error}

m.message.background.info: #D9EDF7
m.message.info: background-color: ${m.message.background.info}; border-color: #BCE8F1; color: #3A87AD;
m.message.info: ${m.message.background.info}

m.message.background.warning: #FCF8E3
m.message.warning: background-color: ${m.message.background.warning};
border-color: #FBEED5; color: #C09853;
m.message.warning: ${m.message.background.warning}
UI properties

You can customize the following theming properties by navigating to System Properties > UI Properties.

- Icons used in the activity formatter
- Background colors for Additional Comments and Work Notes
- Button placement on forms
- Icons used in the Task Activity formatter
- Background colors for Incident Additional Comments and Work Notes

Jakarta CSS class support

In UI16, CSS properties and how they affect the platform UI change depending on the release.

<table>
<thead>
<tr>
<th>CSS class</th>
<th>Description</th>
<th>How to configure</th>
<th>Affected area</th>
</tr>
</thead>
<tbody>
<tr>
<td>$navpage-header-bg</td>
<td>Header background color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td><img src="service_now.png" alt="ServiceNow" /></td>
</tr>
<tr>
<td>$navpage-header-color</td>
<td>Color for header text and the global search icon</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td><img src="service_now.png" alt="ServiceNow" /></td>
</tr>
<tr>
<td>$navpage-header-button-color</td>
<td>Color for logged in user name text and Connect, Help, and settings icons</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td><img src="service_now.png" alt="ServiceNow" /></td>
</tr>
<tr>
<td>$navpage-header-divider-color</td>
<td>Header divider color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td><img src="service_now.png" alt="ServiceNow" /></td>
</tr>
<tr>
<td>$navpage-button-color</td>
<td>Color for the following icons in the sidebars</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td><img src="service_now.png" alt="ServiceNow" /></td>
</tr>
<tr>
<td></td>
<td>- Expand/collapse</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create a conversation (in the Connect sidebar)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Open Connect workspace</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$navpage-button-color-hover</td>
<td>Color for the following icons when a user points to the control:</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>• Global search</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Clear text icon in the navigation filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$search-text-color</td>
<td>Color of the search text, both in the navigation filter and the global search fields</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>$navpage-nav-border</td>
<td>Border color for the navigation filter</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>$nav-highlight-main</td>
<td>Highlights the module after the user has clicked it and in the Connect workspace, highlights the selected conversation.</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>$subnav-background-color</td>
<td>Background for expanded navigation items</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see <a href="#">Create or customize a theme</a>.</td>
<td>Incident, Create New, Create Major Incident, Assigned to me, Open, Open - Unassigned, Resolved, All, Overview, Critical Incidents Map</td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>$navpage-nav-bg</td>
<td>Header and footer for navigator and sidebars and the timestamp header background in the History tab.</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>CSS class</th>
<th>Description</th>
<th>How to configure</th>
<th>Affected area</th>
</tr>
</thead>
<tbody>
<tr>
<td>$navpage-nav-bg-sub</td>
<td>Background for navigator and sidebars</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
<tr>
<td>$navpage-nav-color-sub</td>
<td>Text color in main navigation</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td></td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>navpage-nav-mod-text-hover</td>
<td>Text color when hovering over items in the main navigation</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>nav-hr-color</td>
<td>Navigator separator color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
<tr>
<td>nav-highlight-bar-active</td>
<td>Line under the active tab in the application navigator</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td></td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>$nav-highlight-bar-inactive</td>
<td>Line under the inactive tabs in the application navigator</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see Create or customize a theme.</td>
<td></td>
</tr>
<tr>
<td>$navpage-nav-selected-bg</td>
<td>Navigation selected tab background color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
<tr>
<td>$navpage-nav-selected-color</td>
<td>Currently selected Navigation tab icon color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
<tr>
<td>$navpage-nav-unselected-color</td>
<td>Unselected navigation tab icon and favorite icons color</td>
<td>Navigate to System Properties &gt; Basic Configuration UI16</td>
<td></td>
</tr>
<tr>
<td>CSS class</td>
<td>Description</td>
<td>How to configure</td>
<td>Affected area</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>$connect-latest-message</td>
<td>Color of the latest message in the Connect workspace</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see <a href="https://service-now.com">Create or customize a theme</a>.</td>
<td></td>
</tr>
<tr>
<td>$nav-timeago-header-color</td>
<td>Timestamp header backgrounds in History tab</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>CSS class</th>
<th>Description</th>
<th>How to configure</th>
<th>Affected area</th>
</tr>
</thead>
<tbody>
<tr>
<td>$navpage-nav-app-text</td>
<td>Core content text color</td>
<td>Add the CSS property to the CSS field of a theme. For more information, see <a href="#">Create or customize a theme</a>.</td>
<td></td>
</tr>
<tr>
<td>$navpage-nav-app-text-hover</td>
<td>Core content text color when a user points to the main text</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

## Enabling accessibility features

You can configure accessibility features globally or for specific users. Users can also individually enable specific user preferences for themselves to make the platform more accessible.

The platform includes features that support [Web Content Accessibility Guidelines (WCAG) 2.0 level A](https://www.w3.org/WAI/WCAG20/quickref/) to make the interface more accessible to all users. These features improve the user experience when accessing the instance with screen readers and keyboard navigation.
Accessibility features are not enabled by default because some features are user specific. Administrators have the flexibility to enable features globally or for individual users.

All of these options can be configured globally or for specific users.

- Enable the accessibility option.
- Disable the list editor feature.
- Enable the high contrast theme.
- Use skip links.
- Disable first field focus

**Enable the accessibility feature for UI16 and UI15**

System administrators can enable accessibility for all users throughout the platform.

Users can enable accessibility on their own by selecting the **Accessibility Enabled** check box in the system menu. This enables accessibility for the current user.

Alternative text is included for images throughout the user interface. Settings control the rendering of alternative text for screen readers in place of images and allows skip links to work more effectively.

1. Navigate to **User Administration > User Preferences**.
2. Search for the glide.ui.accessibility preference.
3. Set the Value field to **true**.
4. Optional: To change this setting for a specific user, clear the System check box, then add a user in the user field.
   - Set up a new preference for each user you want to configure this option for.

**Disable the list editor feature**

The **glide.ui.list_edit** property controls list editing, which allows users to edit field values directly from a list without navigating to a form.

When accessing the instance with assistive technologies, disable this feature to allow users to tab between fields more quickly. The default value is **true**, which enables the list editor.

1. Navigate to **System Properties > UI Properties**.
2. Clear the check box for the **Enable list editing** property.
3. Click **Save**.
4. To disable the list editor for a specific user:
   a) Navigate to **User Administration > User Preferences**.
   b) Click **New** and configure the form using the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>list_edit_enable</td>
</tr>
<tr>
<td>System</td>
<td>Make sure the check box is cleared.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user you want to disable list editing for. Add a new user preference for each user you want to disable list editing for.</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
</tbody>
</table>
c) Click **Submit**.

Users may need to sign out and sign back in before the user preference takes effect.

---

**Enable the high contrast theme**

In UI16, administrators can enable the contrast UI theme for users who need a greater contrast in color.

**Role required:** admin

Individual users can enable the contrast theme for themselves by navigating to **System preferences > Theme** then selecting **Contrast UI**.

1. Navigate to **User Administration > User preferences**.
2. Click **New** then configure the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.css.theme.ui16</td>
</tr>
<tr>
<td>System</td>
<td>Make sure the check box is cleared.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user you want to enable the contrast UI theme for. Add a new user preference for each user you want to enable the theme for.</td>
</tr>
<tr>
<td>Type</td>
<td>string</td>
</tr>
<tr>
<td>Value</td>
<td>The sys_id of the contrast UI theme. You can find this by navigating to <strong>System UI &gt; Themes</strong>. Then right-click <strong>Contrast UI</strong> and click <strong>Copy sys_id</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

The user may have to sign out and sign back in for the theme to take effect.

---

**Use skip links**

Skip links allow users to quickly navigate to the main content on a page, list, or form, bypassing icons, banner text, navigation links, and other elements.

The user interface includes skip links to the navigation menu, the content pane and, in UI11, to the form currently displayed in the content pane. If accessibility is not enabled, users can also use skip links to activate accessibility.
Skip link

- **Enable Accessibility**: Enables accessibility. This skip link only appears if the user has not yet enabled accessibility. Pressing enter refreshes the page with accessibility enabled.
- **Skip to navigator**: Skips to the navigation filter in the application navigator.
- **Skip to main content**: Skips to the first selectable field or link in the main content pane.
- **View tasks as a list**: In a visual task board, switches all the task cards to the table view. For more information on viewing task boards in a list view, see View a task board in a list.
- **Skip to Form Content**: in UI11, skips to the first selectable field in the open form pane. If the form pane is not open, this link does not work.

**Attention**: Enable the accessibility feature in order for skip links to work.

When selected, skip links appear in the upper left corner of the user interface.

- Use the Tab and Shift+Tab keys to move forward and back through the skip links and other selectable fields.
- When a skip link is highlighted (outlined in blue), press Enter to select the link.

**Disable first field focus**

When a form loads, the system automatically sends focus to the first field on the form. For accessibility reasons, you can disable this option so that focus starts on the first element on the top of the page.

Role required: admin

1. Navigate to User Administration > User Preferences.
2. Search for glide.ui.accessibility.focus_first_field.
3. Set the Value field to false.
4. Optional: To change this setting for a specific user, clear the System check box, then add a user in the user field.
   
   Set up a new preference for each user you want to configure this option for.

**Using accessibility features**

Accessibility features include keyboard navigation, color and style settings, using a screen reader, and search methods.

**Keyboard accessibility**

The Now Platform is designed to be as accessible as possible without user modification or setting changes. Users can tab through the platform UI without enabling accessibility. However, without
accessibility enabled, tabbing goes from input to input and skips other items on a form, such as reference icons.

Tab-through provides the following options:

- Use skip links to shift focus to different parts of the page without tabbing through every element.
- On edit pages such as forms, the keyboard focus starts at the first editable field on the page.
- If the `glide.ui.accessibility.focus_first_field` user preference is enabled, page focus starts at the first input field at the top of the page content section. In a table, this field is usually the search option. In a form, the field is the first input field in the form.
- Use tab-through and arrow keys to move items around in a slushbucket
- When focused on tabs, use right/left arrow keys to switch tabs
- Arrows keys work within menus to navigate between entries
- On tab-through for a list, the option to enable the Edit table data inline appears, so you can use the list editor, rather than opening the form.
  - When inline edit mode is enabled, screen focus shifts to the first cell in the table.
  - Press the Escape key while a cell is selected to exit inline edit mode. Focus still remains on the cell.
  - Use the arrow keys (in addition to tabbing) to move around the list in inline edit mode.
- If accessibility is enabled, a help icon appears with the HTML field. The help icon indicates how to access and escape the HTML field toolbar.

**Color and style accessibility**

There are several color and style changes that make the platform more accessible.

**Enable the Contrast UI theme**

In the system settings, on the themes tab, select the Contrast UI theme. The Contrast UI theme provides a higher contrast range of colors for the platform UI.

In Service Portal, you can apply the Stock - High Contrast theme to a portal for a higher contrast color range. Portal users also have the option to enable a contrast theme using the Accessibility option in the User Profile widget.

**Patterned charts and graphs**

View charts and graphs that rely heavily on color with patterns in addition to colors. Navigate to System settings > General, then select Data visualization patterns enabled.
Screen reader accessibility

Screen elements in the platform have enhancements that make them accessible to screen readers.

Use NVDA, JAWS, or VoiceOver for non-visual access to the platform.

Skip links allow you to tab straight to the main content instead of tabbing through all the other elements on the page.

When a page reloads or search results display, screen readers inform the user.

Important images and field indicators, for example, status indicators for avatars in list v3, have alternative text for screen readers to read.

In order to reduce confusion when tabbing through modules, the edit application/edit module and add to favorites icons are now inaccessible to screen readers.

In Service Portal, users can add alternative text to containers in their own portal for screen readers to read.

Elements such as links or button are listed as such for screen reader awareness.

Accessibility search methods

There are several ways to search for information in the user interface.

- When a list opens, focus starts in the search field. Tab or shift+tab to navigate away from the search, or start typing while focus is in the search field.
- List views include a Go to search field in the list title bar. Using the * wildcard character in the search text allows you to perform a contains search rather than a starts with search. This type of query may take a little longer to run but can save keystrokes. You can also use several other wildcards with list searches.
- The navigation filter in the application navigator filters the applications and modules that appear in the navigator based on the entered text. Tab through or use skip links to navigate directly to the navigation filter. To open a module, click the module name, or press the Down Arrow to highlight the module name, and then press Enter.

See Available search options for more information about these search methods.

Create a company profile

To customize the ServiceNow instance for your company, you can enter information such as contact phone numbers, street address, and additional notes. You can also customize the company logo and banner text your end users see at the top of each page.

Role required: admin

Much of the company information that you enter is reference information that administrators can view. All users see the company logo and banner text. To see all company information, verify that you are in the My Company view.
My Company view selection

1. Navigate to System Properties > My Company.
2. To change the banner text, update the Banner text field.
3. Select the Primary check box to indicate if this company is the primary company.
   If needed, configure the form to add the Primary check box. Designate only one company in your system as the primary company.
4. To upload your company logo, complete one of the following steps for your version of the UI.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td>Click [Click to add] or [Update] beside UI16 Banner Image.</td>
</tr>
<tr>
<td>UI15 or UI11</td>
<td>Click [Click to add] or [Update] below the Banner image field.</td>
</tr>
</tbody>
</table>

If you leave the banner image blank for either UI16 or UI15, the system uses the image used in System Properties > Basic Configuration > Banner image (glide.product.image) as the default.
5. Click Choose file and select the file, and then click OK.
   To use an image URL instead of a file on your hard drive, enter the URL in the file upload window.
6. Complete the image URL instead of a file on your hard drive, enter the URL in the file upload window.
6. Complete the form with remaining company information.
7. Click Update.
Banner logo link

Properties are available to control the URL and target frame used when clicking the banner logo.

- **glide.banner.image.url**: URL used when clicking the banner image
- **glide.banner.image.url_target**: Target frame used when clicking the banner image
  - `gsft_main` for the main frame
  - `_top` to replace the current browser window
  - `_blank` for a new window/tab

Customize the banner logo

Use the `glide.product.image` and `glide.product.description` properties to change the banner logo and description.

Role required: admin

To update the banner image in the **System Properties > System** page, you must first upload the image.

**Note:** Setting a banner image in the company profile overrides the image selected in **System Properties > System**.

1. To upload the image, complete the following steps.
   a) Navigate to **System UI > Images** and click **New**.
   b) Enter a **Name** for your image.
      Valid names must end in `.gif`, `.png`, `.jpg`, or `.bmp`.
   c) Click the **Click to add** link in the **Image** field, and select and upload the image.
   d) Click **Update**.

2. To set the uploaded image to the banner image, complete the following steps.
   a) Navigate to **System Properties > System**.
   b) In the **Banner image** field, enter the file name of the uploaded image.
   c) Click **Save**.

**Note:** The system limits banner images to 50px.

Customize the favicon

Use the `glide.product.icon` property to change the icon that appears in bookmarks and the browser address bar.

Before you can update the favicon, you must upload the image into the database.

Role required: admin

1. To upload the image, complete the following steps.
   a) Navigate to **System UI > Images** and click **New**.
   b) Enter a **Name** for your image.
      Valid names must end in `.gif`, `.png`, `.jpg`, `.ico`, or `.bmp`. 
c) Click the **Click to add** link in the **Image** field, then select and upload the image.

d) Click **Update**.

2. To set the uploaded image to the favicon, complete the following steps.
   a) Navigate to **System Properties > System**.
   b) In the **Icon image displayed in the bookmarks and browser address bar** field, enter the file name of the uploaded image.
   c) Click **Save**.

The favicon appears in the bookmarks and browser address bar for the platform or the Content Management System (CMS). For more information on how to change the favicon for Service Portal, see **Create a service portal and its branding**.

**Examples of how to modify the banner**

There are various ways that you can modify the banner on your instances.

**Label multiple instances differently**

- On all instances, leave **glide.product.description** <blank>
- On PROD instance, set **glide.product.name** to <My Company>
- On DEV instance, set **glide.product.name** to <My Company - DEV>

**Control the window title**

Since the window title is composed of **glide.product.name** and **glide.product.description**, the following gives you complete control over the banner and the window title.

- **glide.product.name** set to <Window Title that you want>
- **glide.product.name.style** set to <display: none>
- **glide.product.description** set to <blank>

The company record **Banner Image** and **Banner Text** are used to set the banner image and text since the company banner text is not used in the window title.

**Use HTML in the banner text**

- **glide.product.name** set to <My Company>
- **glide.product.name.style** set to <display: none>
- **glide.product.description** set to <Some text <a href="some_url">Click here</a>>

**Position banner text over the banner image**

- **glide.product.name** set to <My Company>
- **glide.product.name.style** set to <display: none>
- **glide.product.image** set to <your company logo.gif>
ServiceNow™ Jakarta Now Platform User Interface

- **glide.product.description** set to <Some text for the description>
- **glide.product.description.style** set to <position:absolute; top:5px; left:100px> (position values may vary based on specified needs)

### Apply a background image to the banner

Often corporate guidelines require more in-depth branding of the ServiceNow interface. Using the tiling technique, you can modify your logo image to have a transparent background, so that you can apply another image to the banner beneath the logo.

Upload an image to the image manager and then create a new property named **css.banner.background.image**, so that you can call the image. The value should look like this.

- **css.banner.background.image** value url('./images/MasterBG.jpgx®)

### Write CSS rules that apply this change

```css
/** BACKGROUND - These properties allow you to add a background tile to the header of the instance **************************/
TD.bannerLeft, TD.bannerCenter, TD.bannerRight, TR#banner_row{background-color: ${banner.background.color};
background-image: ${banner.background.image};
background-position: ${banner.background.position};
background-repeat: ${banner.background.repeat};}
```

**Note:** The banner image and banner text associated with the primary company or specific companies may be used instead of the **glide.product.image** and **glide.product.description** properties to get the same effect.

### Modify the banner

The banner is displayed at the top of the page and is rendered using certain system properties.

- **glide.product.image**
- `<div>glide.product.name</div>`
- `<div>glide.product.description</div>`

The DIV that contains the **glide.product.name** property is only shown if the property contains a value, otherwise, it is not used when rendering the banner. Also, the property **glide.banner.image.title** controls the tooltip that appears when the cursor is over the banner.

**Note:** The My Company record overrides the properties.
Window title

These properties are used to set the window title as follows:

`glide.product.name` `glide.product.description`

If `glide.product.name` is blank, then the ServiceNow name is used as the product name for the window title.

My Company

The banner text and banner image defined for the Company that a user is assigned to may be used to override the `glide.product.image` and `glide.product.description`. The banner text, if specified, is used instead of the `glide.product.description` property. The banner image, if specified, is used instead of the `glide.product.image` property.

Style the banner in UI15

The `glide.product.description` property and the company banner text field may contain HTML if necessary to allow links, color, and so on, to be shown in the banner.

Role required: admin

Use the `glide.product.name.style` property to set CSS properties for the DIV used to display the product name in the banner. Often, this style is set to `display: none` so that the product name is not displayed, but is still used as part of the window title.

Use the `glide.product.description.style` property to set CSS properties for the DIV used to display the product description in the banner, or company banner text.

You can also use CSS properties to change the banner background and text color by completing the following steps.

1. Navigate to System Properties > CSS.
2. In the Banner and list caption background color field, enter the color you want to apply to the banner.
3. In the Banner text color field, enter the color you want to apply to the banner text.
4. Click Save.

Comparing field values

Field comparison allows users to evaluate equality between fields on the same table or on related tables by using operators in the condition builder.

Also, you can compare date type fields to determine whether the values are within a certain range of each other. For example, you can compare the planned start date of a task to the actual start date. You can use field comparisons in a list view and to generate reports.

The primary function of field comparison is evaluating whether two fields on a record or related record have identical values. For example, you can create a filter to display all incidents whose Caller field references the same user record as the Closed by field.

Available operators

Field comparison provides several filter operators for comparing field values.
• **(is same)** if two field values are the same, evaluates to true.
• **(is different)** if two field values are not the same, evaluates to true.
• **(is less than)** if two date values are within a user-defined range of each other, evaluates to true.
• **(is more than)** if two date values are not within a user-defined range of each other, evaluates to true.

### Comparing choice list values

Field comparison compares the dictionary **Value** field of a choice list, not the **Label** value. For example, a high priority incident has a priority value of 1, not 1 - High. To find the **Value** of a choice, right-click the field label and select **Configure Dictionary**. The **Choices** related list shows the **Value** for each choice.

### Comparing empty fields

By default, most filter operations do not return empty fields in their result set. To include records with empty fields in a result set, add a filter condition for the left operand with an operator of **(is empty)**. For more information, see Filtering on empty fields.

### Using operators and operands

When comparing fields, the two fields being compared are called the left operand and right operand. The type of field selected in the left operand, and the operator selected, determine which right operands are available. When using the **(is same)** or **(is different)** operators, the right operand choices include only fields of the same field type, such as **String** or **Integer**, as the left operand.

For example, a filter on the Task (task) table with a left operand of **(Opened by)** and an operator of **(is same)**, only allows you to choose user reference fields, such as the **(Closed by)** field, in the right operand.

The **(is more than)** and **(is less than)** operators are only available with date type fields.

This example filter returns records where the user who opened the record also closed the record.

---

Example filter

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Comparable fields

Field comparison supports the comparison of several fields. The fields that are comparable include the following types:

- String, choice, integer, and boolean fields: Return true if both values match.
- Reference fields: Return true if both reference fields refer to the same record.
- Date and time fields: Can match date values based on hour, day, week, month, quarter, or year. Also, you can evaluate whether two dates fall within a certain range of each other.

Note: Field comparison does not support journal, keyword, script, duration, list, or HTML fields.

Comparing dates

Date comparison allows you to evaluate equality between two components of the date, such as the hour of the day or the date within a month. Also, you can evaluate if two dates fall within a certain range of each other.

Date comparisons are based on the active user’s time zone. For example, as a user in the PST time zone, a filter of (Created) (is same) (Day) as (Closed) evaluates true for an incident created at 6 AM PST and closed at 3:00 PM PST as both times are within the same day. However, a user in the GMT time zone would not see this same incident record in response to the example filter; in GMT those times do not fall on the same date.

You can evaluate equality between date values and you can evaluate unequal dates within a range.

Evaluate unequal dates within a range

For example, you can create a filter of (Created on) (is more than) (3) (Months) (before) Closed to display all records that were created at least three months before they were closed. The numerical value specified, such as the value 3 in the example, must be an integer of no more than two digits. For evaluations of differences larger than 99 units, select a less granular unit of time, such as Months instead of Days.
Unequal dates field comparison

Choice field date comparison choices

<table>
<thead>
<tr>
<th>Choice field</th>
<th>Date Comparison Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>is more than, is less than</td>
</tr>
<tr>
<td>Unit of time</td>
<td>Hours, Days, Weeks, Months, Quarters, Years</td>
</tr>
<tr>
<td>Relative position of dates</td>
<td>before, after, before or after</td>
</tr>
</tbody>
</table>

Evaluate equality between date values

Date comparison evaluates a match for one of several date increments.

You can specify granularity to the hour, day, week, month, quarter, or year. For example, the filter (Created on) (is same) (Week) as (Closed) returns records that were closed in the same week that they were opened. When you run this type of filter, be sure to specify the year in an additional filter condition of (Created) (is same) (Year) as (Closed) to eliminate records that were created a year before they were closed.
**Date field comparison**

1. In the condition builder, create a new condition.
2. Select a date field from the left operand choice list.
3. Select *(is same)* or *(is different)* from the operator choice list.
   An additional choice list appears.
4. Select the granularity from the date range choice list.

**Date range descriptions**

<table>
<thead>
<tr>
<th>Date Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour</td>
<td>Filters on the hour of the day.</td>
</tr>
<tr>
<td>Day</td>
<td>Filters on the day of the month, not the date. For example, a Day value of the 1 of August matches with a Day value of the 1 of September.</td>
</tr>
<tr>
<td>Week</td>
<td>Filters on the week of the year. ServiceNow defines a week as Sunday through Saturday for the purposes of Field Comparison.</td>
</tr>
<tr>
<td>Month</td>
<td>Filters on the month of the year. For example, any date within December returns the 12 month of the year.</td>
</tr>
<tr>
<td>Quarter</td>
<td>Filters on the quarter of the year.</td>
</tr>
<tr>
<td>Year</td>
<td>Filters on the year.</td>
</tr>
</tbody>
</table>

5. Select a different date field from the right operand choice list.
6. Click *Run*.

**Add help to a field label on a form**

You can create field-level help in forms by placing help icons in individual fields and converting the field labels to links to external or internal URLs.

Role required: personalize_dictionary

You can link to any type of file, document, or wiki, and open it in a separate browser window. The following is an example of a form with field label help enabled.
Field label help enabled

1. Open the form.
2. Right-click the label for the field and select Configure Label.
   The Field Label form appears. The fields in the top portion of the form are pre-populated. The Help field is not currently used.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Type text to use as a tooltip that appears when a user places the cursor on the field label.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL of the target file to open when the field label or icon is clicked. This can be a complete URL to a file outside the instance, or a relative URL to a target on the instance.</td>
</tr>
<tr>
<td>URL target</td>
<td>(UI11 only) Type _blank to have the help file open in a new tab, or leave the field blank to have the help file replace the instance in the browser. In UI16 and UI15, the help file opens in a new tab regardless of the URL target value.</td>
</tr>
</tbody>
</table>

4. Click Update.
Homepage administration

A homepage is a ServiceNow interface that consists of navigational elements, functional controls, and system information. Responsive and non-responsive dashboards provide a similar interface with additional functionality.

When a user logs in to an instance, the default homepage defined for their role appears unless the user has switched to a different homepage. Administrators can customize several settings for homepages, including settings that control read or write access for any homepage and how homepages render.

Dashboards encapsulate homepage functionality. If dashboards are enabled, you can **Set dashboards as your Home**.

**Note:** Web Content Accessibility Guidelines (WCAG) 2.0/Section 508 features do not work with homepages. These features only work with dashboards. To convert your homepages, see [Create a dashboard version of a homepage](#).

Administrators can also perform the following actions for homepages.

- Create new global homepages for all users or specific homepages for users with a specified role.
- Specify an alternate login landing page that appears instead of a homepage.
- Configure the homepage splash page, which is a lightweight page that loads before a homepage loads.

**Note:** If you are using responsive dashboards, you can convert your homepage to a dashboard. Advantages include new sharing functionality and easier layout management. See [Create a dashboard version of a homepage](#). Navigate to [System Definition > Plugins](#) to activate the Responsive Dashboards plugin.

Restrict content additions to a homepage

By default, anyone with a role can add content to a homepage.

If the user does not have permission to edit the homepage, the edits are applied to a homepage specific to the user. You can restrict who can add content to homepages by modifying the following property under the [Homepage Admin > Properties](#) module.

**Note:** The option **Add to homepage** does not take into account the property `cms.glide.add_content`. This means that users can add reports to any homepage they can view. The result is that users create new homepages with the added information when they modify a homepage that they don’t own.
Secure a homepage

Homepages have two types of roles: read and write. Read roles limit who can view the page. Write roles limit who can make edits to the page, such as adding and moving widgets or deleting the homepage.

Role required: admin

Note: If no write roles are specified on a homepage, then any user with one of the specified read roles may access this page and delete it.

Note: The option Add to homepage does not take into account the property cms.glide.add_content. This means that users can add reports to any homepage they can view. The result is that users create new homepages with the added information when they modify a homepage that they don’t own.

1. Navigate to Homepage Admin > Pages.
2. Select the homepage you want to secure.
3. Click the edit icons next to Write roles or Read roles.
4. Move the roles you want to restrict homepage access to from the Available column to the Selected column.
5. Click Done.
6. Click Update.

Homepage user preferences

You can set your homepage user preferences.

After users have selected a homepage to view, their homepage preference is stored in User Administration > User Preferences in a preference named homepage. The value of the preference is the sys_id of the homepage the user sees. You can access a list of homepages by navigating to Homepage Admin > Pages.

Users must have at least one role to view homepages.

Add a homepage to an update set and application

You must manually add homepages and content pages to update sets prior to distribution.

Role required: admin
After inclusion, the update set always uses the current version of the page and does not require additional action. Applications automatically include any homepages and content pages that are created within or associated to an application.

1. Navigate to Homepage Admin > Pages.
2. Right-click a homepage record.

The page is added to the current update set.

Add existing reports to a homepage

Add reports to homepages to share them and make them easily accessible.

1. Navigate to a homepage.
2. Click Add content.
3. Select Reports in the left column.
4. Select the table the report is based on in the middle column.
5. Select the report in the right column.
6. Click Add here where you want to place the report on homepage.
7. To add more reports, repeat steps 3 through 6.
8. Click the close icon (×) in the top right corner when you finish adding reports.

Arrange objects on a homepage

Arrange widgets on custom homepages to customize your experience. You can always restore the homepages to the arrangement your system administrator created.

- Moving widgets - Click, hold and drag near the top of a widget to move it another area. Objects in the top or bottom areas display at 100% of the available width. Widgets in the right, left, or center areas display at 50% of the available width. If widgets are added to all these areas, they display at 33% of the available width.

- Removing widgets - Click the icon to remove a widget.

URL widget variable height workaround

URL widget can be used to display a different web page or website as part of a homepage.

URL widgets are set with a fixed height, so you might have to scroll to see the entire web page in the widget. URL widget widths are set by the positioning of the widget on a particular homepage. You cannot modify URL widget height, but you can set up an iFrame in a UI page to manage the height.

1. First, create a UI page. The UI page name must start with render_gadget_ (for example, render_gadget_iFrameSNC). Add the following to the HTML field, replacing the src with the URL that should appear in the iFrame. The height you specify must be a static value and you must use CSS style tags.

```
<iframe id="myframe" src="http://www.service-now.com" scrolling="yes"
        style="height:450px; width:100%"></iframe>
```
2. Next, navigate to **System UI > Widgets** and create or modify a widget to use for selecting your UI page from the **Add content pop-up window** on a homepage. The widget script must reference your UI page. The widget **Name** must be the name of the category in the **Add content** pop-up window. For **Renderer type**, select **JavaScript**. The following script can be added to the **Script** field to create a new widget.

```javascript
function sections ( ) {
  return { 'ServiceNow' : { 'type' : 'iFrameSNC' } });
}

function render ( ) {
  var scope = gs.getCurrentScopeName();
  var type = renderer.getPreference('type');
  return renderer.getRenderedPage(scope + type);
}

function getEditLink ( ) {
  var scope = gs.getCurrentScope();
  var type = renderer.getPreference('type');
  return "sys_ui_page.do?sysparm_query=name=render_gadget_" + scope + type;
}
```

3. When the widget is saved, go to any homepage and add the new content.

### Count gauge colors

In a count gauge, the count item color is based on the upper and lower limit values on the gauge panel.

The following colors are used:

- **Red**: If the count result is greater than or equal to the upper limit.
- **Orange**: If the count result is between the upper and lower limit.
- **Green**: If the count result is less than or equal to the lower limit.

You cannot customize these colors.

The upper and lower limit fields are in the Gauge (sys_gauge) table. You can configure the Gauge form to add these fields.

### Ensure domain separation on a gauge

To ensure domain separation on a gauge when the MSP Extensions plugin is not installed, a domain field must be added to the table for gauges and gauge counts. This domain field must then be set as a reference field.

By default, the Domain Support plugin separates data on certain tables by domain. It does not separate gauges by domain unless the MSP Extensions plugin is installed. The gauge displays data only from the user's domain, but the user is able to see the entire gauge.

Follow these steps to ensure domain separation on gauges if the MSP Extensions plugin is not installed.

1. Navigate to **System UI > Gauges** and select a gauge to separate by domain.
2. **Configure the form layout** and add a new field named **sys_domain**.
3. Configure the dictionary on the **sys_domain** field and fill in the **Reference** field with the domain for this gauge. If left blank, the gauge is global.
4. Select a gauge count record under the gauge related lists.
5. Repeat steps 2 and 3.

Domain fields appear on gauges and gauge counts, and the field references a table. After a domain field exists on a form, all records within the table will have the domain field enabled. By default, these records are global.

Set a default view for a gauge

Use a system property to change the default view for a gauge.

Role required: admin

The default property view value for a gauge on upgraded instances is Portal. For new installs or zBoot instances, the default property value is blank.

1. Enter sys_properties.list in the Navigation filter.
2. Search for the property glide.ui.gauge.view.
3. In the Value field, type the name of the gauge view you want as the default.

Top Searches homepage

The Top Searches homepage displays the most popular searches over the past hour, day, week, or month. The homepage includes widgets for specific tables and across the entire instance.

- Users with the itil role can view the homepage by default. To control access to the page, administrators can secure the homepage.
- Users can add any of the top searches widgets to their homepages. Administrators can control who has access to top searches widgets.
- Users can select the time period for which to view top searches and perform searches directly from the widget.

Use a top search widget

Top searches widgets display the top 10 searches over the past hour, day, week, or month for the specified table or across the entire instance (All).

Take either of the following actions to use a top searches widget.

- Click the desired time period for which to see top searches (default is Day). You can change the time period at any time, and your most recent selection is loaded the next time you view the homepage.
- Click any item on the list to search for it. The Top Searches - All widget performs a global search and a table-specific widget performs a search of the table or application. For example, knowledge searches return knowledge base search results.

Note: Each user’s time period selection is stored by the top_searches.period user preference.

Add a top search on a homepage

You can add a top searches widget to a homepage.

1. On a homepage, click Add content.
2. Select Text Search from the left panel and Top Searches from the middle panel.
3. Select the desired top search widget from the right panel.
4. On the bottom of the window, click **Add here** in the appropriate layout position, and then close the window.

5. Select the time period for which you want to see the top searches (default is Day). The widget displays the top 10 searches for the selected time period.

### Control access to a top search widget

You can control who has access to top searches widgets by restricting who can add content to homepages or by applying roles to the widget.

**Role required:** admin

1. Navigate to **System UI > Widgets**.
2. Select **Text Search**.
3. Click the edit user roles icon and select the required access rights, then click **Done**.
4. Click **Update**.

### Define a table for a top search

You can define the tables for which top searches widgets are available.

**Role required:** admin

1. Navigate to **System Properties > Text Search**.
2. Enter the tables for which you want top searches widgets in the **Comma-separated list of table names which will have home page top searches widgets available for them** field (the `glide.ts.widget.top_search_tables` property).

   The default tables are Knowledge, Problem, Incident, Change Request, Catalog Item, and Live Message (kb_knowledge,problem,incident,change_request,sc_cat_item,live_message).

   **Note:** Adding a parent table includes all searches on tables that extend the parent table. For example, if you add Task, then all Incident, Problem, and other task tables are included.

3. Click **Save**.

### View user preference for time period

Each user’s time period selection is stored with a user preference.

- **`top_searches.period`**: stores the user’s selection for the **Top Searches - All** widget.
- **`top_searches.period.<table name>`**: stores the user’s selection for the **Top Searches - <Table>** widget. For example, **`top_searches.period.kb_knowledge`** stores the user’s preference for **Top Searches - Knowledge**.

1. To view user preferences, navigate to **User Administration > User Preferences**.
2. Find the top searches preferences.
3. Make the necessary changes to the user preferences and save the record.

### Update a top search statistic

Top search statistics are compiled on an hourly basis by the TS Search Summary scheduled job.

**Role required:** admin
Use the following procedure to manually refresh the list.

1. Navigate to **System Scheduler > Scheduled Jobs > Scheduled Jobs**.
2. Open **TS Search Summary**.
3. Change the date and time in the **Next action** field to run the scheduled job at the specified time.
   For example, if it is currently 9:48 AM and you want to run it immediately, set the date to today and the time to 10:00.

   **Note:** This scheduled job is designed to collect hourly data. For optimal data accuracy, do not run this job more frequently.

4. Click **Update**.

**Custom homepage widgets**

There are a number of widgets provided out-of-box to be added to a homepage, but administrators can also create their own widgets.

To create a widget, an administrator must first create a UI page to control its functionality. UI pages are coded in either HTML or Jelly script, and will power the functionality of the widget.

Creating a UI page is outside the scope of this article. However, once the UI page exists, it will be used to render the widget. It is very easy to create a trivial UI page named "my_ui_page" with a single line of text, add it to a homepage, and see how it renders.

After the UI page is scripted, create a widget that renders the UI page and executes its script.

**Create a widget that displays a ServiceNow UI page**

You can create ServiceNow UI page that displays a web page, then make the UI page into a widget that can be added to dashboards and homepages.

Role required: admin

A UI page is a ServiceNow page that is not a list or a form. Certain UI pages, such as external site widgets or gadgets, do not display properly when placed in a dashboard.

**Note:** This functionality requires a knowledge of JavaScript.

1. Create or find a ServiceNow UI page that you want to display as a widget. Note the name of this UI page, to use in Step 4.

   For example, this HTML displays the ServiceNow landing page in an iframe.

   ```html
   <iframe id="myframe" src="http://www.service-now.com" scrolling="yes" style="height:100%; width:100%"></iframe>
   ```

2. Navigate to **System UI > Widgets** and click **New**.

   **Widgets** records are widget category records, not records for individual widgets. When adding a widget to the dashboard, first select the category and then the widget. The javascript you specify in step 4 contains the list of widgets to include in that category.

3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of this widget category. The user selects this category when adding its widgets to a dashboard.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Renderer Type | Select Javascript.
Active | Clear to make the widget unavailable to add to dashboards.
Roles | Select roles that can see this category when adding widgets to dashboards. If no roles are selected, all roles can see the category.

4. Add the following javascript in the Script field, making replacements as specified. The return statement contains the widgets that are listed in this widget category.

```javascript
function sections() {
    return {
        'widget_name': { 'uiPageName' : 'UI_page_name'},
        'widget_name2': {'uiPageName': 'UI_page_name'}
    };
}

function render() {
    var uiPageName = renderer.getPreferences().get("uiPageName");
    return renderer.getRenderedPage(uiPageName);
}

function getEditLink() {
    return "sys_ui_page.do?sysparm_query=name=" +
    renderer.getPreferences().get("uiPageName");
}
```

5. Click Submit.

To learn how to make a UI page without using a framework page template, see the Making a UI page without using the framework page template blog posting by a developer in the ServiceNow Community.

Create a new personal homepage

Users with at least one role can create new personal homepages that are visible to themselves. You can create a new personal homepage with no content on it, or you can create a new homepage that uses the content of an existing page. Either way, the personal homepage is only visible to you by default unless the administrator makes your homepage global. Note that dashboards provide an easier interface for creating, organizing and sharing content. For more information, see Working with responsive dashboards.

Note: Web Content Accessibility Guidelines (WCAG) 2.0/Section 508 features do not work with homepages. These features only work with dashboards. To convert your homepages, see Create a dashboard version of a homepage.

1. Navigate to Self-Service > Homepage to open your current homepage.
2. Click the new page icon ( + ).  
Your new homepage appears with a single dropzone.

3. Add content as needed.

Create a personal homepage based on an existing homepage

Users with at least one role can create personal homepages based on existing homepages that are visible to themselves.

**Note:** Web Content Accessibility Guidelines (WCAG) 2.0/Section 508 features do not work with homepages. These features only work with dashboards. To convert your homepages, see Create a dashboard version of a homepage.

1. Navigate to any existing homepage that you have access to.
2. Change the layout of the homepage or add new content.

The system automatically creates a homepage with the title My Homepage, indicating that the homepage is a personalized one. Any changes you make are applied to the personalized homepage, not the global version.

Create a global homepage or a homepage for specific users

You can create and edit a global homepage that is accessible to all users, or homepages that are accessible to users with specific roles.

Role required: admin

1. Navigate to the Homepage Admin > Pages.
2. Click New.
3. Complete the form.

**Portal page fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the title of the homepage that appears at the top.</td>
</tr>
<tr>
<td>Selectable</td>
<td>Select this option to make the homepage appear in the Switch to page choice list for users. If you specify a user or a role, only the specified user or the users with the specified role can see the page in the choice list.</td>
</tr>
<tr>
<td>View</td>
<td>Enter a unique value that you can use when referencing a global homepage in a URL or module. The View value must be unique. Otherwise, if the View is used by multiple homepages, the Edit Homepage link may not redirect to the current homepage record. Specify a view to be able to edit the homepage for all users who can access it.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| User         | If you want the homepage to be a personal homepage for a specific user, select it here. Clear this field to keep the homepage global or if you want to specify the roles that are required to access the homepage.  
**Note:** If this field is populated, the homepage cannot be global.                                                                                                                                                                                                                                                                                                                                                   |
| Order        | Enter a value that specifies where in the choice list of homepages that this page appears. Lower values move the page up the choice list.                                                                                                                                                                                                                                                                                                                                                   |
| Write roles  | Specify the roles you want users to have to edit this homepage. Write roles limit who can make edits to the page, such as adding and moving widgets or deleting the homepage. For more information, see Secure a homepage.  
**Note:** Users who only have Read access create new versions of a homepage when they edit the homepage.                                                                                                                                                                                                                                                                                                                  |
| Read roles   | Specify the roles you want users to have to view this homepage. Read roles limit who can view the page. The **User** field takes precedence over this field. If you specify a user in the **User** field, only that user can view the homepage, regardless of what roles you add here and regardless of what role that user has.  
**Note:** Users who only have Read access create new versions of a homepage when they edit the homepage.  
**Note:** If no write roles are specified on a homepage, then any user with one of the specified read roles may access this page and delete it. For more information, see Secure a homepage.                                                                                                                                                                                               |

4. Right-click the header and select **Save**.  
5. Click the **Edit Homepage** related link to see the homepage.  
6. **Add content** as needed.  

**Note:** Click **Edit Homepage** to make changes to a global homepage that take effect for all users who can access the homepage. If you click **View Homepage** and make changes, a personal homepage is automatically created for you and those changes take effect only on that personal homepage. To see the **Edit Homepage** link, you must enter a value in the **View** field.
Portal Page form for the asset overview homepage

### Related links

<table>
<thead>
<tr>
<th>Edit Homepage</th>
<th>Edit the homepage as a global homepage. Any changes you make when editing the homepage are visible to all users who can access it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Homepage</td>
<td>View the homepage as a user would. Any changes you make when viewing the homepage automatically create a personalized version of the homepage.</td>
</tr>
</tbody>
</table>

**Note:** You can also add the homepage as a module link in the application navigator.
The new homepage is available in the Switch to Page choice list for the users you specified or for all non-ESS users if the homepage is global.

Create a dashboard version of a homepage

To take advantage of responsive dashboard functionality, you can migrate your existing homepage to a dashboard.

Users with any role can copy their own homepage to a dashboard. Users with the admin role can create dashboard versions of any homepage.

Advantages of dashboards include:

- Responsive design – The widgets on a dashboard are optimized for the screen you are using: desktop, tablet, or mobile phone.
- Drag-and-drop widgets – You can add dashboard widgets precisely where you want them and rearrange the dashboard with easy to use tools.
- Shareability – You can share dashboards easily with users, roles, and groups.

When you create a dashboard version of a homepage, the content is added to the new dashboard, but permissions associated with the homepage are not retained. To apply permissions to the dashboard, specify the permissions again. Users with whom you share a dashboard may or may not be able to edit the dashboard or share it with others. The ability to edit or share a dashboard is based on the user’s role and the permissions granted to them.

Note:

Only pages that are accessible through home.do can be converted. Manually coded UI pages that utilize the homepage layout system, but are not accessible through home.do cannot be converted.

Homepages with layouts that include scripts or style sheets might not work or might not look as expected after conversion. This discrepancy is because jelly code is not evaluated during conversion.

When you convert a homepage to a dashboard, the dashboard is independent of the homepage. Changes you make to the dashboard do not migrate to the source homepage. In addition, changes that you make to the homepage after conversion do not migrate to the dashboard.

1. Enable responsive dashboards. For more information, see Enable responsive dashboards.
2. Navigate to Self-Service > Homepage.
3. From the list, select the homepage you want to copy.
4. Click the Homepage settings icon ⚙️ and choose Create Dashboard Version.
5. Select **Create new dashboard** or **Add to existing dashboard** and click **Create**.

The **Add to existing dashboard** list contains only the dashboards you own.

When successful, the dashboard version opens as a new dashboard or as a tab on the selected dashboard.

**Note:** The layout of the dashboard version is similar to the homepage layout but may not be precisely the same.

**Note:** Homepages with dashboard versions show a button with the text **Open Dashboard Version**. This button takes the user to the most recently created dashboard version of the homepage.

You can share the dashboard version of your homepage with other users. See *Share a responsive dashboard*.

**Customize your homepage content**

Users with at least one role can see a customized homepage when logging in.
Note: If no write roles are specified on a homepage, then any user with one of the specified read roles may access this page and delete it. See Secure a homepage.

Note: Web Content Accessibility Guidelines (WCAG) 2.0/Section 508 features do not work with homepages. These features only work with dashboards. To convert your homepages, see Create a dashboard version of a homepage.

The content on the homepage comes from various sources, including:

- Graphs and charts generated from a report
- Application modules
- A service catalog category
- The scrolling news widget (the News knowledge category)

Note: Web Content Accessibility Guidelines (WCAG) 2.0/Section 508 features do not work with homepages. These features only work with dashboards. To convert your homepages, see Create a dashboard version of a homepage.

System Administration homepage

The System Administration homepage shows administrative tasks as catalog categories that provide administrators with quick access to all the items they need to configure core features, such as homepages, user administration, and email notifications.
## Sys admin homepage

Administrators can customize the System Administration homepage and [add a homepage to an update set and application](#).

## View and return to a homepage

When you log in to an instance or click the company logo, your homepage appears.
Users who customize their homepages see the customized homepage. Users who have not customized their homepages see the homepage for their role, such as admin or itil. If their role has no homepage, a blank page appears.

After logging in, navigate to **Self-Service > Homepage** to return to the last homepage you viewed.

**Note:** Users see the homepage with the lowest **Order** value of the pages they have roles to see when they log in. For more information, see *Create a new personal homepage*.

---

**View your homepage**

The homepage that you can see when you log on ServiceNow is controlled by a number of factors.

The homepage you see, depends on the following:

- If you personalized your homepage, the personalized homepage appears.
- If you did not personalize your homepage, the homepage for your role, such as admin or itil, appears. The homepage with the lowest **Order** value of the pages they have roles to see appears.
- If your role has no homepage, a blank page appears.

Log in to ServiceNow to access your homepage.

The number of records displayed in a list report on your homepage is limited to the number of records displayed in your lists. For example, if you display 100 records in your lists, a maximum of 100 records appears in your list report.

---

**Refresh the homepage**

Homepage users can specify a refresh time of 5, 15, 30, or 60 minutes, or no refresh. It is not possible to configure individual widgets to refresh automatically.

Click the cog wheel icon ( )
to choose a refresh interval. The default is **Off** (no refresh).

Click the refresh icon (⟳) at any time.

### Modify the number of records displayed in a list report

List reports added to a homepage display the same number of records as you have configured for other lists.

For example, if you display 100 records in lists, a maximum of 100 records appears in list reports. For instructions on changing this number, see [Configure and use list functions](#).

### Customize a homepage

You can customize the default homepages that appear for each user.

**Role required: admin**

- Administrators can customize the default homepages that appear for each user by navigating to **Homepage Admin > Pages** and selecting the homepage.
- Users who have roles can customize the homepages that are specified for their roles by navigating to **Self-Service > Homepage**.

1. Navigate to **Homepage Admin > Pages**.
2. Select the homepage to customize.
3. Click **Edit Homepage**.
   The homepage opens just as it does when you view it, but it is in edit mode.
   
   **Note:** Click **Edit Homepage** to make changes to a global homepage that take effect for all users who can access the homepage. If you click **View Homepage** and make changes, a personal homepage is automatically created for you and those changes take effect only on that personal homepage. To see the **Edit Homepage** link, you must enter a value in the **View** field.

4. Add items to the homepage.
   
   a) Click **Add Content**.
   
   A window opens that lets you select from the homepage items that you can add. Some items pertain to specific features and applications, such as CMS content blocks and the Work Management dispatch map. So the list of items varies depending on what is active on your system.
   
   **Warning:** Each widget on your homepage runs individually. For example, a homepage with 10 reports runs each report every time it refreshes. If your homepage consistently loads slowly, try removing widgets to determine why.
   
   b) Select an item to add.
   
   - **Reports:** Reports to the homepage.
   - **Gadgets:** Items like a knowledge search field and sticky notes.
   - **Knowledge Base:** Knowledge base categories.
   - **Labels:** Labels that you use to organize records.
   - **System Applications:** Applications and modules.
   - **World Clocks:** Any available World Clock.
     
     **Note:** The world clock widget is for demo purposes only.
   
   - **Gauges:** All available dashboard gauges. Gauges are defined in **System UI > Gauges**.
     
     **Note:** Gauges are not supported. Add reports to the homepage instead. For more information, see **Add existing reports to a homepage**.
   
   - **Catalog Categories:** Active service catalog categories. The homepage uses the desktop icon of the category as the homepage icon.
   - **Catalogs:** Service catalogs, including all their active categories (starting with the Eureka release).
   - **Diagnostics:** Information you can use for monitoring and troubleshooting your instance, like database connections and JVM garbage collection.
   - **Live Feed:** Your company feed.
   - **Text Search:** Lists of top searches in your instance.
   - **Filters:** System definition filters.

5. Reposition elements on your homepage by dragging and dropping them to a new location.
   The change you make to the homepage is saved automatically.

6. To remove a homepage item, click the (X) on the right side of the header of the item.

### Homepage items

You can add different types of objects or widgets to homepages using the **Add content** button.
In the pop-up window, you select the homepage item you want to add. Some items pertain to specific features and applications. The available items vary depending on what is active on your system.

**Warning:** Each report on your homepage runs individually. For example, a homepage with 10 reports runs each report every time it refreshes. Keep this in mind when adding content to your homepage. If your homepage consistently loads slowly, try removing reports to determine why.

You can reposition items on a homepage by clicking the item header and dragging it to the new location. To remove a homepage item, click the close icon (X) on the right side of the item header.

### Homepage Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Add reports to the homepage. For more information, see <a href="#">Add existing reports to a homepage</a>.</td>
</tr>
<tr>
<td>Gadgets</td>
<td>Items such as a knowledge search field and sticky notes.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Knowledge base categories.</td>
</tr>
<tr>
<td>Labels</td>
<td>Labels that you use to organize records.</td>
</tr>
<tr>
<td>System Applications</td>
<td>Applications and modules.</td>
</tr>
<tr>
<td>World Clocks</td>
<td>Any available world clock.</td>
</tr>
<tr>
<td>Catalog Categories</td>
<td>Active service catalog categories. The homepage uses the category©s desktop icon as the homepage icon.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Service catalogs, including all of their active categories.</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Information you can use for monitoring and troubleshooting the instance, like database connections and JVM garbage collection.</td>
</tr>
<tr>
<td>Live Feed</td>
<td>Your company feed.</td>
</tr>
<tr>
<td>Text Search</td>
<td>Lists of top searches in the instance.</td>
</tr>
<tr>
<td>Filters</td>
<td>System definition filters.</td>
</tr>
</tbody>
</table>

**Note:** The world clock widget is for demo purposes only.

**Note:** Gauges are not supported. Add reports to the homepage instead. For more information, see [Add existing reports to a homepage](#).

For more information on adding content to homepages, see [Add existing reports to a homepage](#).
Edit widget appearance

You can edit how an object on a homepage, also called a widget, looks.

1. Move the pointer to the upper right corner of the widget to show the editing controls.
2. Click the edit widget icon on the right side of the item header.
3. Select one or more options to control the appearance of the widget, such as to show a border, set title alignment and size, and set the report height.
4. Optional: Use the Interactivity options to make the widget a subscriber or publisher. Interactive publishers require Performance Analytics.
5. Click Done.

Change the homepage layout

You can change the layout of widgets on the homepage.

1. From a homepage, click the Change Layout button.
2. Select the layout you want to use.
   Administrators can create or modify layouts by navigating to Homepage Admin > Layouts.
3. Click Change.
**Delete a custom homepage**

Deleting a customized page restores the default homepage for that user.

⚠️ **Warning:** If a user with the admin role clicks **Delete page**, it deletes the homepage from the instance, which affects all users. This action cannot be reverted.

1. Navigate to the custom homepage to delete.
2. Click the homepage settings icon (🔧).

---

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. Click **Delete page**.
4. Click **OK** to confirm the deletion.

### Homepage and content page layouts

Layouts are UI elements that define how blocks of content can be added to a page.

Layouts are used for homepages and content pages. Layouts provide the following functionality.

- Administrators can define custom layouts for homepages or content pages.
- Users who are allowed to modify their homepage can select a layout for their homepage.
- Users who are allowed to add content to their homepages can choose where in the layout to add content.

Most successful web sites use a fairly limited number of layouts to define the structure of a much larger number of pages. For example, a web site may have several dozen pages, but only two or three layouts.

### Layout concepts

Layouts define the overall structure of the page by arranging where dropzones appear on the page.

The dropzone is where content blocks, which make up the content of the page, can be added. The name “dropzone” comes from the fact that content blocks can be dropped into any of these zones. Most content blocks match the width of the dropzone, so the dropzone controls both the location and sizing of the content block.

Defining a custom layout requires knowledge of Jelly script, but there are a number of out-of-box layouts that can be used. After a layout is chosen, the layout dictates where the dropzones on a page appear.

Content blocks can be added at any dropzone to create the actual content of the site. Every layout divides the page into one or more logical areas. A number of commonly used predefined layouts are available, but you can also define your own custom layouts.

### Custom layouts

A homepage layout is a UI macro whose name begins with `layout_`. You can create a UI macro to define a custom layout.

To view the list of available layouts, navigate to **Homepage Admin** > **Layouts**.

- Layouts are XHTML scripts that contains one or more dropzones.
- Dropzones are defined by a TD (table data cell) within the HTML where content can be placed.

---

**Note:** Knowledge of Jelly is required to understand the following example.

For example, here is the code for a layout.

```xml
<?xml version="1.0" encoding="utf-8"?>
<j:jelly trim="true" xmlns:j="jelly:core" xmlns:g="glide"
xmlns:j2="null" xmlns:g2="null">
<table border="0" cellspacing="6" id="${jvar_name}" width="100%">
<tr>
<td colspan="2" id="dropzone0" dropzone="true"/>
</tr>
</table>
</j:jelly>
```
Rules for scripting layouts:

1. A layout must contain at least one table.
2. All dropzones must be TDs within a table.
3. A dropzone has two key attributes:
   a. Its ID starts with "dropzone" (e.g., "dropzone2" or "dropzone3").
   b. It has an attribute of dropzone="true."
4. Dropzone IDs must be unique (e.g., you can't have two dropzones named "dropzone1").

Optional layout features:

- Nested tables are allowed, so it is possible to have a table within a TD within a table.
- There can be TDs that are not dropzones.
- Styles and formatting elements are acceptable.
- Fixed-width TDs (as opposed to variable width) are allowed, although some content, such as graphs, must have a significant minimum width.
- Fixed-height TDs are allowed.

Layout hints and tips:

If cellspacing and cellpadding are set to zero, the drag-and-drop algorithm may have trouble distinguishing one cell from another, since multiple empty cells can potentially occupy the same point in space. It is still possible to place things via the layout control, and they will render properly. However, to use drag-and-drop to move things around, do not drop both cellspacing and padding to zero.

Choose a layout

Certain users can modify the layout of their homepage.

Role required: any role that lets the user change homepage content.

For example, an ESS user cannot change the layout of a homepage, but an ITIL user can change it.

1. On the homepage, click Change Layout.
   The dialog box that appears contains a list of available layouts and a short description of each. Select a layout to see a simplified preview of the layout.
2. Select a layout and click **Change**.

**Note:**

1. If the page already has content and the layout changes, the existing content stays in the same dropzones it started in. For example, content in dropzone2 of the old layout appears in dropzone2 of the new layout as well, although the dropzone may be in a significantly different location on the page.

2. If the new layout has fewer or different dropzones than the old layout, there may be orphaned content. For example, if there is content in dropzone5 of the old layout, and the new layout does not have a dropzone5, that content is now orphaned. Any orphaned content is moved to dropzone1.

---

**Add content to a homepage**

The Add Content interface allows you to specify into which dropzone you want to place your content.

You can see this in action by clicking the **Add content** button.
When you select a piece of content, you see a preview of the content in the middle of the dialog. At the bottom of the dialog, you see a model of your current layout with an **Add here** link in each dropzone.
To add content to a particular dropzone, click **Add here** in the appropriate dropzone. Your content is automatically added without closing the dialog. You see the homepage change in the background.

Users who can change content on a homepage can search for widgets within a category when adding content to a homepage, and configure the appearance of widgets on homepages.

**Homepage caching**

Complex, frequently visited homepages can slow down instance performance by consuming system resources. Homepage caching can improve performance by using less resources to load homepages.

When this feature is enabled, individual homepage widgets are cached and can be used by multiple users until the underlying data they depend upon changes, requiring a re-render.

Administrators can configure properties for homepage caching.

**Configure homepage cache properties**

The render cache is enabled by default with a set of sensible defaults. An administrator can modify the configuration based on the needs of the particular instance.

This behavior is controlled by properties available at **Homepage Admin > Properties**.

**Enable the homepage render cache**

Enables or disables the entire cache. If you disable the cache, then nothing is cached and nothing is retrieved from the cache.

**Maximum amount of time an entry stays in the cache**

By default, the system pulls an entry out of the cache if its underlying data changes. For example, if you have a report of ‘incidents by priority’ that goes in the cache, the system removes it from the cache if the underlying incident data is updated. However, even if the underlying data has not changed, the system automatically expires cache entries older than this age. The default is 60 seconds, meaning that, at most, a cache entry persists for 60 seconds before being expired.

**Enable aggressive caching**

If aggressive caching is turned on, then the only time entries are removed from the render cache is if they expire. Even if the underlying data changes, the system still returns the previously rendered chart/graph/whatever until it expires from old age.

Setting this to true can significantly improve performance, but it does so at the expense of serving known stale data. Under some circumstances, however, a combination of aggressive caching and a short maximum cache age (see above), may be appropriate.

**Homepage caching notes and limitations**

Review these notes and limitation when configuring homepage caching.

1. Instances with less than one hundred or so concurrent users should not expect to see a significant benefit to this feature in most real-world scenarios. Homepage visits in these situations are infrequent enough that most widgets will have aged out of the cache before a second user visits a homepage. If you do not experience performance problems with your homepages, tweaking the behavior of this cache is not recommended.

2. The homepage cache is segmented by company, domain, and roles, so users with different rights and visibility into the system cannot see each other's data by pulling it out of the
cache. This does, however, mean that cache efficiency will be lower for instances that make extensive use of domain separation.

3. In an environment with a cluster of multiple UI nodes (as opposed to a UI node and worker configuration), each node has its own homepage cache. Entries are removed from the homepage cache only when their data changes on the node upon which they are cached. Entries are always removed from the cache when they expire.

**Homepage splash page**

When the homepage splash page is configured, a lightweight splash page loads before a homepage loads. The result is a more responsive experience for users.

For example, after logging in, users can navigate directly to the information they need without waiting for the homepage to load.

![Homepage splash page](image1)

**Activate the homepage splash page**

Homepage splash pages are automatically activated for new instances. If you are upgrading from a previous version, activate the Homepage Splash Page plugin if it is not already active.

Role required: admin

For evaluation, you can activate the plugin for an application that requires a purchased subscription on a non-production instance. To activate the plugin on production instances, you must purchase the subscription. To purchase a subscription, contact your ServiceNow account manager. For details on purchasing a plugin, see [Purchase a plugin](#).

Some plugins require activation by ServiceNow personnel. Request these plugins through the HI Customer Service System instead of activating them yourself. For details, see [Request a plugin](#).
For plugins that you can activate yourself, continue with the following steps.

1. Navigate to **System Definition > Plugins**.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
   - If the plugin has optional features that depend on other plugins, those plugins are listed under **Some files will not be loaded because these plugins are inactive**. The optional features are not installed until the listed plugins are installed (before or after the installation of the current plugin).
4. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—Sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good practice when you first activate the plugin on a development or test instance.
   - You can also load demo data after the plugin is activated by clicking the **Load Demo Data Only** related link on the System Plugin form.
5. Click **Activate**.

### Configure a property for a homepage splash page

The Homepage Splash Page plugin installs the `glide.home.page` property and modifies the value of the `glide.login.home` property.

1. Enter `sys_properties.list` in the navigation filter and press the Enter key.
2. Select the `glide.home.page` system property.
   - This property defines which page to load when a user selects a homepage from the banner.
3. Set the **Value** field to one of the following strings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use the homepage splash page (default)</td>
<td><code>home_splash.do?sysparm_direct=true</code></td>
</tr>
<tr>
<td>To use homepages without the splash page</td>
<td><code>home.do</code></td>
</tr>
</tbody>
</table>

4. Click **Update**.
   - The System Properties list reopens.
5. Select the `glide.login.home` system property.
   - This property defines which page to load when a user logs in.
6. Set the **Value** as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use the homepage splash page (default)</td>
<td><code>home_splash.do?sysparm_direct=true</code></td>
</tr>
<tr>
<td>To use homepages without the splash page</td>
<td><code>home.do</code></td>
</tr>
</tbody>
</table>

You can also specify a different login landing page, if desired.
7. Click **Update**.

### Service catalog home page configuration

The home page for a service catalog provides the primary front end for ordering items within that catalog. You can configure various elements of the pages within the Service Catalog.
Administrators and catalog administrators can design a home page in any of the following ways.

- Customizing the catalog home page.
- Adding, removing, and arranging categories.
- Enabling content types.
- Using catalog properties to provide additional control over behavior and appearance.
- Using renderers to define the appearance of categories.

**Note:** End users can access the catalog through the customizable user home page, or with content management pages that use content blocks for categories.

### Enable content types

Enable the content types for using in a catalog.

1. Navigate to Service Catalog > Catalog Administration > Properties.
2. In the **List of content types (comma-separated) to allow on the catalog homepage** (glide.sc.home.filter) property, enter the content types to use in the service catalog.

   To see a list of content types available, navigate to System UI > Widgets.

   The default value is Service Catalog, which includes only service catalog categories. For example, to include service catalog categories and gauges, set the property to Service Catalog, Gauges.

### Customize a catalog homepage

Customize a catalog homepage to provide end users with access to catalogs from one homepage.

1. Navigate to Service Catalog > Catalog.
2. Click the add content icon (+) at the top of the page to add a category.
3. Select a category in the middle panel of the pop-up window that appears.
4. Click **Add here** in the location where the category appears on the homepage.
5. Optional: Repeat steps 3–4 to add more categories.
6. Close the pop-up window.
7. Optional: To change a category location, drag it to the appropriate place.
8. Optional: To remove a category, click the (X) icon on the top right of the category header.

**Define the mobile layout**

You can configure the mobile layout for categories within a service catalog.

Role required: admin

By default, service catalog categories appear on mobile devices in the same order as on desktop devices.

1. Navigate to **Service Catalog > Mobile Admin > Mobile Layout** to display a list of service catalogs.
2. Click the lookup icon for the service catalog you want to configure.
   The mobile layout displays details for the catalog.
3. Click **Edit** to select which categories appear on mobile devices, and in which order.
Service Catalog mobile layout catalogs

4. Add, remove, or reorder the selected mobile categories, and then click **Save**.
Configure content types

You can configure content types for the service catalog.

You can use service catalog properties to configure content types, which are also called widgets.

To view service catalog properties, navigate to Service Catalog > Catalog Administration > Properties.

Navigate to System UI > Widgets to see a list of content types available.

Enable content types for the Service Catalog

By default, only service catalog categories are displayed on the service catalog homepage.

To select additional content types, add these types in a comma-separated list in the List of content types (comma-separated) to allow on the catalog homepage property (glide.sc.home.filter).

For example, to include service catalog categories and gauges, set the property to Catalog Categories, Gauges.

Display the expand/collapse icon

By default, the expand / collapse icon is not displayed for categories on the service catalog homepage.

To display this icon on the left of each category, select the Yes check box that appears next to the Toggle whether the expand/collapse icon is rendered for category widgets on the service catalog homepage property (glide.sc.homepage.show.collapse).
Configure search and navigation

You can use service catalog properties to configure search and navigation within the service catalog homepage.

Navigate to Service Catalog > Catalog Administration > Properties to view service catalog properties.

Restrict search access

Each catalog homepage provides a search bar to help locate items not displayed on the homepage. By default, any user who can access the catalog homepage can search using this search bar.
To restrict access to this search function by role, use the **List of roles (comma-separated) that can search the service catalog** property (**glide.sc.can_search**).

For example, to only allow logged-in users to access search, set this field to blank. To remove the search function for all users, set this field to **None**.

**Note:** Search results only show items that the logged-in user can access.

---

**Hide search results from inactive categories**

By default, search results are returned from all categories, including inactive categories.

To avoid returning results from inactive categories, set the **Service catalog searches return items in inactive categories** property (**glide.sc.search.disabled_cats**) to **No**. For example, when designing a new category, you can avoid users seeing search results from this category until you are ready to make it active.

**Note:** Security constraints can also make a category or catalog item inaccessible.

---

**Restrict search by item type**

By default, a search field does not appear when viewing order guides, record producers, and wizard launchers.

To define which catalog item types do not show the search field, list these types in the **List of class names for catalog items that do not have the search field displayed** (**glide.sc.item.cannot_show_search**) property.

For example, to enable searching when viewing record producers, remove **sc_cat_item_producer** from this list.
Request a reset of a password for a service or an application.

Whose password needs to be reset?

Joe Employee

What application password do you need reset?

How would you like to be contacted with your new password?

More Information

- Email
- Telephone
- SMS

Submit
Service catalog search bar enabled

Enable breadcrumb links

By default, breadcrumbs appear without links when using content management pages as service catalog homepages.

To display these breadcrumbs with links, set the **Use links for breadcrumbs rendered in Service Catalog pages accessed via a CMS site** property (**glide.sc.use_breadcrumb_links.cms**) to **Yes**. This setting provides greater navigational control for end users.

Disable search suggestions

By default, service catalog searches display "Did you mean?" suggestions if a search does not return any results and an alternate spelling or similar recent search does.

To disable these suggestions, set the **Specify whether search suggestions should be enabled** property (**glide.sc.search.suggestions**) to **No**.

Change the parameter for parallel homepage rendering

The system uses a parallel rendering algorithm to speed up home page rendering.
Role required: admin

In testing, the average performance benefit is between 20% to 50% depending on the page in question. Administrators can set parallel homepage rendering properties for optimal performance on an instance. To change the parameters for parallel homepage rendering, add the following system properties.

1. `glide.ui.homepage.parallel`: enables or disables parallel homepage rendering. The default value is `true`.
2. `glide.ui.homepage.parallelism`: sets the number of threads to use when rendering a homepage. The default value is `2`.

Turn on homepage render time

To see render times on homepage widgets, you can turn on homepage debugging.

Role required: admin

Navigate to System Diagnostics > Debug Homepage Render.
For the remainder of your session, load times appear on homepage widgets and debugging messages appear at the bottom of homepages. Use these times to identify items that may slow down homepage rendering.
Troubleshoot a report on a homepage

You can troubleshoot reports that may be impacting homepage performance by identifying which reports are on the problem homepage, determining which reports are running slowly, and correcting problems in slow reports.

Role required: admin

1. Navigate to **Homepage Admin > Pages**.
   Opening the homepage record instead of the homepage saves time and system resources.
2. Open the problem homepage record.
3. In the **Portal** related list, note item names in the **Summary** field.
   These items may not all be reports.
4. Enter `sys_report.list` in the navigation filter to open a list of all reports.
5. Search for a report title that matches an item on the homepage that you noted down from the **Summary** field.
6. Open the report and run it.
7. If the report runs slowly, look for and correct the following common reporting mistakes.
   - Returning too many results
   - Grouping by fields such as duration or name
   - Reporting on a user-created table that uses many joins on other tables
8. If the report runs slowly and correcting common mistakes does not help, examine the type of report and what data it reports. Look for ways to optimize or replace the report.
9. Repeat these steps for each item on the homepage.
Index

Numerics

508 compliance
  keyboard accessibility 354
508 compliance screen reader 357

A

accessibility
  color and style 355
  first field focus 354
  high contrast 353
  screen reader 357
accessibility features
  search method tips 357
  set up 351
activity formatter
  activity filter configuration 68
  activity filter in UI1 68
  activity filter in UI16 and UI15 68
activity stream
  mentions 197
application menu
  creating 45
  modules, creating 46
application menus
  adding to a category 44
application menus or modules
  disabling 43
  enabling 43
application navigator
  navigation filter 42
  UI1 37, 38
  UI11 perspectives 38
  UI15 29
  UI15 favorites 31
  UI16 16, 19
  UI16 favorites 20
  UI16 navigation history 23, 24
Attachments
  remove 88
  rename 88
  uploading 88, 89
avatar 203

B

banner frame
  UI1 39
  UI15 31
  UI16 24
basic configuration 329, 333
bookmarks
  creating 54
  customizing 55
  deleting 56
  opening 56
brand instance 329, 333
breadcrumbs 123
Breadcrumbs 125, 126, 126, 127, 133, 136, 138, 139, 141, 141, 141, 141, 142

C

Catalog
  home page
    managing 397
  homepage
    managing 398, 398, 400, 402, 403
change password module
  create 52
checklists
  enable 90
Company Profile
  create 357, 359, 359, 360, 361, 362
Condition builder
  date/time fields 179
  empty fields, filtering 178
  format 177
Condition builders
  operators 181
content-sensitive help
  help context types 234
context-sensitive help
  creating custom contexts 232
  introduction to 228
Core Configuration
  overview 219
create homepages
  for specific users 377
  global 377
  new personal 376
  personal based on existing 377
CSS changes 343
CSS release changes 343
CSS styles
  default 338
CSS theme
  selecting 336
  theme picker, enabling 336
CSS theme support
  activating 336
custom filter URL
  URL module 51
customize homepages
  add items 387
  change 389
  custom homepage 390
  delete 390
  edit widget appearance 389
  homepage 383, 384, 385
  homepage layout 389
  list report 386
  modify 386
  number of records 386
  refresh 385
<table>
<thead>
<tr>
<th>Page</th>
<th>ServiceNow Jakarta Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>system administration 383</td>
<td>view 384</td>
</tr>
<tr>
<td>database</td>
<td>audio files 280</td>
</tr>
<tr>
<td>Database</td>
<td>storing images 280, 281, 281</td>
</tr>
<tr>
<td>Dot-walking</td>
<td>159</td>
</tr>
<tr>
<td>Dot-walking examples</td>
<td>160</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>database</td>
<td></td>
</tr>
<tr>
<td></td>
<td>audio files 280</td>
</tr>
<tr>
<td>Database</td>
<td>storing images 280, 281, 281</td>
</tr>
<tr>
<td>Dot-walking</td>
<td>159</td>
</tr>
<tr>
<td>Dot-walking examples</td>
<td>160</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>edge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UI1 40</td>
</tr>
<tr>
<td></td>
<td>UI15 31</td>
</tr>
<tr>
<td>edit guided tour</td>
<td>257</td>
</tr>
<tr>
<td>editing form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>edit multiple records in a list using 151</td>
</tr>
<tr>
<td>editing forms</td>
<td>canceling changes 84</td>
</tr>
<tr>
<td></td>
<td>inserting records 83</td>
</tr>
<tr>
<td>embedded help</td>
<td>add 245</td>
</tr>
<tr>
<td></td>
<td>add from copy 244</td>
</tr>
<tr>
<td></td>
<td>planning 240</td>
</tr>
<tr>
<td></td>
<td>system properties 239</td>
</tr>
<tr>
<td>embedded help roles</td>
<td>242</td>
</tr>
<tr>
<td>embedded lists</td>
<td>69</td>
</tr>
<tr>
<td>encoded queries</td>
<td>operators 181</td>
</tr>
<tr>
<td>Encoded Query Strings</td>
<td>generate through filter 146</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>favorite</td>
<td>19</td>
</tr>
<tr>
<td>field label</td>
<td>form 366</td>
</tr>
<tr>
<td></td>
<td>help 366</td>
</tr>
<tr>
<td>field status indicators</td>
<td>UI1 67</td>
</tr>
<tr>
<td></td>
<td>UI15 66</td>
</tr>
<tr>
<td>field values</td>
<td>comparing 362</td>
</tr>
<tr>
<td></td>
<td>dates, evaluating 365</td>
</tr>
<tr>
<td>fields on a form</td>
<td>66</td>
</tr>
<tr>
<td>filters</td>
<td>operators 181</td>
</tr>
<tr>
<td>Filters</td>
<td>delete 139</td>
</tr>
<tr>
<td></td>
<td>edit 139</td>
</tr>
<tr>
<td></td>
<td>related list condition 129</td>
</tr>
<tr>
<td></td>
<td>save 139</td>
</tr>
<tr>
<td></td>
<td>use 139</td>
</tr>
<tr>
<td>form context menu</td>
<td>64</td>
</tr>
<tr>
<td>form fields</td>
<td>66</td>
</tr>
<tr>
<td>form pane tabs</td>
<td>85</td>
</tr>
<tr>
<td>forms</td>
<td>, apply a template 84</td>
</tr>
<tr>
<td></td>
<td>, editing 82</td>
</tr>
<tr>
<td>canceling changes</td>
<td>84</td>
</tr>
<tr>
<td>checklists</td>
<td>activating 92</td>
</tr>
<tr>
<td></td>
<td>creating new 92</td>
</tr>
<tr>
<td></td>
<td>deleting 93</td>
</tr>
<tr>
<td></td>
<td>enable 90</td>
</tr>
<tr>
<td>configuring related list fields</td>
<td>78</td>
</tr>
<tr>
<td>editing</td>
<td>83, 84</td>
</tr>
<tr>
<td>field status indicators</td>
<td>66, 67</td>
</tr>
<tr>
<td>form headers by version</td>
<td>59</td>
</tr>
<tr>
<td>form headers, UI1 62</td>
<td></td>
</tr>
<tr>
<td>form headers, UI15 61</td>
<td></td>
</tr>
<tr>
<td>form headers, UI16 59</td>
<td></td>
</tr>
<tr>
<td>form pane tabs</td>
<td>85</td>
</tr>
<tr>
<td>inserting records</td>
<td>83</td>
</tr>
<tr>
<td>personalizing records</td>
<td>86</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>gauges</td>
<td>domain separation 372</td>
</tr>
<tr>
<td>glide.ui16.live_forms.enabled</td>
<td>205</td>
</tr>
<tr>
<td>grid mode</td>
<td>156</td>
</tr>
<tr>
<td>grouped list</td>
<td>list v3 121</td>
</tr>
<tr>
<td>grouped lists</td>
<td>options 119</td>
</tr>
<tr>
<td>gtd</td>
<td>251</td>
</tr>
<tr>
<td>guided tour</td>
<td>add 253</td>
</tr>
<tr>
<td>guided tour designer</td>
<td>251</td>
</tr>
<tr>
<td>guided tour triggers</td>
<td>250</td>
</tr>
<tr>
<td>guided tour view</td>
<td>258</td>
</tr>
<tr>
<td>guided tours</td>
<td>248</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>help</td>
<td>overview help slides</td>
</tr>
<tr>
<td></td>
<td>creating 261</td>
</tr>
<tr>
<td></td>
<td>example 264</td>
</tr>
<tr>
<td>system user guide</td>
<td>configuring the help page 278</td>
</tr>
<tr>
<td></td>
<td>creating a help page 273</td>
</tr>
<tr>
<td></td>
<td>creating a section 274</td>
</tr>
<tr>
<td></td>
<td>creating entry points for display 279</td>
</tr>
<tr>
<td></td>
<td>creating help documents 275</td>
</tr>
<tr>
<td>help system</td>
<td>introduction to 228</td>
</tr>
<tr>
<td>homepage</td>
<td>adding 373</td>
</tr>
<tr>
<td></td>
<td>controlling access 374</td>
</tr>
<tr>
<td></td>
<td>customizing 386</td>
</tr>
<tr>
<td></td>
<td>defining tables for 374</td>
</tr>
<tr>
<td>Top Searches</td>
<td>373, 373, 373, 374, 374, 374, 374</td>
</tr>
<tr>
<td>update top search statistics</td>
<td>374</td>
</tr>
<tr>
<td>using</td>
<td>373</td>
</tr>
<tr>
<td>viewing</td>
<td>385</td>
</tr>
<tr>
<td>viewing user preferences for time period</td>
<td>374</td>
</tr>
<tr>
<td>homepage administration</td>
<td>add to an update set and application 370</td>
</tr>
<tr>
<td></td>
<td>restrict content additions 369</td>
</tr>
</tbody>
</table>
secure a homepage 370
user preferences 370
homepage caching
configure properties 395
notes and limitations 395
homepage gauges 373
homepage splash page
activate plugin 396
configure 397
homepage widgets 375
homepages
customize 382, 383, 384, 385, 386, 387, 389, 390
render time 407
troubleshooting 409
widgets 371
Homepages
gauges 372
widgets 371, 371
I
image file extension 285
Interface
using 54
K
keyboard accessibility 354
L
latitude 315
layout
add content 393
choose 392
concepts 391
custom 391
defining 391
list editor
edit multiple records in a list using 150
use 148
list v2 99
list v3
grid mode 156
group by 121
split mode 156, 157
lists
editing 147
field status indicator 110
personalizing 152, 154
search 116
search by column 117
sort 110
switch views 112
lists, embedded 69
logging in 42
longitude 315
M
manage favorite 19
map locations 315
map pages
create 320
create modules 324
scripting 325
mentions
activity stream 197
menu categories
adding application menus to 44
menu category
defining 35, 41
menu lists
modifying 43
module icons
modify 38
module link type 48
most active tags
activating 216
deactivating 217
removing 217
most recent tags
activating 216
deactivating 217
removing 217
N
Navigation Actions
adding sites 227
users 228
Navigation and UI
view management 310
Navigation Stack 221
new records
create 149
O
operators
Condition builders 181
encoded queries 181
filters 181
overview help pages
creating
example 264
P
parallel homepage
rendering 406
personal lists 152
Q
queries 51
R
recently viewed records
history 215
related list condition 129
related lists
  adding fields 78
  configure the edit option 72
  configure when a related list loads 71
  create a default filter 72
  create default filter 80
  create defined 73
  example of defined 75, 77
  incidents by same caller 75
  select related records 70
Response time indicator 219, 221

S
search
  lists
    wildcards 118
  wildcards
    list search 118
section 508 compliance features
  disable list editor 352
  enable accessibility 352
  use skip links 353
shortcuts
  keyboard 217
slushbuckets
  arrange selections 172
  find available items 173
  items
    setting the number of visible in the available column 174
    use 172
split mode
  configure fitte 156
  list v3 156, 157
system properties
  embedded help 239
  system settings 24

T
tag
  assigning 207, 208, 209, 209, 210, 211
  editing 207, 211, 211, 212, 212, 212
  using 213

themes
  apply in a form 84
  company default 337
  create 337
  customize 337
Theming an Instance 329, 334, 335, 335, 336, 343
tree picker
  examples 175
tree picker attribute
  add 175

U
Ui configuration
  favicon 359
UI15
  configure roles to switch to UI16 16
  switch to UI16 15
UI15 compare style 11
UI16
  activating 15
  configure roles to switch to UI15 16
  switch to UI15 15
UI16 compare style 11
URL
  navigating 200, 201, 201
URL module
  custom filter URL 51
  opens in new window 51
useful scripts
  Restrict Form Views by Role 311
user guide
  configuring the help page 278
  creating a help page 273
  creating a section 274
  creating entry points for display 279
  creating help documents 275
  introduction to 271
user interface
  banner frame
    UI16 24
User interface
  application navigator
    navigation filter 42
    UI11 37, 38
    UI11 perspectives 38
    UI15 29
    UI15 favorites 31
    UI16 16, 19
    UI16 favorites 20
    UI16 navigation history 23, 24
  banner frame
    UI11 39
    UI15 31
  browser support 218
  disabling UI15 29
  edge
    UI11 40
    UI15 31
  navigating applications 42
user interface plugins
  components 199
user preference settings 287
user preferences 285
user presence
  disabling 204
using forms
  form headers 59
  UI11 form headers 62
  UI15 form headers 61
  UI16 form headers 59
using lists
  action check box 112
  column headings 105
  customize number of rows 111
  embedded lists 113
  fields 108
list title menu 102
list v2 99
list v3
grid mode 156
split mode 156, 157
pop-up forms 107
Using Lists
  display activity streams 114
  encoded query strings 144, 146

V
View Management
  create a view rule 310

W
welcome page
  content 313
  elements 313
  login section 313
welcome page content
  company-specific 314
welcome screen
  remove 305